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Warning: The GIFtools cookbook provides supporting documentation for proprietary software developed by
the UBC Geophysical Inversion Facility. Currently, GIFtools software is only accessible by the consortium of
companies which funded the GIFtools project. Plans to commercialize this software is underway.

Welcome to the GIFtools cookbook! Below you will find the Quick-start guide (introduction and installation), and links
to all of GIFtools functionality.
Warning: The GIFtools cookbook provides supporting documentation for proprietary software developed by
the UBC Geophysical Inversion Facility. Currently, GIFtools software is only accessible by the consortium of
companies which funded the GIFtools project. Plans to commercialize this software is underway.
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CHAPTER

ONE

GIFTOOLS QUICK-START GUIDE

• Framework
• Interface (GUI)

1.1 Why GIFtools ?
The UBC-Geophysical Inversion Facility
(GIF) has developed a large number of highperformance forward modeling and inversion codes over the last decades. While
proving to be useful in characterizing the
sub-surface, the usability of these codes remained challenging due to the number of
complex tasks needed from the user:
(1) Gather and format a wide range of
geoscientific data
(2) Interact with various Fortran codes
and utilities
(3) Manage and archive projects
GIFtools has been designed to facilitate the
interaction between the practicing geophysists and the various forward and inversion
codes through a modular Framework. The front-end of GIFtools is its Graphical User Interface (GUI) menu structure.

1.2 GIFtools Framework
The GIFtools Framework has been
designed to store, visualize and modify the different Objects needed to interact with the various Fortran executable. In computer language, an
object is a container holding a set of
attributes and functions that can be
used to perform tasks. You can think

3

GIFtoolsCookbook Documentation, Release 1.0

of it as computer hardware. For example, a GIFdata object knows all the necessary details about the geophysical experiment (location, receivers, units,
etc.) and can perform actions (add/substract, write to file, plot, etc.)
Objects can be linked to each other, like building
blocks, to achieve more complex tasks. For example,
a Model needs a Mesh in order to exist in 3D and be
visualized.
More complex objects, such as a GIFinversion, need to
know about many other objects in order to exist (Data,
Mesh and Model). Once all the pieces are connected,
the inversion object can interact with external Fortran
codes and knows how to handle the various outputs.

1.3 Graphical
(GUI)

User

Interface

The next four subsections will describe the main components of GIFtools pointed out below:
The following video also introduces the look and feel of
GIFtools:
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1.3.1 Menus
GIFtools is menu driven. To perform any action, the user can select from the appropriate menu at the top of the GIFtools
window (or right-click the object to bring up the menu options). The four main menus that are always available are:
1. Project: This menu allows you to save / load / add a project, set the working directory (where the project will
write/look for files) or set the number of OpenMP threads (for running inversions).
2. Edit: This menu will let you rename, copy, or delete the object that is currently selected.
3. Import: This is the main menu structure for importing items (data, meshes, etc) into GIFtools (see Importing
Files for a list of items to import).
4. Create: This menu allows the user to create items such as Folders (to keep the tree organized; see below),
Workflows, Inversions, and other items that may call Fortran executables created by UBC-GIF
Beyond these four menus, additional menus will appear depending upon the item that is selected, such as
Visualization (above is an example when selecting a mesh3D item):

1.3.2 Tree
All of the items in GIFtools fall under a GIFproject. Beyond that, each is present in the tree structure on the right-side.
Folders can be created or are transformed (in the case of inversions that have been loaded) to contain other items. In the
above case, the gravity gradiometry data (GGdata object), topography (TOPOdata object), and mesh (mesh3D object)
are in the folder final, but are still in the project. To move items to a folder, simply left-click, drag-and-drop the
item into the folder. To get items back to the main project folder, drag-and-drop to the GIFproject at the very top.

1.3.3 Information panel
Every item selected has a panel that shows up on the right-side of the main GIFtools window. This panel gives the
user a brief over-view of the item, such as the number of cells for a mesh, or the number of frequencies in an FEMdata
(Frequency-ElectroMagnetics Data) item. For data items, certain columns must be denoted in order to export them for
inversion. These are known as input/output headers (often referred to as i/o headers).

1.3. Graphical User Interface (GUI)

5

GIFtoolsCookbook Documentation, Release 1.0

1.3.4 Notes section
This is a section where a log of what has happened to the selected item is recorded. Additionally, users may write their
own comments in this section to remind them what was performed. To write notes, click on the note section and begin
typing.

1.3.5 Need Help?
When you get to a dialog box and are not sure what to do, look for the question mark button:

The button will link you to a short tutorial on how (a) you got there and (b) what to do inside the dialog box. If you
find a bad link, let us know here !
Warning: The GIFtools cookbook provides supporting documentation for proprietary software developed by
the UBC Geophysical Inversion Facility. Currently, GIFtools software is only accessible by the consortium of
companies which funded the GIFtools project. Plans to commercialize this software is underway.
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CHAPTER

TWO

INSTALLATION

To install GIFtools, you will need to go the the website and download the latest installation executable (Log-in required).
To obtained a login, please contact us
• System Requirement

2.1 Installation notes
The two available executables are either GIFtools_vXpX_install or GIFtools_vXpX_offlineInstall. The only
difference is that the off-line install is much bigger to ensure that the Matlab run-time environment that is needed is
accessible if not already installed. The former installation executable will use the internet to call Matlab to check on
the environment and download if necessary. Either way, you will need administrator privileges. Once downloaded
here are the 7 steps to follow:
1. Double click on executable, which will lead you to this screen (you can trust us. . . ):

If you use a proxy server and you are using the GIFtools_vXpX_install.exe, you will need to click on the Connection
Settings button and put the server name and port along with a user ID and password to access the internet.
2. Click Next and choose the installation directory for GIFtools. This does not necessarily need to be in C:\
Program Files\GIF! If you have created another folder somewhere on your computer, you may install GIFtools
there (e.g., D:\GIFtools\)
NOTE 1: If you have previous versions of GIFtools on your computer, you can put the latest version in the parent
directory (e.g., C:\Program Files\GIF). This directory will also be where you should place all of your executables
(i.e. inversion executables, MeshTools3D, etc.) that GIFtools would require. Here is an example:
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NOTE 2: If you chose the Add a shortcut to the desktop option, you will need to perform step 7 on that
shortcut too!
4. Click Next: One of two things will now happen, either (1) you will have to install the run-time compiler or (2)
the compiler will already be installed. If (1), follow the on-screen instructions (most likely just keep clicking
next) and this will lead you to step 5. If (2) this window will show up:

5. You are ready for install! Click Install >. It will take a minute or two.

6. If everything worked out, you will get to the screen below giving you step 7’s instructions. Click Finish and
read below to finish the install so the link is not broken.
7. Fix the Start-in directory link for GIFtools. Go to the Start menu and find GIFtools_vXpX and right-click and
select properties:
Note that the Start in: field is blank. Copy and paste the Target: field to the Start in: field. Then remove
GIFtools_vXpX.exe from the Start in field so that only the directory is present:
Click Apply and then OK. GIFtools is now installed and can be started from the Start menu
Tip: Why did we have to do step 7? Windows makes a copy in the registry and starts GIFtools there. The visualization
package (VTK) that is used requires static Java libraries and therefore GIFtools needs to be started where those dynamic
libraries are located.

2.1. Installation notes
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Tip: Manual shortcuts to desktop do not require step 7! If you have gone into GIFtools application directory,
right-clicked and chose Create shortcut, then the the shortcut (by default it will ask you if you want to put it on the
desktop) will already have the Start in: field adjusted.

2.2 GIFtools system requirements
Below are the system requirements for GIFtools.

2.2.1 Operating System
• Microsoft Windows 7
• Microsoft Windows 8
• Microsoft Windows 10
• Linux (by request)
• Mac (by request)

2.2. GIFtools system requirements
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2.2.2 CPU type
• 64-bit (Designed on Intel Core i7)

2.2.3 Disk size
• Requires 275 MB of disk space (not including GIF Fortran executables)

2.2.4 Network
• Deployment via GIFtools_vXpX_install requires internet
• Deployment via GIFtools_vXpX_Offlineinstall
• There is no license server for GIFtools
• Tutorial links within GIFtools calls user-default internet browser

2.2.5 Memory
• 2 GB (4+ GB recommended)

2.2.6 Display resolution
• 1920 x 1080 with TrueColor

2.2.7 Point device
• MS-Mouse compliant

2.2.8 .NET framework
• Minimum .NET framework version 4.5.1

2.2.9 Visual C++ 2013 x64
• Download

2.2.10 Browser
• Calls user-selected default browser for tutorial links
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2.3 Installing Fortran Modeling/Inversion Codes
Forward modeling, inversion and other specialized functionality is carried out using a set of external executables written in Fortran. For each modeling code (Mag3D, DCIPoctree, E3DMT, etc. . . ), there is a separate coding package.
Individual licenses must be purchased to use each Fortran coding package in addition to the GIFtools license.
If the user is licensed to use particular Fortran coding package, the installation steps are as follows:
• Acquire the .zip file containing the Fortran coding package. Note that Consortium sponsors have specialized
access and may login and download Fortran packages from the UBC-GIF website .
• Unzip the file and place the contents into a desired folder.
• Add the folder to your computer’s path variables. That is, go to your computer’s settings to ‘edit system environment variables’, and add the folder to the one called ‘PATH’. If this step is not completed, your computer will
not find the necessary executables when running the Fortran code from the GUI.

2.4 Python Installation (Optional)
Starting from version 2.25, GIFtools has the option to run some functionalities from the open-source community;
namely batch 2D DC/IP inversions. In order to get access to these codes, users must install Python. This is done
through the Anaconda project

2.4.1 Part 1
If you do not already have Python 3.5 or greater already installed, please follow these steps to get setup:
• Download the latest Miniconda
• Run the installed executable
– Let Anaconda set the Environment Path (check both boxes!!)

– simpegEM1D and its dependencies
2.3. Installing Fortran Modeling/Inversion Codes
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Full installation time ≈ 15 min
Congratulation, you should now have access to the Python ecosystem! More packages can be installed through command lines:
Either with anaconda (recommended)> conda install PackageName
or alternatively through pip> pip install PackageName

2.4.2 Part 2
Now that you have Python installed, you must ensure that GIFtools can find Python when it is needed. To do this, you
will need to edit your computer’s environment variables. For Windows computers, this is set through the control panel
under Edit the System Environment Variables.
In the System Properties window, click the Environment Variables button. In the Environment Variables window
that pops up, you will need to select the variable called PATH and click edit for either the user variables (whoever is
logged in) or system variables (everyone). If there is no variable called PATH, you will need to create a new variable
called PATH.
When you click edit, the Edit Environment Variable window will pop up. You must add the path to Anaconda3 and the Library\bin subdirectory. In our case, these directories were C:\Users\devin\anaconda3 and
C:\Users\devin\anaconda3\Library\bin.
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CHAPTER

THREE

BASIC FUNCTIONALITY

The basic GIFtools functionality is always accessible through 4 drop-down menus (Project, Edit, Import and Create
). This functionality allows the user to manage GIF projects, delete/copy/rename objects, import data files and create
various GIF objects. Once created, a specific set of actions (or methods) can be carried out on each of these objects.
Object-specific methods are described in the object-dependent functionality section.

3.1 Project
The contents of this drop-down menu will assist in saving, opening and managing GIF projects.

3.1.1 Properties
Properties allows the user to manage certain aspects of the GIFtools program and how it interacts with
your computer. Under properties, the user may:
• Set the project’s working directory
• Set the start-up directory for GIFtools
• Set the number of threads to run an inversion
• Project auto-save functionality
• HDF5 Options
NOTE: Setting the working directory at the start of a new project is strongly advised, as it will make files
relevant to the project easy to find. Although the auto-save time is set to a default value (5 min), you may
wish to change it when starting a new project
Set the project’s working directory
The project’s working directory tells GIFtools where to output files general files and where to begin choosing files in the directory. Other working directories (e.g., folders, inversions, etc.) are saved as a relative
path the project directory so that everything can be reproduced on multiple computers. To change the
project’s working directory use the menu:
Project → Set properties → Set working directory
NOTE: The shortcut for the functionality is control + shift + d.
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Set the start-up directory for GIFtools
By default, GIFtools starts with the working directory where the executable is located. Users may change
this directory by using the menu below. GIFtools will then begin in the start-up directory when the executable starts.
Project → Set start-up directory

NOTE: The shortcut for the functionality is control + alt + d.
Set the number of threads to run an inversion
GIF inversion programs use OpenMP to parallelize matrix-vector multiplication and sensitivity calculations in linear inversions. GIFtools allows the user to change the number of OpenMP threads so the
inversions do not slow down the CPU. Use the menu structure:
Project → Set properties → Set openMP threads for Fortran codes

NOTE 1: The shortcut for the functionality is control + shift + d.
16
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NOTE 2: GIFtools will only find out the number of cores the CPU is operating on and not the actual
threads. If you would like to manage the number of threads the inversions use, the environment variable
OMP_NUM_THREADS will need to be set (see below).
Setting environment variable for OpenMP threads (optional)
To set the maximum number of OpenMP threads, an environment variable will need to be established.
Follow these steps:
1. Click on the windows menu and then right-click on Computer and click on Properties

2. Click on Advanced System Settings to get the the window below.
3. Click on Environment variables and then create a new variable (or edit if the variable
OMP_NUM_THREADS exists) by clicking new:

3.1. Project
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4. Click OK then Apply and exit. Re-start GIFtools and the number of threads will appear.
NOTE: If you are unsure how many threads the computer has there are two ways of finding out:
1. Run a GIF program such as PFWEIGHT or MAGINV3D. The program will tell you how many
threads it uses without by just bringing up a command prompt (shift + right-click + open
command window here). The program will have to be pathed or perform this task in the parental
directory of GIFtools.
2. Open Windows task manager (right-click on bottom task bar then Start task manager) and
go to Performance. Count the number of windows in CPU Usage History (below is an example of
12):

Project auto-save functionality
GIFtools will auto-save a copy of the project. The feature is helpful in case something was deleted, for
some reason the program crashed, or you forgot to save the project before quitting GIFtools. The autosave copy is called “GIFtoolsAutoSave.mat” and is located in the \Windows\Users\yourUserName (i.e.,
home) folder. Please note that the current project file is not touched when auto saving and that the autosave project will be over-written each time this function is called. The project can be saved in its normal
location by using the Save project feature. The user may select the amount of passing time (in minutes)
between auto saves. To set this time, use the menu structure below:
• Project → Set properties → Set time between auto save
NOTE 1: The shortcut for saving a project is control + shift + t.
NOTE 2: The counter for auto save automatically re-sets after a project has been saved. The user can see
the last time an auto save occurred in the information panel by clicking on the project in the tree.

3.1. Project
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HDF5 file options
GIFtools projects are stored in compressed HDF5 file format. Two basics options are available to the user
• Change compression: Allow to set the level of compression used by HDF5 [default 8]
• Select project H5 file: Option to pull data from a specific file H5 file.

3.1.2 Save the project
To save your project, use the menu structure below. The “Save-as” will save the project under the new
name.
• Project → Save → Project
• Project → Save → Project As

NOTE: The shortcut for saving a project is control + s.

3.1.3 Load an existing project
To load an existing project, use the menu structure below. You will be asked to if you want to discard your
changes (even if you have just saved). Select Yes and the project will load and update, if necessary.
Project → Load → Project
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NOTE: The shortcut for the functionality is control + L (lower case).

3.1.4 Load a recently-saved project
GIFtools will save the last six projects that have been saved. To load a recently-saved project, use the menu
structure below. You will be asked to if you want to discard your changes (even if you have just saved).
Select Yes and the project will load and update, if neccessary.
Project → Load recent project → [project name]

3.1.5 Add another project
GIFtools gives the user the ability to combine other projects that have been saved. To add an existing
project to the current project, use the structure found below. The added project will become its own folder
in the tree.
Project → Add existing project

NOTE: The shortcut for the functionality is control + shirt + L (lower case).

3.1.6 View
To open your current working directory, collapse all folders within GIF project or expand all folders within
GIF project, use the menu structure below.
• Project → View → View working directory
• Project → View → Collapse all folders
• Project → View → Expand all folders

3.1. Project
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3.1.7 About GIFtools
The About menu has the information regarding the GIF main website information and version number of
GIFtools. To get to the about page, use the following menu structure:
Project → About

3.2 Edit
The contents of this drop-down menu will allow the user to rename, copy and delete objects.
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3.2.1 Rename
Rename objects within GIFtools:
Edit → Rename

3.2.2 Copy
To make a copy of any object within GIFtools:
Edit → Copy

3.2.3 Delete
Delete objects within GIFtools:
Edit → Delete

3.3 Import
GIFtools is capable of importing data, meshes, physical property models, cell weights, geological maps and other rasterbased images, as well as shape files (RGIS vector). This information can be imported from a variety of file formats,
including: GIF format, XYZ format and CSV format. Once imported, the information/data will be represented in
GIFtools as an “object”. To see what you can do with each object, visit the object-dependent functionality page. The
types of information which may be imported to GIFtools is organized as follows:

3.3.1 Import Data
GIFtools allows the user to import various types of geophysical, geological and geographical data from a
multitude of file formats. The following data types can be imported into GIFtools under: Import → Data
Import magnetic data
Magnetic data can be loaded from three main file types: Use the main project menu: Import → Data →
Magnetics

3.3. Import

23

GIFtoolsCookbook Documentation, Release 1.0

File formats:
• GIF format
• XYZ format
• CSV format
Import gravity data
Gravity data can be imported in from three main file types: Use the main project menu: Import → Data
→ Gravity

File formats:
• GIF format
• XYZ format
• CSV format
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Import gravity gradiometry data
Gravity gradiometry data can be imported in from three main file types: Use the main project menu:
Import → Data → Gravity gradient (GG)

File formats:
• GIF format
• XYZ format
• CSV format
Import topography
Topography can be imported through six different file formats: Use the main project menu: Import →
Topo

File formats:
• 3D GIF format
• 2D GIF format
• XYZ format
• CSV format
• Canadian Digital Elevation Data (CDED)
• USGS 1-degree

3.3. Import
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Import a surface
General surface object can be imported through three different file formats: Use the main project menu:
Import → Surface

File formats:
• GIF format (Same as topography)
• XYZ format
• CSV format
Import borehole data
Importing borehole data requires two or three files (survey optional and assumes vertical boreholes if not
given) that will be asked for in a separate dialog. To get to the import dialog, use the main project menu:
Import → Borehole Data

This brings up the following import dialog:
From the browse buttons in Step 1, select the collar file, survey file (optional; if not provided, GIFtools
assumes the borehole extend vertically downwards), and the property file. Once all the files are selected
in Step 1, click on the “Load” button in Step 2.
26
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3.3. Import
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For the example files we are using, our import dialog now looks like the following:

Our example has three properties: ID, LENGTH, and unitless. These are the headers provided in the
property file. We select all three properties in this case. Once the desired properties are selected, we can
move onto Step 3.
Step provides two options on how the borehole data are discretized: either the files contain data points at
discrete xyz locations or the files provide a “to” and “from” value for each measurement or observation.
Below, we will show how to import each type of borehole data.
Note: The datasets used for “discrete” and “interpolate” are different so the property headers will differ
as well.
Discrete
For discrete data, select the “Discrete” radio button. The import dialog will look like:
Click OK to import the borehole data. You will notice that a grayed-out BOREdata item has been added
to the GIFtools project tree. And the following dialog appears:
For the collar, survey, and property files, select the appropriate headers from the drop-down menus for
each item. The options will match the headers given in the respective files. Once done, the dialog looks
like the following:
Again, because the borehole data in this case are data points are discrete locations, we use the “Depth”
radio button instead of “Intervals”. Once all the headers are assigned, click OK. The data are now being
28
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3.3. Import
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3.3. Import
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imported into GIFtools. Once done, the BOREdata item in the project tree will have a name. The name
will be the same as the property file name (in our case, “geology”).
The info panel will show the origin of the property data, a data summary, the set i/o headers, and the
borehole IDs that were imported:

Now the borehole data can be visualized, discretized onto a mesh, and used within Model Builder to create
models and weighting functions.
Example
Collar, survey, and property file along with a GIFtools project to repeat the above steps to import discrete
borehole data: download
Interpolate
Now, let’s import borehole data that has measurement between two elevations (i.e., to and from). Repeat
the steps above to import borehole data in GIFtools, up to Step 3. Because this borehole data has “To” and
“From” columns, we now select the “Interpolate” radio button in Step 3 for the data discretization.
We have decided to interpolate these data every 10 m.
Click OK to import the files and move onto the header dialog. The header dialog will appear just as before,
except now the “Intervals” option is selected instead of “Depth”. Select the appropriate headers for each
item. Once done, our dialog looks like the following:
Click OK to import and set the headers. Once imported, a BOREdata item has been added to the GIFtools
project tree and the name of it is the same as the property file name. In this case, that is “Geology1”.
When the item is highlighted in the tree, the info panel will provide the same type of information as we
saw earlier for the discrete example:
Now the borehole data can be visualized, discretized onto a mesh, and used within Model Builder to create
models and weighting functions.
Example
Collar, survey, and property file along with a GIFtools project to repeat the above steps to import interpolated borehole data: download
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3.3. Import
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Note: GIFtools needs all location data to be in meters! Check your borehole data in case it may be in feet.
File formats:
See below links for specifics on the files associated with borehole data:
• Collar file
• Survey file
• Property file
Import miscellaneous property data
This type of data covers the range of anything someone would want to bring in that has a position and
value (numeric or character).
Use the main project menu: Import → Miscellaneous property data

File formats:
Property data is imported via the following file formats:
• XYZ
• CSV
Import DC/IP data
DC and IP data can be imported in from three main file types: Use the main project menu: Import →
Data → DC/IP

3.3. Import
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Import 2D DC/IP data
DC and IP data used by the DCIP2D inversion routine can be imported through six different file formats:
Use the main project menu: Import → DC/IP → 2D
Note: Importation from a CSV/XYZ file is found under Import → DC/IP and is independent of dimension
in the menu

File formats:
• 2D GIF location file
• 2D GIF data file
• XYZ file
• CSV file
Import 3D DC/IP data
DC and IP data used by the DCIP3D inversion routine can be imported using the main project menu:
Import → DC/IP → 3D
Note: Importation from a CSV/XYZ file is found under Import → DC/IP and is independent of dimension
in the menu
File formats:
• 3D GIF location file
• 3D GIF observed data file
• DCIPF3D predicted data file
• XYZ file
• CSV file
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import 3D TDIP data

It is possible to import IP data with several times windows from a CSV or XYZ file (this is not supported
by any DCIP GIF format).
Step 1: assign spatial data and time windows
Click this button to specify the Easting, Northing and Elevation columns.
In the window that pops up, set the time of each time windows (can also be loaded from a text file with
one time per line)
step 2: select the data type and data columns
Add and select a data type. Clic on specify type and assign the header for each corresponding column (can
also be loaded from a text file with one header per line)
Step 3: add miscellaneous data
This step is used to define any remaining data columns. This might include intensity of the sources etc.

3.3. Import
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Import EM data
Frequency-domain (FEM), Time-domain (TEM) and Natural Source (NSEM) electromagnetic data can be
imported in from three main file types:
Import → Data → F|T|NS EM
Import FEM data
To import frequency-domain electromagnetic (FEM) data, use the main project menu:
Import → Data → Frequency-domain EM
There are four types of FEM data that can be loaded from files:

File formats:
• GIF EM1DFM format
• GIF E3D format
• GIF E3D v2 format
• XYZ format

EM1DFM format
Loads a data file for the EM1DFM inversion and forward modeling codes. The data position is set relative
to the transmitter as specified by the EM1DFM file format. The function returns a FEM1Dsounding object.
Import → Data → Frequency-domain EM → GIF EM1D format
The following parameters are set for the user:
Properties:
• Transmitters:
– Dipole moment: mom_t
– Orientation ot_a
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– Along-line offset (m) = 0
– Cross-line offset (m) = 0
– Vertical offset (m): Relative to topography
• Receiver:
– Dipole moment: mom_r
– Along-line offset: The along-line position of receivers, relative to transmitter locations
– Cross-line offset: The cross-line position of receivers, relative to transmitter locations
– Vertical offset: Relative to topography
Note: The position of the data is set by the “sounding” location. Only the relative offsets between the
transmitters and receivers are available in the EM1DFM file format. Data locations have been assigned to
the transmitter locations upon import for consistency.

E3D format
Loads data files formated for the original E3D data file format . The function returns an FEMdata object
where only the transmitter geometry is defined. The receivers are defined as point measurements that
samples the fields (E, H) along the Cartesian axes.
Import → Data → Frequency-domain EM → GIF E3D format
Note: The FEMdata object assumes that the provided field data have been measured along the Cartesian
axes or that the user has rotated the fields in pre-processing. For more general cases with arbitrary receivers
orientation (in-line), consider making use of the FEM3Dsounding class.

E3D v2 format
Loads data specifically formatted for the E3D v2 and E3D v2 tiled codes. The function returns an
FEM3Dsounding object.
Import → Data → Frequency-domain EM → GIF E3D v2 format
The receivers and transmitters are defined by their respective input files. As a result, you will need 4 files
when importing E3D v2 data:
• Data file
• Frequency file
• Receiver file
• Transmitter file
Note: Both the transmitters and receivers geometry are defined in 3D. The relative offsets can be calculated using the Calculate Transmitter/Receiver separation function.
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Import TEM data
To import time-domain electromagnetic (TEM) data, use the main project menu: There are four types of
TEM data that can be loaded from files:
Import → Data → Time-domain EM

File formats:
• GIF EM1DTM format
• GIF H3DTD | TDoctree format
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• GIF TDoctree v2 format
• XYZ format

EM1DTM format
Loads a data file for the EM1DTM inversion and forward modeling codes. The data position is set relative
to the transmitter as specified by the EM1DTM file format. The function returns a TEM1Dsounding object.
Import → Data → Frequency-domain EM → GIF EM1D format
The following parameters are set for the user:
Properties:
• Transmitters:
– Dipole moment: Set by argument
– Orientation Set by argument
– Along-line offset (m) = 0
– Cross-line offset (m) = 0
– Vertical offset (m): Relative to topography
• Receiver:
– Dipole moment: Set by argument
– Along-line offset: The along-line position of receivers, relative to transmitter locations
– Cross-line offset: The cross-line position of receivers, relative to transmitter locations
– Vertical offset: Relative to topography
Note: The position of the data is set by the “sounding” location. Only the relative offsets between the
transmitters and receivers are available in the EM1DTM file format. Data locations have been assigned to
the transmitter locations upon import for consistency.

H3DTD | TDoctree format
Loads data files formated for the H3DTD, TDoctree and TDoctree tiled codes. The function returns a
TEMdata object where only the transmitter geometry is defined. The receivers are defined as point measurements that samples the fields (E, H) along the Cartesian axes.
Import → Data → Time-domain EM → GIF H3DTD | TDoctree format
Note: The TEMdata object assumes that the provided field data have been measured along the Cartesian
axes or that the user has rotated the fields in pre-processing. For more general cases with arbitrary receivers
orientation (in-line), consider making use of the TEM3Dsounding class.
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TDoctree v2 format
Loads data specifically formatted for the TDoctree v2 code. The function returns a TEM3Dsounding object.
Import → Data → Time-domain EM → GIF TDoctree v2 format

The receivers and transmitters are defined by their respective input files. As a result, you will need 4 files
when importing TDoctree v2 data:
• Data file
• Time channels file
• Receiver file
• Transmitter file
Note: Both the transmitters and receivers geometry are defined in 3D. The relative offsets can be calculated using the Calculate Transmitter/Receiver separation function.
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Import MT and/or ZTEM data
There are a few file options to import magnetotelluric (MT: impedance or apparent resistivity and phase)
or Z-axis Tipper EM (ZTEM) data:
Import → Data → Natural-source EM

File formats:
• MTZ3D formatted data
• E3DMT formatted data
• E3DMT v2 formatted data
• EDI formatted MT data
• ASCII formatted ZTEM data

MTZ3D format
To load impedance tensor MT, apparent resistivity MT or ZTEM data that are formatted for the MTZ3D
code, the menu structure is:
Import → Data → Natural-source EM → GIF MTZ3D format
E3DMT format
To load impedance tensor MT and/or ZTEM data that are formatted for the E3DMT code, the menu
structure is:
Import → Data → Natural-source EM → GIF E3DMT format
Some things to note about loading E3DMT observed/locations data:
• If MT and ZTEM are contained within the same file, GIFtools will parse into an IMPdata object and
a ZTEMdata object
3.3. Import
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• Although it is good practice, the locations for each frequency do not need to be the same. Frequencylocation pairs without data are given a value of NaN.
Some things to note about loading E3DMT predicted data:
• The user must specify the ZTEM and or IMP data object(s) associated with the predicted data in the
screen shown below. E3DMT version 1 does not support apparent resistiviy and phase data.
• Let us assume multiple data objects were used to create the observations/locations file for the forward
modeling/inversion. When loading the predicted data, the user must select the data objects in the same
order they used to create the observations/locations file.

E3DMT version 2 data
To load impedance tensor MT and/or ZTEM data that are formatted for the E3DMT v2 code, the menu
structure is:
Import → Data → Natural-source EM → GIF E3DMT v2 format
The receivers frequencies are defined by their respective input files. As a result, you will need 3 files when
importing TDoctree v2 data:
• Data file
• Frequencies file
• Receivers file
Note: About loading E3DMT version 2 observed/locations data
• Although it is good practice, the locations for each frequency do not need to match. Frequencylocation pairs without data are given a value of NaN.
• The IDs for the receivers do not need to be in any particular order but they do need to be unique.
• If the respective IDs for Hx and Hy receivers are all the same (e.g. a base station for ZTEM data),
the resulting ZTEM data object will still have a datatype of MTH.

Note: About loading E3DMT version 2 predicted data
• The user must select the associated ZTEM or IMP data object when loading predicted data. E3DMT
version 2 does not support apparent resistivity and phase data.
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MT data: EDI format
To load MT data that are in one or more EDI files (GIFtools will prompt and allow for multiple files), the
menu structure is:
• Make impedance data object: Import → Data → Natural-source EM → MT EDI file(s) →
Impedance
• Make apparent resistivity data object: Import → Data → Natural-source EM → MT EDI file(s)
→ Apparent resistivity and phase:
Once selected, the user must do the following:
1) Use Browse to find the EDI file(s) which they would like to important data from
2) Select Load to temporarily load all the data
3) Select the properties (data columns) which they would like in their final data object (IMPdata or
APPdata)
4) Choose whether or not the data must be transferred from X = Easting and Y = Northing to X =
Northing and Y = Easting. The latter is used by GIF with Z defined as +ve downward.
5) Select OK

Important:
• We assume the EDI file data are defined by The Society of Exploration Geophysicists MT / EMAP
Data Interchange Standard . That is, the EDI data uses a +𝑖𝜔𝑡 time-dependency. Also, the data are
Northing-Easting-Down.
• GIFtools will convert the (LONG, LAT) to WGS84 UTM when importing.
• GIFtools converts impedance data from a +𝑖𝜔𝑡 (EDI standard) convention to a −𝑖𝜔𝑡 (GIF standard)
convention automatically.
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• GIFtools assumes that impedance tensor data have column names ZXXR, ZXXI, ZXYR, ZXYI, ZYXR,
ZYXI, ZYYR and ZYYI and the apparent resistivities have column names RHOXX, PHSXX, RHOXY,
RHOXY, RHOYX, RHOYX, RHOYY and RHOYY.
• GIFtools assumes the impedance data are in units mV/km/nT and will converted these data to V/A
as required by GIF inversion programs.
• If impedance data are being imported, GIFtools will import all other data columns but will NOT
modify them in any way. Thus if ZTEM or other data exist in the EDI files, it is up to the user to
apply the appropriate corrections upon loading.

ZTEM data: ASCII format
To load ZTEM data that are in a CSV or XYZ ASCII format, the menu structure is:
• XYZ format: Import → Data → Natural-source EM → ZTEM general ASCII → XYZ
• CSV format: Import → Data → Natural-source EM → ZTEM general ASCII → CSV file

NOTE: XYZ and CSV file formats do not include base stations for ZTEM data, which will need to be
imported or set separately.
Import XYZ EM data
Common to FEM, TEM and ZTEM, data be can loaded from a general column file that contains position
and multiple data channels.

Note:
• It is recommended to load the raw data as FEM3Dsounding or TEM3Dsounding object such that both
transmitters and receivers can be defined at every location using Create offset Tx/Rx.
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• For detailed instructions on how to import TEM data from a csv or xyz file, follow the instructions
in this recipe.
• XYZ and CSV file formats do not include transmitters, which will need to be imported separately.
Step 1: assign spatial data, specify frequencies/times and number of data type
Click this button to specify the Easting, Northing and Elevation columns. The user will also specify the
frequencies/times contained within the data and the number of data groups. If the data contain both real
and imaginary components of the response at three different frequencies, then there are 3 frequencies and
2 data groups resulting in 6 total data columns.
Step 2: specify data types
Select which data type you would like to specify from the drop-down menu and click specify type. In the
window that pops up, set the header name for the data type and assign the data to each frequency.
Step 3: add miscellaneous data
This step is used to define any remaining data columns. This might include orientation information for the
transmitters and receivers, etc. . .
Object-dependent functionalities (or methods) can be accessed by clicking on the object after the import
process is complete.

3.3.2 Import Mesh
Under Import → Mesh, the user can import various types of 1D, 2D or 3D meshes. These include
both tensor meshes (link to example) and OcTree meshes (link to example). In GIFtools, this results in
the creation of a ‘mesh object’. Once created, GIFtools will allow the user to carry out a set of objectdependent actions (or methods) involving the mesh object. The methods applicable to each mesh object
are presented on the object-dependent functionality page. The following mesh types can be imported into
GIFtools:
• 1D Tensor Mesh
• 2D Tensor Mesh
• 3D Tensor Mesh
• OcTree Mesh
Import a 1D Tensor Mesh
Use the main project menu: Import → Mesh → 1D

Refer to 1D Mesh file for file format.
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Import a 2D Tensor Mesh
Use the main project menu: Import → Mesh → 2D

File format:
Refer to 2D Mesh file for file format.
Import a 3D Tensor Mesh
Use the main project menu: Import → Mesh → 3D

File format:
Refer to 3D Mesh file for file format.
Import an OcTree mesh
Use the main project menu: Import → Mesh → Octree

File format:
Refer to OcTree mesh file for file format.
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3.3.3 Importing a model
Under Import → Model, the user can import physical property models and active cell models. In order to
import a model, the user must first have a mesh within their GIFtools project; see import mesh or generate
mesh. In GIFtools, importing a model results in the creation of a ‘model object’. Once created, GIFtools
will allow the user to carry out a set of object-dependent actions (or methods) involving the model object.
The methods applicable to each model object are presented on the object-dependent functionality page.
The following model types can be imported into GIFtools:
• Import a Cell-Centered Model
• Import a Vector Model
• Import an Active Model
Prerequisites:
• A mesh object (link)
Import a cell centered model
Importing a model first requires a mesh. The import dialog will prompt the user to either choose an existing
mesh in the project or browse to load another.
Use the main project menu: Import → Model → Cell centred

Prerequisites:
Import a mesh:
• 1D mesh
• 2D mesh
• 3D mesh
• OcTree mesh
File formats:
Models can only be imported via GIF-formatted files
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Import a vector model
Importing a model first requires a mesh. The import dialog will have the user either choose a mesh or
browse.
Use the main project menu: Import → Model → Vector

Prerequisites:
Import a mesh:
• 2D mesh
• 3D mesh
• OcTree mesh
File formats:
Models can only be imported via GIF-formatted vector files
Import an active-cell model
Importing a model first requires a mesh. The import dialog will prompt the user to either choose an existing
mesh in the project or browse to load another. Active cells will contain only values of -1, 0, or 1.
Use the main project menu: Import → Model → Active

Prerequisites:
Import a mesh:
• 2D mesh
• 3D mesh
• OcTree mesh
File formats:
Active models can only be imported via GIF-formatted files
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3.3.4 Import weights
Under Import → Weights, the user can import cell and face weights used to control the inversion. See
the Fundamentals of inversion for more details about the role of weighting matrices.

Import full weights file
Import → Weights → Full weight file
Import only face weights
Import → Weights → Only faces
Import Sensitivity as Weights
Import → Weights → Sensitivity as weights
This option allows to create cell and face weights based on the sensitivity.txt file generated for example by DCINV2D and DCINV3D.
ws = J𝑎𝑝𝑝𝑟𝑜𝑥 /𝑚𝑎𝑥(J𝑎𝑝𝑝𝑟𝑜𝑥 ) + 𝛿
wx = A𝑓𝑐 𝑥 ws
wy = A𝑓𝑐 𝑦 ws
wz = A𝑓𝑐 𝑧 ws
where ws , ws , ws and ws are the cell-center and cell-face weights, J𝑎𝑝𝑝𝑟𝑜𝑥 are the values from the
sensitivity.txt file, values from 𝛿 is a user-defined threhold parameter ([DEFAULT=1e-2]) and
𝑓
A𝑓𝑐 𝑥 , A𝑐 𝑦 , A𝑓𝑐 𝑧 are averaging operators taking the cell-center values to the respective faces.

3.3.5 Import Images
TODO: Introduction and image
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Import geologic images
GIFtools allows one to import geologic maps in order to populate models and ultimately constrain inversions. Plan-view images can be imported in current versions. In the near future, cross-section images will
be accessed through the same menu pipeline.
Use the main project menu: Import → Image → Plan-view

Along with the image file, a world file is required to georectify the image. A legend file to specify the RGB
values for each geology unit can be imported when importing the image or either imported or created after
image importation.
NOTE: Images with distinct colour combinations and no text will perform much better when discretizing
models. Below is an example:

World file format
The world file has been specified by Esri (.tfw file). It is a plain text file with the following lines. GIFtools
will recognize rotations given in this file.
• Line 1: pixel size in the Easting direction in pixels
• Line 2: rotation about Northing axis
• Line 3: rotation about Easting axis
• Line 4: pixel size in the Northing direction in pixels, (almost always negative)
• Line 5: Easting coordinate of the center of the upper left pixel
• Line 6: Northing coordinate of the center of the upper left pixel
Below is an example:
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Legend file format
The legend file will be an XYZ or CSV with a header. The important headers are the geology unit (integer),
Red, Green, and Blue values (0-255) contained within image. Comments are denoted by “!” or “//”. Below
is an example of 8 units (0 being background white) for the image above.

To create a legend file, load the image and use the menu:
Plan-view image → Legend → Create → Table view

3.3.6 Import shape file
TODO: Introduction and image
Import polygon shape file
RECIPE PENDING

3.3. Import

53

GIFtoolsCookbook Documentation, Release 1.0

3.4 Create
Create allows the user to generate objects which are used to carry out a wide variety of tasks. These tasks include:
forward modeling various types of geophysical data, inverting geophysical data, interpolating models onto different
meshes and performing equivalent source processing for potential fields. By defining the desired task as an object, we
can make sure the user only fills in fields and carries out actions which are relevant to the specified task. The actions
(or methods) which can be applied to each object are found on the object-dependent functionality page. Objects which
can be generate through create are as follows:

3.4.1 Workflow Objects
TODO: Explain what these are.

Placeholder
Inversion Workflow Object
Workflows help the user to quickly start an inversion. Begin a workflow by going to the main Create menu
and choose the inversion best suits you:
Create → Workflow → Inversion
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3.4.2 Create forward models

Create 3D magnetic forward model
To create magnetic data from a susceptibility model using the tensor code MAGFOR3D (versions 5.0, 5.1,
and 6.0) or the octree code OCTMAGDE, use menu structure:
Create → Forward → Magnetics → MAG3D (v5.0)
Create → Forward → Magnetics → MAG3D (v5.1)
Create → Forward → Magnetics → MAG3D (v6.0)
Create → Forward → Magnetics → PDE (octree; v1.1b)
Create a gravity forward model
To create gravity data from a density-contrast model using the tensor code GZFOR3D (versions 5.0, 5.1, and
6.0) or the octree code OCTGRVDE, use the menu structure:
Create → Forward modelling → Gravity → GRAV3D (v5.0; 5.1; 6.0)
Create → Forward modelling → Gravity → PDE (octree; v1.1b)
Create a gravity gradiometry forward model
To create gravity gradiometry data from a density-contrast model using the tensor code GG3D (versions 5.1
and 6.0), use the menu structure:
Create → Forward modelling → Gravity gradiometry → GG3D (5.1; 6.0)

3.4. Create
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Create a DC/IP forward model
To create a DC or IP forward model using the tensor code (DCIP2D or DCIP3D) or the octree code
(DCIPoctree), use the following menu structure:

2D Tensor code
To create a DC or IP forward model which uses the software DCIP2D, the menu structure is:
• DC: Create → Forward modelling → DC/IP → 2D DC
• IP: Create → Forward modelling → DC/IP → 2D IP
The inputs to the forward model can be specified though edit options
3D Tensor code
To create a DC or IP forward model which uses the software DCIPF3D, the menu structure is:
• DC: Create → Forward modelling → DC/IP → 3D DC
• IP: Create → Forward modelling → DC/IP → 3D IP
The inputs to the forward model can be specified though edit options
Octree code
To create a DC or IP forward model which uses the software DCIPoctree, the menu structure is:
• DC: Create → Forward modelling → DC/IP → Octree DC
• IP: Create → Forward modelling → DC/IP → Octree IP
The inputs to the forward model can be specified though edit options

56

Chapter 3. Basic Functionality

GIFtoolsCookbook Documentation, Release 1.0

Create a frequency-domain EM forward model
To create frequency-domain EM data from a conductivity model using the octree code E3D, use the menu
structure:
Create → Forward modelling → Frequency-domain EM → E3D
Create a time-domain EM forward model
To create time-domain EM data from a conductivity model using the octree code TDoctree (1 mesh)
or TDoctree (tiled), use the menu structure:
Create → Forward modelling → Time-domain EM → TDoctree (1 mesh)
Create → Forward modelling → Time-domain EM → TDoctree (tiled)

3.4.3 Create an inversion

Create a mag inversion
There are four different inversion objects that can be created to invert magnetic data using a 3D mesh.
The first three are using the program MAG3D with version control (5.0, 5.1, 6.0). The fourth is a magneticvector inversion using the program MVI. To use an octree mesh, the code OCTMAGDE can be used. The
menus needed to create these are:
Create → Inversion → Magnetics → Induced (MAG3D 5.0)
Create → Inversion → Magnetics → Induced (MAG3D 5.1)
Create → Inversion → Magnetics → Induced/amplitude (MAG3D 6.0)
Create → Inversion → Magnetics → MVI (magnetic vector)
Create → Inversion → Magnetics → PDE (octree)
NOTE: GIFtools inversion objects will take care of the prerequisite weighting and sensitivity programs
prior to inversion for the user.
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Create a gravity inversion
There are three different inversion objects that can be created to invert gravity data using a 3D mesh. These
objects use the program package GRAV3D with version control (5.0, 5.1, and 6.0). The menus needed to
create these are:
Create → Inversion → Gravity → GRAV3D 5.0
Create → Inversion → Gravity → GRAV3D 5.1
Create → Inversion → Gravity → GRAV3D 6.0
Create → Inversion → Gravity → PDE (octree)
NOTE: GIFtools inversion objects will take care of the prerequisite weighting and sensitivity programs
prior to inversion for the user.
Create a gravity graviometry inversion
Gravity gradiometry data can be inverted using a 3D mesh using the code GG3D. The menu needed to create
such an item is:
Create → Inversion → Gravity gradiometry → GG3D
NOTE: GIFtools inversion objects will take care of the prerequisite weighting and sensitivity programs
prior to inversion for the user.
Create a DC/IP inversion
DC/IP data can be inverted using a 2D mesh, 3D mesh, and an octree mesh. All of these can be accessed
through the menu for DC/IP:
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2D DC/IP
To create a DC/IP 2D inversion using the software package DCIP2D, use the menu structure:
• DC: Create → Inversion → DC/IP → 2D DC
• IP: Create → Inversion → DC/IP → 2D IP
To set the parameters for the inversion, see edit options.
3D DC/IP
To create a DC/IP 3D inversion using the software package DCIP3D, use the menu structure:
• DC: Create → Inversion → DC/IP → 3D DC
• IP: Create → Inversion → DC/IP → 3D IP
To set the parameters for the inversion, see edit options.
Octree DC/IP
To create a DC/IP octree inversion using the software package DCIPoctree, use the menu structure:
• DC: Create → Inversion → DC/IP → Octree DC
• IP: Create → Inversion → DC/IP → Octree IP
To set the parameters for the inversion, see edit options.
Create an FEM data inversion
Frequency-domain EM (FEM) data can be inverted through the program E3D, which requires an ocTree
mesh. To create the inversion object, use the menu structure:
Create → Inversion → Frequency-domain EM → E3D (octree)
Create → Inversion → Frequency-domain EM → EM1DFM (1D)
Create an TEM data inversion
Time-domain EM (TEM) data can be inverted through the programs TDoctree (1 mesh) or TDoctree
(tiled), which require an ocTree mesh. To create the inversion objects, use the menu structure:
Create → Inversion → Time-domain EM → TD octree (1 mesh)
Create → Inversion → Time-domain EM → TD octree (tiled)
Create → Inversion → Time-domain EM → EM1DTM (1D)
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Create a natural-source EM inversion
Natural-source EM data, such as ZTEM or MT data can be inverted on an octree mesh using E3DMT ver
1 or E3DMT ver 2. To create the inversion objects, use the menu structure:
Create → Inversion → Natural-source EM → E3DMT ver 1 (octree)
Create → Inversion → Natural-source EM → E3DMT ver 2 (octree)

3.4.4 Create equivalent source processing

Create magnetic equivalent sources
The equivalent-source problem is solved via inversion and so the menus are quite similar to those of the
inversion class. The menus needed to create a magnetic equivalent source item are:
Create → Processing → Magnetics equivalent source
NOTE: GIFtools equivalent-source items will take care of the prerequisite sensitivity programs prior to
equivalent source processing for the user.
Create gravity equivalent sources
The equivalent-source problem is solved via inversion and so the menus are quite similar to those of the
inversion class. The menus needed to create a gravity equivalent source item are:
Create → Processing → Gravity equivalent source
NOTE: GIFtools equivalent-source items will take care of the prerequisite sensitivity programs prior to
equivalent source processing for the user.
Create gravity gradiometry equivalent sources
The equivalent-source problem is solved via inversion and so the menus are quite similar to those of the
inversion class. The menus needed to create a gravity equivalent source item are:
Create → Processing → Gravity gradiometry equivalent source
NOTE: GIFtools equivalent-source items will take care of the prerequisite sensitivity programs prior to
equivalent source processing for the user.
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3.4.5 Fortran Utility Programs
Create octree mesh

Create an ocTree mesh from DC or IP data
Interaction with the Fortran utility program create_octree_mesh_dcip can be done by creating an DCIPmeshUtility item. This item will interact with the utility program to create an
ocTree mesh from a DC3D or IP3D data item for the dcipoctree package. To create, use the
menu structure:
Create → Fortran utility program → Create ocTree mesh → DC (and IP)
Create an ocTree mesh from FEM data
Interaction with the Fortran utility program create_octree_mesh_e3d can be done by creating an E3DmeshUtility item. This item will interact with the utility program to create an ocTree
mesh from an FEM data item for the inversion program e3d. To create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → E3D (FEMdata)
Create an ocTree mesh from FEM 3D sounding data
Interaction with the Fortran utility program create_octree_mesh_e3d_v2 can be done by
creating an E3Dver2meshUtility item. This item will interact with the utility program to create
an ocTree mesh from a FEM 3D sounding data item for the inversion program e3d_v2. To
create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → E3D ver 2 (FEM3Dsounding)

3.4. Create
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Create a tiled ocTree mesh from FEM 3D sounding data
Interaction with the Fortran utility program create_octree_mesh_e3d_v2_tiled can be
done by creating an E3Dver2tilemeshUtility item. This item will interact with the utility program to create an ocTree mesh from a FEM 3D sounding data item for the inversion program
e3d_v2_tiled. To create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → E3D ver 2 tiled
(FEM3Dsounding)
Create an ocTree mesh from MT or ZTEM data
Interaction with the Fortran utility program create_octree_mesh_e3dmt can be done by
creating an E3DMTmeshUtility item. This item will interact with the utility program to create
an ocTree mesh from an IMPdata or ZTEMdata item for the inversion program e3dmt. To
create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → E3DMT (IMPdata and
ZTEMdata)
Create an ocTree mesh from MT or ZTEM data for v2
Interaction with the Fortran utility program create_octree_mesh_e3dmt_v2 can be done by
creating an E3DMTver2meshUtility item. This item will interact with the utility program to create an ocTree mesh from an IMPdata or ZTEMdata item for the inversion program e3dmt_v2.
To create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → E3DMT ver 2 (IMPdata and
ZTEMdata)
Create an ocTree mesh from TEM data
Interaction with the Fortran utility program create_octree_mesh_td can be done by creating
a TDoctreeUtility item. This item will interact with the utility program to create an ocTree mesh
from a TEM data item for the inversion program tdoctree. To create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → TDoctree (TEMdata)
Create a tiled ocTree mesh from TEM data
Interaction with the Fortran utility program create_octree_mesh_td_tiled can be done by
creating a TDoctreeTiledUtility item. This item will interact with the utility program to create
an ocTree mesh from a TEM data item for the inversion program tdoctree_tiled. To create,
use the menu structure:
Create → Fortran utility program → Create ocTree mesh → TDoctree tiled (TEMdata)
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Create an ocTree mesh from TEM 3D sounding data
Interaction with the Fortran utility program create_octree_mesh_td_v2 can be done by
creating a TDoctreever2Utility item. This item will interact with the utility program to create
an ocTree mesh from a TEM3Dsounding item for the inversion program tdoctree_v2. To
create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → TDoctree ver 2
(TEM3Dsounding)
Create an ocTree mesh for DC data
Interaction with the Fortran utility program create_octree_mesh can be done by creating
a DCIPcreateOctreeMesh item. This item will interact with the utility program to create an
ocTree mesh from an DC or IP data item for the inversion program DCoctree and IPoctree.
To create, use the menu structure:
Create → Fortran utility program → Create ocTree mesh → DC (and IP)
Create an ocTree mesh for gravity
Interaction with the Fortran utility program create_octree_mesh_mag can be done by creating an GRAVcreateOctreeMesh item. This item will interact with the utility program to create
an ocTree mesh from a gravity data item for the inversion program octgravde. To create, use
the menu structure:
Create → Fortran utility program → Create ocTree mesh → Gravity (PDE)
Create an ocTree mesh for magnetics
Interaction with the Fortran utility program create_octree_mesh_mag can be done by creating an MAGcreateOctreeMesh item. This item will interact with the utility program to create
an ocTree mesh from a magnetics data item for the inversion program octmagde. To create,
use the menu structure:
Create → Fortran utility program → Create ocTree mesh → Magnetics (PDE)
Interpolate Models
Interpolate a 3D model to another 3D mesh
Interaction with the Fortran utility program interpolate_model can be done by creating an
interplate_model item. This item will interact with the utility program to interpolate a model
with a 3D mesh (not ocTree) to another 3D mesh. To create, use the menu structure:
Create → Fortran utility program → Interpolate models → Mesh3D to mesh3D
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Interpolate a 3D model to an octree mesh
Interaction with the Fortran utility program 3DModel2Octree can be done by creating an
mesh3DtoOctreeModel item. This item will interact with the utility program to interpolate
a model with a 3D mesh to an octree mesh. The utility gives the option to use the input octree
mesh or generate a new refined octree mesh.
To create, use the menu structure:
Create → Fortran utility program → Interpolate models → Mesh3D to octree
Interpolate an octree model to a 3D mesh
Interaction with the Fortran utility program octreeTo3D can be done by creating an octreeToMesh3DModel item. This item will interact with the utility program to interpolate a model
with an octree mesh to a 3D mesh. To create, use the menu structure:
Create → Fortran utility program → Interpolate models → Octree to mesh3D
Interpolate an octree model to another octree mesh
Interaction with the Fortran utility program remesh_octree_model can be done by creating
an octreeToOctreeModel item. This item will interact with the utility program to interpolate a
model with an octree mesh to another octree mesh. To create, use the menu structure:
Create → Fortran utility program → Interpolate models → Octree to octree
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Octree Utilities

Regularize an octree mesh
Interaction with the Fortran utility program regularizeOctreeMesh can be done by creating
an regularizeOctreeMesh item. This item will interact with the utility program to generate a
regularized octree mesh from an existing octree mesh. To create, use the menu structure:
Create → Fortran utility program → Octree utilities → Regularize octree mesh
Refine an octree mesh
Interaction with the Fortran utility program refine_octree can be done by creating an refineOctree item. This item will interact with the utility program to make an octree mesh finer
based on the values of the input model. To create, use the menu structure:
Create → Fortran utility program → Octree utilities → Refine octree mesh
Create surface weights for an octree mesh
Interaction with the Fortran utility program create_weight_file can be done by creating an
createSurfaceWeight item. This item will interact with the utility program to create an octree
surface weighting file. The input file specifies the number of surface layers and the weight
assigned to each surface. To create, use the menu structure:
Create → Fortran utility program → Octree utilities → Create surface weights
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Create interface weights for an octree mesh
Interaction with the Fortran utility program interface_weights can be done by creating an
createInterfaceWeight item. This item will interact with the utility program to create a weight
file for the octree cell faces. The input file specifies a tolerance and the weight for the edges.
The weights are set to the give edge weight value when the absolute value of the gradient of
the model is larger than the tolerance. Weights should be less than 1 to have a sharp boundary
and greater than 1 for a smooth boundary. The input file also specifies the number of surface
layers and the surface weight value for the x and y faces for those layers. To create, use the
menu structure:
Create → Fortran utility program → Octree utilities → Create interface weights
Export cell centre locations for an octree mesh
Interaction with the Fortran utility program octree_cell_centre can be done by creating an
exportCellCentreLocations item. This item will interact with the utility program to export a
3-column file with the cell centre locations of the octree mesh cells. To create, use the menu
structure:
Create → Fortran utility program → Octree utilities → Export cell centre locations
DCIP Octree Code Utilities
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Create surface electrodes (DC/IP)
Interaction with the Fortran utility program surface_electrodes can be done by creating
an surfaceElectrodes item. This item will interact with the utility program to place DC/IP
electrodes on the discretized topography. To create, use the menu structure:
Create → Fortran utility program → DCIP Octree utilities → Create surface electrodes
(DC/IP)
Create sensitivity weights for DC/IP octree
Interaction with the Fortran utility program dcsensitivity can be done by creating an sensitivityWeightsDCIP item. This item will interact with the utility program to generate a sensisitivity weights model for DC or IP octree inversions. To create, use the menu structure:
Create → Fortran utility program → DCIP Octree utilities → Create sensitivity weights
(DC/IP)

3.4.6 Create Tensor Mesh
GIFtools allows you to rapidly create a tensor mesh based on the extent of any GIFdata or TOPOdata
objects.

3.4. Create
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Create 1D Mesh

The creation of a 1D mesh requires the following basic parameters:
• Core cell thickness (𝑑𝑧)
• Core cell extent, either defined manually or extracted from a chosen GIFdata object:
– Z max: Top elevation
– Z min: Bottom elevation
• Padding distance with core cells. The padding cells are converted to “core cells” after creation
– Above
– Below
• Padding distance with expansion
– Distance above
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– Distance below
– Expansion factor (𝑥𝑛 * 𝑑𝑧)
Create 2D Mesh

The creation of a 2D mesh follows the same principal as the creation of a 1D Mesh with the added parameters:
• Core cell width (𝑑𝑥)
• Horizontal core extent, either defined manually or extracted from a chosen 2Ddata object:
– West: Left limit coordinate
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– East: Right limit coordinate
• Padding distance with expansion
– Distance West
– Distance East
Create 3D Mesh

The creation of a 3D mesh follows the same principal as the creation of a 2D Mesh with the added parameters:
• Core cell width (𝑑𝑦)
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• Horizontal core extent, either defined manually or extracted from a chosen 3Ddata object:
– North limit coordinate
– South limit coordinate
• Padding distance with expansion
– Distance North
– Distance South

3.4.7 Create a simple ground or airborne survey
To create a simple ground or airborne survey for potential field data, use the menu structure below:
Create → Survey → Simple surface/airborne survey
The following dialog will pop up:

The dialog requires the following parameters to be input by the user. The figure at the bottom also shows
what the parameters indicate.
• Survey type: Select the desired survey type from the drop-down menu. The options include totalfield magnetics, magnetic amplitude, gravity, gravity gradiometry, gravity gradiometry (VK1), and
gravity gradiometry (FALCON).
• Topography: Use either a constant topography value or a TOPOdata object by selecting the desired
radio button. For a value, provide the value in the text box. For a TOPOdata object, use the drop-down
menu to select available objects from the project or use the browse button to import a topography
file.
• Height above topography: The value to drape the receivers at. If a constant topography value was
given, then the receivers will all be at a constant height above that value. If a TOPOdata object was
selected, the receivers will be draped at the height given above the topography. To place the receivers
at a constant height even if there is topography, select “Value” and enter 0. Then simply give the
desired elevation for the receivers in the box for height above topography.
• Easting origin: The easting coordinate for center of survey
• Northing origin: The northing coordinate for center of survey
• Bearing: The bearing of the survey lines, using a compass (i.e., north is 0 degrees, east is 90 degrees,
etc). Rotation angle about the origin.
• Line length: The length of the survey lines.
• Number of survey lines: The total number of survey lines.
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• Data spacing: The distance between receivers along a survey line.
• Line spacing: The distance between individual survey lines.
Click OK to create the new data item. It will have the easting, northing, and elevation columns set in the
I/O headers.
Once we click OK, we’ll see the MAGdata item in the GIFtools project tree as “NewSurvey (MAGdata)”.
The survey can be viewed using VTK. The diagram below also explains what most parameters mean.

3.4.8 Create a simple DCIP survey
To create a simple DCIP survey, use the menu structure below:
Create → Survey → Simple DCIP survey
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• Survey type: Type of data object
• Dimension: Choice of 2D or 3D DCIPdata object.
• Transmitter Type: Choice between pole or dipole transmitters
• Receiver Type: Choice between pole or dipole receiver
• Centroid
– Value: The easting and northinf coordinate for center of survey
– Topography: Center of topography objects
∗ [OPTIONAL] Apply topography: Drape survey onto topography.
• Bearing: The bearing of the survey lines, using a compass (i.e., north is 0 degrees, east is 90 degrees,
etc). Rotation angle about the origin.
• Line length: The length of the survey lines.
• Line spacing: The distance between individual survey lines.
• Number of survey lines: The total number of survey lines.
• Electrode Spacing: Dipole seperation
• Number of receivers per transmitter: Maximum number of layers on pseudo-section
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3.4.9 Create a Model Builder Module (Functionality Pending)
The Model Builder module allows the user to create reference models, weights, and bounds constraints for
inversion from geology and other physical property measurements. To create a Model Builder module:
Create → Model Builder

Requirements:
• A mesh object
• An Active cells model
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CHAPTER

FOUR

OBJECT FUNCTIONALITY

All of the these functions can be accessed through the menus at the top after selecting the object in the GIFtools tree.
The main categories presented here are:
In GIFtools, data, meshes, models and other things are defined as ‘objects’. By doing this, GIFtools ensures that the
user may only
Here, we describe the specific set of actions (or methods) which can be applied to each type of object.

4.1 Data
4.1.1 General Functions for Data
PLACEHOLDER
“Data Type” Data Menu
Edit data headers
Click on desired data object, the menu with its class name (e.g., MAGdata for magnetic data)
→ Edit data headers
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Delete data columns
Click on desired data object, the menu with its class name (e.g., MAGdata for magnetic data)
→ Delete data column(s)

NOTE: Data columns that are used in the i/o Headers will not show up on the list of columns
eligible for deletion.
Create topography from data
In rare occasions when topography is not given (or in the event of forward modelling gridded
data), the user can create a “draped” topography data object at the data locations by clicking on
desired data object, the menu with its class name (e.g., MAGdata for magnetic data) → Create
topo

Create a 3D mesh from data
To create a 3D (tensor) mesh from a given data set, click on desired data object, the menu with
its class name (e.g., FEMdata for Frequency-domain EM data) → Create mesh
NOTE: For EM data, GIFtools will prompt the use for a background resitivity in order to perform “back-of-the-envelope” calculations for skin depth to determine a suggested core region.
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Export GIF data file
GIFtools will allow the user to export any data object to its corresponding GIF format. The i/o
headers will need to be set prior to exportation.
Select data object then menu with the class of the object
Object → Export → Data (``Code`` Format)
where Code is the name of the inversion style (will be GIF formatted)
Below is an example using MAGdata and exporting for MAG3D:

Special types
Most data type can be export by the above method. However, certain data types require one or
more additional steps. Links to exporting these data types are found below:
• Export E3DMT version 1 observations/locations
• Export E3DMT version 2 observations/locations

4.1. Data
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Export XYZ file
Data objects with their attributes can be exported to a column seperated data format:
Object → Export → XYZ Format
A second menu will be prompt for the selection of properties to be exported.

Export Property Statistics
It is often useful to get an overview of the data properties based on simple statistics. This
information can be useful for data QC or to define uncertainties.
Object → Export → Statistics
A second menu will be prompt for the selection of properties to be exported as above. The
output file holds 8 columns:
Property | Minimum | 25thPRCT | Median | Mean | 75thPRCT | Maximum | stdDev
In the case of EMdata object, statistics are calculated independently for each time or frequency.
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Data Manipulation Menu
Set input/output data headers
Input/output (i/o) data headers are important because it symbolized the data columns that will
be exported to GIF inversion codes. If i/o headers are required, but not filled, they will appear
in red in the information panel provided to the right of the data object when selected:

To set the i/o header, select the object and then the menu Data manipulation → set I/O headers

Downsample Data
Data may be downsample in three ways: Simple down-sampling, mesh-based and by distance.
With any method that deletes data locations, a new data object will be created after downsampling. See below for details.
Traditional downsampling
Traditional downsampling requires a number, 𝑛, which represents the fractional number of data
kept (e.g, 3 is one-third, 4 is one-quarter). This downsampling can be done on any data object
as the algorithm finds only the unique horizontal locations of data. To downsample the data
this way, the menu structure is:
Data manipulation → Downsampling → Simple
NOTE: This method of downsampling can be reached from the data viewer. Data first need to
be selected (to either be downsampled or left alone) via the View → Edit → Data selection
tab of the viwer control dialog. Then select its neighbouring tab: View → Edit → Simple edit
and select the radio button under “Downsample area.” The value associated with this will be 𝑛
as given above. A new data object name will be required.

4.1. Data
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Downsample by mesh
The second method of downsample requires a mesh (either 3D or ocTree) and will keep only
one datum location per cell. EM data will have its times/frequencies preserved. The option also
allows for either the closest location to the centre of each cell or a random location in each cell
will be chosen. To access this function use:
Data manipulation → Downsampling → Mesh Based

Downsample by distance
The third method downsamples the data based on the distance between points
Data manipulation → Downsampling → Distance

Remove data outside mesh
This function allows the user to remove data outside of a 3D mesh region that is of interest.
With any method that deletes data locations, a new data object will be created after mesh-based
removal. There are two options to choose: (1) removal outside the horizontal extent of the mesh
or (2) removal outside the entire extent of the mesh. To perform either of these two tasks, click
on the data object and then use the following menu (number corresponds from above):
1. Data manipulation → Remove data → Outside mesh lateral extent or
2. Data manipulation → Remove data → Outside of an entire mesh

4.1. Data

83

GIFtoolsCookbook Documentation, Release 1.0

Calculate a polynomial trend
Any data column may have a polynomial trend calculated. For access to this feature via magnetics or gravity data, click on the data item of interest and use the menu below. For all other
data types, this feature can be accessed though the data viewer (See Note 2).
Data manipulation → Calculate → Polynomial trend
The calculation of a polynomial trend can be accessed in the data viewer. Data first need to be
selected via the View → Edit → Data selection tab of the viwer control dialog. Then select
its neighbouring tab: View → Edit → Regional fit. A new data column name is manditory as
well as the degree of polynomial.

Note: For removal of the trend, see the Calculator for how to subtract one column from another
within a data object.

Apply a simple math operation to data
This functionality is used to apply basic math operations to a column of data. To access this
functionality, click on the data item of interest and use the menu:
Data manipulation → Calculate
Actions can be performed through the following pop-up window:
Step 1: For 𝑥 (Property), 𝑐 (Value or Property) and 𝑦 (new Property), choose from the
following set of mathematical operations.
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• Addition: adds Value to the selected Property; e.g. 𝑦 = 𝑥 + 𝑐
• Subtraction: subtracts Value from the selected Property; e.g. 𝑦 = 𝑥 − 𝑐
• Multiplication: multiplies the selected Property by Value; e.g. 𝑦 = 𝑥 × 𝑐
• Division: divides the selected Property by Value; e.g. 𝑦 = 𝑥/𝑐
• Power: computes the power (elementwize) of Property by the Value; e.g. 𝑦 = 𝑥𝑐
• Exponential: computes the power (elementwize) of Value by the Property; e.g. 𝑦 =
𝑐𝑥
• Logarithm: computes the logarithm of Property with base Value [2|10|𝑒] ; e.g. 𝑦 =
𝑙𝑜𝑔𝑐 (𝑥)
• Replace Min: returns the smaller of the two values when comparing Value to each
entry in the selected Property; e.g. 𝑦 = min(𝑥, 𝑐)
• Replace Max: returns the larger of the two values when comparing Value to each
entry in the selected Property; e.g. 𝑦 = max(𝑥, 𝑐)
• Absolute: returns the absolute value of Property; e.g. 𝑦 = |𝑥|
• Deg -> Rad: returns Property in radian; e.g. 𝑦 = 𝑥 * 𝜋/180
• Rad -> Deg: returns Property in degree; e.g. 𝑦 = 𝑥 * 180/𝜋
Step 2: Set :math:`x` Choose a property Property from the drop-down menu
• OPTIONAL: For EMdata objects, operations can be applied on a single frequency or
time channel.
4.1. Data
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Step 3: Set :math:`c`
• OPTION 1: Chose a Property from the object
• OPTION 2: Enter a number into the field for Value
Step 4: Determine if new Property is created
• Create is not selected: The new Property of data will replace the selected Property
of data
• Create is selected: A new Property is created for the calculated data and a name
must be provided
Step 5 [OPTIONAL]: Apply and continue
• Allows the user to keep the Calculator window opened and proceed with more operations. Any new Property columns are added to the drop-down menues.
Note: Spatial (X,Y) i/o Headers are not shown within the calculator. To apply the constant
calculator to the x- or y-coordinates, remove them from the i/o header.

Add Gaussian noise to data
On occasion, one may want to add noise to a forward modelled dataset in order to test an
inversion. To add Gaussian noise to a data column or columns, click on the data item of interest
and use the menu:
Data manipulation → Calculate → Add Gaussian noise
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NOTE 1: Spatial (X,Y) i/o Headers are not shown within the calculator.
Add Constant Column
One may want to append a constant value to the data object.
Calculate line and bearing
Geophysical survey are often collected along survey lines. While the data may have Easting
and Northing information, it is often useful to also know the direction (bearing) of survey. This
function groups the survey observation stations with line IDs, and provide the local bearing of
each observation with respect to its nearest neighbours.

NOTE: The assumption is made that survey points are provided in the same order as they were
collected.
Calculate elevation from surface
This functionality allows the user to create an elevation (height of the data) column from a
surface or topography object using a linear interpolation method. Elevations can be set at, above
or below the surface by a specified amount. In addition, data columns (such as a flight altitude
column) within the data object can be used to create the elevation values. This functionality is
accessed through:
Data Manipulation → Calculate → Calculate elevation from surface
Coordinates
This functionality is accessed through:
Data Manipulation → Coordinates
and can be used to:
• rotate or shift raw data into a local coordinate system
• use altitude data and surface topography to determine the data elevation

4.1. Data
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Shift spatial coordinates
This functionality allows the user to shift the Easting and Northing locations of the data within
a data object. The action creates new data columns and does not delete the preexisting Easting
and Northing locations. This functionality is accessed through:
Data Manipulation → Coordinates → Shift spatial coordinates
Rotate spatial coordinates and data
This functionality allows the user to change the Easting and Northing locations of the data
within a data object by rotating about a fixed point. The use may also apply the rotation to
specified data columns; this is useful when the dataset contains horizontal field measurements.
This functionality is accessed through:
Data Manipulation → Coordinates → Rotate spatial coordinates
Use look-up table
This functionality allows the user to convert locations of the data from local coordinates to Easting and Northing by using a Survey file. This operation is routinely performed after importing
raw DCIP2Ddata objects.
Data Manipulation → Coordinates → Look-up table
Assign uncertainties
Assigning uncertainties is vital to inversion and therefore is also required as an i/o header. An
explanation of the uncertainties and their role in the inversion process can be found in inversion
fundamentals. To assign uncertainties to a data object, click on the object and select the menu:
Data manipulation → Assign uncertainties
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Frequency and Time-Dependent Uncertainties
GUI
The user may want to specify or visualize a particular floor and percent for the uncertainties at
every distinct frequency/time. In this case, the user may select:
• Data manipulation → Assign uncertainties → GUI
If the data and uncertainties I/O header has been set, error bars will be auto-populated. Uncertainties are assigned or modified by carrying out the following steps:
• FOR ALL data columns you want to compute and assign uncertainties for:
– Select the data column from the data type drop-down menu
– Fill in the Column name to specify the name of the column containing the uncertainties
– FOR ALL times/frequencies you want to compute and assign uncertainties for:
∗ Select the time/frequency from the time/frequency drop-down menu
∗ Under Select data, specify the percent uncertainty (0 < 𝜀% < 100) and floor uncertainty for those data
∗ Click Assign selected to apply the uncertainties to that particular data type and
time/frequency. Click Assign to all to apply the same factional percent and floor to
the data at all times/frequencies. If either of these buttons is not clicked, GIFtools
will not temporarily remember these uncertainties while calculating uncertainties
for another data type and/or frequency.
When uncertainties for all data columns have been assigned, select OK to finish

4.1. Data
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Column File [% | floor]
Users can load percentages and floors uncertainties at every distinct frequency/times from a
column file. The user will be prompt with a list of properties to use. Multiple channels (i.e.
Real and Imaginary data) can be set with the same file.

Important: The number of rows in the selected file must equal the number of frequencies/times present in the data object.

Assign Simple Uncertainties
To apply a constant floor value and identical percent when computing uncertainties for all data,
select:
Data manipulation → Assign uncertainties → Simple
Add data from another data object of same type
Any data object can be combined with another data object from its same class (e.g., MAGdata
with MAGdata). Click on the data item of interest and, With the exception of DC/IP data (see
NOTE below), use the menu:
Data manipulation → Merge [data class] objects
NOTE: DC/IP data: For DC or IP data, this function is found using the menu structure:
Data manipulation → Add data → Merge [data class] objects
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Create different data type
Visualization Menu
GIFtools allows the user three different ways to view data. The methods are grouped under
Visualization menu when clicking on a data item.

VTK data viewer
3D visualization is performed through the VTK (Visualization ToolKit) data viewer. To get to
this viewer, the spatial i/o headers must be set. Then click on the data item and use the menu:
Visualization → VTK view
The shortcut for this viewer is control + k for any item selected in the tree.
Table viewer
To access the table viewer (and editor), click on the data item and the use the menu:
Visualization → Table view
The shortcut for this viewer is control + t for any item selected in the tree.
Statistics viewer
GIFtools offers a histogram view with minor statistics of each column of data. To access the
histogram viewer, click on the data item and the use the menu:
Visualization → Statistics
The shortcut for this viewer is control + h for any item selected in the tree.

4.1.2 Magnetic Data
Data Manipulation for Magnetic Data
Edit inducing magnetic field parameters
The inducing field (inclination, declination, and field strength) is vital to properly creating a
sensitivity matrix in inversion and forward modelling. This is only performed on a magnetic
data object (MAGdata).
Select the object and the menu Data manipulation → Edit field params
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Remove the IGRF from magnetic data
To remove the IGRF value from a magnetic data set, the i/o header for the data must be set.
Click on the data item of interest and use the menu:
Data manipulation → Calculate → Subtract IGRF value

NOTE 1: A separate way of removing the IGRF would be through the Calculator.
Calculate elevation from topography and flight height
This functionality allows the user to compute the elevation of their data from using a topography
object. It is accessed through:
Data Manipulation → Coordinates → Calculate elevation from surface
Required
• A topography object

4.1. Data
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Change data type
To change whether GIFtools treads a Mag data object as amplitude data, TMI data or other data,
use the change data type feature. This can be accessed through:
• Data Manipulation → Create different data type → Total-field magnetic data
• Data Manipulation → Create different data type → Magnetic amplitude data
• Data Manipulation → Create different data type → Other data type

4.1.3 DC/IP Data
Data Manipulation
Calculate: Transform between apparent resistivity and normalized voltage
The DC/IP inversion algorithms require normalized voltage for their input. GIFtools offers
a transform between apparent resitivity and normalized voltage (and vice versa). As a side
product, the geometric factor will be calculated, although one could do that separately as a
stand-alone task. Each transformation is found within the Data manipulation → Add data
submenu after clicking on the DC or IP item of interest. Each item in the menu list within
GIFtools has the value to be calculated first. See below for each transformation.

Apparent resistivity to normalized voltage
Click on the data item of interest and use the menu:
Data manipulation → Add data → Normalized voltage from apparent resistivity
Normalized voltage to Apparent resistivity
Click on the data item of interest and use the menu:
Data manipulation → Add data → Apparent resistivity from normalized voltage
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Geometry factor
Click on the data item of interest and use the menu:
Data manipulation → Add data → Geometric factor
Convert DC/IP 3D data to 2D
There are two different ways to create 2D data sets from a 3D DC/IP data set: (1) through a
menu or (2) through the VTK viewer (Control + k when DC/IP3D data selected). Here we
assume that there is a 3D DC or IP data set already in your project (see loading 3D DC/IP data
into GIFtools). Converting topography in this process is important so that DCIP2D does not
assume the data are down boreholes. Topography can be imported into GIFtools from quite a
few file formats.
Both methods will project the data locations along the line and round to the nearest millimetre.
The original 3D locations (i.e., UTM locations) will be stored in the new 2D data item.
Menu driven
For 3D DC data, use the menu:
Data manipulation → Convert data type → To a 2D DC data set
For 3D IP data, use the menu:
Data manipulation → Convert data type → To a 2D IP data set

• OPTION 1: Line Definition
This menu brings up the dialog box shown below. The user has the option to use two
points along the line or the line direction. The positive, non-zero tolerance (m) is used
to determine which data are sufficiently near the line to use for the projection (like
a box). At this point, topography can also be projected on the line (recommended)
sampled at the given interval.
NOTE: For ease, one may use the table view (control + T or Visualization → Table
view) while the dialog box is open to fill out the points along the line.
• OPTION 2: Line ID
This menu brings up the dialog box shown below. DCIP data are seperated based on the
lineID property. User can export TOPO2Ddata objects extracted from a TOPOdata
object.
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Convert DCdata to IPdata
It is possible to convert directly a DC3Ddata to IP3Ddata and vice versa to preserve the survey
configurations.
Data manipulation → Convert data type → To DC[IP]3D data set
VTK viewer
Select the DC/IP 3D data item and bring up the viewer (control + k) or:
Visualization → VTK view
Within the viewer, select the Edit tab on the control dialog and then Data selection. Using the
control button will allow the user to make multiple selections. Select the data to project (or not
project if it is easier) onto the 2D line (example below).

Then (still under the Edit tab), select the Create 2D lines tab (see below). Choose either the
data that was selected or the data not selected. If a topography item is located in the project,
choose the topography (if applicable) and sampling rate. The sampling rate is only required
if topography is selected. Fill out the new item’s name and click apply. The 2D DC/IP data
item is now ready to be input into a DC/IP 2D inversion along with the 2D topography item, if
applicable.

NOTE: For multiple lines, the VTK viewer is most likely the best (and quickest) option as it
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will compute the line. Multiple lines can be created by: clearing the selection, selecting the
next line, changing the name of the 2D DC/IP item to create, and clicking Apply.
Apply topography to DC/IP data
In some cases, the elevations of electrodes are not given or have not been set (i.e., the surface
format). DC/IP data can have elevation added to the data set through the interpolation of a
topography data item. Click on the data item of interest and use the menu:
Data manipulation → Add data → Apply topography

Remove Negative data value
In some cases, apparent resistivities can appear negative due to an issue in the measurements.
This option allows the user to remove all data points with negative values in a specific column.
Data manipulation → Remove data → Negative data

4.1.4 EM Data
EM Data Classes
There are two main types of EM data that can be created in GIFtools.
• EMdata
• EMsounding
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EMdata
For the EMdata class, the receivers are assumed to be point measurements of EM fields (E, H)
collected along the Cartesian directions. Only the transmitter type can be defined as
• TRX_LOOP: Simple loop
– Radius of the transmitter
– 𝜃 angle from vertical (0=planar loop)
– 𝛼 (azimuthal) angle from North
• TRX_ORIG: Defined by vertices
– For purely inductive source, the first and last entry must be the same in order to
close the wire path.
The EMdata class is used for:
• E3Dv1
• H3DTD
• TDoctree v1

EMsounding
For the EMsounding class, parameters describing both the transmitter and receiver are required
and used in the forward and inverse problems. This is the most general format. It allows to
easily store airborne data collected from transmitters and receivers of arbitrary shapes and orientations. The EMsounding is further divided into two sub-classes:
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EM1Dsounding
For EM1Dsounding objects, receiver can either be defined as a dipole or loop source. The
position of the receiver is set relative to the transmitter locations. The following parameters
are required:
• Along-line offset: The along-line position of receivers, relative to transmitter locations
• Cross-line offset: The cross-line position of receivers, relative to transmitter locations
• Vertical offset: The vertical location of the receivers relative to the surface
• Dipole Moment: Uses a right-handed positive down coordinate system
The EM1Dsouding data class used for:
• EM1DFM inversion,
• EM1DTM inversion

EM3Dsounding
For EM3Dsounding objects, information about the position and orientation of the system are
stored directly by the transmitter and receiver objects.
• Loop transmitter/receiver: Loop transmitters and receivers must be defined in a lefthanded (clockwise) manner. For example, a horizontal loop must be defined in a clockwise
manner for its dipole moment to be in the vertical direction. For N loop segments, you will
need to define N+1 nodes; e.g. you must close the loop. If a closed loop is used to define
a receiver, the corresponding data are the magnetic field in units A/m.
• Wire transmitter/receiver: Wire transmitters and receivers are defined using node locations without repetition of the first node.
For display purposes, the averaged receiver node locations are used to plot the data.
This data class is use for:
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• E3Dv2 tiled
• TDoctree v2

EM Data Manipulation
Extract data based on times or frequencies
To extract all the data associated with a certain time(s) or frequency(ies), click on the data item
of interest and use the menu:
• TEM data: Data manipulation → Time-based extraction of data
• FEM data: Data manipulation → Frequency-based extraction of data

NOTE: This will create a new data item.

4.1. Data

101

GIFtoolsCookbook Documentation, Release 1.0

View and/or edit the times or frequencies of a data set
To view (with the option to edit) the times or frequencies within a data set, click on the data
item of interest and use the menu:
• TEM data: Data manipulation → Change or view times
• FEM data: Data manipulation → Change or view frequencies

NOTE: Editing will NOT create a new dataset and will over-write the previous
times/frequencies.
Set Data Normalization (FEM and TEMsounding Only)
Both the EM1DFM and EM1DTM inversion codes can interpret a variety of representations of
EM data. To ensure the data are interpreted correctly by the EM1DFM and EM1DTM codes,
the data normalization must be properly set. This functionality can be accessed through:
Data manipulation → Set Data Normalization
FEM data
For FEM sounding data, the options for defining the type of data are as follows:
• ppm: secondary field component as parts-per-million of the primary field
• %: secondary field component as a fractional percent of the strength of the primary field
• A/m: secondary field component in A/m
• Total field: total field (primary + secondary) in A/m
TEM data
For TEM sounding data, the options for defining B-field data are as follows:
• nano-Tesla
• micro-Tesla
• milli-Tesla
and the options for defining dB/dt data are as follows:
• micro-Volts
• milli-Volts
• Volts
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Note: If the dipole moment of the receiver is 1 Am 2 , then the magnitude of the EMF induced
in the receiver coil in Volts equals the time-derivative of the magnetic flux density in T/s.

Set Time Normalization (TEMsounding Only)
The EM1DTM inversion code can use a variety of units for the time channel column. To ensure the data are interpreted correctly by the EM1DTM code, the time normalization must be
properly set. This functionality can be accessed through:
Data manipulation → Set Time Normalization
The options for defining the units of the time column are as follows:
• micro-seconds
• milli-seconds
• seconds
Calculate Transmitter-Receiver seperation
This function computes the in-line, cross-line and vertical seperation between the transmitter
and receiver for each datum.
Add Transmitters
Here, the user may specify the transmitter locations and properties based on the data locations.
Select the object: “data type menu” → Add transmitters
• Transmitter geometry
– From File: Lets the user import a template geometry (XYZ coordinates) defining
the transmitter coil.
– Loop: Defines a simple loop transmitter with radius set by the user.
– Dipole: Defines a dipole transmitter with moment set by the user (for
EM1Dinversion)
• Bearing
– Calculate: Let GIFtools determine the bearing of survey lines. Assumes that the
survey points are sorted in order of acquisition.
– From data object: Bearing already supplied by the data object.
• Offsets relative to bearing (XYZ)
– Along-line offset: Distance along the survey lines between the data location and
transmitter
– Cross-line offset: Distance perpendicular to the survey lines between the data location and transmitter
– Vertical offset: Elevation difference between the data location and transmitter. For
the EM1Dsounding class, the offset is relative to the ground.
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• Rotation angles
– Relative to bearing: Apply the rotation angles relative to the flight line orientation.
Otherwise angles are relative to the Cartesian grid.
– Pitch angle: Rotation angle about the wings of the bird. Positive angle moves the
nose up, tail down.
– Roll angle: Rotation angle about the length of the bird. Positive angle moves the
left wing up, right wing down.
– Yaw angle: Rotation angle about the XY plane. Positive angle rotates the bird
clockwise.

Important: Make sure you have set i/o headers for the xyz-data locations. This functionality
computes the transmitter locations based on the i/o headers.

Remove Transmitters
This functionality allows the user to remove transmitter information from the data object.
Select the object and the menu “data type menu” → Remove transmitters
Add Receivers
See the Add Transmitter function.
Waveform (TDEM objects only)
Here, we describe functionality related to defining, viewing and exporting waveforms for TEM
data objects. This functionality is accessed through:
data type menu → Waveform
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Create Exponent On - Ramp Off
Here, the user defines an exponential ramp-on linear ramp-off waveform and sets it to the selected TEM data object. This functionality is accessed through:
data type menu → Waveform → Create exponent on; ramp off
The parameters defining this waveform are as follows:
• minimum time: the starting time for the waveform (in seconds). This time must be before
your first time channel
• maximum time: the end time for the waveform (in seconds). This time must be after your
latest time channel
• time = 0: the shut-off time
• Number of segments: Number of intervals after t0 which use a different time-step length
• Samples per segment: Number of linearly sampled points which define the time-step
length in each segment
• Exponent slope: The constant 𝛼 defining the exponential ramp on
• Exponent time: The duration of the exponential ramp on
• Number of exp samples: Number of data points, linearly sampled, defining the waveform
during the exponential ramp on
• Ramp time: The duration of the linear ramp off
• Number of ramp samples: Number of data points, linearly sampled, defining the waveform during the linear ramp off
Create Step Off
Here, the user defines a step-off waveform and sets it to the selected TEM data object. This
functionality is accessed through:
data type menu → Waveform → Create step off
The parameters defining this waveform are as follows:
• minimum time: the starting time for the waveform (in seconds). This time must be before
your first time channel
• maximum time: the end time for the waveform (in seconds). This time must be after your
latest time channel
• time = 0: the shut-off time
• Number of segments: Number of intervals after t0 which use a different time-step length
• Samples per segment: Number of linearly sampled points which define the time-step
length in each segment
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Import a Waveform
Here, the user imports a custom waveform from a text file and sets it to the selected TEM data
object. This functionality is accessed through:
data type menu → Waveform → Import (3D format)
View
Here, the user may look at the waveform assigned to the selected TEM data object. This functionality is accessed through:
data type menu → Waveform → View
Export for 1D
Here, the user may export the waveform in the format used by the EM1DTM code. This functionality is accessed through:
data type menu → Waveform → Export for 1D
Export for 3D
Here, the user may export the waveform in the format used by 3D codes. This functionality is
accessed through:
data type menu → Waveform → Export for 3D

4.1.5 MT Data
MT data can be contained either within an impedance data object (IMPdata) or an apparent resistivity
and phases data object (APPdata). The data columns and functionality associated with these items are as
follows:
Data:
• X, Y and Z: These are columns for the Easting, Northing and vertical position respectively.
• Frequency: The frequency at which each datum was collected.
• ZXXR, ZXXI, ZXYR, ZXYI, ZYXR, ZYXI, ZYYR, ZYYI: For impedance data (IMPdata), these
columns represent the real and imaginary components of impedance tensor elements.
• RHOXX, RHOXY, RHOYX, RHOYY: For apparent resistivity and phase data (APPdata), these
columns represent the apparent resistivities for impedance tensor elements.
• PHSXX, PHSXY, PHSYX, PHSXX: For apparent resistivity and phase data (APPdata), these
columns represent the phases for impedance tensor elements.
• Rx station ID: For the E3DMT version 2 code, each observation location has a set of receivers which
is given an ID number. This column contains the station ID numbers for each datum.
Functionality:
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MT “Data Type” Data Menu
Set/Reset Receivers from Data Locations
To forward model or invert impedance data using the E3DMT version 2 code, all wire receivers
that measure the electric field and all inductive loop receivers that measure the magnetic field
must be defined. If data were loaded into GIFtools using EDI, MTZ3D or E3DMT version 1
formats, this functionality can be used to define the dimensions of the wire and loop receivers
from the data locations. If data were loaded from an E3DMT version 2 data file, then the
receivers are automatically defined according to the receiver file . This functionality is accessed
via:
[data type] → Set/reset receivers from data locations
In the pop-up window shown below, the user specifies the following:
• H-receiver width: Sets the dimensions of loop receivers measuring the H-field
• E-receiver length: Sets the length of the wire receivers measuring the E-field
• Number of Segments (H): Number of segments used to define H-receiver loops. If 4 is
entered, the loop is square and H-receiver width is the side length of the loop. If a number
larger than 4 is entered, the loop is circular and H-receiver width is the diameter.
• Number of Segments (E): Number of segments used to define the E-receiver wires. A
number larger than 1 means you would like to be more accurate as you integrate the electric
field over the path of the wire
• Orientation from Northing: This value is the angle, in degrees, from geographic North.
It is positive in the clockwise direction. If in standard orientation (𝑍𝑥𝑦 = 𝐸𝑥 /𝐻𝑦 with X
= Northing, Y = Easting and Z = down), then use a value of 0. If the receivers are rotated
relative to geographic North, you can model this with E3DMT v2.
• Stn ID column name: the name of the data header given to the SNID column

Some things to note about this functionality:
• The centers of wire and loop receivers are at the location of the associated datum.
• By using this functionality, you will replace the receivers and receiver index column associated with this data object.
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Export Observation/Locations
E3DMT version 1 format (Impedance only)
The E3DMT version 1 code can forward model and jointly invert data from multiple impedance
tensor and/or ZTEM data objects. When selecting an impedance data object and choosing
Impedance data → Export, a pop-up window appears (see below). The user then:
1) Select the impedance and/or ZTEM data objects they would like to export into a single
observations/locations file
2) Select OK

Some things to note about this functionality:
• The order in which you select the data objects is the order in which the observations/locations show up in the exported file.
• You cannot export apparent resistivity and phase data.
• When loading predicted data, it is important to remember the order or data objects you
used to create the locations file. If forward modeling or inversion is done through the GUI,
the forward modeling/inversion object will remember the correct order.
• If all data headers are set for all objects, an observations file is exported. If no data headers
are set for any object, a locations file is exported.
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E3DMT version 2 format (Impedance only)
The E3DMT version 2 code requires an observations or survey index file, a receivers file and
a frequencies file form the third pup-up window. The user selects the observations or survey
index file from the first pop-up window, the receivers file from the second pop-up window, and
the frequencies file form the third pup-up window.
MT Data Manipulation Menu
Rotate impedance tensors
This functionality is used to rotate the impedance tensor in the case that the primary direction
(X) does not lie along the Northing. This functionality can be accessed through:
• Data manipulation → Calculate → Rotate impedance tensor
The user will enter the amount of degrees clockwise they would like to rotate the impedance
tensor data. For example, let us assume the data are defined such that X is towards the Northwest
and Y is towards the Northeast. If we enter a value of 45, the impedance tensor data will
be rotated to UBC-GIF convention (X = Northing and Y = Easting); assume that Z is +ve
downward.
Convert between impedance data and apparent resistivity and phase data
This functionality either:
• generates apparent resistivity and phase data from impedance data, or
• generates impedance data from apparent resistivity and phase data
This functionality can be accessed through:
• Data manipulation → Create new item → Convert to apparent resistivity and phase
data (APPdata)
• Data manipulation → Create new item → Convert to impedance data (IMPdata)
Some things to note about this functionality:
• A new data object is created when this functionality is used
• To compute 𝜌𝑥𝑦 and 𝜑𝑥𝑦 from Re[ 𝑍𝑥𝑦 ] and Im[ 𝑍𝑥𝑦 ], you must set the associated data
headers. Some goes for the reverse operation.
• This functionality works regardless of whether data use a time-dependency of 𝑒𝑖𝜔𝑡 or 𝑒−𝑖𝜔𝑡 .

4.1.6 ZTEM Data
ZTEM data can are contained within a Z-axis Tipper EM data object (ZTEMdata). The data columns,
properties and functionality associated with these items are as follows:
Data
• X, Y and Z: These are columns for the Easting, Northing and vertical position respectively.
• Frequency: The frequency at which each datum was collected.
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• TZXR, TZXI, TZYR, TZYI: For apparent resistivity and phase data (APPdata), these columns
represent the real and imaginary components of the elements of the transfer function.
• Rx station ID: For the E3DMT version 2 code, each observation location has a set of receivers which
is given an ID number. This column contains the station ID numbers for each datum.
• Base station ID: This column contains the base station ID numbers for each datum.
Properties:
• ZTEM data type: A flag which determines whether a base station is used when modeling ZTEM data
Functionality:
ZTEM “Data Type” Data Menu
Set/Reset Base Station
To forward model or invert ZTEM data using the MTZ3D or E3DMT version 1 codes, the base
station must first be defined. If data were loaded into GIFtools using EDI or E3DMT version 2
formats, this functionality can be used to define the base station. If data were loaded from and
E3DMT version 1 or MTZ3D data file, then the base station(s) may automatically be defined.
This functionality is accessed via:
ZTEM data → Set/reset base station
In the pop-up window shown below, the user specifies the following:
• Hx, Hy receiver width: Sets the dimensions of loop receivers measuring the horizontal
H-field
• Hz receiver length: Sets the dimensions of loop receivers measuring the vertical H-field
• Hx, Hy Number of Segments: Number of segments used to define receiver loops measuring Hx and Hy. If 4 is entered, the loops are square and Hx, Hy receiver width is the
side length of each loop. If a number larger than 4 is entered, the loops are circular and
Hx, Hy receiver width is the diameter.
• Hz Number of Segments: Number of segments used to define receiver loops measuring
Hz. If 4 is entered, the loop is square and Hz receiver width is the side length of the loop. If
a number larger than 4 is entered, the loop is circular and Hz receiver width is the diameter.
• Orientation from Northing: This value is the angle, in degrees, from geographic North.
It is positive in the clockwise direction. If in standard orientation (𝑍𝑥𝑦 = 𝐸𝑥 /𝐻𝑦 with X
= Northing, Y = Easting and Z = down), then use a value of 0. If the receivers are rotated
relative to geographic North, you can model this with E3DMT v2.
• Stn ID column name: the name of the data header given to the SNID column
Some things to note about this functionality:
• By using this functionality, you will replace any pre-existing base stations and replace the
base station index (BASEID) column.
• This functionality works for ZTEM simulations with and without base stations.
• A base station can be set and used within the framework of the E3DMT version 2 code.
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Set ZTEM Data Type
For the E3DMT version 1 code, there are several inversion options for inverting ZTEM data:
• MTT: A fix base station is used to measure Hx and Hy, while Hz is measured at each data
locations
• MTE: Same as above, however the values for Hx and Hy are computed from the starting
model
• MTH: No base station. Hx, Hy and Hz are all measured at every data location
This functionality can be accessed via:
ZTEM data → Set ZTEM data type
Some things to note about this functionality
• If the user chooses type MTT or MTE, they will need to set/reset base station and set the
io Header for the BASEID column to use the E3DMT version 1 code.
• As of right now, the E3DMT version 2 code only supports MTH. In the future, this may
change.
Set/Reset Receivers from Data Locations
To forward model or invert ZTEM data using the E3DMT version 2 code, all inductive loop
receivers that measure the magnetic field must be defined. If data were loaded into GIFtools
using EDI, MTZ3D or E3DMT version 1 formats, this functionality can be used to define the
dimensions of the loop receivers from the data locations. If data were loaded from an E3DMT
version 2 data file, then the receivers are automatically defined according to the receiver file .
This functionality is accessed via:
ZTEM data → Set/reset receivers from data locations
In the pop-up window shown below, the user specifies the following:
• Easting width: the width along the Easting direction for loops that measure Hy and Hz
• Northing width: the width along the Northing direction for loops that measure Hx and
Hz
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• Vertical width: the width along the vertical direction for loops that measure Hx and Hy
• Stn ID column name: the name of the data header given to the SNID column

Some things to note about this functionality:
• The centers of loop receivers are at the location of the associated datum.
• By using this functionality, you will replace the receivers and receiver index column
(SNID) associated with this data object.
• If ZTEM data type is MTH, then Hx and Hy will be measured at the observation locations.
If ZTEM data type is MTT or MTE and you have set a base station, then the locations of the
loops measuring Hx and Hy will be at the location of the base station. This functionality
will not work however if there are multiple base stations.
Remove Base Station
This functionality removes all base stations associate with the ZTEM data object. This functionality is accessed via:
ZTEM data → Remove base station
Export Observation/Locations
E3DMT version 1 format
This functionality is described within the MT section.
E3DMT version 2 format
This functionality is described within the MT section.
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ZTEM Data Manipulation Menu
Compute Total Divergence Columns
Tipper data are sensitive to lateral changes in electrical conductivity. To represent the tipper
data in a way that is directly sensitive to conductive and resistive structures, we can compute
the total divergence parameter (termed the ‘DT’). For both the real and imaginary components,
the total divergence parameter is computed by:
𝐷𝑇 =

𝜕𝑇𝑦
𝜕𝑇𝑥
+
𝜕𝑥
𝜕𝑦

Before and after computing this quantity within the GIFtools framework, there are a few things
the user should consider:
• The data must be represented in UBC-GIF format. That is, X = Northing, Y = Easting and
Z +ve downward
• The UBC-GIF coordinate system also applies when taking derivatives
• When plotting the total divergence for the real component with GIFtools, you will generally
see maxima (positive anomalies) over conductors and minima (negative anomalies) over
resistive zones.
This functionality is accessed though:
Data Manipulation → Calculate → Compute total divergence (DT) columns
When applying this functionality, GIFtools computes discrete derivatives. It is up to the user
to choose the accuracy of the derivatives by setting the spacing between discrete points used in
the computation. A default value of 100 is set. We suggest the user choose 1/4 to 1/2 the flight
line separation distance.
Transform Data Convention for ZTEM Data
ZTEM data are frequently collected in a data convention that is survey-dependent. This functionality applies the necessary transform to go from the survey-dependent coordinate system to
UBC-GIF. The necessary transform can be determined from the ZTEM polarization information provided by the contractor. This functionality can be accessed through:
Data Manipulation → Coordinates → ZTEM data transformation
There are 3 considerations when applying the transformation. These are described below.
Set Flight Bearing: For each datum, this is the ‘along-line’ direction. Here, you enter the
degrees clockwise from Northing that corresponds to the along-line direction. For UBC-GIF
codes, you can think of the along-line direction “X” as being the Northing direction. There are
two options:
• Constant: All of the data is defined in the same along-line direction
• Column: If the along-line direction for each datum is provided in a column, it can be
applied.
Define cross-line direction: UBC-GIF convention defines the cross-line direction “Y” as being
90 degrees clockwise from the along-line direction “X”. However, ZTEM data are frequently
defined as having a cross-line direction that is 90 degrees counter clockwise from the along-line
direction. Here there are two options:
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• Cross-line direction is 90 degrees CCW from along-line direction: Need to include this in
the transform to go to UBC-GIF convention.
• Cross-line direction is 90 degrees CW from along-line direction: This does not need to be
taken into account in the transform.
Convert Z Direction: UBC-GIF data convention is Z +ve downward whereas some surveydependent conventions may use Z +ve upward. For this, there are two options:
• Convert from Z +ve up to Z +ve down
• Convention is already Z +ve down

4.2 Mesh
4.2.1 Modifying a Tensor mesh
GIFtools allows you to modify your Tensor mesh based on parameters that are auto-detected by GIFtools or that
have been previously stored on the GIFmesh object. GIFtools will prompt a Mesh Creation panel with parameters
auto-filled for either a mesh1D, mesh2D or mesh3D. See the corresponding documentation for more details.

4.2.2 Create Model
Create a constant model
There are two ways to create a constant model object:
• From a mesh: select mesh and the class menu (e.g., mesh3D) → Create model → Constant model
• From a model: select model and the menu GIFmodel → Create constant model
Create an active cells model
There are two active cell models that can be created from a mesh:
1. Active cells from topography (GIF topography object required): select mesh and the class menu (e.g., mesh3D)
→ Create model → Active cells from topo
2. Model of all active cells: select mesh and the class menu (e.g., mesh3D) → Create model → Full active cells
model

4.2.3 Create Weights
For a given mesh, this functionality is used to create a GIFweights object. The newly created GIFweight object will
have default cell weights and face weights, with all weight values equal to 1. The cell weights are defined by a GIFmodel
and the face weights are defined by a FACEmodel. To use this functionality:
[Mesh Object] → Create weighting item

4.2. Mesh
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Fig. 1: Mesh modification options
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4.2.4 Shift Mesh Coordinates
This tool allows you to translate the coordinates of a mesh using the current and shifted Easting and Northing
coordinates.

4.2.5 Refine an ocTree mesh from topography
In cases where small cells can be too prohibitive in the presence of topography, the user can create an octree mesh
with the original cell size in the core region, but with a refined cell size within the mesh in the areas where topography
undulations occur. To refine the ocTree mesh, select the mesh and then the menus:
meshOctree → Create model → Refined mesh and create active cells

NOTE: This will create a new ocTree mesh and an active cells model.

4.2.6 View a mesh
GIFtools allows the user two different ways to view a mesh. The methods are grouped under Visualization menu when
clicking on the mesh item.
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MeshTools3D
To view the model in meshTools3D, click on the data item and the use the menu:
Visualization → MeshTools3D
The shortcut for this viewer is control + m for any item selected in the tree.
NOTE: MeshTools3D.exe must be pathed or located in the parental directory of GIFtools for this function to work.
VTK data viewer
3D visualization is performed through the VTK (Visualization ToolKit) model viewer. Click on the model item and
use the menu:
Visualization → VTK view
The shortcut for this viewer is control + k for any item selected in the tree.

4.2.7 Export a mesh
GIFtools will allow the user to export any mesh object at any time. Select mesh object then menu with the class of the
object (e.g., mesh3D) → Export
Below is an example for a 3D mesh:

4.2.8 Extract Model Section
This tool allows the user to extract sections from multiple 3D models.
Mesh → Extract Sections
The function returns a GIFfolder with mesh and model corresponding to the chosen sections. The sections are stored
on a 2.5D mesh made up of 1 m thick layers.

4.2. Mesh
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4.2.9 Merge (Interpolate) 3D models
This tool allows the user to merge multiple 3D models onto a given mesh. The operation can be done across meshes with
different discretization. The main menu allows the user to specify simple grid transformations as well as interpolation
parameters:

The following fields control the inverse distance interpolation:
∑︀𝑁
𝑖=1 mi 𝑟𝑖
m̄ = ∑︀
𝑁
𝑖=1 𝑟𝑖
[︀
]︀1/2
𝑟𝑖 = (𝑥(𝑚)
¯ − 𝑥(𝑚𝑖 ))2 + (𝑦(𝑚)
¯ − 𝑦(𝑚𝑖 ))2 + 𝛿
where x and y define the cell center location of model column m in the underlying mesh.
Options
Maximum Interpolation Distance
N. Interpolation Points
Threshold parameters
No-data-value
Rotation center [X,Y]
Rotation angle
Translation [X,Y]

Description
Neighboring cells with active property values
Number of neighbors included in the weighted average
Smoothing factor
Fill values for air cells and empty model
Easting, Northing position of rotation center
Rotation counter-clockwise from East
Grid translation distances

Example
• Download this example

4.2. Mesh
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4.3 Model
4.3.1 General Functionality
Viewing a model
GIFtools allows the user three different ways to view models. The methods are grouped under Visualization menu when clicking on the model item.

MeshTools3D
To view the model in meshTools3D, click on the data item and the use the menu:
Visualization → MeshTools3D
The shortcut for this viewer is control + m for any item selected in the tree.
NOTE: MeshTools3D.exe must be pathed or located in the parental directory of GIFtools for this function
to work.
VTK data viewer
3D visualization is performed through the VTK (Visualization ToolKit) model viewer. Click on the model
item and use the menu:
Visualization → VTK view
The shortcut for this viewer is control + k for any item selected in the tree.
Statistics viewer
GIFtools offers a histogram view with minor statistics for the model. To access the histogram viewer, click
on the data item and the use the menu:
Visualization → Statistics
The shortcut for this viewer is control + h for any item selected in the tree.

4.3. Model
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Export a Model
GIFtools will allow the user to export any model object at any time through either:
• Active-cell model → Export
• Geology Model → Export
• GIF Model → Export

NOTE Exporting of the model will not export its associated mesh (see Exporting meshes)!

4.3.2 Active Cells Models
Create Constant Geological Model
This feature allows the user to create a geology model where all active cells (below topography) and inactive
cells (air cells) can be assigned constant physical property values. Once created, the user is responsible for
setting the physical property values for the active and inactive cells; see geology models. This functionality
is accessed through:
Active-cell model → Create model → Constant geology model

4.3.3 Create a Model Builder Module
The Model Builder module allows the user to create reference models, weights, and bounds constraints for
inversion from geology and other physical property measurements. If the GIF project contains an active
cells model, the user may create a Model Builder model by:
Select active cells model → Model Builder → Start modelBuilder module
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4.3.4 Geological Models
Set I/O Headers
This functionality sets the input and output columns for the data defining the geological model. This
functionality can be accessed through:
Geology Model → Geology definition → Set I/O headers
Rename Headers
This functionality allows the user to rename the headers for the columns which define the geological model.
This functionality can be accessed through:
Geology Model → Geology definition → Set I/O headers
Edit Geology Definitions
This functionality is accessed through:
Geology Model → Geology definition → Edit
For each unit defined in the geological model, this functionality allows the user to set constant value for:
• The geology ID
• The mean property value
• The lower bound for the property value
• The upper bound for the property value
• A constant weighting for the cells within each geology
• Add a comment about the geological unit such as its lithology
Create Physical Property Model (GIF Model)
This functionality allows the user to create a physical property models (GIF models) from a geological
model. This functionality can be accessed through:
Geology Model → Create model → From property values
Requirements:
• Values for each geological unit in the geological model must be confirmed
• The I/O headers for each column defining the geological model should confirmed

4.3. Model
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Create Active Model from Units
This functionality allows the user to create an active cells model from a geological model. The user
may specify which geological units are active and which are inactive. This functionality can be accessed
through:
Geology Model → Create model → Active model from units

4.3.5 Functionality for GIF Models
Set Unit Name for the Model
To set the model unit name, select the GIFmodel object then the menu:
GIFmodel → Edit → Set unit name

NOTE This will not change the values of the units (use the simple calculator to change units)! Simply the
unit name.
Set Air/Ground Cells in Models
There are two ways to assign aircell values to a physical property model.
OPTION 1: From active model
For GEO models and GIF models, the physical property values for the air cells can be manual set through
either:
• GIF Model → Edit → Assign value to air cells
• Geology Model → Change values → Assign value to air cells
Note: Prequisites: An active cell model associated with the model’s mesh.
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OPTION 2: Fill values upward and cut with topography
TThis function allows the user to re-define the air/ground interface. First, model values from the top ground
cells (from no-data-value) are copied vertically. Secondly, air cells are assigned based on a topography or
active model objects.

Perform Simple Mathematical Operations on Model Values
To perform a simple mathematical operation (i.e., change units), select the GIFmodel object then the menu:
GIFmodel → Edit → Calculate → Simple calculator

4.3. Model
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Perform Mathematical Operations Involving Another Model
To perform a mathematic operations involving another model (i.e., sum the values), select the GIFmodel
object then the menu:
GIFmodel → Edit → Calculate → Model calculator

Replace Value
This functionality allows the user to change the physical property value of cells within a GIF model based
on their current value. This functionality is accessed through:
GIFmodel → Edit → Replace value
The following fields are then filled in:
• Old value: approximate value for cells whose physical property will be replaced
• New value: new physical property value for cells being replaced
• Tolerance: The extent at which physical property values may differ from old value and be replace
by new value
Fill No-Data-Values (2D Interpolation)
This functionality allows the user to interpolate the physical property values between columns of models. The algorithm first copy ground values upward, then proceed with and inverse distance interpolation
between columns of model values.
The following fields control the inverse distance interpolation:
∑︀𝑁
m̄ =

𝑖=1

mi 𝑟𝑖

∑︀𝑁

𝑖=1 𝑟𝑖

[︀
]︀1/2
𝑟𝑖 = (𝑥(𝑚)
¯ − 𝑥(𝑚𝑖 ))2 + (𝑦(𝑚)
¯ − 𝑦(𝑚𝑖 ))2 + 𝛿
where x and y define the cell center location of model column m in the underlying mesh.
• Number of interpolation cells (N): Number of neighboring cells to use in the 2D inverse distance
(1=NearestNeighbor)
• Threshold parameter (𝛿): Smoothing parameter controlling thresholding the inverse distances
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• North-South Stretching Factor: Value controlling the stretching of the interpolation along the
North-South direction. Increase this value to compensate for East-West oriented models.
• East-West Stretching Factor: Value controlling the stretching of the interpolation along the NorthSouth direction. Increase this value to compensate for North-South oriented models.
• No-data-value: Value used in the search of empty model columns and air cells for the upward fill
• Interpolation type: Perform the weighted averaging in linear or logarithmic space

Nearest Neighbour (3D Interpolation)
This funcationality will apply nearest neighbour to interpolate the model from one 3D or OcTree mesh to
another 3D or OcTree mesh. This functionality is accessed through:
Model → 3D options → Nearest neighbour interpolation

images/modelNearestInterp.png

Important parameters for the interpolation and management of cells in the padding are as follows:
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• Air value: The value given to all cells lying outside the active topography
• Padding Cell Options:
– Nearest neighbour: All cells within the active topography will be determined via nearest neighbour interpolation
– Set padding to constant: All active topography cells in the padding will be assigned a constant
value
– Decay to constant: Cells in the padding will decay towards a background value according to the
following expression
)︂1/3
(︂
𝑉
𝑚0 + (𝑚𝑖 − 𝑚0 ) 𝜂 𝑞 where 𝑞 = 1 −
𝑉𝑚𝑖𝑛
where 𝑚0 is the background value, 𝑚𝑖 is the value if nearest neighbour was applied, 0 < 𝜂 < 1 and 𝑉 is
the volume. For OcTree meshes, 𝜂 ∈ [0.8, 0.9] works well. For tensor models, 𝜂 ∼ 0.5 works well.

images/modelNearestInterp_examples.png

Fig. 2: Examples of different padding choices when input model is only defined in the core mesh region. Nearest
neighbour (left). Constant (middle). Decay to constant (right).
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Add Rectangular Block and Polyhedra-Based Structures
The property data locations or locations based on data values may be used. Either convex or non-convex
polyhedra may be calculated. Select the GIFmodel object then the menu:
• Block: GIFmodel → Edit → Add → Rectangular Block
• Convex: GIFmodel → Edit → Add → convex polyhedron from PROPdata
• Non-convex: GIFmodel → Edit → Add → non-convex polyhedron from PROPdata

Prerequisites
A property data (PROPdata) item must be ref:imported <importProp>.
Switch Mesh (of equal size)
Create Active Model
This functionality will examine the cell values in a GIFmodel and create and ACTIVEmodel object. The
ACTIVEmodel keeps track of which cells like below the surface topography. This functionality is accessed
through:
GIFmodel → Create → Active model
So long as the size of the mesh is the same, the associated mesh for any model can be changed through
either:
• Active-cell model → Switch mesh
• Geology Model → Switch mesh
• GIF Model → Edit → Switch mesh
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4.4 Images
4.4.1 General Functionality for Images
Legend
Here, we describe all functionality which can be accessed through either of:
• Plan-view image → Legend
• Cross-section image → Legend
Set I/O Headers
The input/output headers for the legend can be set through either:
• Plan-view image → Legend → Set I/O headers
• Cross-section image → Legend → Set I/O headers
Rename I/O Headers
The current input/output headers for the legend can be changed through either:
• Plan-view image → Legend → Rename headers
• Cross-section image → Legend → Rename headers
Import
A pre-existing legend file can be imported and linked directly with the selected image through either:
• Plan-view image → Legend → Import
• Cross-section image → Legend → Import
Edit
The numerical index (i.e. 1, 2, 3,..) which define each RGB value in the image can be changed through either:
• Plan-view image → Legend → Edit
• Cross-section image → Legend → Edit

4.4. Images
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Create legend for plan-view images
Once the image is selected, the legend defining each distinct geological unit can be defined through either:
• Plan-view image → Legend → Create → Table
• Cross-section image → Legend → Create → Table
Also see:
• Importing and formatting for legend files is explained here
Import
If the legend corresponding to the image has be set, the legend file can be exported through either:
• Plan-view image → Legend → Export
• Cross-section image → Legend → Export
Refine RGB Tolerance
Here, we describe all functionality which can be accessed through either of:
• Plan-view image → Refine RGB Tolerance
• Cross-section image → Refine RGB Tolerance
Export
The image, world file and corresponding legend file can be exported as a .tiff file through either:
Here, we describe all functionality which can be accessed through either of:
• Plan-view image → Export
• Cross-section image → Export

4.5 Weights
Here we describe the general functionality for GIFweight objects.

4.5.1 Set Model
For a given GIFweight object, the user may want to change the cell or face weights. This done through ‘Set Model’:
Weighting functions → Set Model → Cell Weighting
Weighting functions → Set Model → Face Weighting
This action will make a copy of the GIFmodel or FACEmodel selected, place it within the items contained in the
GIFweight object, then set the new cell/face weights as a property of the GIFweight object. The user must make sure
that the GIFmodel or FACEmodel is consistent with the mesh size and dimensions associated with the weights object.
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4.5.2 Export Weights
This functionality will write out separate files containing the cell and the face weights. This functionality is accessed
as follows:
Weighting functions → Export
If desired, the user could select any of the models within the GIFweight object and export them independently.

4.6 Workflow
GIFtools-Workflows have been designed to streamline more complex tasks, such as inversions, and guide the user
through the decision process.

4.6.1 Inversion
GIFtools-Workflows have been designed to streamline more complex tasks, such as inversions, and guide the user
through the decision process.

4.6.2 Batch Inversion
With a BatchInversion object, the user can schedule to run several independent inversions (data, topography, mesh) but with common inversion parameters. This Workflow was primarily designed
to reduce the processing time of DCIP2D data. Inversion objects are
created and stored under a common folder structure. Recovered models can be merged for viewing in 3D.
Create Batch Inversion

Batch Inversion object can be created through the Project menu
structure:
Create → Workflow → Batch Inversion
4.6. Workflow
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A BatchInversion folder will be created in your project directory.
The following sections cover the different options available under the
Batch Inversion menu structure.

Set Inversion (Template)
This option will prompt a menu for the selection of an Inversion
object used as a template for all subsequent inversions. General inversion options, such as 𝛼-values, reference and starting models can be set on this object.
Workflow → Set Template

Select Data Objects
This option will prompt a menu for the selection of Data objects, for which an Inversion object will be created.
Workflow → Select Data Objects
[OPTIONAL]: For DCIP2D inversions, a second menu for the selection of TOPO2Ddata objects will follow:
If none are selected, the Batch Inversion will default to the input topography of the Template.
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Create/Write Inversions
With this option, the Batch Inversion routine copies the Template and replace only the components specific to
each inversions (data, mesh, topography). By default, the selected Data and TOPO2Ddata objects will be copied to the
newly created inversion object.
Workflow → Create/Write all
Run Inversions
Option to run all the inversion in series.
Workflow → Run
OPTION 1: Run locally
Just as for any other inversion programs, the Fortran executable can be called locally. The user has to wait for all
inversions to be completed before carrying on with the project.
OPTION 2: Run Setup (Cloud)
This option allows the user to run the series of inversion on a remote computer (cloud). Files and directories needed
for the individual inversions are stored to disk, along with a Python script for the execution. The user will need to copy
the content of the inversion directory as well as the BatchInversion.py script. To run the script type in a command
line:
python BatchInversion.py [Directory] [FortranCode]
where:
[Directory] is the relative path between the python script and the input files. If the same folder, use .\
[FortranCode] is name of the inversion routine to be used (e.g. dcinv2d, maginv3d)
Load All
Selecting this option triggers GIFtools to seek for results in the corresponding list of directories associated with individual inversion objects. If the inversion was run on a remote machine, the directories must be copied in the working
directory of the parent BatchInversion. Only the last model and predicted will be loaded, but convergence curves
can be viewed.
Workflow → Load All
Merge Results
This option allows the user to merge the inverted models into a common mesh. Models are interpolated using the Merge
3D Model routine.
• For DCIP2D, geometric transformations between local coordinate and global 3D coordinates are calculated from
a DCIP3Ddata object containing the LineID identifier for each 2D inversions.
• For general GIFmodel 3D objects, the Merge 3D Model menu option lets the user apply geometric transformation
(Shift+Rotation) to each models used by the interpolation.
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4.6.3 Model Space
With the Model Space Workflow, the user can explore the solution space associated with underdetermined inverse
problems. The workflow proceeds with a series of inversion over a range of parameter values. The resulting models
can be visualized and compared along set cross sections.

Create → Workflow → Model Space
Set inversion object
This option will prompt a menu for the selection of an Inversion object used as a template for all subsequent inversions. Only the inversion parameter under investigation will be altered for subsequent inversions
Workflow → Set Template

Edit Options
This option sets the range of inversion parameters to iterate over. Values for 𝛼, 𝑚𝑟𝑒𝑓 , 𝑚0 are available for all inversion
objects. MAGINV3D_v6 and GZINV3D_v6 allow for sparsity on model values 𝑝-value and model gradients 𝑞-values.
Workflow → Edit Options

4.6. Workflow
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Write All
This option creates the files and directories needed for the individual inversions These are stored to disk, along with a
Python script for the execution.
Workflow → Write all
Run
Workflow → Run
OPTION 1: Run locally
Just as for any other inversion programs, the Fortran executable can be called locally. Make sure you have sufficient
resources to run the inversion.
OPTION 2: Run remotely
To run the inversion on a remote computer, the user will need to copy the content of the inversion directory as well as
the BatchInversion.py script.
To run the script type in a command line:
python BatchInversion.py [Directory] [FortranCode]
where:
[Directory] is the relative path between the python script and the input files. If the same folder, use .\
[FortranCode] is name of the inversion routine to be used (e.g. dcinv2d, maginv3d)
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Load All
Selecting this option triggers GIFtools to seek for results in the corresponding list of directories associated with individual inversion objects. If the inversion was run on a remote machine, the directories must be copied in the working
directory of the parent BatchInversion. Only the last model and predicted will be loaded, but convergence curves
can be viewed.
Workflow → Load All
Export Section
In order to compare multiple models at once, individual sections can be exported using the Model Extraction tool.
Workflow → Extract Sections

4.6.4 Depth of investigation (DOI) calculation
With the DOI Workflow, the user can compare two models in order to estimate the robustness of geophysical anomalies.
The resulting DOI index can be visualized and used as weights in subsequent inversions.

Create → Workflow → DOI calculation
Edit Options
DOI calculations follow the work presented in Li & Oldenburg 1999. The calculation requires two models and their
respective reference values.
• model 1 (& 2)
inverted models with two different reference models
• reference 1 (& 2)
reference models used in the inversion
• method
– option 1: Cell-by-cell. The first method looks at the deviation of models normalized by the difference
in reference value on a cell-by-cell basis:
4.6. Workflow
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𝑅(𝑥, 𝑦) =

𝑚1 (𝑥, 𝑧) − 𝑚2 (𝑥, 𝑧)
𝑚𝑟𝑒𝑓
− 𝑚𝑟𝑒𝑓
1
2

where 𝑚1 and 𝑚2 are the two chosen models and 𝑚𝑟𝑒𝑓
and 𝑚𝑟𝑒𝑓
their respective background reference1
2
models. Model parameters with large R values are assign high credibility.
– option 2: Cross-correlation: The second strategy measures the difference between two images over n
cells in a rectangular window. The cross-correlation between the two models are calculated as
∑︀𝑁
¯ 1 )(𝑚2𝑖 − 𝑚
¯ 2)
𝑖 (𝑚1𝑖 − 𝑚
𝐶 = (︂
)︂(1/2)
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𝑚
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𝑖
𝑖
where 𝑚
¯ is the average of the model over the window. The DOI index is calculated by
𝑅=

𝐶 −1
2

• threshold
Threshold used on the DOI to cut the models.
Output
• reference model 1 (& 2)
reference models used for the computation
• DOI:
Computed DOI
• DOI_Thresholded
DOI model which has been thresholded (with the input thresold) at the surface to highlight the area of
interest (see figure below for an example).
• DOI_Masked_model1 (&2)
Model masked based on the thresholded DOI.

4.7 Forward Modeling
4.7.1 Set the working directory
The working directory tells GIFtools where to output files (and run the forward model) associated with
the selected item. It is suggested to set the directory prior to setting any other properties . Click on the
forward modeling item, select the menu showing its class (e.g., E3Dforward or GRAVforward):
[Forward modelign class] → Set working directory
NOTE: The shortcut for the functionality is control + d.

4.7. Forward Modeling
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4.7.2 Edit Options for Forward Modeling Objects
The edit options functionality is responsible for setting all parameters and objects used in the forward
model. This includes setting the mesh, survey file, topography and other parameters. To set the forward
modeling parameters through edit options, click the object and select:
[Forward modeling class] → Edit options

The options for each forward modeling type are organized as follows:
Edit Options for Gravity Forward Modeling Objects
Grav3D
This functionality is responsible for setting all forward modeling parameters pertaining to the
“gravfor3d”, “gravfor3d_51” and “gravfor3d_60” forward modeling codes; see GRAV3D manual . Within the edit options window, the user may set the following parameters:
• Model: A relative density model. Because the model is already associated with a mesh
within GIFtools, the mesh does not need to be specified here.
• Data locations: Set the object which contains the observations locations.
• Topography (optional): The user may define the surface topography using a TOPOdata
object. If the surface topography is flat and set at an elevation of 0 m, the user may set to
null.
• Apply: The values and objects specified in each field are not set until the user has clicked
Apply.
Units
Inputs:
• Model: a relative density model in units 𝑔/𝑐𝑚3
Outputs:
• Predicted data: gravity anomaly in milliGal (mGal )

4.7. Forward Modeling
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Edit Options for Magnetic Forward Modeling Objects
Mag3D
This functionality is responsible for setting all forward modeling parameters pertaining to the
“magfor3d”, “magfor3d_51” and “magfor3d_60” forward modeling codes; see MAG3D manual . Within the edit options window, the user may set the following parameters:
• Model: A magnetic susceptibility model. Because the model is already associated with a
mesh within GIFtools, the mesh does not need to be specified here.
• Data locations: Set the object which contains the observations locations and background
field information. If a MAGdata object is supplied (ver. 5.0, 5.1 and 6.0), total magnetic
anomaly data are predicted. If an AMPdata object is supplied (ver. 6.0 only), then magnetic
amplitude data are predicted.
• Topography (optional): The user may define the surface topography using a TOPOdata
object. If the surface topography is flat and set at an elevation of 0 m, the user may set to
null.
• Lower bound (ver. 5.1 and 6.0): In the case that all susceptibility values are positive, this
field is best left blank as the default value is 0. In the case that you are using an effective
susceptibility model, where effective susceptibility values are negative due to remanence,
this parameter must be set. All cells with effective susceptibility values below the threshold
value are ignored during the forward modeling; i.e. they are treated as air cells and are not
used when creating the sensitivity matrix.
• Apply: The values and objects specified in each field are not set until the user has clicked
Apply.
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Units
Inputs:
• Model: magnetic susceptibility in SI units
• Lower bound: effective susceptibility in SI units
Outputs:
• Predicted data: total magnetic intensity and amplitude data are predicted in nanoTeslas
(nT )
MVI
This functionality is responsible for setting all forward modeling parameters pertaining to the
MVI forward modeling codes. Within the edit options window, the user may set the following
parameters:
• Model: A magnetic vector intensity (MVI) model. Because the model is already associated with a mesh within GIFtools, the mesh does not need to be specified here.
• Data locations: Set the object which contains the observations locations and background
field information. The locations must be defined by a MAGdata object.
• Topography (optional): The user may define the surface topography using a TOPOdata
object. If the surface topography is flat and set at an elevation of 0 m, the user may set to
null.

4.7. Forward Modeling
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• Apply: The values and objects specified in each field are not set until the user has clicked
Apply.

Units
Inputs:
• 3D effective susceptibility model: this model is a 3d vector model containing effective
susceptibility values in SI units. The first column contains the effective susceptibility values along the direction of the inducing field. The remaining columns are effective susceptibilities along two orthogonal directions with respect to the inducing field direction.
Outputs:
• Predicted data: total magnetic intensity and amplitude data are predicted in nanoTeslas
(nT )
Edit Options for DCIP Forward Modeling Objects
DCIP2D
This functionality is responsible for setting all forward modeling parameters pertaining to the
“DC2Dforward” and “IP2Dforward” forward modeling codes; see DCIP2D online manual .
Within the edit options window, the user may set the following parameters:
• Locations: Observation locations or observed data object. This object contains the electrode locations.
• Topography: Sets topography as
– Default: Sets topography assuming all electrode are located on the Earth’s surface
– Value: Set the surface to the specified elevation value
– Object: A 2D topography data object
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• Conductivity Model: Set the conductivity model (required for “DC2Dforward” and
“IP2Dforward” objects)
• Chargeability Model: Set the chargeability model (not required for “DC2Dforward” objects)
• Wave: To solve the 2D problem, the problem must be solved in the wave domain. N
specifies the number of log-distribution waves numbers used between Min and Max. The
default is set to: N = 13, Min = 2.5e-4 and Max = 1.
• Other options (IP only): For IP forward modeling, the user may specify if the IP data
are computed using a non-linear method or by a linear approximation (in which case the
sensitivity is stored).
– Non-linear: In this case, the forward modeling operator is non-linear with respect to
the model. The input model is an intrinsic chargeability model (𝜂 ∈ [0, 1]). The output
data are the apparent intrinsic chargeabilities.
– Linear: In this case, we assume the chargeability is sufficiently small. The forward
modeling operator becomes approximately linear with respect to the model. The input
model can be any representation of intrinsic or integrated chargeability; i.e. 𝜂 ≪ 1,
mV/V, ms, mrad etc. The units used for the input model are the units used in the
predicted data. Once again, the predicted data represent an apparent chargeability.
Note: The conductivity and chargeability models are automatically linked to a mesh. That is
why a mesh object does not need to be specified within edit options.
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Units
Inputs:
• Conductivity model: S/m
• Chargeability model: If non-linear modeling is used, the input model must contain intrinsic chargeabilities (i.e. 𝜂𝑎 ∈ [0, 1]). If linear modeling is used, any type of intrinsic or
integrated chargeability can be used to define the model
Outputs:
• DC data: The DC data are the observed voltage normalized by the transmitter current (i.e.
∆𝑉 /𝐼)
• IP data: The IP data are the apparent chargeabilities. The units are the same as the input
chargeability model.
DCIP3D
This functionality allows to forward DC data from a tensor mesh, a DC survey and a conductivity model. Topography can also be added. Many options are shared with the DCIP2D Forward
described above.

• vector memory: Specifies how solution vectors are to be stored in the computer’s memory.
Use “store all” to store all vectors in memory.
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• Output Potential: If ticked, the potentials of every cell are written to the file potentials
x.txt where x is the current electrode pair number. This file can be viewed in meshTools3D.
DCIP Octree
The GUI for forward modeling with the DCIP octree codes is similar to the Tensor Mesh ones.

Edit Options for Frequency Domain EM
E3D version 1
This functionality is responsible for setting all forward modeling parameters pertaining to the
E3D version 1 code (e3d.exe); see manual . Within the edit options window below, the user
sets the following parameters for the forward modeling:
• Locations: The user selects an FEMdata object from the dropdown menu.
• Topography (optional): The user may define the surface topography using an
ACTIVEmodel object or set all cells as active. If using a conductivity model where
air cells are defined as 1e-8 S/m, merely set all topography cells to active. If
an ACTIVEmodel is used to define the underground cells, all cells in the air are
automatically assigned a value of 1e-8 S/m.
• Conductivity model: This is the required conductivity model for forward modeling the data.
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• Background susceptibility model: Here, the user can specify a background
magnetic susceptibility model for the forward modeling. There are 3 options:
– No Sus: The Earth is considered non-susceptible
– Value: A constant magnetic susceptibility value is assigned to all cells lying
below the surface topography (not currently implemented)
– Model: The user supplies an OcTree model
• Model total field or secondary field:
– Total field: the data output by the forward modeling is the total field.
– Secondary (analytic): the code will forward model the secondary field. It will
do this by computing the total field for the conductivity model provided, then
subtracting the analytic total field using the homogeneous background conductivity provided. To subtract the free-space primary field, let the background
conductivity be 1e-8 S/m.
– Secondary (numeric): the code will forward model the secondary field. It
will do this by computing the total field for the conductivity model provided,
then subtracting the numerically computed total field using the homogeneous
background conductivity provided. To subtract the free-space primary field, let
the background conductivity be 1e-8 S/m.
• Solver Options: The forward problem can be solver using the direct Pardiso
solver or the BiCG iterative solver. The parameters for the accuracy of the iterative solver are described in the E3D v1 manual .
Units
Inputs:
• Conductivity model: Octree model with conductivity in S/m
• Susceptibility model: OcTree model with magnetic susceptibility in SI units
Outputs:
• Either total field or secondary field data in A/m
E3D version 2 (and version 2 tiled)
This functionality is responsible for setting all forward modeling parameters pertaining to the
E3D version 2 code (done with e3d_v2.exe) and the E3D version 2 tiled code (done with
e3d_v2_tiled.exe); see E3D v2 manual or see E3D v2 tiled manual . Within the edit options
window below, the user sets the following parameters for the forward modeling:
• Locations: The user selects an FEM3Dsounding object from the dropdown
menu.
• Topography (optional): The user may define the surface topography using an
ACTIVEmodel object or set all cells as active. If using a conductivity model where
air cells are defined as 1e-8 S/m, merely set all topography cells to active. If
an ACTIVEmodel is used to define the underground cells, all cells in the air are
automatically assigned a value of 1e-8 S/m.
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• Conductivity model: This is the required conductivity model for forward modeling the data.
• Background susceptibility model: Here, the user can specify a background
magnetic susceptibility model for the forward modeling. There are 3 options:
– No Sus: The Earth is considered non-susceptible
– Value: A constant magnetic susceptibility value is assigned to all cells lying
below the surface topography (not currently implemented)
– Model: The user supplies an OcTree model
• Model total field or secondary field:
– Total field: the data output by the forward modeling is the total field.
– Secondary (analytic): the code will forward model the secondary field. It will
do this by computing the total field for the conductivity model provided, then
subtracting the analytic total field using the homogeneous background conductivity provided. To subtract the free-space primary field, let the background
conductivity be 1e-8 S/m.
– Secondary (numeric): the code will forward model the secondary field. It
will do this by computing the total field for the conductivity model provided,
then subtracting the numerically computed total field using the homogeneous
background conductivity provided. To subtract the free-space primary field, let
the background conductivity be 1e-8 S/m.
• Solver Options: The forward problem can be solver using the direct Pardiso
solver or the BiCG iterative solver. The parameters for the accuracy of the iterative solver are described in the E3D v1 manual .
• Mesh tiles file: If you are using the tiled code, this space is used to set the filepath
to the local meshes (or tiles)
Units
Inputs:
• Conductivity model: Octree model with conductivity in S/m
• Susceptibility model: OcTree model with magnetic susceptibility in SI units
Outputs:
• Either total field or secondary field data in A/m
Edit Options for Natural Source EM (MT and ZTEM)
E3DMT version 1
This functionality is responsible for setting all forward modeling parameters pertaining to the
E3DMT version 1 code (e3dMTfwd.exe); see manual . Within the edit options window below,
the user sets the following parameters for the forward modeling:
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• Locations: The user selects one or more data objects from the list provided, allowing for simultaneous forward modeling of MT and ZTEM data. It is important
to note that the ordering of the data locations is identical to the ordering of the
object selected. To change the ordering of data locations written to file, use the
Shift up and Shift down buttons.
Note: If multiple data objects are used to forward modeling data, then upon
loaded the output of E3DMT version 1, those data are parsed into several
data objects.
• Topography (optional): The user may define the surface topography using an
ACTIVEmodel object or set all cells as active. If using a conductivity model where
air cells are defined as 1e-8 S/m, merely set all topography cells to active. If
an ACTIVEmodel is used to define the underground cells, all cells in the air are
automatically assigned a value of 1e-8 S/m.
• Real conductivity model: This is the required conductivity model for forward
modeling natural source EM data.
• Imaginary conductivity model (optional): The user may select another conductivity model to represent the imaginary component of the conductivity at a
particular frequency; e.g. this functionality should only be used to predict the
response at a single frequency.
• 1D background conductivity model: The E3DMT version 1 code solves a 1D
problem on a background conductivity model and uses the solution to obtain the
source term needed for the 3D problem. This is explained in more detail in the
E3DMT version 1 manual . Here, the user has two options:
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– Value: A constant conductivity value is used for the background conductivity
– Model: A 1D conductivity model is used as the background conductivity. The
number of conductivity values defining this model must equal the number of
underlying mesh cells defining the OcTree mesh in the z-direction; see manual
.
Note: If there is significant topography, computation of the boundary
conditions and thus the final 3D solution may not be as accurate. In this
case, it is suggested the user model data with E3DMT version 2.
• Susceptibility model: Here, the user can specify a background magnetic susceptibility model for the forward modeling. There are 3 options:
– No Sus: The Earth is considered non-susceptible
– Value: A constant magnetic susceptibility value is assigned to all cells lying
below the surface topography
– Model: The user supplies an OcTree model
• Apply: The values and objects specified are saved to the forward modeling object.
Units
Inputs:
• Real conductivity model: OcTree model with conductivity in S/m
• Imaginary conductivity model: Octree model with conductivity in S/m
• 1D background conductivity: A 1D model with conductivity in S/m
• Susceptibility model: OcTree model with magnetic susceptibility in SI units
Outputs:
• MT data: Real and imaginary components of impedance tensor entries (V/A)
• ZTEM data: Real and imaginary components of transfer function entries (unitless)
E3DMT version 2
This functionality is responsible for setting all forward modeling parameters pertaining to the
E3DMT version 2 code (done with e3dMTinv_ver2.exe); see manual . Within the edit options
window below, the user sets the following parameters for the forward modeling:
• Locations: The user selects a data object from the drop-down list. If an IMPdata
object is selected, the code will forward model MT data. If a ZTEMdata object
is selected, the code will forward model ZTEM data. It will not forward model
both simultaneously.
• Topography (optional): The user may define the surface topography using an
ACTIVEmodel object or set all cells as active. If using a conductivity model where
air cells are defined as 1e-8 S/m, merely set all topography cells to active. If

4.7. Forward Modeling

157

GIFtoolsCookbook Documentation, Release 1.0

an ACTIVEmodel is used to define the underground cells, all cells in the air are
automatically assigned a value of 1e-8 S/m.
• Conductivity model: This is the required conductivity model for forward modeling natural source EM data.
• Background conductivity model: The E3DMT version 2 code must first compute the source term needed for the 3D problem and can do so in a variety of ways.
This is explained in more detail in the E3DMT version 2 manual . Here, the user
specifies if the source term is computed using a 1D or 3D approach, then supplies
the appropriate model. In total, there are 4 options for defining the background
conductivity model:
– 1D + Value: A 1D background conductivity model is used. This model has a
constant conductivity value below the highest surface topography.
– 1D + Model: A 1D background conductivity model is used. The number of
conductivity values defining this model must equal the number of underlying
mesh cells defining the OcTree mesh in the z-direction; see manual .
– 3D + Value: A 3D background conductivity model is used. This model has a
constant conductivity value for all cells below the surface topography.
– 3D + Model: A 3D background conductivity model is used. The background
conductivity model must be defined on the OcTree mesh used to forward model
the data.
Note: If surface topography is negligible, the the 1D background model is accurate
and computationally efficient. If topography is significant, it is advised that a 3D
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background model is used.
• Apply: The values and objects specified are saved to the forward modeling object.
Units
Inputs:
• Conductivity model: OcTree model with conductivity in S/m
• 1D background conductivity: A 1D model with conductivity in S/m
• 3D background conductivity: OcTree model with conductivity in S/m
Outputs:
• MT data: Real and imaginary components of impedance tensor entries (V/A)
• ZTEM data: Real and imaginary components of transfer function entries (unitless)

4.7.3 Copy a forward modeling item
Once the forward model has run and the results loaded, GIFtools does not allow the straight copying of
the forward modeling items (it has been “archived”). It does, however, allow you to copy the options that
were chosen for the forward model to a new one. Click on the forward modeling item, select the menu
showing its class (e.g., E3Dforward or GRAVforward):
[Forward model class] → Copy options

4.7.4 Write input files to directory
Prior to running the forward model, the user must write the appropriate input files to the working directory.
To write all files, regardless, click on the forward modeling item, select the menu showing its class (e.g.,
E3Dforward):
[Forward modeling class] → Write files
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4.7.5 DCIP: Surface or General data format
For DCIP data object, GIFtools allow to export two types of data format for the forward modeling: Surface Data Format (recommended): Use this data format if the electrodes are at the surface. The Zvalues will be excluded from the output data file and the forward modeling code will take care of projecting
them at the surface. This avoid the risk of having electrodes in the air or underground. - General Data
Format: Use this option if any electrode is underground. The Z-values are specified in the output data
file.
[Forward modeling class] → Write files

4.7.6 Run a Forward Model
Prior to running the forward model, the user must write the necessary input files to the working directory.
For the forward model, that includes the input file, mesh, physical property model and possibly topography.
Click on the forward modeling item, select the menu showing its class (e.g., E3Dforward):
[Forward modeling class] → Run [forward model name]

4.7.7 Load Predicted Data
Once the forward model has run, the user may load the predicted data. Click on the forward modeling
item, select the menu showing its class (e.g., E3Dfoward or GRAVforward):
• Load all results: [Forward modeling class] → Load predicted data
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4.8 Inversion
4.8.1 Set the inversion’s working directory
The working directory tells GIFtools where to output files (and run the inversion) associated with the
selected item. It is suggested to set the directory prior to setting any other properties . Click on the
inversion item, select the menu showing its class (e.g., E3Dinversion or GRAVinversion):
[Inversion class] → Set working directory

NOTE: The shortcut for the functionality is control + d.

4.8.2 Edit Options for Inversion Objects
The edit options functionality is responsible for setting all parameters and objects used in the inversion.
This includes setting the mesh, data, topography, bounds, regularization being used and methods used to
compute the trade-off parameter. To set the inversion parameters through edit options, click the inversion
object and select:
[Inversion class] → Edit options

The options for each inversion type are organized as follows:
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Edit Options for Gravity Inversion Objects
Grav3D Inversion
This functionality is responsible for setting all inversion parameters pertaining to the 3D gravity
inversion codes; see GRAV3D background theory. The edit options window is comprised of 3
tabs:
• Sensitivity: Sets the mesh, observed data, topography, sensitivity weighting and wavelet
compression
• Inversion: Sets protocols for the trade-off parameter (𝛽) and all parameters pertaining to
the model objective function (alphas, cells weights, upper and lower bounds, active cells,
reference models and starting models)
• Blocky model norms (ver 5.1 and above): can be activated to recover sparse and blocky
models; see sparse and blocky norms

Fig. 3: Sensitivity (left), inversion (middle) and blocky model norms (right) tabs for GRAV inversion objects.

Units
Inputs:
• Observed data: gravity anomaly data given in units of milliGal (mGal)
• Reference/background density model: 𝑔/𝑐𝑚3
Outputs:
• Recovered anomalous density model: 𝑔/𝑐𝑚3
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Sensitivity Tab
• Mesh: mesh for the recovered model
• Observed data: observed data including uncertainties
• Topography: a topography data object. Leave as null for flat topography at an elevation
of 0 m.
• Weighting: set the type and parameters for sensitivity weighting. The parameters which
define the sensitivity weighting are described in the Grav3D manual .
– Type: Depth or distance. The choice determines the expression used for the weighting
– Exponent: Given by 𝛼 in the manual. This parameter has default = 2 to reflect the
fact the fields fall of as 1/𝑟2
– Z0 or R0: These constants are defined by equations in the manual. R0 and Z0 are
small and generally chosen to be 1/4 the length of the smallest cell dimension
• Wavelet parameter: wavelet compression of the sensitivity matrix is used reduced the
memory requirements for storing the sensitivity matrix and improve the speed of the inversion algorithm. The details of this are described in the Grav3D manual
– Type: sets the type of wavelet transform applied to the rows of the sensitivity matrix
– Mode:
∗ Relative error: the level of wavelet compression is specified by a relative threshold
(default = 0.05)
∗ Threshold: the level of wavelet compression is specified an absolute threshold
– Threshold: user specified value based on choice in mode
Inversion Tab
• Inversion Mode: Sets the protocol for the trade-off parameter (𝛽 )
– Discrepancy: sets the stopping criteria for the inversion using the discrepancy principle. Chi-factor determines the stopping criteria and tolerance sets how close to the
ideal stopping criteria before the inversion is terminated.
– User Input: the user specifies the exact value for the trade-off parameter (beta )
• Weighting: Sets the weights for smallness and smoothness regularization in x, y and z;
for relevant equations see manual .
– Default: Sets the values of alpha S, alpha X, alpha Y and alpha Z based on cell
dimensions
– Alphas: Sets specific values for alpha S, alpha X, alpha Y and alpha Z
– Lengths: User sets values Len E, Len N and Len Z which define the values of alpha
√︁ X,
alpha Y and alpha Z relative to alpha S. These relationships are given by 𝐿𝑥 = 𝛼𝛼𝑥𝑠 ,
√︁
√︁
𝛼
𝑧
𝐿𝑦 = 𝛼𝑦𝑠 and 𝐿𝑧 = 𝛼
𝛼𝑠 .
• Weighting object: Specify additional cell weights. Use null if no additional model
weights are supplied.
• Reference model options:
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– Value: use a constant value to define the reference model
– Object: use a GIFmodel as the reference model
• Role in objective function: the user selects SMOOTH_MOD or SMOOTH_MOD_DIF. If
SMOOTH_MOD is selected, the reference model is included only in the smallness term in
the model objective function. If SMOOTH_MOD_DIF is selected, the reference model is
included in the smallness and smoothness terms in the model objective function. Further
explanation of this is found in fundamentals of inversion.
• Initial model:
– Value: use a constant value to define a homogeneous starting model
– Object: use a GIF model as the starting model
• Lower bounds:
– Value: set a constant value for the lower bounds for all cells
– Object: use a GIF model to supply cell-specific lower bounds
• Upper bounds:
– Value: set a constant value for the upper bounds for all cells
– Object: use a GIF model to supply cell-specific upper bounds
• Active cells: Specifies which cells lying below the surface topography are active during
the inversion. All other cells remain fixed-valued (equal to starting model). Use null to set
all cells lying below surface topography as active.
• Sensitivity matrix:
– Default: If this option is chosen, the code will generate the sensitivity matrix and save
it to the working directory.
– Already exists: If the sensitivity matrix for your problem has already been created,
this option allows the user to point to the sensitivity file and avoid recomputation
Blocky Model Norms Tab (ver. 5.1 and 6.0)
Sparse and blocky model norms are explained in fundamentals of inversion. Below are parameter descriptions for fields within edit options.
• Lp exponent:
– Value: set as a constant value 𝑝 ∈ (0, 2]
– Object: use a GIF model to supply cell-specific values for 𝑝
– Null: a default value of 𝑝 = 2 or 𝑞 = 2 is used
• Lq exponent (Easting, Northing or Vertical):
– Value: set as a constant value 𝑝 ∈ (0, 2] or 𝑞 ∈ (0, 2]
– Object: use a GIF model to supply cell-specific values for 𝑝 or 𝑞
– Null: a default value of 𝑝 = 2 or 𝑞 = 2 is used
• Lp/Lq scaling: the nature of these parameters are discussed in fundamentals of inversion
– Lp vs Lq scale: the user alter the weighting between smallness and smoothness while
performing the sparse inversion. Default = 1.
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– Lp epsilon: see fundamentals of inversion
– Lq epsilon: see fundamentals of inversion
Edit Options for Magnetic Inversion Objects
Mag and Mag Amplitude Inversion (Mag3D)
This functionality is responsible for setting all inversion parameters pertaining to the 3D magnetic inversion codes (Mag inversion and Mag amplitude inversion); see MAG3D background
theory. The edit options window is comprised of 3 tabs:
• Sensitivity: Sets the mesh, observed data, topography, sensitivity weighting and wavelet
compression
• Inversion: Sets protocols for the trade-off parameter (𝛽) and all parameters pertaining to
the model objective function (alphas, cells weights, upper and lower bounds, active cells,
reference models and starting models)
• Blocky model norms (ver 5.1 and above): can be activated to recover sparse and blocky
models; see sparse and blocky norms

Fig. 4: Sensitivity (left), inversion (middle) and blocky model norms (right) tabs for MAG inversion and MAG amplitude inversion objects.
Note: In order to update the set of inversion parameters, you must click apply.

Units
Inputs:
• Observed data: total magnetic intensity and amplitude data are given in nanoTeslas (nT )
• Reference/background susceptibility model: SI units
Outputs:
• Recovered susceptibility model: SI units
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Sensitivity Tab
• Mesh: mesh for the recovered model
• Observed data:
– Magnetic data: total magnetic intensity data. Versions 5.0, 5.1 and 6.0
– Amplitude data: magnetic amplitude data. Version 6.0 only
• Topography: a topography data object. Leave as null for flat topography at an elevation
of 0 m.
• Weighting: set the type and parameters for sensitivity weighting. The parameters which
define the sensitivity weighting are described in the Mag3D manual .
– Type: Depth or distance. The choice determines the expression used for the weighting
– Exponent: Given by 𝛼 in the manual. This parameter has default = 3 to reflect the
fact dipolar fields fall of as 1/𝑟3
– Z0 or R0: These constants are defined by equations in the manual. R0 and Z0 are
small and generally chosen to be 1/4 the length of the smallest cell dimension
• Wavelet parameter: wavelet compression of the sensitivity matrix is used reduced the
memory requirements for storing the sensitivity matrix and improve the speed of the inversion algorithm. The details of this are described in the Mag3D manual
– Type: sets the type of wavelet transform applied to the rows of the sensitivity matrix
– Mode:
∗ Relative error: the level of wavelet compression is specified by a relative threshold
(default = 0.05)
∗ Threshold: the level of wavelet compression is specified an absolute threshold
– Threshold: user specified value based on choice in mode
Inversion Tab
• Inversion Mode: Sets the protocol for the trade-off parameter (𝛽 )
– Discrepancy: sets the stopping criteria for the inversion using the discrepancy principle. Chi-factor determines the stopping criteria and tolerance sets how close to the
ideal stopping criteria before the inversion is terminated.
– User Input: the user specifies the exact value for the trade-off parameter (beta )
• Weighting: Sets the weights for smallness and smoothness regularization in x, y and z;
for relevant equations see manual .
– Default: Sets the values of alpha S, alpha X, alpha Y and alpha Z based on cell
dimensions
– Alphas: Sets specific values for alpha S, alpha X, alpha Y and alpha Z
– Lengths: User sets values Len E, Len N and Len Z which define the values of alpha
√︁ X,
alpha Y and alpha Z relative to alpha S. These relationships are given by 𝐿𝑥 = 𝛼𝛼𝑥𝑠 ,
√︁
√︁
𝛼
𝑧
𝐿𝑦 = 𝛼𝑦𝑠 and 𝐿𝑧 = 𝛼
𝛼𝑠 .

166

Chapter 4. Object Functionality

GIFtoolsCookbook Documentation, Release 1.0

• Weighting object: Specify additional cell weights. Use null if no additional model
weights are supplied.
• Reference model options:
– Value: use a constant value to define the reference model
– Object: use a GIFmodel as the reference model
• Role in objective function: the user selects SMOOTH_MOD or SMOOTH_MOD_DIF. If
SMOOTH_MOD is selected, the reference model is included only in the smallness term in
the model objective function. If SMOOTH_MOD_DIF is selected, the reference model is
included in the smallness and smoothness terms in the model objective function. Further
explanation of this is found in fundamentals of inversion.
• Initial model:
– Value: use a constant value to define a homogeneous starting model
– Object: use a GIF model as the starting model
• Lower bounds:
– Value: set a constant value for the lower bounds for all cells
– Object: use a GIF model to supply cell-specific lower bounds
• Upper bounds:
– Value: set a constant value for the upper bounds for all cells
– Object: use a GIF model to supply cell-specific upper bounds
• Active cells: Specifies which cells lying below the surface topography are active during
the inversion. All other cells remain fixed-valued (equal to starting model). Use null to set
all cells lying below surface topography as active.
• Sensitivity matrix:
– Default: If this option is chosen, the code will generate the sensitivity matrix and save
it to the working directory.
– Already exists: If the sensitivity matrix for your problem has already been created,
this option allows the user to point to the sensitivity file and avoid recomputation
Blocky Model Norms Tab (ver. 5.1 and 6.0)
Sparse and blocky model norms are explained in fundamentals of inversion. Below are parameter descriptions for fields within edit options.
• Lp exponent:
– Value: set as a constant value 𝑝 ∈ (0, 2]
– Object: use a GIF model to supply cell-specific values for 𝑝
– Null: a default value of 𝑝 = 2 or 𝑞 = 2 is used
• Lq exponent (Easting, Northing or Vertical):
– Value: set as a constant value 𝑝 ∈ (0, 2] or 𝑞 ∈ (0, 2]
– Object: use a GIF model to supply cell-specific values for 𝑝 or 𝑞
– Null: a default value of 𝑝 = 2 or 𝑞 = 2 is used
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• Lp/Lq scaling: the nature of these parameters are discussed in fundamentals of inversion
– Lp vs Lq scale: the user alter the weighting between smallness and smoothness while
performing the sparse inversion. Default = 1.
– Lp epsilon: see fundamentals of inversion
– Lq epsilon: see fundamentals of inversion
MVI Inversion
This functionality is responsible for setting all inversion parameters pertaining to the 3D magnetic vector intensity inversion code. The edit options window is comprised of 4 tabs:
• Sensitivity: Sets the mesh, observed data, topography, sensitivity weighting and wavelet
compression
• Inversion → General: Sets parameters for the magnetic susceptibility model being recovered
• Inversion → Vector Options: Sets parameters for the magnetic remanence being recovered
• Sparsity: Set the sparsity parameters for the induced and remanent components.

Fig. 5: (left) Sensitivity , (middle left) general inversion , (middle right) vector options and (right) sparsity parameter
tabs for MVI inversion objects.
Note: In order to update the set of inversion parameters, you must click apply

Units
Inputs:
• Observed data: total magnetic intensity data are given in nanoTeslas (nT )
• Reference/background susceptibility models for P, S or T: GIF model with effective
susceptibility values in SI. Unlike the recovered model, only a single column values is
provided.
• Norm model: (Mode 2 ATP only): Model norm file for the cell-based sparsity parameter
(unitless).

168

Chapter 4. Object Functionality

GIFtoolsCookbook Documentation, Release 1.0

Outputs:
• Effective susceptibility model: this model is a 3d vector model containing effective susceptibility values in SI units. The first column contains the effective susceptibility values
along the direction of the inducing field. The remaining columns are effective susceptibilities along two orthogonal directions with respect to the inducing field direction.
• Angle model: (Mode 2 ATP only) Two models for the vertical (theta) and horizontal (phi)
angles in radian.
Sensitivity Tab
• Mesh: mesh for the recovered model
• Observed data: total magnetic intensity data.
• Topography: a topography data object. Leave as null for flat topography at an elevation
of 0 m.
• Wavelet parameter: wavelet compression of the sensitivity matrix is used reduced the
memory requirements for storing the sensitivity matrix and improve the speed of the inversion algorithm. The details of this are described in the Mag3D manual
– Type: sets the type of wavelet transform applied to the rows of the sensitivity matrix
– Mode:
∗ Relative error: the level of wavelet compression is specified by a relative threshold (default = 0.05)
∗ Threshold: the level of wavelet compression is specified an absolute threshold
– Threshold: (Default null) Search method (recommended), or user specified value
based on choice in mode
Inversion (General) Tabs
• Vector Mode: Sets the coordinate system used in the inversion
– PST+ATP: First run the smooth inversion in Cartesian coordinate system [PST],
followed by an inversion in Spherical system [ATP]. Sparsity only available for this
mode.
– PST: Only run the smooth inversion in Cartesian coordinates system.
• Inversion Mode: Sets the protocol for the trade-off parameter (𝛽 )
– Discrepancy: sets the stopping criteria for the inversion using the discrepancy principle. Chi-factor determines the stopping criteria and tolerance sets how close to the
ideal stopping criteria before the inversion is terminated.
– User Input: the user specifies the exact value for the trade-off parameter (beta)
• Weighting: Sets the weights for smallness and smoothness regularization in x, y and z;
for relevant equations see manual .
– Default: Sets the values of alpha S, alpha X, alpha Y and alpha Z based on cell
dimensions
– Alphas: Sets specific values for alpha S, alpha X, alpha Y and alpha Z
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– Lengths: User sets values Len E, Len N and Len Z which define the values of alpha
√︁ X,
alpha Y and alpha Z relative to alpha S. These relationships are given by 𝐿𝑥 = 𝛼𝛼𝑥𝑠 ,
√︁
√︁
𝛼
𝑧
𝐿𝑦 = 𝛼𝑦𝑠 and 𝐿𝑧 = 𝛼
𝛼𝑠 .
• Weighting object: Specify additional cell weights. Use null if no additional model
weights are supplied.
• Reference model options:
– Value: use a constant value to define the reference model
– Object: use a GIFmodel as the reference model
• Role in objective function: the user selects SMOOTH_MOD or SMOOTH_MOD_DIF. If
SMOOTH_MOD is selected, the reference model is included only in the smallness term in
the model objective function. If SMOOTH_MOD_DIF is selected, the reference model is
included in the smallness and smoothness terms in the model objective function. Further
explanation of this is found in fundamentals of inversion.
• Initial model:
– Value: use a constant value to define a homogeneous starting model for the principle
effective susceptibility
– Object: use a GIF model as the starting model
• Lower bounds:
– Value: set a constant value for the lower bounds for all cells
– Object: use a GIF model to supply cell-specific lower bounds
• Upper bounds:
– Value: set a constant value for the upper bounds for all cells
– Object: use a GIF model to supply cell-specific upper bounds
• Active cells: Specifies which cells lying below the surface topography are active during
the inversion. All other cells remain fixed-valued (equal to starting model). Use null to set
all cells lying below surface topography as active.
• Sensitivity matrix:
– Default: If this option is chosen, the code will generate the sensitivity matrix and save
it to the working directory.
– Already exists: If the sensitivity matrix for your problem has already been created,
this option allows the user to point to the sensitivity file and avoid recomputation
Inversion (Vector Options) Tab
• Remanent magnetization weight (Gamma): dictates the emphasis at which the inversion
explains the data with effective susceptibilities parallel to the inducing field vs orthogonal.
Increasing Gamma results in more emphasis being places on magnetization along the
inducing field direction (primary component). Defaul = 1.
• Initial model (S or T):
– Value: use a constant value to define a homogeneous starting model
– Object: use a GIF model as the starting model
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• Reference model (S or T):
– Value: use a constant value to define the reference model
– Object: use a GIFmodel as the reference model
• Lower bounds (S or T):
– Value: set a constant value for the lower bounds for all cells
– Object: use a GIF model to supply cell-specific lower bounds
• Upper bounds (S or T):
– Value: set a constant value for the upper bounds for all cells
– Object: use a GIF model to supply cell-specific upper bounds
• Weights (S or T): Specify additional cell weights. Use null if no additional model weights
are supplied.
Sparsity
• Lps-norm (Model): Norm applied to the vector amplitude either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpx-norm (Model): Norm applied to the gradient of vector amplitude along the
x-axis (Easting) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpy-norm (Model): Norm applied to the gradient of vector amplitude along the
y-axis (Northing) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpz-norm (Model): Norm applied to the gradient of vector amplitude along the
z-axis (Vertical) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpx-norm (Theta): Norm applied to the gradient of Theta angle along the x-axis
(Easting) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
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• Lpy-norm (Theta): Norm applied to the gradient of Theta angle along the y-axis
(Northing) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpz-norm (Theta): Norm applied to the gradient of Theta angle along the z-axis
(Vertical) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpx-norm (Phi): Norm applied to the gradient of Phi angle along the x-axis
(Easting) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpy-norm (Phi): Norm applied to the gradient of Phi angle along the y-axis
(Northing) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lpz-norm (Phi): Norm applied to the gradient of Phi angle along the z-axis
(Vertical) either
– Value: set a constant value for the approximated norm
– Object: use a GIF model to supply cell-specific approximated norm
– Null (Default 2)
• Lp/Lp scaling: Master scaling between the model norm and gradient norm
– Default: Scale=1, \(epsilon \) found by cooling schedule
– User Defined:
∗ Lp vs Lq scale: Number >0, where 1 = equal penalty
∗ Lp epsilon: Threshold value for model value (effective zero)
∗ Lq epsilon: Threshold value for gradient values (effective zero)
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Edit Options for DCIP Inversion Objects
DCIP2D
This functionality is responsible for setting all inversion parameters pertaining to the
“DC2Dinversion” and “IP2Dinversion” codes; see DCIP2D online manual . The edit options
window is comprised of 2 tabs:
• Basic: Sets minimum required input for the inversion
• Advanced: Sets advanced parameters for the inversion, including: the solver, regularization, weights and hard constraints

Fig. 6: Basic (left), advanced parameters 1 (middle) and advanced parameters 2 (right) tabs.

Units
Inputs:
• Observed DC data: observed voltage, normalized by the transmitter current (i.e. ∆𝑉 /𝐼
)
• Observed IP data: apparent intrinsic chargeabilities (i.e. 𝜂𝑎 ∈ [0, 1])
• Reference/background conductivity model: S/m
• Reference chargeability model: intrinsic chargeabilities (i.e. 𝜂𝑎 ∈ [0, 1])
Outputs:
• Recovered conductivity model: S/m
• Recovered chargeability model: intrinsic chargeabilities (i.e. 𝜂 ∈ [0, 1])
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Basic
• Mesh: mesh for the recovered model
– Default (DC only): The cell size, core region and padding are set automatically
based on the electrode spacings and locations. This option will output a mesh object.
– Semi-default (DC only): The user specifies the minimum number of cells between
electrodes (default = 4) and the aspect ratio (default = 2). The aspect ratio is the
vertical dimensions of the cells divided by the horizontal width. This options will
output a mesh object.
– Object: a mesh object is provided. Reference models, starting models and bound
models must all exist on this mesh. For IP inversion, the mesh from the DC inversion
must be used.
• Observed data:
– For DC inversion, the data are the observed voltage, normalized by the transmitter
current (i.e. ∆𝑉 /𝐼 ).
– For IP inversion, the data are the apparent intrinsic chargeabilities where 𝜂𝑎 ∈ [0, 1].
– Data format:
∗ Surface Data Format (recommended): Use this data format if the electrodes
are at the surface. The Z-values will be excluded from the output data file and
the forward modeling code will take care of projecting them at the surface.
This avoid the risk of having electrodes in the air or underground.
∗ General Data Format: Use this option if any electrode is underground. The
Z-values are specified in the output data file.
• Topography:
– Default: Sets topography assuming all electrode are located on the Earth’s surface
– Value: Set the surface to the specified elevation value
– Object: A 2D topography data object
• Conductivity Model (IP inversion only): Constant value or conductivity model object.
Reference and starting models are set in the advanced parameters tab.
Advanced (Parameter 1)
Trade-off parameter: The inversion choses the optimum trade-off parameter based on the chi
factor.
• Chi factor: sets the target data misfit for the inversion (default = 1). 𝑡𝑎𝑟𝑔𝑒𝑡 = 𝐶.𝐹. ×
# 𝑑𝑎𝑡𝑎.
• Max number of iterations: maximum number of iterations to find optimum trade-off
parameter (default = 50).
Inverse solver: Sets the solver used to determine the model update direction.
• SVD: Singular value decomposition
• CG: Conjugate gradient solver. The user may specify the number of conjugate gradient
iterations (default = 10) and the accuracy of the solve (default = 0.01).
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Length scales: Sets the weights for smallness and smoothness regularization in x and z; for
relevant equations see manual .
• Default: Sets the values of alpha S, alpha X and alpha Z based on cell dimensions
• Alphas: Sets specific values for alpha S, alpha X and alpha Z
• Lengths: User sets values Len E and Len Z which define the values
of alpha X√︁and alpha
√︁
𝛼𝑥
𝑧
Z relative to alpha S. These relationships are given by 𝐿𝑥 = 𝛼𝑠 and 𝐿𝑧 = 𝛼
𝛼𝑠 .
Bounds: Here, the user specified the lower and upper bounds for the inverted physical property
values. For both lower and upper bounds, the user may choose from the following options:
• None: No bounds
• Value: A constant value applied to all cells
• Object: A model object containing a distinct bound value for every cell
Output files: Here, the user controls the number of output files. They may choose to output
every iteration of the inversion or just the final result
Wave: To solve the 2D forward problem, the problem must be solved in the wave domain.
N specifies the number of log-distribution waves numbers used between Min and Max. The
default is set to: N = 13, Min = 2.5e-4 and Max = 1.
Huber norm: Here, the user specifies the norm for the data misfit. For description of the data
misfit see the DCIP2D manual .
• Default data misfit: the data misfit is defined by an 𝐿2 -norm
• Huber norm: the data misfit is defined by the Huber norm and the user may specify the
Huber constant (𝑐).
Advanced (Parameter 2)
Model objective function norm: Here, the user specifies the norm for the smallness and
smoothness in X and Z. Background information regarding the model objective function norm
and relevant parameters can be found within the DCIP2D manual
• Default norm: an 𝐿2-norm is used for the smallness and smoothness terms
• Ekblom norm (CG solver only): The Ekblom norm can be used to recover more compact
and blockier models. For each term in the model objective function, the user specifies the
parameters 𝜖 and 𝜌.
Reference model: Here, the user specifies the reference model used in the inversion. There are
3 choices:
• Default: no reference model is used
• Value: a constant reference model is used
• Object: the user specifies a model object as the reference model
Role in the model objective function: Here, the user chooses from the following 2 options in
the case a reference model is used:
• SMALLEST MODEL ONLY: The reference model is only used in the smallness term.
The inversion attempts to preserve the structures found in the reference model.
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• ALL DERIVATIVES: The reference model is used in the smallness and smoothness
terms. The inversion attempts to preserve the structures and gradients found the in the
reference model.
Initial model: The user specifies the starting model. There are 3 choices:
• Default: the best-fitting half spaced is used as a starting model
• Value: a constant reference model is used
• Object: the user specifies a model object as the reference model
Weighting functions: Here, the user may choose not to include additional model weights
(none) or include face/model weights using a weights object or sensitivity-based
weighting. (see section Import sensitivity as weights).
• no weighting: no weight is applied
• Sensitivity weighting: If this latest option is chosen, the program will be called
a first time to compute the sensitivity matrix. GIFtools will then automatically
load the sensitivity, compute the weight and launch the full inversion (see
fundamentals section).
– On cells center: the sensitivity weights are applied to the smallness term
– On faces: the sensitivity weights are applied on the gradient terms.
– threshold: apply a threshold to the sensitivity weights
• Choose weighting GIFmodel: select a GIFmodel to use as weights
DCinversion → Discrete Topo/Weights → Create Sensitivity Weights
ws = J𝑎𝑝𝑝𝑟𝑜𝑥 /𝑚𝑎𝑥(J𝑎𝑝𝑝𝑟𝑜𝑥 ) + 𝛿
wx = A𝑓𝑐 𝑥 ws
wy = A𝑓𝑐 𝑦 ws
wz = A𝑓𝑐 𝑧 ws
where ws , ws , ws and ws are the cell-center and cell-face weights, J𝑎𝑝𝑝𝑟𝑜𝑥 are the values from the sensitivity.txt file, values from 𝛿 is a user-defined threhold parameter
𝑓
([DEFAULT=1e-2]) and A𝑓𝑐 𝑥 , A𝑐 𝑦 , A𝑓𝑐 𝑧 are averaging operators taking the cell-center values
to the respective faces.
Active cells: If all cells are updated during the inversion, set as null. If an active cells model is
supplied, only the cells which are set as active will be updated during the inversion. The values
of the remaining cells are determined by the starting model.
DCIP3D v5.5
Functionality specific to the DCIPinversion object
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Fig. 7: Inversion parameters tab (left), Models and constraints tab (right).
Inversion Parameters Tab
Mesh: The 3D tensor mesh file used in the DC or IP inversion
Observed Data: a DC3Ddata or IP3Ddata object
Data format: the surface and general buttons are used to set whether the output observed data
file is formatted as surface data or in general format (usually borehole).
Topography:
• TOPOdata: An xyz TOPOdata object. If you leave as null, the topography will correspond to the top of your mesh.
• ACTIVEmodel: An ACTIVEmodel object that defines which cells are above and below
the surface topography.
• IDX file: File path to an idx file. This is a special file which can be used to define topography for the DCIP3D coding package.
Conductivity model (IP inversion only): Define a constant value for all Earth cells or provide
a GIFmodel.
Wavelet parameters: Define parameters for the wavelet compression for the sensitivity matrix.
For more on these parameters, see the DCIP3D v5.5 manual .
Vector memory: Specifies how solution vectors are to be stored in the computer’s memory.
For more on these parameters, see the DCIP3D v5.5 manual .
Forward problem - Solver tolerance: Sets the relative tolerance for the accuracy of the solution of the forward problem.
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Models and Constraints Tab
Inversion Mode: Either use the discrepancy principle to choose the optimum trade-off parameter or fix the trade-off parameter for the optimization. For more on these parameters, see the
DCIP3D v5.5 manual .
Sensitivity Matrix: The Default option is selected if the user must form the sensitivity matrix
for the problem. If you have done an inversion with the same data and mesh, you can use the
already exists option to set the file path to the sensitivity matrix binary file.
Weighting: Sets the weights for smallness and smoothness regularization in x, y and z; for
relevant equations fundamentals of inversion
• Default: Sets the values of alpha S, alpha X, alpha Y and alpha Z based on cell dimensions
• Alphas: Sets specific values for alpha S, alpha X, alpha Y and alpha Z
• Lengths: User sets values Len E, Len N and Len Z which define the values of alpha X,
alpha Y and alpha Z relative to alpha S.
Weights object:
• No weighting: select if you have not created sensitivity weighting yet or if no weighting
is being applied.
• Weights object: A GIFweights object that represents sensitivity weights or an additional
weights object. Note that when creating sensitivity weights, you can multiply this weights
object by the sensitivity weights.
Active cells: An ACTIVEmodel which denotes active cells in the inversion. If null, the active
cells are determined by the topography.
Initial model:
• Value: A constant background value
• Object: GIFmodel object
• Default: best-fitting halfspace
Reference model:
• Value: A constant background value
• Object: GIFmodel object
• Default: best-fitting halfspace
Role in model objective function: To see the difference between SMOOTH_MOD and
SMOOTH_MOD_DIF , see the fundamentals of inversion .
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DCIP Octree

Important: This manual contains the documentation for DCIP octree package releases beginning on 2020-05-08. This version of the package is compatible with GIFtools v2.31 and
later. If using an earlier version of GIFtools, everything is essentially the same except for the
independent smallness weights option.

Fig. 8: Basic (left), model options (middle) and advanced parameters (right) tabs.

Basic
• Data file format:
– Surface: All electrodes are projected to the discrete surface topography. This setting
uses the surface file format and ignores the elevation columns for the electrodes.
– General: Elevation columns for the electrodes must be set. Here, any electrodes
lying above the discrete surface topography are projected downward while all other
electrodes are left in their original positions. This necessary when borehole data are
included.
• Observed data: The user selects a DC3Ddata or IP3Ddata object from the drop-down
list.
• Mesh: OcTree mesh on which a conductivity/chargeability model is recovered.
• Topography: The user may define the surface topography using an ACTIVEmodel object
or set all cells as active (ALL_ACTIVE). If using reference/starting models where air cells
are defined as 1e-8 S/m, merely set all topography cells to active. If an ACTIVEmodel is
used to define the underground cells, all cells in the air are automatically assigned a value
of 1e-8 S/m.
• Background conductivity (IP only): For IP inversion, the user must define a background
conductivity model. Either a constant value for all cells below the surface topography or
a GIFmodel.
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Model Options
• Beta Cooling Schedule: Sets the rate of decrease in beta as the algorithm puts increasing
emphasis on fitting the data; see fundamentals of inversion.
– Default: A default cooling schedule is used.
– Custom: The user sets the following parameters:
∗ beta max: Starting beta value
∗ beta min: Final beta value before the algorithm quits (if target misfit not attained)
∗ reduction factor: a multiplicative constant between (0,1). Sets how much beta is
reduced at each iteration
• Chi Factor: Sets the target data misfit for the inversion. A chi-factor of 1 (default value)
implies the data misfit is equal to the total number of data observations.
• Weighting constants: Sets the weights for smallness and smoothness regularization in x,
y and z; see fundamentals of inversion.
– Default: Sets the values of alpha S, alpha E, alpha N and alpha Z based on cell
dimensions
– Alphas: Sets specific values for alpha S, alpha E, alpha N and alpha Z
– Lengths: User sets values Len E, Len N and Len Z which define the values of alpha
X,
to alpha S. These relationships are given by 𝐿𝐸 =
√︁ alpha Y and√︁alpha Z relative√︁
𝛼𝐸
𝛼𝑁
𝛼𝑍
,
𝐿
=
and
𝐿
=
𝑁
𝑍
𝛼𝑆
𝛼𝑆
𝛼𝑆 .
• Cell and interface weights: Here, the user may specify the implementation of cell and/or
face weighting; see fundamentals of inversion. In this case, the user selects a GIFweight
object that is defined on the OcTree mesh.
• Independent smallness weights: Standard cell weights are applied in both the smallness and smoothness terms. This functionality allows the user to include independent cell
weights only to the smallness term. The user will choose a GIFweight object whose cell
weights are to be applied. If you have a GIFmodel that you would like to use as independent smallness weights, first use octree mesh to create weights object, then click the
newly created GIFweights object and use set model.
• Active model cells: Here, the user specifies which cells are active during the inversion
(allowed to change their value). If all are set to active, then all cells within the surface
topography are allowed to change. If an active cells model is used, only the active cells
change their value during the inversion; the remaining cells (inactive) are left as the starting model value.
• Initial model: Staring model for the inversion. Can be either a constant value or an
OcTree model
• Upper bounds: Upper bounds for the recovered conductivity model.
– None: No upper bounds
– Value: Set a constant upper bound to be applied to all cells.
– Model: An OcTree model that defines the upper bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Lower bounds:
– None: No lower bounds
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– Value: Set a constant lower bound to be applied to all cells.
– Model: An OcTree model that defines the lower bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Reference model: Reference model for the inversion; see fundamentals of inversion.
– Value: Set a constant value for the reference model.
– Model: An OcTree model that defines the reference model.
• Update reference model throughout:
– Un-checked: The reference model remains the same throughout the entire inversion.
This option emphasizes preserving structures included in the reference model.
– Checked: Each time beta is updated, the current recovered model is set as the reference model for the next beta value. This results in faster convergence but does not
emphasize preserving structures in the original reference model as strongly.
• Role in model objective function: See fundamentals of inversion
– SMOOTH_MOD: Reference model only used in smallness term in the model objective function
– SMOOTH_MOD_DIF: Reference model using in the smallness and smoothness
terms in the model objective function
Advanced Parameters
• Newton iteration settings: Sets stopping criteria for Gauss-Newton iterations; see
DCIPoctree manual . Parameters are:
– tol_nl: stopping criteria based on gradient size (defaul = 0.01)
– mindm: stopping criteria based on size of model perturbation (default = 0.001)
– iter_per_beta: maximum number of Gauss-Newton iterations (default = 3)
• IPCG settings: Sets tolerances for solving the system at each Gauss-Newton iteration
using incomplete preconditioned conjugate gradient; see DCIPoctree manual . Parameters
are:
– tol_ipcg: relative tolerance for solution (default = 0.01)
– max_iter_ipcg: maximum number of IPCG iterations (20)
Edit Options for EM1DFM Inversion Objects
This functionality is responsible for setting all inversion parameters pertaining to the EM1DFM
code. The list of parameters used to run the EM1DFM Fortran code are described in the
EM1DFM package website; see main input file and inversion methodologies. The edit options
window is comprised of 3 tabs:
• Global: Sets global inversion parameters such as the 1D mesh, data object, 1D inversion
type, model type and computation of the trade-off parameter
• Conductivity: specifies the starting model, reference model and regularization for conductivity in the inversion
• Susceptibility: specifies the starting model, reference model and regularization for susceptibility in the inversion
4.8. Inversion
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Fig. 9: Global (left), conductivity (middle) and susceptibility (right) tabs for EM1DFM inversion objects.
Global Tab
Required Minimum Input: Here, the user specifies the:
• mesh
• observed data
• topography (for adaptive and laterally constrained only)
• additional model weights (optional)
Model Options: The user may invert for:
• a conductivity model
• a positive susceptibility model where a static background conductivity is used
• conductivity and positive susceptibility models
• conductivity and unbounded susceptibility models
Solver Options: Solver options set several parameters used in the EM1DFM Fortran code. The
details of each parameters are discussed in the EM1DFM manual under main input file
Mode: GIFtools is capable of carrying out three distinct 1D inversion approaches:
• Static: Each transmitter is associated with a distinct sounding. The inversion independently recovers a 1D model for each sounding.
• Adaptive: Here, surface topography is provided. The inversion is carried out in the same
way as before, however the vertical locations of models relative to one another are set
based on topography
• Laterally constrained: In this approach, the data at each sounding are only sensitive
to a particular 1D model. However, the set of 1D models is subject to smoothness constraints in the x and y directions. For this algorithm, three parameters must be set (these
parameters are described below):
– Max Distance
– Number of Stations
– Smoothing Factor

182

Chapter 4. Object Functionality

GIFtoolsCookbook Documentation, Release 1.0

For each 1D inversion being run by the EM1DFM Fortran code, there are 4 ways in which the
trade-off parameter (𝛽) can be calculated. The performance of each trade-off mode is determine
by a set of parameters:
• Discrepancy
– Chi Factor and Tolerance: The algorithm will find the 𝛽 such that the data misfit
𝜑𝑑 is within 𝑁 × (𝐶.𝐹. ± 𝑇 𝑜𝑙) where 𝑁 is the number of observations, 𝐶.𝐹.
is the chi factor and 𝑇 𝑜𝑙 is the tolerance. Generally a 𝐶.𝐹. = 1 and 𝑇 𝑜𝑙 = 0.1
are used (static and adaptive only)
– Initial Chi Factor and Cooling Factor: This chooses the 𝛽 for the first iteration according to the aforementioned method. In this case the tolerance is set
automatically. For each new global iteration, 𝛽𝑖 = 𝛽𝑖−1 /𝐶, where 𝐶 > 1 is the
cooling factor (laterally constrained only)
– Max Beta Iterations: Maximum number of new 𝛽 the algorithm will compute
to find best value
– Max Global Iterations: Maximum number of iterations for which the laterally
constrained inversion will find a new 3D model
• Fixed trade-off
– Beta: For static and adaptive 1D, the user specifies a constant value and the
problem is solved using that 𝛽. For laterally constrained 1D, this represents the
initial 𝛽 value.
– Cooling Factor: For each iteration, 𝛽𝑖 = 𝛽𝑖−1 /𝐶, where 𝐶 > 1 is the cooling
factor
– Max Beta Iterations: Maximum number of decreases in 𝛽 the algorithm will
use to hit target misfit
– Max Global Iterations: Maximum number of iterations for which the laterally
constrained inversion will find a new 3D model
• GCV (static and adaptive only)
– Max Beta Decrease: Maximum allowable decrease in 𝛽 for estimated of 𝛽 using
the GCV method
– Max Beta Iterations: Maximum number of new 𝛽 the algorithm will compute
to find the best value
• L-curve (static and adaptive only)
– Max Beta Decrease: Maximum allowable decrease in 𝛽 for estimated of 𝛽 using
the L-curve criterion
– Max Beta Iterations: Maximum number of new 𝛽 the algorithm will compute
to find the best value
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Conductivity and Susceptibility Tabs
Inversion Mode
Here, we describe approach taken by each inversion mode option.
Static
During the static inversion approach, 1D inversions are performed independently for each
sounding according to the EM1DFM manual. This results in one recovered model for every
sounding. This approach does not consider topography and the active layers in each independent inversion are identical to those in the layer file (1D mesh) provided. The set of recovered
1D models can be plotted on a 3D mesh which is created while the inversion is running. The
top of the 3D mesh is set as the elevation of the highest data observation. The surface location
of each recovered model is plotted at the top of the mesh (even though the surface location and
the top of the mesh might be at different elevations).
Adaptive
During the adaptive inversion approach, topography is considered by including a topography
data or surface data object. Without including topography, this inversion approach is identical
to the static 1D inversion. If topography is included, then the top locations of the layers used
for every independently recovered 1D model correspond to the top of the 3D mesh; the top
if the 3D mesh is set as the elevation of the highest data observation. For each 1D inversion,
layers above the surface topography are set as air cells (inactive) and the algorithm recovers a
conductivity model for the cells below. When plotted on the 3D mesh, the tops of the recovered
1D models (including air cells) correspond to the top of the 3D mesh. Thus, direct comparison
of laterally variability of recovered models is possible with this approach.
Laterally Constrained
Algorithm
• WHILE 𝜑𝑑 > target misfit AND 𝑖𝑡𝑟 < Max Global Iterations:
– FOR every sounding location 𝑖:
∗ Perform 1D inversion (the first 𝛽𝑖 is either set as a fixed value or determined
using the discrepancy principle)
– FOR every sounding location 𝑖:
∗ Find the closest 𝑁 stations within 𝑀 𝑎𝑥 𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 to the sounding
∗ Use the inverse weighting formula to update the reference model for the sounding
∗ Cool 𝛽𝑖 according to the cooling factor
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Plotting 1D Models on a 3D Mesh
Generating the Mesh:
When survey parameters are set through FEM sounding → Edit options, a 3D mesh is generated based on the 1D mesh (layers) provided and the minimum lateral spacing between observation locations. The 3D mesh allows the user to plot the set of recovered 1D models but is
not used in any of the inversion approaches. The x and y widths of cells within the 3D mesh
are set based on the minimum lateral spacing between observation locations. The top of the 3D
mesh corresponds with the elevation of the highest data observation location. The z widths of
the cells within the 3D mesh are given directly by the 1D mesh (layers); thus if the 1D mesh
has N layers, the 3D mesh will have N cells in the vertical.

Fig. 10: Recovered 1D models plotted on a 3D mesh without topography (left) and with (topography).
Impact on Inversion and Plotting:
The decision on whether or not to use topography results in two cases. If topography is not
included, then every layer within the 1D model is active during each independent 1D inversion.
Thus if the 1D mesh contains 𝑁 layers, each independently recovered 1D model will have 𝑁
conductivity and/or susceptibility values. When plotted on the 3D mesh at the corresponding
horizontal location (based on observation location), all cells in the vertical direction are populated by non-zero values. However, since the top of the 3D mesh corresponds to the elevation
of the highest observation location, the tops of all 1D models are also plotted at this height. As
a result, data locations will appear underground when 1D models and data are plotted at the
same time.
If topography is included, then for every independent 1D inversion, the algorithm finds all the
layers that would plot below the surface topography on the 3D mesh and sets them as active.
Thus if the 1D mesh contained 𝑁 layers, the number of layers that are active in any 1D inversion
is 𝑁𝑎𝑐𝑡 ≤ 𝑁 . When plotting the set of recovered 1D models, the highest non-zero value at each
sounding location will correspond to the surface topography and all cells above it will be zero.
When creating a 1D mesh, the user must ultimately account for the potential decrease in the
number of active cells when deciding to include topography.
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Edit Options for EM1DTM Inversion Objects
This functionality is responsible for setting all inversion parameters pertaining to the EM1DTM
code. The list of parameters used to run the EM1DTM Fortran code are described in the
EM1DTM package website; see main input file and inversion methodologies. The edit options
window is comprised of 3 tabs:
• Global: Sets global inversion parameters such as the 1D mesh, data object, 1D inversion
type, model type and computation of the trade-off parameter
• Conductivity: specifies the starting model, reference model and regularization for conductivity in the inversion

Fig. 11: Global (left) and conductivity (middle) tabs for EM1DTM inversion objects.

Global Tab
Required Minimum Input: Here, the user specifies the:
• mesh
• observed data
• topography (for adaptive and laterally constrained only)
• additional model weights (optional)
Model Options: The user may invert for:
• a conductivity model
• a positive susceptibility model where a static background conductivity is used
• conductivity and positive susceptibility models
• conductivity and unbounded susceptibility models
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Solver Options: Solver options set several parameters used in the EM1DTM Fortran code. The
details of each parameters are discussed in the EM1DTM manual under main input file
Mode: GIFtools is capable of carrying out three distinct 1D inversion approaches:
• Static: Each transmitter is associated with a distinct sounding. The inversion independently recovers a 1D model for each sounding.
• Adaptive: Here, surface topography is provided. The inversion is carried out in the same
way as before, however the vertical locations of models relative to one another are set
based on topography
• Laterally constrained: In this approach, the data at each sounding are only sensitive
to a particular 1D model. However, the set of 1D models is subject to smoothness constraints in the x and y directions. For this algorithm, three parameters must be set (these
parameters are described in the EM1DFM inversion modes):
– Max Distance
– Number of Stations
– Smoothing Factor
For each 1D inversion being run by the EM1DTM Fortran code, there are 4 ways in which the
trade-off parameter (𝛽) can be calculated. The performance of each trade-off mode is determine
by a set of parameters:
• Discrepancy
– Chi Factor and Tolerance: The algorithm will find the 𝛽 such that the data misfit
𝜑𝑑 is within 𝑁 × (𝐶.𝐹. ± 𝑇 𝑜𝑙) where 𝑁 is the number of observations, 𝐶.𝐹.
is the chi factor and 𝑇 𝑜𝑙 is the tolerance. Generally a 𝐶.𝐹. = 1 and 𝑇 𝑜𝑙 = 0.1
are used (static and adaptive only)
– Initial Chi Factor and Cooling Factor: This chooses the 𝛽 for the first iteration according to the aforementioned method. In this case the tolerance is set
automatically. For each new global iteration, 𝛽𝑖 = 𝛽𝑖−1 /𝐶, where 𝐶 > 1 is the
cooling factor (laterally constrained only)
– Max Beta Iterations: Maximum number of new 𝛽 the algorithm will compute
to find best value
– Max Global Iterations: Maximum number of iterations for which the laterally
constrained inversion will find a new 3D model
• Fixed trade-off
– Beta: For static and adaptive 1D, the user specifies a constant value and the
problem is solved using that 𝛽. For laterally constrained 1D, this represents the
initial 𝛽 value.
– Cooling Factor: For each iteration, 𝛽𝑖 = 𝛽𝑖−1 /𝐶, where 𝐶 > 1 is the cooling
factor
– Max Beta Iterations: Maximum number of decreases in 𝛽 the algorithm will
use to hit target misfit
– Max Global Iterations: Maximum number of iterations for which the laterally
constrained inversion will find a new 3D model
• GCV (static and adaptive only)
– Max Beta Decrease: Maximum allowable decrease in 𝛽 for estimated of 𝛽 using
the GCV method
4.8. Inversion
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– Max Beta Iterations: Maximum number of new 𝛽 the algorithm will compute
to find the best value
• L-curve (static and adaptive only)
– Max Beta Decrease: Maximum allowable decrease in 𝛽 for estimated of 𝛽 using
the L-curve criterion
– Max Beta Iterations: Maximum number of new 𝛽 the algorithm will compute
to find the best value
Conductivity and Susceptibility Tabs
Inversion Mode
See the EM1DFM inversion modes for more details.
Edit Options for Frequency Domain EM
E3D version 1
This functionality is responsible for setting all inversion parameters pertaining to the E3D version 1 code (e3d.exe); see manual . Within the edit options window below, there are 3 tabs:
• Basic: Sets minimum required input for the inversion
• Model Options: Sets starting model, reference model, upper and lower bounds,
weighting constraints and trade-off parameter (beta) options
• Inversion Parameters: Sets advanced parameters and tolerances for the inversion
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Basic
• Observed data: The user selects an FEMdata object from the drop-down list.
• Mesh: OcTree mesh on which a conductivity model is recovered.
• Topography: The user may define the surface topography using an ACTIVEmodel object
or set all cells as active (ALL_ACTIVE). If using reference/starting models where air cells
are defined as 1e-8 S/m, merely set all topography cells to active. If an ACTIVEmodel is
used to define the underground cells, all cells in the air are automatically assigned a value
of 1e-8 S/m.
• Solver type: The forward problem can be solved with either a direct solver or an iterative
solver. The direct solver requires more memory but is faster. The iterative solver is slower
but allows the solution of larger problems.
– Iterative: Uses the BICGstab algorithm.
– Direct: Uses Paradiso
• Model total field or secondary field:
– Total field: the data output by the forward modeling is the total field.
– Secondary (analytic): the code will forward model the secondary field. It will do
this by computing the total field for the conductivity model provided, then subtracting
the analytic total field using the homogeneous background conductivity provided. To
subtract the free-space primary field, let the background conductivity be 1e-8 S/m.
– Secondary (numeric): the code will forward model the secondary field. It will do
this by computing the total field for the conductivity model provided, then subtracting
the numerically computed total field using the homogeneous background conductivity
provided. To subtract the free-space primary field, let the background conductivity
be 1e-8 S/m.
• Background susceptibility model: Here, the user can specify a background magnetic
susceptibility model for the inversion. There are 3 options:
– No Sus: The Earth is considered non-susceptible
– Value: A constant magnetic susceptibility value is assigned to all cells lying below
the surface topography (not currently implemented)
– Model: The user supplies an OcTree model
Model Options
• Beta Cooling Schedule: Sets the rate of decrease in beta as the algorithm puts increasing
emphasis on fitting the data; see fundamentals of inversion.
– Default: A default cooling schedule is used.
– Custom: The user sets the following parameters:
∗ beta max: Starting beta value
∗ beta min: Final beta value before the algorithm quits (if target misfit not attained)
∗ reduction factor: a multiplicative constant between (0,1). Sets how much beta is
reduced at each iteration
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• Chi Factor: Sets the target data misfit for the inversion. A chi-factor of 1 (default value)
implies the data misfit is equal to the total number of data observations.
• Weighting constants: Sets the weights for smallness and smoothness regularization in x,
y and z; see fundamentals of inversion.
– Default: Sets the values of alpha S, alpha E, alpha N and alpha Z based on cell
dimensions
– Alphas: Sets specific values for alpha S, alpha E, alpha N and alpha Z
– Lengths: User sets values Len E, Len N and Len Z which define the values of alpha
X,
to alpha S. These relationships are given by 𝐿𝐸 =
√︁ alpha Y and√︁alpha Z relative√︁
𝛼𝐸
𝛼𝑁
𝛼𝑍
,
𝐿
=
and
𝐿
=
𝑁
𝑍
𝛼𝑆
𝛼𝑆
𝛼𝑆 .
• Additional weights: Here, the user may specify the implementation of additional cell
and/or face weighting; see fundamentals of inversion. In this case, the user selects a
GIFweight object that is defined on the OcTree mesh.
• Active model cells: Here, the user specifies which cells are active during the inversion
(allowed to change their value). If all are set to active, then all cells within the surface
topography are allowed to change. If an active cells model is used, only the active cells
change their value during the inversion; the remaining cells (inactive) are left as the starting model value.
• Initial model: Staring model for the inversion. Can be either a constant value or an
OcTree model
• Upper bounds: Upper bounds for the recovered conductivity model.
– None: No upper bounds
– Value: Set a constant upper bound to be applied to all cells.
– Model: An OcTree model that defines the upper bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Lower bounds:
– None: No lower bounds
– Value: Set a constant lower bound to be applied to all cells.
– Model: An OcTree model that defines the lower bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Reference model: Reference model for the inversion; see fundamentals of inversion.
– Value: Set a constant value for the reference model.
– Model: An OcTree model that defines the reference model.
• Update reference model throughout:
– Un-checked: The reference model remains the same throughout the entire inversion.
This option emphasizes preserving structures included in the reference model.
– Checked: Each time beta is updated, the current recovered model is set as the reference model for the next beta value. This results in faster convergence but does not
emphasize preserving structures in the original reference model as strongly.
• Role in model objective function: See fundamentals of inversion
– SMOOTH_MOD: Reference model only used in smallness term in the model objective function
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– SMOOTH_MOD_DIF: Reference model using in the smallness and smoothness
terms in the model objective function
Advanced Parameters
• Newton iteration settings: Sets stopping criteria for Gauss-Newton iterations; see E3D
version 1 manual . Parameters are:
– tol_nl: stopping criteria based on gradient size (defaul = 0.01)
– mindm: stopping criteria based on size of model perturbation (default = 0.001)
– iter_per_beta: maximum number of Gauss-Newton iterations (default = 3)
• IPCG settings: Sets tolerances for solving the system at each Gauss-Newton iteration
using incomplete preconditioned conjugate gradient; see E3D version 1 manual . Parameters are:
– tol_ipcg: relative tolerance for solution (default = 0.01)
– max_iter_ipcg: maximum number of IPCG iterations (20)
• BICG settings: If solving the forward problem using an iterative solver, these parameters specify the tolerances and stopping criteria for the BiCGstab algorithm;
see E3D version 1 manual <https://e3d.readthedocs.io/en/e3d/content/theory.html#
gauss-newton-solve>`__ .
– tol_bicg: (default = 1e-11)
– tol_ipcg_bicg: (default = 1e-5)
– max_it_bicg: (default 150)
Units
Inputs:
• Initial model: OcTree model with conductivity in S/m
• Reference model: Octree model with conductivity in S/m
• Susceptibility model: OcTree model with magnetic susceptibility in SI units
• Upper and lower bounds: Octree model with conductivity in S/m
• Either total field or secondary field data in A/m
Outputs:
• Conductivity model: OcTree model with conductivity in S/m
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E3D version 2 (and version 2 tiled)
This functionality is responsible for setting all inversion parameters pertaining to the E3D
version 2 code (done with e3d_v2.exe) and the E3D version 2 tiled code (done with
e3d_v2_tiled.exe); see E3D v2 manual or see E3D v2 tiled manual . Within the edit options
window below, the user sets the following parameters for the forward modeling:
• Basic: Sets minimum required input for the inversion
• Model Options: Sets starting model, reference model, upper and lower bounds,
weighting constraints and trade-off parameter (beta) options
• Inversion Parameters: Sets advanced parameters and tolerances for the inversion

Basic
• Observed data: The user selects either and impedance data or ZTEM data object from
the drop-box provided.
• Mesh: OcTree mesh on which a conductivity model is recovered.
• Forward tile meshes file path (tiled code only): Sets the path to the file containing the
local meshes (tiles)
• Topography: The user may define the surface topography using an ACTIVEmodel object
or set all cells as active (ALL_ACTIVE). If using reference/starting models where air cells
are defined as 1e-8 S/m, merely set all topography cells to active. If an ACTIVEmodel is
used to define the underground cells, all cells in the air are automatically assigned a value
of 1e-8 S/m.
• Model total field or secondary field:
– Total field: the data output by the forward modeling is the total field.
– Secondary (analytic): the code will forward model the secondary field. It will do
this by computing the total field for the conductivity model provided, then subtracting
the analytic total field using the homogeneous background conductivity provided. To
subtract the free-space primary field, let the background conductivity be 1e-8 S/m.
– Secondary (numeric): the code will forward model the secondary field. It will do
this by computing the total field for the conductivity model provided, then subtracting
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the numerically computed total field using the homogeneous background conductivity
provided. To subtract the free-space primary field, let the background conductivity
be 1e-8 S/m.
• Background susceptibility model: Here, the user can specify a background magnetic
susceptibility model for the inversion. There are 3 options:
– No Sus: The Earth is considered non-susceptible
– Value: A constant magnetic susceptibility value is assigned to all cells lying below
the surface topography (not currently implemented)
– Model: The user supplies an OcTree model
Model Options
• Beta Cooling Schedule: Sets the rate of decrease in beta as the algorithm puts increasing
emphasis on fitting the data; see fundamentals of inversion or E3D v2 manual .
– Default: A default cooling schedule is used.
– Custom: The user sets the following parameters:
∗ beta max: Starting beta value
∗ beta min: Final beta value before the algorithm quits (if target misfit not attained)
∗ reduction factor: a multiplicative constant between (0,1). Sets how much beta is
reduced at each iteration
• Chi Factor: Sets the target data misfit for the inversion. A chi-factor of 1 (default value)
implies the data misfit is equal to the total number of data observations.
• nBetas: Set the maximum number of times that Beta is reduced and the optimization is
carried out to recover a new model.
• Weighting constants: Sets the weights for smallness and smoothness regularization in x,
y and z; see fundamentals of inversion.
– Default: Sets the values of alpha S, alpha E, alpha N and alpha Z based on cell
dimensions
– Alphas: Sets specific values for alpha S, alpha E, alpha N and alpha Z
– Lengths: User sets values Len E, Len N and Len Z which define the values of alpha
X,
to alpha S. These relationships are given by 𝐿𝐸 =
√︁ alpha Y and√︁alpha Z relative√︁
𝛼𝐸
𝛼𝑁
𝛼𝑍
𝛼𝑆 , 𝐿𝑁 =
𝛼𝑆 and 𝐿𝑍 =
𝛼𝑆 .
• Additional weights: Here, the user may specify the implementation of additional cell
and/or face weighting; see fundamentals of inversion. In this case, the user selects a
GIFweight object that is defined on the OcTree mesh.
• Active model cells: Here, the user specifies which cells are active during the inversion
(allowed to change their value). If all are set to active, then all cells within the surface
topography are allowed to change. If an active cells model is used, only the active cells
change their value during the inversion; the remaining cells (inactive) are left as the starting model value.
• Initial model: Staring model for the inversion. Can be either a constant value or an
OcTree model
• Upper bounds: Upper bounds for the recovered conductivity model.
4.8. Inversion
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– None: No upper bounds
– Value: Set a constant upper bound to be applied to all cells.
– Model: An OcTree model that defines the upper bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Lower bounds:
– None: No lower bounds
– Value: Set a constant lower bound to be applied to all cells.
– Model: An OcTree model that defines the lower bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Reference model: Reference model for the inversion; see fundamentals of inversion.
– Value: Set a constant value for the reference model.
– Model: An OcTree model that defines the reference model.
• Update reference model throughout:
– Un-checked: The reference model remains the same throughout the entire inversion.
This option emphasizes preserving structures included in the reference model.
– Checked: Each time beta is updated, the current recovered model is set as the reference model for the next beta value. This results in faster convergence but does not
emphasize preserving structures in the original reference model as strongly.
• Role in model objective function: See fundamentals of inversion
– SMOOTH_MOD: Reference model only used in smallness term in the model objective function
– SMOOTH_MOD_DIF: Reference model using in the smallness and smoothness
terms in the model objective function
Inversion Parameters
• Newton iteration settings: Sets stopping criteria for Gauss-Newton iterations; see E3D
v2 manual . Parameters are:
– tol_nl: stopping criteria based on gradient size (defaul = 0.01)
– iter_per_beta: maximum number of Gauss-Newton iterations (default = 3)
• IPCG settings: Sets tolerances for solving the system at each Gauss-Newton iteration
using incomplete preconditioned conjugate gradient; see E3D v2 manual . Parameters
are:
– tol_ipcg: relative tolerance for solution (default = 0.01)
– max_iter_ipcg: maximum number of IPCG iterations (20)
• Memory settings: This code factors the forward system at each frequency for repeated
use in the inversion algorithm. The user has a choice in where the factorizations are stored:
– Store in RAM: Factorizations are stored in RAM. This option is the fastest, however
the user may run into memory limits.
– Write to file: Factorizations are written to files. Larger problems can be solved,
however the continual reading and writing of files makes this options slower.
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• Tile code options:
– Percent factors keep: A number between 0 and 1 denoting the fractional percent of
tiles being used each time the sensitivities are computed.
– Sensitivity Options: Compute full sensitivities or approximate
– Index specific tiles: Only invert using a subset of the data for the files specified.
Units
Inputs:
• Initial model: OcTree model with conductivity in S/m
• Reference model: Octree model with conductivity in S/m
• Susceptibility model: OcTree model with magnetic susceptibility in SI units
• Upper and lower bounds: Octree model with conductivity in S/m
• Either total field or secondary field data in A/m
Outputs:
• Conductivity model: OcTree model with conductivity in S/m
Edit Options for Natural Source EM (MT and ZTEM)
E3DMT version 1
This functionality is responsible for setting all inversion parameters pertaining to the E3DMT
version 1 code (e3dMTinv.exe and e3dMTinv_iter.exe); see manual . Within the edit options
window below, there are 3 tabs:
• Basic: Sets minimum required input for the inversion
• Model Options: Sets starting model, reference model, upper and lower bounds,
weighting constraints and trade-off parameter (beta) options
• Inversion Parameters: Sets advanced parameters and tolerances for the inversion
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Basic
• Observed data: The user selects one or more data objects from the list provided, allowing for joint inversion of MT and/or ZTEM data. It is important
to note that the ordering of the data locations is identical to the ordering of the
object selected. To change the ordering of data locations written to file, use the
Shift up and Shift down buttons.
Note: If multiple data objects are used in the inversion, then upon
loading predicted data, the data are parsed into several data objects.
• Mesh: OcTree mesh on which a conductivity model is recovered.
• Topography: The user may define the surface topography using an ACTIVEmodel object or set all cells as active (ALL_ACTIVE). If using reference/starting models where air cells are defined as 1e-8 S/m, merely set all topography cells to active. If an ACTIVEmodel is used to define the underground
cells, all cells in the air are automatically assigned a value of 1e-8 S/m.
• Background susceptibility model: Here, the user can specify a background
magnetic susceptibility model for the inversion. There are 3 options:
– No Sus: The Earth is considered non-susceptible
– Value: A constant magnetic susceptibility value is assigned to all cells
lying below the surface topography
– Model: The user supplies an OcTree model
• 1D background conductivity model: The E3DMT version 1 code solves a 1D
problem on a background conductivity model and uses the solution to obtain
the source term needed for the 3D problem. This is explained in more detail in
the E3DMT version 1 manual . Here, the user has two options:
– Value: A constant conductivity value is used for the background conductivity
– Model: A 1D conductivity model is used as the background conductivity. The number of conductivity values defining this model must equal
the number of underlying mesh cells defining the OcTree mesh in the zdirection; see manual .
Note: If there is significant topography, computation of the boundary conditions
and thus the final 3D solution may not be as accurate. In this case, it is suggested
the user model data with E3DMT version 2.
• Solver type: The forward problem can be solved with either a direct solver or
an iterative solver. The direct solver requires more memory but is faster. The
iterative solver is slower but allows the solution of larger problems.
– Iterative: Uses the BICGstab algorithm.
– Direct: Uses Paradiso

196

Chapter 4. Object Functionality

GIFtoolsCookbook Documentation, Release 1.0

Model Options
• Beta Cooling Schedule: Sets the rate of decrease in beta as the algorithm puts increasing emphasis on fitting the data; see fundamentals of inversion or the E3DMT version 1
manual .
– Default: A default cooling schedule is used.
– Custom: The user sets the following parameters:
∗ beta max: Starting beta value
∗ beta min: Final beta value before the algorithm quits (if target misfit not attained)
∗ reduction factor: a multiplicative constant between (0,1). Sets how much beta is
reduced at each iteration
• Chi Factor: Sets the target data misfit for the inversion. A chi-factor of 1 (default value)
implies the data misfit is equal to the total number of data observations.
Important: This code uses a measure of data misfit that is different from the
majority of GIF codes. It is recommended the user be familiar with the measure
of data misfit; see manual .
• Weighting constants: Sets the weights for smallness and smoothness regularization in x,
y and z; see fundamentals of inversion.
– Default: Sets the values of alpha S, alpha E, alpha N and alpha Z based on cell
dimensions
– Alphas: Sets specific values for alpha S, alpha E, alpha N and alpha Z
– Lengths: User sets values Len E, Len N and Len Z which define the values of alpha
X,
to alpha S. These relationships are given by 𝐿𝐸 =
√︁ alpha Y and√︁alpha Z relative√︁
𝛼𝐸
𝛼𝑁
𝛼𝑍
𝛼𝑆 , 𝐿𝑁 =
𝛼𝑆 and 𝐿𝑍 =
𝛼𝑆 .
• Additional weights: Here, the user may specify the implementation of additional cell
and/or face weighting; see fundamentals of inversion. In this case, the user selects a
GIFweight object that is defined on the OcTree mesh.
• Active model cells: Here, the user specifies which cells are active during the inversion
(allowed to change their value). If all are set to active, then all cells within the surface
topography are allowed to change. If an active cells model is used, only the active cells
change their value during the inversion; the remaining cells (inactive) are left as the starting model value.
• Initial model: Staring model for the inversion. Can be either a constant value or an
OcTree model
• Upper bounds: Upper bounds for the recovered conductivity model.
– None: No upper bounds
– Value: Set a constant upper bound to be applied to all cells.
– Model: An OcTree model that defines the upper bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Lower bounds:
– None: No lower bounds
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– Value: Set a constant lower bound to be applied to all cells.
– Model: An OcTree model that defines the lower bound for each cell individually.
Values corresponding to inactive cells in the inversion are ignored.
• Reference model: Reference model for the inversion; see fundamentals of inversion.
– Value: Set a constant value for the reference model.
– Model: An OcTree model that defines the reference model.
• Update reference model throughout:
– Un-checked: The reference model remains the same throughout the entire inversion.
This option emphasizes preserving structures included in the reference model.
– Checked: Each time beta is updated, the current recovered model is set as the reference model for the next beta value. This results in faster convergence but does not
emphasize preserving structures in the original reference model as strongly.
• Role in model objective function: See fundamentals of inversion
– SMOOTH_MOD: Reference model only used in smallness term in the model objective function
– SMOOTH_MOD_DIF: Reference model using in the smallness and smoothness
terms in the model objective function
Inversion Parameters
• Newton iteration settings: Sets stopping criteria for Gauss-Newton iterations;
see E3DMT version 1 manual . Parameters are:
– tol_nl: stopping criteria based on gradient size (defaul = 0.01)
– mindm: stopping criteria based on size of model perturbation (default =
0.001)
– iter_per_beta: maximum number of Gauss-Newton iterations (default =
3)
• IPCG settings: Sets tolerances for solving the system at each Gauss-Newton
iteration using incomplete preconditioned conjugate gradient; see E3DMT version 1 manual . Parameters are:
tol_ipcg:
relative tolerance for solution (default = 0.01)
max_iter_ipcg: maximum number of IPCG iterations (20)
• Data weighting for joint inversion: If multiple datasets are being inverted
jointly, then the contribution of each dataset towards the total data misfit should
be weighted; otherwise, the inversion does not fit each dataset evenly. For more
details, see fundamentals of inversion. For E3DMT version 1, options are:
– No weighting between datasets: Used if only a single dataset is being
inverted .
– Weight by relative number of data: Suggested if multiple datasets are
being inverted. This option will automatically weight the contribution of
the data misfits for each datasets in order to fit each dataset equally.
– Data weighting constants: Specify the set of weighting constants for joint
inversion. Weighting based on the number of data is still applied and the
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constants entered are scaled such that the target misfit for the inversion remains the same.
Note: The E3DMT version 1 executable does not have the ability to perform joint
inversion. To carry out the joint inversion of MT and ZTEM data, the uncertainties
are scaled by a constant factor. Although the uncertainties are changed, the target
misfit for the inversion (total # data × chi factor) does not.
• BICG settings: If solving the forward problem using an iterative solver, these
parameters specify the tolerances and stopping criteria for the BiCGstab algorithm.
– tol_bicg: (default = 1e-11)
– tol_ipcg_bicg: (default = 1e-5)
– max_it_bicg: (default 150)
– freq_Aphi: (default = 1e6)
Units
Inputs:
• Initial model: OcTree model with conductivity in S/m
• Reference model: Octree model with conductivity in S/m
• 1D background conductivity: A 1D model with conductivity in S/m
• Susceptibility model: OcTree model with magnetic susceptibility in SI units
• Upper and lower bounds: Octree model with conductivity in S/m
• MT data: Real and imaginary components of impedance tensor entries (V/A)
• ZTEM data: Real and imaginary components of transfer function entries (unitless)
Outputs:
• Conductivity model: OcTree model with conductivity in S/m
E3DMT version 2
This functionality is responsible for setting all inversion parameters pertaining to the E3DMT
version 2 code (e3dMTinv_ver2.exe); see manual . Within the edit options window below, there
are 3 tabs:
• Basic: Sets minimum required input for the inversion
• Model Options: Sets starting model, reference model, upper and lower bounds,
weighting constraints and trade-off parameter (beta) options
• Inversion Parameters: Sets advanced parameters and tolerances for the inversion

4.8. Inversion
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Basic
• Observed data: The user selects either and impedance data or ZTEM data
object from the drop-box provided.
• Mesh: OcTree mesh on which a conductivity model is recovered.
• Topography: The user may define the surface topography using an ACTIVEmodel object or set all cells as active (ALL_ACTIVE). If using reference/starting models where air cells are defined as 1e-8 S/m, merely set all topography cells to active. If an ACTIVEmodel is used to define the underground
cells, all cells in the air are automatically assigned a value of 1e-8 S/m.
• Background susceptibility model: Here, the user can specify a background
magnetic susceptibility model for the inversion. There are 3 options:
– No Sus: The Earth is considered non-susceptible
– Value: A constant magnetic susceptibility value is assigned to all cells
lying below the surface topography
– Model: The user supplies an OcTree model
• Background conductivity model: The E3DMT version 2 code must first compute the source term needed for the 3D problem and can do so in a variety of
ways. This is explained in more detail in the E3DMT version 2 manual . Here,
the user specifies if the source term is computed using a 1D or 3D approach,
then supplies the appropriate model. In total, there are 4 options for defining
the background conductivity model:
– 1D + Value: A 1D background conductivity model is used. This model
has a constant conductivity value below the highest surface topography.
– 1D + Model: A 1D background conductivity model is used. The number
of conductivity values defining this model must equal the number of underlying mesh cells defining the OcTree mesh in the z-direction; see manual
.
– 3D + Value: A 3D background conductivity model is used. This model has
a constant conductivity value for all cells below the surface topography.
– 3D + Model: A 3D background conductivity model is used. The background conductivity model must be defined on the OcTree mesh used to
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forward model the data.
Note: If surface topography is negligible, the the 1D background model is accurate
and computationally efficient. If topography is significant, it is advised that a 3D
background model is used.

Model Options
• Beta Cooling Schedule: Sets the rate of decrease in beta as the algorithm puts
increasing emphasis on fitting the data; see fundamentals of inversion or the
E3DMT version 1 manual .
– Default: A default cooling schedule is used.
– Custom: The user sets the following parameters:
∗ beta max: Starting beta value
∗ beta min: Final beta value before the algorithm quits (if target misfit not
attained)
∗ reduction factor: a multiplicative constant between (0,1). Sets how much
beta is reduced at each iteration
• Chi Factor: Sets the target data misfit for the inversion. A chi-factor of 1 (default value) implies the data misfit is equal to the total number of data observations.
Important: This code uses a measure of data misfit that is different from the majority of GIF codes. It is recommended the user be familiar with the measure of data
misfit; see manual .
• Weighting constants: Sets the weights for smallness and smoothness regularization in x, y and z; see fundamentals of inversion.
– Default: Sets the values of alpha S, alpha E, alpha N and alpha Z based
on cell dimensions
– Alphas: Sets specific values for alpha S, alpha E, alpha N and alpha Z
– Lengths: User sets values Len E, Len N and Len Z which define the values
of alpha X, alpha Y√︁and alpha Z √︁
relative to alpha√︁
S. These relationships
are given by 𝐿𝐸 = 𝛼𝛼𝐸𝑆 , 𝐿𝑁 = 𝛼𝛼𝑁𝑆 and 𝐿𝑍 = 𝛼𝛼𝑍𝑆 .
• Additional weights: Here, the user may specify the implementation of additional cell and/or face weighting; see fundamentals of inversion. In this case,
the user selects a GIFweight object that is defined on the OcTree mesh.
• Active model cells: Here, the user specifies which cells are active during the
inversion (allowed to change their value). If all are set to active, then all cells
within the surface topography are allowed to change. If an active cells model is
used, only the active cells change their value during the inversion; the remaining
cells (inactive) are left as the starting model value.
• Initial model: Staring model for the inversion. Can be either a constant value
or an OcTree model
4.8. Inversion
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• Upper bounds: Upper bounds for the recovered conductivity model.
– None: No upper bounds
– Value: Set a constant upper bound to be applied to all cells.
– Model: An OcTree model that defines the upper bound for each cell individually. Values corresponding to inactive cells in the inversion are ignored.
• Lower bounds:
– None: No lower bounds
– Value: Set a constant lower bound to be applied to all cells.
– Model: An OcTree model that defines the lower bound for each cell individually. Values corresponding to inactive cells in the inversion are ignored.
• Reference model: Reference model for the inversion; see fundamentals of inversion.
– Value: Set a constant value for the reference model.
– Model: An OcTree model that defines the reference model.
• Update reference model throughout:
– Un-checked: The reference model remains the same throughout the entire
inversion. This option emphasizes preserving structures included in the
reference model.
– Checked: Each time beta is updated, the current recovered model is set as
the reference model for the next beta value. This results in faster convergence but does not emphasize preserving structures in the original reference
model as strongly.
• Role in model objective function: See fundamentals of inversion
– SMOOTH_MOD: Reference model only used in smallness term in the
model objective function
– SMOOTH_MOD_DIF: Reference model using in the smallness and
smoothness terms in the model objective function
Inversion Parameters
• Newton iteration settings: Sets stopping criteria for Gauss-Newton iterations; see
E3DMT version 2 manual . Parameters are:
– tol_nl: stopping criteria based on gradient size (defaul = 0.01)
– iter_per_beta: maximum number of Gauss-Newton iterations (default = 3)
• IPCG settings: Sets tolerances for solving the system at each Gauss-Newton iteration
using incomplete preconditioned conjugate gradient; see E3DMT version 2 manual . Parameters are:
– tol_ipcg: relative tolerance for solution (default = 0.01)
– max_iter_ipcg: maximum number of IPCG iterations (20)
• Memory settings: This code factors the forward system at each frequency for repeated
use in the inversion algorithm. The user has a choice in where the factorizations are stored:
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– Store in RAM: Factorizations are stored in RAM. This option is the fastest, however
the user may run into memory limits.
– Write to file: Factorizations are written to files. Larger problems can be solved,
however the continual reading and writing of files makes this options slower.
Units
Inputs:
• Initial model: OcTree model with conductivity in S/m
• Reference model: Octree model with conductivity in S/m
• 1D background conductivity: A 1D model with conductivity in S/m
• Susceptibility model: OcTree model with magnetic susceptibility in SI units
• Upper and lower bounds: Octree model with conductivity in S/m
• MT data: Real and imaginary components of impedance tensor entries (V/A)
• ZTEM data: Real and imaginary components of transfer function entries (unitless)
Outputs:
• Conductivity model: OcTree model with conductivity in S/m

4.8.3 Compute and Apply Sensitivity Weights for 3D DC and IP Inversions
Specifically for DC3Dinversion and IP3Dinversion objects, we can compute and appliy sensitivity
weights once completing the edit options step. A different approach is required for 2D and OcTree inversion codes.
DC3D Inversion
Step 1: Write the set of files that are required for computation of the sensitivities. For DC3D inversion,
the sensitivities and the resulting sensitivity weights are written to the subfolder sensitivity_weights. To
write the files for surface data or general format:
DC3Dinversion → Create and apply sensitivity weights → Write files → surface format
DC3Dinversion → Create and apply sensitivity weights → Write files → general format

Step 2: Compute sensitivities. This is done by calling the inversion code and terminating after 1 iteration.
To compute the sensitivities:
DC3Dinversion → Create and apply sensitivity weights → Compute sensitivities

4.8. Inversion
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Step 3: Load output and set weights. Here, the user will select the file sensitivity.txt which contains the
averages sensitivities.
DC3Dinversion → Create and apply sensitivity weights → Load output and set weights
In the pop-up window shown below, the user will see:
• truncation value: The weights model will be normalized to have a maximum value of 1. So essentially, this is the minimum values in the weights model. Something like 0.001 - 0.01 is usually
good.
• Apply sensitivity weights to cells and faces, or just cells
• Setting final weights used in inversion: The user may replace the current weights object with the
sensitivity weights. The user may also multiply the current weights model by the sensitivity weights.
The user may also load the weights object without altering the current inversion parameter.

IP3D Inversion
Step 1: Write the set of files that are required for computation of the sensitivities. For IP inversion, we
can work in the main inversion directory. To write the files for surface data or general format:
IP3Dinversion → Create sensitivity matrix → Write files for IPSEN3D → surface format
IP3Dinversion → Create sensitivity matrix → Write files for IPSEN3D → general format

Step 2: Compute sensitivities. To compute the sensitivities:
IP3Dinversion → Create sensitivity matrix → run IPSEN3D
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Step 3: Load output and set weights. Here, the user will select the file sensitivity.txt which contains the
averages sensitivities.
DC3Dinversion → Create and apply sensitivity weights
In the pop-up window shown below, the user will see:
• truncation value: The weights model will be normalized to have a maximum value of 1. So essentially, this is the minimum values in the weights model. Something like 0.001 - 0.01 is usually
good.
• Apply sensitivity weights to cells and faces, or just cells
• Setting final weights used in inversion: The user may replace the current weights object with the
sensitivity weights. The user may also multiply the current weights model by the sensitivity weights.
The user may also load the weights object without altering the current inversion parameter.

4.8.4 Write inversion files to directory
General
Prior to running the inversion, the user must write the appropriate inversion files to the working directory.
For inversion that require sensitivity calculations (magnetics, gravity, gravity gradiometry, IP, etc), see
below. To write all files, regardless, click on the inversion item, select the menu showing its class (e.g.,
E3Dinversion):
[Inversion class] → Write [inversion name] files

4.8. Inversion
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DCIP: Surface or General data format
For DCIP data object, GIFtools allow to export two types of data format for the inversion: - Surface Data
Format (recommended): Use this data format if the electrodes are at the surface. The Z-values will be
excluded from the output data file and the inversion code will take care of projecting them at the surface.
This avoid the risk of having electrodes in the air or underground. - General Data Format: Use this
option if any electrode is underground. The Z-values are specified in the output data file.
[Forward modeling class] → Write files

4.8.5 Run an inversion
Prior to running the inversion, the user must write the inversion files to the working directory. For inversion
that require sensitivity calculations (magnetics, gravity, gravity gradiometry, IP, etc), see below. Click on
the inversion item, select the menu showing its class (e.g., E3Dinversion):
[Inversion class] → Run [inversion name]
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Run an inversion with a sensitivity prerequisite
For those inversions that require sensitivity matrices (and weighting), there are two ways of running the
inversion. The first (and easiest) is use the Run → All menu. GIFtools will create a batch file and run all
the necessary executables.

NOTE 1: In the case of simply changing standard deviations, the sensitivity (and weighting) does not
need re-ran. Instead, the user can use the Run → [inversion name] menu as shown above. Do not forget
that files need be written to disk if any changes have been updated.
NOTE 2: GIFtools gives the user the ability to run only the sensitivity and weighting if desired (see above
figure). In those cases, the name of the input file will be required (and thus the write statement should have
been used).
Run a DCIP inversion with a sensitivity-weighting
For DCINV2D and DCINV3D, there is an option to use sensitivity-weighting. If this option is chosen, the
program will be called a first time to compute the sensitivity matrix. GIFtools will then automatically load
the sensitivity, compute the weights and launch the full inversion.

4.8.6 Load inversion results and output
Once the inversion has run, the user may load either all or a selection of the predicted data and recovered models. Click on the inversion item, select the menu showing its class (e.g., E3Dinversion or
GRAVinversion):
• Load all results: [Inversion class] → Load results → All results
• Load selected results: [Inversion class] → Load results → Selected results

4.8. Inversion
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4.8.7 View inversion results
GIFtools allows the user two different ways to view the output of the inversion. The methods are grouped
under Visualization menu when clicking on the inversion item.

Convergence curves
To view the convergence curves, click on the inversion item and the use the menu:
Visualization → Convergence curves
The shortcut for this viewer is control + k for any inversion item selected in the tree.
Log file
To view the log file of the inversion, click on the item and use the menu:
Visualization → Log file

4.8.8 Copy an inversion item
Once the inversion has run and the results loaded, GIFtools does not allow the straight copying of the
inversion item (it has been “archived”). It does, however, allow you to copy the options that were chosen for the inversion to a new one. Click on the inversion item, select the menu showing its class (e.g.,
E3Dinversion or GRAVinversion):
[Inversion class] → Copy options
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4.9 Processing
4.9.1 Equivalent Source Processing
Set the equivalent source working directory
The working directory tells GIFtools where to output files (and run the program) associated
with the selected item. It is suggested to set the directory prior to setting any other properties .
Click on the equivalent-source item, select the menu showing its class (e.g., MAGEquivalent
source or GRAVEquivalent source):
[Equivalent-source class] → Set working directory

NOTE: The shortcut for the functionality is control + d.
Edit the equivalent-source’s options
To change the options of the equivalent source, such as the mesh, data item, topography,
or bounds, click on the equivalent source item, select the menu showing its class (e.g.,
MAGEquivalent source or GRAVEquivalent source):
[Equivalent source class] → Edit options

Write equivalent-source files to directory
Prior to running the equivalent-source program, the user must write the appropriate files to
the working directory. To write all files click on the equivalent-source item, select the menu
showing its class (e.g., MAGequivalent source):
[Equivalent-source class] → Write All
For those who would like to micro-manage the equivalent-source program, the sensitivity
and inversion file may be written in separate steps using the Write → [Equivalent-source
sensitivity name] or Write → [Equivalent-source inversion name], respectfully.
NOTE: The Write all command will automatically also write the sensitivity files for the user.

4.9. Processing
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Run the equivalent-source program
Prior to running the equivalent-source program, the user must write the files to the working
directory. There are two ways of running the equivalent source. The first (and easiest) is use
the Run → All menu. GIFtools will create a batch file and run all the necessary executables.
The second is to run the sensitivity and “inversion” separately. For the first: click on the
equivalent-source item, select the menu showing its class (e.g., MAGEquivalentSource):
[Equivalent-source class] → Run → All

NOTE 1: In the case of simply changing standard deviations, the sensitivity (and weighting)
does not need re-ran. Instead, the user can use the Run → [equivalent-source name] menu
as shown above. Do not forget that files need be written to disk if any changes have been
updated.
NOTE 2: GIFtools gives the user the ability to run only the sensitivity if desired (see above
figure). In those cases, the name of the input file will be required (and thus the write statement
should have been used).
NOTE 3: In the case of equivalent source processing, the data are the final product rather
than the recovered model. Therefore, we recommend running the code with the full sensitivity
matrix at the end in order to remove any distortions caused by the wavelet compression.
Load equivalent-source output
Once the equivalent source has run, the user may load either all or a selection of the predicted
data and recovered models. It is recommended that only the last iteration (that has been performed with the full sensitivity matrix) be loaded. Click on the equivalent-source item, select
the menu showing its class (e.g., MAGEquivalent source or GRAVEquivalent source):
• Load all results: [Equivalent-source class] → Load results → All results
• Load selected results: [Equivalent-source class] → Load results → Selected results
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View equivalent-source results
GIFtools allows the user two different ways to view the output of the equivalent source. The
methods are grouped under Visualization menu when clicking on the equivalent-source item.

Convergence curves
To view the convergence curves, click on the equivalent-source item and the use the menu:
Visualization → Convergence curves
The shortcut for this viewer is control + k for any equivalent-source item selected in the
tree.
Log file
To view the log file of the equivalent source, click on the item and use the menu:
Visualization → Log file
Copy an equivalent-source item
Once the equivalent-source program has run and the results loaded, GIFtools does not allow the straight copying of the equivalent-source processing item (it has been “archived”).
It does, however, allow you to copy the options that were chosen for the equivalent source
to a new one. Click on the equivalent source item, select the menu showing its class (e.g.,
MAGEquivalentSource or GRAVEquivalentSource):
[Equivalent source class] → Copy options
Warning: The equivalent source codes are currently under review.

4.9. Processing
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4.10 Fortran Utility Program
4.10.1 Set the utility’s working directory
The working directory tells GIFtools where to output files (and run the utility) associated with the selected
item. Click on the utility item, select the menu showing its class (e.g., Interpolate model utility):
[Utility class] → Set working directory

NOTE: The shortcut for the functionality is control + d.

4.10.2 Set Data for OcTree Mesh Generation
For generating OcTree meshes with Fortran utilities, we must set an appropriate data object. For example,
if E3DMT OcTree mesh generation is used, an IMPdata, APPdata or ZTEMdata object must be used. For
any Fortran Octree mesh generation utility, this functionality is accessed through:
[Utility class] → Set data object

4.10.3 Edit the utility’s options
To change the options of the utility, click on the utility item, select the menu showing its class (e.g.,
Interpolate Model utility):
[utility class] → Edit options
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DCIP OcTree Mesh Utility
• Input Options (related documentation for DCIP OcTree)

Important: If surface is selected, all electrodes will be projected to the discrete surface topography. If
general is selected, all electrodes above the discrete surface topography are projected and all electrodes below the discrete surface are left in their original locations. The latter option is mean for datasets containing
borehole data.

E3DMT Mesh Utility
• Enter an estimate background resistivity value. This value is used to estimate the necessary padding
distances.
• Input Options (related documentation for E3DMT)

Important: Regarding the shift_data button. If MT data are used to design the survey, shift_data will
create a receivers file that places all receivers on the discretized surface. If ZTEM data are used to design
the survey, shift_data will create a receivers file such that true flight height is preserved over the discretized

4.10. Fortran Utility Program

213

GIFtoolsCookbook Documentation, Release 1.0

214

Chapter 4. Object Functionality

GIFtoolsCookbook Documentation, Release 1.0

surface.

E3DMT v2 Mesh Utility
• Enter an estimate background resistivity value. This value is used to estimate the necessary padding
distances.

• Input Options (related documentation for E3DMT v2)

E3D_ver2_Tiled Mesh Utility
• Enter an estimate background resistivity value. This value is used to estimate the necessary padding
distances.
• Input Options (related documentation for E3D v2 tiled)
– Core cell dimension
∗ East, North and Thickness dimension of the smallest octree level
– Octree Refinement Level
∗ Power of expension (Min. fact.): Integer value of power 2
∗ Minimum cell size (min_cell_size_fwd): Sets the minimum cell size for the
forward mesh, factor of base core cell.
∗ Maximum topography-based cell size (max_topo_cell): Largest cell before
rapid octree expansion.
– Padding cell expansion
∗ Distance to expand outside the core region along the Cartesian directions.
– Topography

4.10. Fortran Utility Program
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∗ Value: Assume flat topography at given elevation (m)
∗ Object: Topography defined by a TOPOdata object
– Core Region refinement (Inversion)
∗ Sets the discretization depth for the first three octree levels (global inversion
mesh)
– Core region refinement (Forward)
∗ Sets the discretization depth for the first three octree levels (local forward
meshes)
– Number of cells around Rx
∗ Number of cells around each receiver for the first three octree levels
– Make polygon
∗ Value: Distance (m) outside the data convex haul
∗ Object: Points defining the outer core region
Project Electrodes to Discrete Topography
DC/IP Octree Sensitivity Utility
Set parameters to compute approximate senstivity weights model for DC or IP octree inversion. The utility
will look at the data type to determine whether DC or IP weights are being computed.
Input Options (thorough description of all parameters provided in DCIP octree documentation)
• If surface is selected, all electrodes will be projected to the discrete surface topography. If general
is selected, all electrodes above the discrete surface topography are projected and all electrodes
below the discrete surface are left in their original locations. The latter option is mean for datasets
containing borehole data.
• Number of samples: This is the number of iterations for approximating the diagonals of 𝐽 𝑇 𝐽 with
Hutchinson’s or probing approach. A value of 10 is reasonable.
4.10. Fortran Utility Program
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• Computation method: Choose one of the approximate or analytic methods for computing the sensitivities. We suggest using average sensitivities or RMS sensitivities because these approaches are
analytic and do not take much longer than any of the approximate sensitivity methods.
• Truncation Factor: We must apply a truncation factor due to the large dynamic range of the sensitivities. A value between 0.01 and 0.2 is good.
• Apply Smoothing: Artifacts related to approximating the sensitivities can negatively impact the final
inversion result. To mitigate this, we ‘smooth out’ these artifact. This paramter specifies the number
of times smoothing is applied. A value of 1-5 works well.

4.10.4 Run a utility program
The user choose the menu item Run to run the utility. GIFtools will write out any files that are required
to run the utility (unlike an inversion). Click on the utility item, select the menu showing its class (e.g.,
Interpolate Model utility):
[Utility class] → Run utility

4.10.5 Load utility program results
Once the utility has run, the user can load the created files (model(s), mesh(es), etc). via the Read output
files command under the utility’s menu. The items will load underneath the utility make it a folder.

4.11 Survey
4.12 Model Builder Module
4.12.1 Model Builder Menu
Set/View Working Directory
A specific directory for models and meshes associated with the model builder module can be set or viewed through:
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Model Builder → Working Directory
Set Model

4.12.2 Build Model
Create Model Using Surfaces
This functionality allows the user to set the physical property values for cells that lie between two surfaces. The surfaces
may be defined by topography (TOPOdata) or surfaces (SURFACEdata). Physical property values can be set for cells
within the active or inactive space. This functionality is accessed through:
Create model → Using surfaces
Populate Values (or geologic units)
This functionality is accessed through:
Create model → Using surfaces → populate values (or geologic units)
Populate (in)active Regions
This functionality is accessed through:
Create model → Using surfaces → populate (in)active regions
Geologic Model from Map Image
Geologic Model from GIF Model
Geologic Model from Polygon Shape Items
Statistic of Multiple Models

4.12.3 Build Constraints

4.12. Model Builder Module
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CHAPTER

FIVE

UBC FILE FORMATS

5.1 Data
5.1.1 XYZ file format
GIFtools assumes all XYZ files are in a specific format. The file should have an uncommented header line and be
white-spaced delimited (tabs/space mixture is ok). Comments are given throughout the file by: / , ! , or %. There are
seven specific keywords that should not be in the header:
• Line
• Test
• Trend
• Tie
• Base
• Special
• Random
Below is a sample XYZ file with the header [X Y Z Total_Field]:

5.1.2 CSV file format
The CSV file should have an uncommented header line and be comma delimited. Comments are given throughout the
file by: / , ! , or %. There are no specific keywords that are assumed to be comment lines.
Below is a sample CSV file with the header [HID,DEPTH,AZIMUTH,DIP]:

5.1.3 Magnetic observations: GIF file
This file is used to specify the inducing field parameters, anomaly type, observation locations, and the observed magnetic anomalies with estimated standard deviation. The values of parameters specifying the inducing field anomaly
type and observation locations are identical to those in file. The output of the forward modelling program has the
same structure except that the column of standard deviations for the error is omitted. Lines starting with ! are comments. GIFtools will read either format through when importing a magnetic data set in GIF format. The structure of
the GIF-formatted magnetics observations file is:
Parameter definitions:
• incl, decl: Inclination and declination of the inducing magnetic field. The declination is specified positive east
with respect to the northing used in the mesh and locations files. The inclination is positive down.
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• geomag: Strength of the inducing field in nanoTesla (nT).
• ainc, adec, idir: Inclination and declination of the anomaly projection. Set idir=0 for a multi-component dataset
and idir=1 for a single component dataset where all the observations have the same inclination and declination
of the anomaly projection.
• ndat: Number of observations. When single component data are specified the number of observations is equal to
the number of data locations. When multi-component data are specified the number of observations will exceed
the number of data locations. For example, if three-component data are specified at 𝑁 locations, the number of
observations is 3𝑁 .
• E, N, ELEV: Easting, northing, and elevation of the observation measured in meters. Elevation should be above
the topography for surface data, and below the topography for borehole data. The observation locations can be
listed in any order.
• (ainc𝑛 , adec𝑛 ): Inclination and declination of the anomaly projection for nth observation. This is used only when
idir=0. The brackets [· · · ] indicate that these two field are optional depending upon the value of idir.
• Mag𝑛 : Magnetic anomaly data, measured in nT.
• Err𝑛 : Standard deviation of Mag𝑛 . This represents the absolute error. It must be positive and non-zero.
NOTE: It should be noted that the data are extracted anomalies which are derived by removing the regional from
the field measurements. It is crucial that the data be prepared as such. The total field anomaly is calculated when
ainc=incl and adec=decl. An example is inputting the vertical field anomaly, Bz, calculated by setting ainc=90
and adec=0. The easting and northing components are respectively given by the inclination and declination pairs (0,
90) and (0, 90). The user can specify other (ainc, adec) pairs to calculate the other anomaly components such
as the Bx or By. Easting, northing, and elevation information should be in the same coordinate system as defined in
the mesh.
Examples
The following are two examples of data files. The first example file specifies a set of total field anomaly data, and the
second example file provides a set of multi-component borehole data.
Example 1: single-component data

Example 2: Multi-component data
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5.1.4 Gravity observations: GIF file
This file is used to specify the observation locations and observed gravity anomalies with estimated standard deviation.
The output of the forward modelling program gzfor3d has the same structure except that the column of standard
deviations for the error is omitted. Lines starting with ! are comments. The following is the GIF-formatted file
structure of a gravity observations file:

Parameter definitions:
• ndat: Number of observations.
• E, N, ELEV: Easting, northing and elevation of the observation, measured in meters. Elevation should be above
the topography for surface data, and below the topography for borehole data. The observation locations can be
listed in any order.
• Grav 𝑖 : Anomalous gravity of ith datum measured in mGal.
• Err 𝑖 : Standard deviation of Grav𝑛 . This represents the absolute error. It must be positive and non-zero.
NOTE: It should be noted that the data are extracted anomalies which are derived by removing the regional from the
field measurements. Furthermore, the inversion program assumes that the anomalies are produced by a density contrast
distribution in g/cm 3 with mesh cells in meters. Therefore, it is crucial that the data be prepared in mGal.
Example

5.1.5 Gravity gradiometry observations: GIF file
This file is used to specify the observation locations and observed gravity gradiometry anomalies with estimated standard deviation. The output of the forward modelling program ggfor3d has the same structure except that the column
of standard deviations for the error is omitted. This data file is quite similar to the gravity data style except with a
component header. Lines starting with ! are comments. The following is the GIF-formatted file structure of a gravity
observations file:
Parameter definitions:

5.1. Data
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• comp: Two-letter flag(s) for the data types: xx, xy, xz, yy, yz, zz. This is proceeded by the flag datacomp=.
Multiple components can be separated by anything, but must only take up one character (e.g., a comma or a
space).
• nloc: Number of locations.
• E, N, ELEV: Easting, northing, and elevation of the observation, measured in meters.
• gg 𝑛𝐶𝑜𝑚𝑝
: Anomalous (//(j^{th}//) component of the gravity gradient at the //(i^{th}//) location measured in
𝑖
Eotvos.
• Stn 𝑛𝐶𝑜𝑚𝑝
: Standard deviation of the (//(j^{th}//) component of the gravity gradient at the //(i^{th}//) location.
𝑖
It must be positive and non-zero.
NOTE: The program package assumes a density contrast distribution in g/cm 3 with mesh cells in meters. Therefore,
it is crucial that the data be prepared in Eotvos.
Example 1
Below is an example of observations of the vertical gradient only (Gzz):
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Example 2
Below is an example of the gravity gradient observations with all six components:

5.1.6 DC/IP 2D Locations file
This file contains the electrode locations for DCIPF2D. The electrodes file follows the same formats at the Observations
files, but without data and standard deviations. Thus, an electrode file can have three different formats: the general,
surface, or simple format. Only a single format is allowed in a data file. The general format is the only format
that will allow the use of borehole locations. The type of format chosen for forward modelling does not make any
difference to the DCIPF2D and is determined only by the user’s preference. At the beginning of execution, the programs
will determine the format and the output files will be written in the same format.
General format
The forward modelling code DCIPF2D can handle arbitrary electrode configurations, and a mixture of different configurations can be present in the data file. This is accomplished by specifying the locations of four electrodes for each
location. Whenever the two current electrodes, or two potential electrodes, are given the identical location, that particular pair is considered to be a single pole with the negative electrode being at infinity. The format consists of a line
with the current electrode location and number of potential electrode locations associated with it. Each location has 𝑥
and 𝑧 coordinates. An example of the format file structure is as follows:
1.

5.1. Data
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1.

1. 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 1, Type of IP data is apparent chargeability
2. 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 2, Type of IP data is secondary potentials
𝐴𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode A
𝐴𝑧𝑖 : i𝑡ℎ elevation of current electrode A
𝐵𝑖𝑥 : i𝑡ℎ horizontal position along line of current electrode B
𝐵𝑖𝑧 : i𝑡ℎ elevation of current electrode B
𝑀𝑗𝑥 : j𝑡ℎ horizontal position along line of potential electrode M associated with the i𝑡ℎ current pair
𝑀𝑗𝑧 : j𝑡ℎ elevation of potential electrode M associated with the i𝑡ℎ current pair
𝑁𝑗𝑥 : j𝑡ℎ horizontal position along line of potential electrode N associated with the i𝑡ℎ current pair
𝑁𝑗𝑧 : j𝑡ℎ elevation of potential electrode N associated with the i𝑡ℎ current pair
Example of general format
The following is an example of locations for DC data (e.g., no IPTYPE):
In the above example, there are two current electrode locations, the first with six potential electrodes and the second
with two potential electrode data. The line “IPTYPE=2” would be added if this file were IP data of second potentials.
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Surface format
The surface format is similar to the general format with difference that the elevation data is not given. Instead, the
program places the electrodes on top of the discretized topographic surface. Accordingly, this format cannot be used
with borehole data and if no topography is given, assumes the data are on top of the mesh at an elevation of 0.
Whenever the two current electrodes, or two potential electrodes, are given the identical location, that particular pair
is considered to be a single pole with the negative electrode being at infinity. The format consists of a line with the
current electrode location and number of potential electrode locations associated with it. An example of the format file
structure is as follows:

The following are detailed summaries of components of the surface-format observations file:
1. 𝐶𝑜𝑚𝑚𝑒𝑛𝑡 𝑙𝑖𝑛𝑒: Any comments can go here. This line is ignored by dcipf2d and must have a preceding “!”
2. ’number of sources’: integer number giving the totla number of sources in the file.
5.1. Data
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3. 𝐼𝑃 𝑇 𝑌 𝑃 𝐸: Only used for IP inversion and not required if only using DC inversion. NOTE: If omitted from IP
inversion, the program will choose 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 1.
• 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 1, Type of IP data is apparent chargeability
• 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 2, Type of IP data is secondary potentials
4. 𝐴𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode A
5. 𝐵𝑖𝑥 : i𝑡ℎ horizontal position along line of current electrode B
6. 𝑀𝑗𝑥 : j𝑡ℎ horizontal position along line of potential electrode M associated with the i𝑡ℎ current pair
7. 𝑁𝑗𝑥 : j𝑡ℎ horizontal position along line of potential electrode N associated with the i𝑡ℎ current pair
Example of surface format
The following is an example of IP data in units of apparent chargeability:
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In the above example, there are two current electrode locations, the first with four potential electrodes and the second
with two potential electrode data. The line “IPTYPE=1” would be absent if this file were DC data.
Simple format
The simple format is the most straightforward, but also most restrictive of the three formats. The elevations are not
given similar to the surface format with difference that the elevation data is not given. Instead, the program places the
electrodes on top of the discretized topographic surface. Accordingly, this format cannot be used with borehole data
and if no topography is given, assumes the locations are on top of the mesh at an elevation of 0. Whenever the two
current electrodes, or two potential electrodes, are given the identical location, that particular pair is considered to be
a single pole with the negative electrode being at infinity. The format consists of a line with the current electrode pair
location and potential electrode location pair. An example of the format file structure is as follows:

The following are detailed summaries of components of the simple-format observations file:
1. 𝐶𝑜𝑚𝑚𝑒𝑛𝑡 𝑙𝑖𝑛𝑒: Any comments can go here. This line is ignored by dcipf2d and must have a preceding “!”
2. 𝐼𝑃 𝑇 𝑌 𝑃 𝐸: Only used for IP inversion and not required if only using DC inversion. NOTE: If omitted from IP
inversion, the program will choose 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 1.
• 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 1, Type of IP data is apparent chargeability
• 𝐼𝑃 𝑇 𝑌 𝑃 𝐸 = 2, Type of IP data is secondary potentials
3. 𝐴𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode A
4. 𝐵𝑖𝑥 : i𝑡ℎ horizontal position along line of current electrode B
5. 𝑀𝑗𝑥 : j𝑡ℎ horizontal position along line of potential electrode M associated with the i𝑡ℎ current pair

5.1. Data
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6. 𝑁𝑗𝑥 : j𝑡ℎ horizontal position along line of potential electrode N associated with the i𝑡ℎ current pair
Example of simple format
The following is an example of the simple format. The data are the same as given in the surface format example; IP
data in units of apparent chargeability:

5.1.7 DC/IP 2D Observations file
This file contains the observed measurements and the associated electrode locations. Both potential data and apparent
chargeability data are stored in the same format. This will be the format of all the data files that are output from
DCIPF2D, and are input to DCINV2D and IPINV2D.
It is assumed that the survey is carried out either along a line in the 𝑥−direction perpendicular to geologic strike or
along a borehole. In the presence of topography, it is assumed that all current and potential electrodes are located along
the line and are placed on the topography at each 𝑥 location. In other words, the programs in the DCIP2D package
will automatically place the electrodes on the surface according to the topography and the 𝑥 location given in the
observations file. Electrodes will be at 𝑧 = 0 if topography is not given (e.g., set to null). The 𝑧 coordinates should be
provided in the observations file when the data are located down a borehole.
The observations file can have three different formats: the General format, Surface format, Simple format format. Only
a single format is allowed in a data file. The general format is the only format that will allow the use of borehole
locations. The type of format chosen to store the data does not make any difference to the DCIP2D program library or
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GIFtools and is determined only by the user’s preference. At the beginning of execution, the programs will determine
the format and the output files will be written in the same format. Standard deviations are optional in each format.
The calculation of the standard deviation within is given below in the detailed summaries of components. All standard
deviations must either be given or not given to be calculated.
General format
The DCIP2D can handle arbitrary electrode configurations, and a mixture of different configurations can be present in
the data file. This is accomplished by specifying the locations of four electrodes for each datum. Whenever the two
current electrodes, or two potential electrodes, are given the identical location, that particular pair is considered to be a
single pole with the negative electrode being at infinity. The format consists of a line with the current electrode location
and number of potential electrode locations associated with it. Each location has 𝑥 and 𝑧 coordinates. An example of
the format file structure is as follows:

• Comment Line: Any comments can go here. This line is ignored by dcinv2d
• COMMON_CURRENT: This flag is given prior to to let the code know that it is a general format file
• IPTYPE: Only used for IP inversion and not required if only using DC inversion.
– IPTYPE = 1: Flag for apparent chargeability IP data
– IPTYPE = 2: Flag for secondary potentials IP data
•

A𝑥𝑖 : i𝑡ℎ

horizontal position along line of current electrode A

• A𝑧𝑖 : i𝑡ℎ elevation of current electrode A
• B𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode B
• B𝑧𝑖 : i𝑡ℎ elevation of current electrode B
• M𝑥𝑗 : j𝑡ℎ horizontal position along line of potential electrode M associated with the i𝑡ℎ current pair
5.1. Data
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• M𝑧𝑗 : j𝑡ℎ elevation of potential electrode M associated with the i𝑡ℎ current pair
• N𝑥𝑗 : j𝑡ℎ horizontal position along line of potential electrode N associated with the i𝑡ℎ current pair
• N𝑧𝑗 : j𝑡ℎ elevation of potential electrode N associated with the i𝑡ℎ current pair
• val𝑗 : j𝑡ℎ observed datum related to the j𝑡ℎ potential pair and i𝑡ℎ current pair. The potential measurements must
be measured value in Volts, or a dimensionless real number (not percentage) for apparent chargeability (potential
is always normalized to unit current amplitude). There are four types of IP data generally in use; two gathered in
the time domain and two gathered in the frequency domain. For small chargeabilities, as is nearly always the case
for earth materials, all data types can be used as input for inversion, and resulting models will have chargeabilities
in the same units.
• stn𝑗 : j𝑡ℎ standard deviation associated with the j𝑡ℎ datum. This is a positive, absolute value (i.e., not a percentage).
Example of general format
The following is an example of DC data (e.g., no IPTYPE):

In the above example, there are two current electrode locations, the first with six potential electrodes and the second
with two potential electrode data. The line IPTYPE=2 would be added if this file were IP data of second potentials.
Surface format
The surface format is similar to the general format with difference that the elevation data is not given. Instead, the
program places the electrodes on top of the discretized topographic surface. Accordingly, this format cannot be used
with borehole data and if no topography is given, assumes the data are on top of the mesh at an elevation of 0.
Whenever the two current electrodes, or two potential electrodes, are given the identical location, that particular pair
is considered to be a single pole with the negative electrode being at infinity. The format consists of a line with the
current electrode location and number of potential electrode locations associated with it. An example of the format file
structure is as follows:
The following are detailed summaries of components of the surface-format observations file:
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• Comment Line: Any comments can go here. This line is ignored by dcinv2d
• IPTYPE: Only used for IP inversion and not required if only using DC inversion.
– IPTYPE = 1: Flag for apparent chargeability IP data
– IPTYPE = 2: Flag for secondary potentials IP dataa
• A𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode A
• B𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode B
• M𝑥𝑗 : j𝑡ℎ horizontal position along line of potential electrode M associated with the i𝑡ℎ current pair
• N𝑥𝑗 : j𝑡ℎ horizontal position along line of potential electrode N associated with the i𝑡ℎ current pair
• val𝑗 : j𝑡ℎ observed datum related to the j𝑡ℎ potential electrode pair and i𝑡 ℎ current electrode pair. The potential
measurements must be measured value in Volts, or a dimensionless real number (not percentage) for apparent
chargeability (potential is always normalized to unit current amplitude). There are four types of IP data generally
in use; two gathered in the time domain and two gathered in the frequency domain. For small chargeabilities,
as is nearly always the case for earth materials, all data types can be used as input for inversion, and resulting
models will have chargeabilities in the same units.
• stn𝑗 : j𝑡ℎ standard deviation associated with the j𝑡ℎ datum. This is a positive, absolute value (not a percentage) in
units of the data.

5.1. Data
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Example of surface format
The following is an example of IP data in units of apparent chargeability:

In the above example, there are two current electrode locations, the first with four potential electrodes and the second
with two potential electrode data. The line IPTYPE=1 would be absent if this file were DC data.
Simple format
The simple format is the most straightforward, but also most restrictive of the three formats. The elevations are not
given similar to the surface format with difference that the elevation data is not given. Instead, the program places the
electrodes on top of the discretized topographic surface. Accordingly, this format cannot be used with borehole data
and if no topography is given, assumes the data are on top of the mesh at an elevation of 0. Whenever the two current
electrodes, or two potential electrodes, are given the identical location, that particular pair is considered to be a single
pole with the negative electrode being at infinity. The format consists of a line with the current electrode pair location
and potential electrode location pair. An example of the format file structure is as follows:

The following are detailed summaries of components of the simple-format observations file:
• Comment Line: Any comments can go here. This line is ignored by
• IPTYPE: Only used for IP inversion and not required if only using DC inversion.
– IPTYPE = 1: Flag for apparent chargeability IP data
– IPTYPE = 2: Flag for secondary potentials IP data
• A𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode A
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• B𝑥𝑖 : i𝑡ℎ horizontal position along line of current electrode B
• M𝑥𝑖 : i𝑡ℎ horizontal position along line of potential electrode M
• N𝑥𝑖 : i𝑡ℎ horizontal position along line of potential electrode N
• val𝑗 : i𝑡ℎ observed datum. The potential measurements must be measured value in Volts, or a dimensionless real
number (not percentage) for apparent chargeability (potential is always normalized to unit current amplitude).
There are four types of IP data generally in use; two gathered in the time domain and two gathered in the frequency
domain. For small chargeabilities, as is nearly always the case for earth materials, all data types can be used as
input for inversion, and resulting models will have chargeabilities in the same units.
• stn𝑗 : i𝑡ℎ standard deviation associated with the i𝑡ℎ datum. This is a positive, absolute value (i.e., not a percentage)
in units of the data.
Example of simple format
The following is an example of the simple format. The data are the same as given in the surface format example; IP
data in units of apparent chargeability:

5.1.8 DCIP3D locations files
Locations file
This file is used to specify current and potential electrode locations required for the forward modelling of DC/IP data.
The locations file has the following structure:
Parameter definitions:
!

Lines starting with ! are comments.

IPTYPE
A special directive that indicates the IP data type. This directive is only required in IP data files.
The IPTYPE enables the IP inversion programs to distinguish the apparent chargeability and other
similar IP measurements from the basic secondary potentials.
• IPTYPE = 1 is commonly used for IP data in which apparent chargeability is well defined (i.e. using
dimensionless apparent chargeability, integrated chargeability, PFE, or phase data acquired using electrode
configurations that do not produce zero crossings in the measured total potential). The following are
some examples of this type of geometry: any pole-pole array (surface or borehole), surface pole-dipole or
dipole-dipole array along the same traverse, gradient arrays where the potential electrodes are parallel to
5.1. Data
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the current electrodes, or borehole pole-dipole or dipole-dipole array with all active electrodes in the same
borehole.
• IPTYPE = 2 is used for secondary potential IP data measured using any electrode geometry. This is typically used when cross-line surface data or cross-hole borehole data are inverted. For these array geometries,
the apparent chargeability cannot be defined since the total potential can be zero.
• The dimensionless apparent chargeabilities (IPTYPE = 1) and the secondary potentials (IPTYPE = 2)
can be mixed in the same file. Thus an IP data file can have several occurrences of IPTYPE. All the data
are treated as the same type following an IPTYPE directive until a new line changes the type.
𝑋𝐴(𝑖), 𝑌 𝐴(𝑖), 𝑍𝐴(𝑖)
Location (X,Y,Z) of the 𝑖𝑡ℎ , current electrode A (measured in metres).
𝑋𝐵(𝑖), 𝑌 𝐵(𝑖), 𝑍𝐵(𝑖)
Location (X,Y,Z) of the 𝑖𝑡ℎ , current electrode B (measured in metres).
𝑋𝑀 (𝑖, 𝑗), 𝑌 𝑀 (𝑖, 𝑗), 𝑍𝑀 (𝑖, 𝑗)
Location (X,Y,Z) of the 𝑗 𝑡ℎ potential electrode M, corresponding with the 𝑖𝑡ℎ current electrode or electrode pair
(measured in metres).
𝑋𝑁 (𝑖, 𝑗), 𝑌 𝑁 (𝑖, 𝑗), 𝑍𝑁 (𝑖, 𝑗)
Location of the 𝑗 𝑡ℎ , potential electrode N corresponding with the 𝑖𝑡ℎ current electrode or electrode pair (measured
in metres).
𝑁𝐶
The total number of current electrodes or electrode pairs.
NOTE: The brackets [· · · ] indicate that the enclosed parameter is optional. The Z location of the electrodes is optional
if you are working only with surface data (i.e. your electrodes are draped to topography) and the IPTYPE only needs
to be specified if you are working with IP data.

242

Chapter 5. UBC File formats

GIFtoolsCookbook Documentation, Release 1.0

Examples of a locations file
We provide two example files below. The first file is for a simple surface dataset while the second file shows how
borehole data can be incorporated.
Example of surface data locations:

Example with borehole data locations:

5.1. Data
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5.1.9 DC/IP 3D Observations file
This file contains the observed measurements and the associated electrode locations. Both potential data and apparent
chargeability data are stored in the same format. This will be the format of all the data files that are output from and to
DCIP3D. For convenience, there are two slightly different file formats: the General format and Surface format formats.
The two data formats cannot be mixed in one file. Both formats are consistent the two-dimensional version of the code
() except for the addition of a 𝑦 location. Any comments for either format are given in the beginning and denoted by !
prior to the comment.
NOTE: The output of the forward modelling programs DCIP3DF DCIPoctreeFwd does not quite have the correct
format to be considered an observation file since the final column which is supposed to contain standard deviations for
the error is instead replaced with computed apparent conductivities/chargeabilities.
General format
A mixture of different configurationsat any electrode location and configuration can be present in the data file. This is
accomplished by specifying the locations of four electrodes for each datum. Whenever the two current electrodes, or
two potential electrodes, are given the identical location, that particular pair is considered to be a single pole with the
negative electrode being at infinity. It should be noted that if this format is used and topography is desired, then the
topography format used must be GIF discrete topography file. The format consists of a line with the current electrode
location and number of potential electrode locations associated with it. An example of the format file structure is below.

The following are detailed summaries of components of the standard-format observations file:
• IPTYPE: Only used for IP inversion and not required if only using DC inversion.
– IPTYPE = 1: Flag for apparent chargeability IP data
– IPTYPE = 2: Flag for secondary potentials IP data
•
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• A𝑦𝑖 : i𝑡ℎ northing position (𝑦) of current electrode A
• A𝑧𝑖 : i𝑡ℎ vertical position (𝑧) of current electrode A
• B𝑥𝑖 : i𝑡ℎ easting position (𝑥) current electrode B
• B𝑦𝑖 : i𝑡ℎ northing position (𝑦) of current electrode B
• B𝑧𝑖 : i𝑡ℎ vertical position (𝑧) of current electrode B
• M𝑥𝑗 : j𝑡ℎ easting position (𝑥) of potential electrode M associated with the i𝑡ℎ current pair
• M𝑦𝑗 : j𝑡ℎ northing position (𝑦) of potential electrode M associated with the i𝑡ℎ current pair
• M𝑧𝑗 : j𝑡ℎ vertical position (𝑧) of potential electrode M associated with the i𝑡ℎ current pair
• N𝑥𝑗 : j𝑡ℎ easting position (𝑥) of potential electrode N associated with the i𝑡ℎ current pair
• N𝑦𝑗 : j𝑡ℎ northing position (𝑦) of potential electrode N associated with the i𝑡ℎ current pair
• N𝑧𝑗 : j𝑡ℎ vertical position (𝑧) of potential electrode N associated with the i𝑡ℎ current pair
• val𝑗 : j𝑡ℎ observed datum related to the j𝑡ℎ potential electrode pair and i𝑡 ℎ current electrode pair. The potential
measurements must be measured value in Volts, or a dimensionless real number (not percentage) for apparent
chargeability (potential is always normalized to unit current amplitude). There are four types of IP data generally
in use; two gathered in the time domain and two gathered in the frequency domain. For small chargeabilities,
as is nearly always the case for earth materials, all data types can be used as input for inversion, and resulting
models will have chargeabilities in the same units.
• stn𝑗 : j𝑡ℎ j𝑡ℎ standard deviation associated with the j𝑡ℎ datum. This is a positive, absolute value (i.e., not a
percentage).
Example of general format
The following is an example of DC data (e.g., no IPTYPE):

In the above example, there are two current electrode locations, the first with six potential electrodes and the second
with two potential electrode data. The line IPTYPE=2 would be added if this file were IP data of second potentials.

5.1. Data
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Surface format
The surface format is similar to the general format with difference that the elevation data is not given. Instead, the
program places the electrodes on top of the discretized topographic surface. Accordingly, this format cannot be used
with borehole data and if no topography is given, assumes the data are on top of the mesh. Whenever the two current
electrodes, or two potential electrodes, are given the identical location, that particular pair is considered to be a single
pole with the negative electrode being at infinity. The format consists of a line with the current electrode location and
number of potential electrode locations associated with it. This format can be used with any topography type. An
example of the format file structure is as follows:

The following are detailed summaries of components of the surface-format observations file:
• IPTYPE: Only used for IP inversion and not required if only using DC inversion.
– IPTYPE = 1: Flag for apparent chargeability IP data
– IPTYPE = 2: Flag for secondary potentials IP data
•

A𝑥𝑖 : i𝑡ℎ

easting position (𝑥) of current electrode A

•

A𝑦𝑖 : i𝑡ℎ

northing position (𝑦) of current electrode A

•

B𝑥𝑖 : i𝑡ℎ

easting position (𝑥) current electrode B

•

B𝑦𝑖 : i𝑡ℎ

northing position (𝑦) of current electrode B

•

M𝑥𝑗 : j𝑡ℎ

easting position (𝑥) of potential electrode M associated with the i𝑡ℎ current pair

• M𝑦𝑗 : j𝑡ℎ northing position (𝑦) of potential electrode M associated with the i𝑡ℎ current pair
• N𝑥𝑗 : j𝑡ℎ easting position (𝑥) of potential electrode N associated with the i𝑡ℎ current pair
• N𝑦𝑗 : j𝑡ℎ northing position (𝑦) of potential electrode N associated with the i𝑡ℎ current pair
• val𝑗 : j𝑡ℎ observed datum related to the j𝑡ℎ potential electrode pair and i𝑡 ℎ current electrode pair. The potential
measurements must be measured value in Volts, or a dimensionless real number (not percentage) for apparent
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chargeability (potential is always normalized to unit current amplitude). There are four types of IP data generally
in use; two gathered in the time domain and two gathered in the frequency domain. For small chargeabilities,
as is nearly always the case for earth materials, all data types can be used as input for inversion, and resulting
models will have chargeabilities in the same units.
• stn𝑗 : j𝑡ℎ j𝑡ℎ standard deviation associated with the j𝑡ℎ datum. This is a positive, absolute value (i.e., not a
percentage).
Example of surface format
The following is an example of IP data in units of apparent chargeability:

In the above example, there are two current electrode locations, the first with four potential electrodes and the second
with two potential electrode data. The line IPTYPE=1 would be absent if this file were DC data.

5.1.10 Borehole collar file format
GIFtools assumes that the borehole collar file is in either the XYZ or CSV file format. The file must have the at least
the following information (but not necessarily these specific names or order):
1. Hole_ID: If the hole ID names require a space, then a CSV file should be used. These identifications can be
numeric or characters (with no quotes), but should be consistent with the survey and property files.
2. Easting: East coordinate in metres (may be local coordinate system)
3. Northing: North coordinate in metres (may be local coordinate system)
4. Elevation: Elevation in metres (z+ up) of the collar
5. Length: Length of the borehole in metres

5.1. Data
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Example
Below is a sample collar file (CSV format) where “hole” is the Hole_ID and “depth” is the Length:

5.1.11 Borehole survey file format
GIFtools assumes that the borehole survey file is in either the XYZ or CSV file format. If the file is not given during the
borehole data import, than GIFtools assumes the boreholes are vertical. The file must have the at least the following
information (but not necessarily these specific names or order):
1. Hole_ID: If the hole ID names require a space, then a CSV file should be used. These identifications can be
numeric or characters (with no quotes), but should be consistent with the collar and property files.
2. Length: Length of observation down the borehole
3. Azimuth: Azimuth of the borehole trace at the downhole length in degrees. 90\(^o\) is North.
4. Dip: Dip of the borehole trace at the downhole length in degrees. Dip is from horizontal: -90\(^o\) is vertical
and 0\(^o\) is a horizontal trace.
Example
Below is a sample survey file (XYZ format) where “HID” is the Hole_ID and “DEPTH” is the Length:
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5.1.12 Borehole property file format
GIFtools assumes that the borehole property file is in either the XYZ or CSV file format. This file requires either the
length downhole for point measurements or two columns defining the start/end to the observation section. The file may
contain multiple properties that would be set in the input/output header later in GIFtools. It is possible to import an
integer field that describes geology or characters (e.g., “PK” or “Pyroclastic Kimberlite” if a CSV file). The file must
have the at least the following information (but not necessarily these specific names or order):
1. Hole_ID: If the hole ID names require a space, then a CSV file should be used. These identifications can be
numeric or characters (with no quotes), but should be consistent with the collar and survey files.
2. Length: Length of observation down the borehole OR
3. Depth_From: Start of the observation section (if length not given)
4. Depth_To: End of the observation section (if length not given)
Examples
Example 1: Length
Below is a sample borehole property file (XYZ format) where “ID” is the Hole_ID three properties can be imported
(SI, G/CC, and S/M):

Example 1: Depth section
Below is a sample borehole property file (XYZ format) where “HID” is the Hole_ID and “FROM” is the Depth_From,
“TO” is the Depth_to (note NaN are the values of no data):

5.1. Data

249

GIFtoolsCookbook Documentation, Release 1.0

5.1.13 Miscellaneous property file format
A miscellaneous property file is in either the XYZ or CSV file format. This file simply requires the spatial coordinates
and then can contain any information (numeric or character). The file must have the the following information (but not
necessarily these specific names or order):
1. Easting: The easting coordinate (can be local) in metres
2. Northing: The northing coordinate (can be local) in metres
3. Elevation: The elevation in metres
Examples
Below is a sample property file (XYZ format) giving the drill outline of a kimberlite:

5.1.14 FEM data: GIF file
This file is used to specify the transmitters and associated data for a Frequency-domain ElectroMagnetic (FEM) survey.
The file is broken down based on the transmitters and requires all data types be present (although they may be filled
with an ignore value; see below). The convention is z+down and x+ East and y+ North. Comment lines begin with !.
The data line contains 27 columns (x,y,z,E data and H data with uncertainties), but may be filled with ignore flags to
denote using only certain data types. Below is the general format:
Parameter definitions:
• flg: Any string/value that does not contain actual data. By default, GIFtools will export NaN as the ignore value.
The flag IGNORE preceeds this input.
• ntrxTimesNfreq: Number of transmitters multiplied by the number of frequencies. The flag N_TRX preceeds
this input.
• TRX_FLAG: The \(i^{th}\) transmitter. This line contains the specific transmitter flag and block defining the
transmitter. See GIF EM transmitters for specifications on formatting different transmitters.
• frq: The frequency of the following receivers for the given transmitter. The flag FREQUENCY preceeds this input.
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• nRec: Number of receivers associated with the frequency given above for the given (\(i^{th}\)) transmitter. The
flag N_RECV preceeds this input.
• 𝑋[𝑖,𝑗,𝑘] : Easting (m) of the \(k^{th}\) receiver at the \(j^{th}\) frequency for the \(i^{th}\) transmitter.
• 𝑌[𝑖,𝑗,𝑘] : Northing (m) of the \(k^{th}\) receiver at the \(j^{th}\) frequency for the \(i^{th}\) transmitter.
• 𝑍[𝑖,𝑗,𝑘] : Elevation (m) of the \(k^{th}\) receiver at the \(j^{th}\) frequency for the \(i^{th}\) transmitter.
• Edata: 12 columns containing electric-field data and their uncertainties of the \(k^{th}\) receiver at the \(j^{th}\)
frequency for the \(i^{th}\) transmitter (in order):
– 𝐸𝑥𝑟 : Real part of the electric-field component in the Easting direction.
– 𝐸𝑥𝑟𝑠𝑡𝑛 : Standard deviation of the real part of the electric-field component in the Easting direction. This
must be a positive, non-zero number.
– 𝐸𝑥𝑖 : Imaginary part of the electric-field component in the Easting direction.
– 𝐸𝑥𝑖𝑠𝑡𝑛 : Standard deviation of the imaginary part of the electric-field component in the Easting direction.
This must be a positive, non-zero number.
– 𝐸𝑦 𝑟 : Real part of the electric-field component in the Northing direction.
𝑟
– 𝐸𝑦𝑠𝑡𝑛
: Standard deviation of the real part of the electric-field component in the Northing direction. This
must be a positive, non-zero number.

– 𝐸𝑦 𝑖 : Imaginary part of the electric-field component in the Northing direction.
𝑖
: Standard deviation of the imaginary part of the electric-field component in the Northing direction.
– 𝐸𝑦𝑠𝑡𝑛
This must be a positive, non-zero number.

– 𝐸𝑧 𝑟 : Real part of the vertical electric-field component.
𝑟
: Standard deviation of the real part of the vertical electric-field component. This must be a positive,
– 𝐸𝑧𝑠𝑡𝑛
non-zero number.

– 𝐸𝑧 𝑖 : Imaginary part of the vertical electric-field component.
𝑖
– 𝐸𝑧𝑠𝑡𝑛
: Standard deviation of the imaginary part of the vertical electric-field component. This must be a
positive, non-zero number.

• Hdata: 12 columns containing magnetic-field data and their uncertainties of the \(k^{th}\) receiver at the
\(j^{th}\) frequency for the \(i^{th}\) transmitter (in order):
– 𝐻𝑥𝑟 : Real part of the magnetic-field component in the Easting direction.
– 𝐻𝑥𝑟𝑠𝑡𝑛 : Standard deviation of the real part of the magnetic-field component in the Easting direction. This
must be a positive, non-zero number.
– 𝐻𝑥𝑖 : Imaginary part of the magnetic-field component in the Easting direction.
– 𝐻𝑥𝑖𝑠𝑡𝑛 : Standard deviation of the imaginary part of the magnetic-field component in the Easting direction.
This must be a positive, non-zero number.
– 𝐻𝑦 𝑟 : Real part of the magnetic-field component in the Northing direction.
𝑟
– 𝐻𝑦𝑠𝑡𝑛
: Standard deviation of the real part of the magnetic-field component in the Northing direction. This
must be a positive, non-zero number.

– 𝐻𝑦 𝑖 : Imaginary part of the magnetic-field component in the Northing direction.
𝑖
– 𝐻𝑦𝑠𝑡𝑛
: Standard deviation of the imaginary part of the magnetic-field component in the Northing direction. This must be a positive, non-zero number.

– 𝐻𝑧 𝑟 : Real part of the vertical magnetic-field component.

252

Chapter 5. UBC File formats

GIFtoolsCookbook Documentation, Release 1.0

𝑟
– 𝐻𝑧𝑠𝑡𝑛
: Standard deviation of the real part of the vertical magnetic-field component. This must be a
positive, non-zero number.

– 𝐻𝑧 𝑖 : Imaginary part of the vertical magnetic-field component.
𝑖
– 𝐻𝑧𝑠𝑡𝑛
: Standard deviation of the imaginary part of the vertical magnetic-field component. This must be
a positive, non-zero number.

NOTE: Each FREQUENCY flag must be preceded by the transmitter definition, regardless of whether it is the same as
the previous transmitter. See the DIGHEM example below.
Examples
The following are two examples of data files.
Example 1: One transmitter (large loop) at two frequencies of 10 Hz and 50 Hz and one receiver location:

Example 2: Co-planar DIGHEM data example. Two transmitters (two loops) at the frequencies of 900, 7200, and
56000 Hz with with only Hz real and imaginary (and standard deviations) given:

5.1.15 TEM data: GIF file
This file is used to specify the transmitters and associated data for a Time-domain ElectroMagnetic (TEM) survey. The
file is broken down based on the transmitters and requires all data types be present (although they may be filled with
an ignore value; see below). The convention is z+down and x+ East and y+ North. Comment lines begin with !. The
data line contains 27 columns (x, y, z, E, H, and dB/dt data with uncertainties), but may be filled with ignore flags to
denote using only certain data types. Below is the general format:

Parameter definitions:
• flg: Any string/value that does not contain actual data. By default, GIFtools will export NaN as the ignore value.
The flag IGNORE preceeds this input.
5.1. Data
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• ntx: Number of transmitters. The flag N_TRX preceeds this input.
• TRX_FLAG: The \(i^{th}\) transmitter. This line contains the specific transmitter flag and block defining the
transmitter. See GIF EM transmitters for specifications on formatting different transmitters.
• nRec: Number of receivers for the \(i^{th}\) transmitter. The flag N_RECV preceeds this input.
• nTime: The number of time channels for the \(j^{th}\) receiver associated with the \({i^{th}\) transmitter. The
flag N_TIMES preceeds this input.
• 𝑋[𝑖,𝑗,𝑘] : Easting (m) of the \(j^{th}\) receiver at the \(k^{th}\) time for the \(i^{th}\) transmitter.
• 𝑌[𝑖,𝑗,𝑘] : Northing (m) of the \(j^{th}\) receiver at the \(k^{th}\) time for the \(i^{th}\) transmitter.
• 𝑍[𝑖,𝑗,𝑘] : Elevation (m) of the \(j^{th}\) receiver at the \(k^{th}\) time for the \(i^{th}\) transmitter.
• 𝑇 𝑖𝑚𝑒: Time (sec) of the observation.
• Edata: 6 columns containing electric-field data aligning with the cartesian coordinate system and their uncertainties \(j^{th}\) receiver at the \(k^{th}\) time for the \(i^{th}\) transmitter (in order):
– 𝐸𝑥: Electric-field component in the Easting direction.
– 𝐸𝑥𝑠𝑡𝑛 : Standard deviation of the electric-field component in the Easting direction. This must be a positive,
non-zero number.
– 𝐸𝑦: Electric-field component in the Northing direction.
– 𝐸𝑦𝑠𝑡𝑛 : Standard deviation of the electric-field component in the Northing direction. This must be a positive, non-zero number.
– 𝐸𝑧: Vertical component of the electric-field.
– 𝐸𝑧𝑠𝑡𝑛 : Standard deviation of the vertical component of the electric-field. This must be a positive, non-zero
number.
• Hdata: 6 columns containing magnetic-field data aligning with the cartesian coordinate system and their uncertainties \(j^{th}\) receiver at the \(k^{th}\) time for the \(i^{th}\) transmitter (in order):
– 𝐻𝑥: Magnetic-field component in the Easting direction.
– 𝐻𝑥𝑠𝑡𝑛 : Standard deviation of the magnetic-field component in the Easting direction. This must be a
positive, non-zero number.
– 𝐻𝑦: Magnetic-field component in the Northing direction.
– 𝐻𝑦𝑠𝑡𝑛 : Standard deviation of the magnetic-field component in the Northing direction. This must be a
positive, non-zero number.
– 𝐻𝑧: Vertical component of the magnetic-field.
– 𝐻𝑧𝑠𝑡𝑛: Standard deviation of the vertical component of the magnetic-field. This must be a positive,
non-zero number.
• dBdTdata: 6 columns containing 𝜕𝐵/𝜕𝑡 data aligning with the cartesian coordinate system and their uncertainties \(j^{th}\) receiver at the \(k^{th}\) time for the \(i^{th}\) transmitter (in order):
– 𝜕𝐵/𝜕𝑡𝑥 : Derivative the B-field in the Easting direction.
– 𝜕𝐵/𝜕𝑡𝑠𝑡𝑛
𝑥 : Standard deviation of the derivative the B-field in the Easting direction. This must be a positive,
non-zero number.
– 𝜕𝐵/𝜕𝑡𝑦 : Derivative the B-field in the Northing direction.
– 𝜕𝐵/𝜕𝑡𝑠𝑡𝑛
𝑦 : Standard deviation of the derivative the B-field in the Northing direction. This must be a
positive, non-zero number.
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– 𝜕𝐵/𝜕𝑡𝑧 : Vertical component of the derivative the B-field.
– 𝜕𝐵/𝜕𝑡𝑠𝑡𝑛
𝑧 : Standard deviation of the vertical component of the derivative the B-field. This must be a
positive, non-zero number.
Examples
Example 1: The following is an example with 2 vertical magnetic dipole transmitters, each with 1 receiver recording
at 19 time channels. Only the 𝜕𝐵/𝜕𝑡𝑧 data and its uncertainty are given:

Example 2:: The second example is from a UTEM survey. The large loop is given by 20 locations, has 2 receivers
recording at 9 time channels. Only the 𝜕𝐵/𝜕𝑡𝑧 data and its uncertainty are given and some early times are not recorded
and thus would be ignored:

5.1. Data
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5.1.16 EM transmitter formats
This “block” format will be used for describing EM transmitters within FEM and TEM data files. The types of EM
transmitters available are:
• Large-loop,
• Line-current,
• Dipole, and
• Loop
Large-loop transmitter
A large-loop transmitter, also known as the “original” distributed current source-closed loops or grounded wires. Below
is an example of the closed loop. The block is started by the flag TRX_ORIG:

The parameters given are: - 𝑁 : Number of unique locations defining the transmitter (+1 added for the closed loop) 𝑋𝑖 : Easting (m) of \(i^{th}//) transmitter location - 𝑌𝑖 : Northing (m) of \(i^{th}\) transmitter location - 𝑍𝑖 : Elevation
(m) of \(i^{th}\) transmitter location
NOTES: The last value is a repeat of the first value to “close” the loop. The source is described by the number of nodes
(must have at least 4) where 4 denote a groundwire and > 4 is a closed loop. The current in the transmitter is assumed
to be 1 Ampere.
Line-current transmitter
A line transmitter is an analytical general closed loop of line currents. It is designed to handle arbitrary complex
transmitters with user defined number of nodes. The format for this source type is same as above; the difference is in
how the transmitter currents are handled. The block is started by the flag TRX_LINES:
The parameters given are:
• N: Number of unique locations defining the transmitter
• 𝑋𝑖 : Easting (m) of \(i^{th}\) transmitter location
• 𝑌𝑖 : Northing (m) of \(i^{th}\) transmitter location
• 𝑍𝑖 : Elevation (m) of \(i^{th}\) transmitter location
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Dipole transmitter
There are two different types of dipole transmitters: magnetic and electric. The flags for each of these are respectively
TRX_MAGNETIC_DIPOLE and TRX_ELECTRIC_DIPOLE. Below is an example of an magnetic dipole:

The parameters given are:
• 𝑋: Easting (m) location of the transmitter
• 𝑌 : Northing (m) location of the transmitter
• 𝑍: Elevation (m) location of the transmitter
• 𝜃: vertical angle in degrees from z+ up.
• 𝛼: angle in degrees from y+ north.
• 𝑀 : Moment of the dipole in SI units (could be one if the data are normalized)
NOTE: A vertical dipole (z+ up) is defined by \( \theta = \alpha = 0\).
Loop transmitter
A transmitter defined by an analytical circular loop. This type of transmitter is a good approximation for airborne
systems (VTEM, HeliGEOTEM, AeroTEM, etc.). The flag is TRX_LOOP and the block is defined as:

The parameters given are:
• 𝑋: Easting (m) location of the transmitter
• 𝑌 : Northing (m) location of the transmitter
• 𝑍: Elevation (m) location of the transmitter
• 𝑅: Radius (m) of the loop

5.1. Data
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• 𝜃: vertical angle in degrees from z+ up.
• 𝛼: angle in degrees from y+ north.
NOTE: A loop parallel to the xy plane is \( \theta = \alpha = 0\).

5.1.17 MT / ZTEM data: E3DMT version 1
Formatting and examples for E3DMT version 1 data files can be found here:
• Observations file
• Predicted data file
• Survey and locations file
• Supporting theory

5.1.18 MT / ZTEM data: E3DMT version 2
Formatting and examples for E3DMT version 2 data files can be found here:
• Observations file
• Predicted data file
• Survey index file
• Receiver file
• Supporting theory

5.1.19 MT / ZTEM data: MTZ3D GIF file
This file is the structure for MT and/or ZTEM data associated with the inversion program MTZ3D. The type of data is
set by a data flag. Data that should be ignored are denoted by an i. The general format is:
Parameter definitions:
• DT: The data type flag. The flag DATATYPE preceeds this input. The options for the data flag are:
– MTZ: MT data; impedance data with both imaginary and real parts.
– MTR: MT data; apparent resitivities and phases
– MTT: ZTEM data; real and imaginary tipper functions is absolute ratio. Hx and Hy are constant at
the reference (base) station location. This is the most typical flag for ZTEM data.
– MTB: Both MT and ZTEM data; ZTEM data is denoted by providing a reference (base) station after
the frequency declaration.
• flg: Any value that does not contain actual data. By default, GIFtools will export NaN as the ignore value. The
flag IGNORE preceeds this input.
• FREQ: The frequency for the data type.
• nRec: Number of receivers associated with the given frequency.
• [𝐵𝑎𝑠𝑒𝑋[𝑗,𝑘] ...]: This line is only present for ZTEM data. The line consists of the (X,Y,Z) for the base station
followed by “i” (usually 8 columns) for the number of data columns given on the next line.
• [𝑋[𝑗,𝑘] ...]: Easting (m) of the \(k^{th}\) receiver for the \(j^{th}\) data type.
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• [𝑌[𝑗,𝑘] ...]: Northing (m) of the \(k^{th}\) receiver for the \(j^{th}\) data type.
• [𝑍[𝑗,𝑘] ...]: Elevation (m) of the \(k^{th}\) receiver for the \(j^{th}\) data type.
• data: Columns of data / uncertainty pairs depending upon the data type:
– Impedence MT data: The 16 data columns are in MT coordinates (X+ north, Y+ East, Z+ down) and
consist of the following in order:
∗ 𝑍𝑋𝑋 𝑟 : Real part of the ZXX component
𝑟
∗ 𝑍𝑋𝑋𝑠𝑡𝑛
: Standard deviation of the real part of the ZXX component

∗ 𝑍𝑋𝑋 𝑖 : Imaginary part of the ZXX component
𝑖
∗ 𝑍𝑋𝑋𝑠𝑡𝑛
: Standard deviation of the imaginary part of the ZXX component

∗ 𝑍𝑋𝑌 𝑟 : Real part of the ZXY component
𝑟
∗ 𝑍𝑋𝑌𝑠𝑡𝑛
: Standard deviation of the real part of the ZXY component

∗ 𝑍𝑋𝑌 𝑖 : Imaginary part of the ZXY component
𝑖
: Standard deviation of the imaginary part of the ZXY component
∗ 𝑍𝑋𝑌𝑠𝑡𝑛

∗ 𝑍𝑌 𝑋 𝑟 : Real part of the ZYX component
𝑟
∗ 𝑍𝑌 𝑋𝑠𝑡𝑛
: Standard deviation of the real part of the ZYX component

∗ 𝑍𝑌 𝑋 𝑖 : Imaginary part of the ZYX component
𝑖
: Standard deviation of the imaginary part of the ZYX component
∗ 𝑍𝑌 𝑋𝑠𝑡𝑛

∗ 𝑍𝑌 𝑌 𝑟 : Real part of the ZYY component
𝑟
∗ 𝑍𝑌 𝑌𝑠𝑡𝑛
: Standard deviation of the real part of the ZYY component

∗ 𝑍𝑌 𝑌 𝑖 : Imaginary part of the ZYY component
𝑖
: Standard deviation of the imaginary part of the ZYY component
∗ 𝑍𝑌 𝑌𝑠𝑡𝑛

– Apparent resistivity / phase MT data: The 16 data columns consist of the following in order (phase in
degrees and apparent resistivity in Ohm-m):
∗ 𝑍𝑋𝑋 𝑟 : ZXX component of apparent resistivity
𝑟
: Standard deviation of the ZXX component of apparent resistivity
∗ 𝑍𝑋𝑋𝑠𝑡𝑛

∗ 𝑍𝑋𝑋 𝑝 : ZXX component of phase
𝑝
∗ 𝑍𝑋𝑋𝑠𝑡𝑛
: Standard deviation of the ZXX component of phase

∗ 𝑍𝑋𝑌 𝑟 : ZXY component of apparent resistivity
𝑟
∗ 𝑍𝑋𝑌𝑠𝑡𝑛
: Standard deviation of the ZXY component of apparent resistivity

∗ 𝑍𝑋𝑌 𝑝 : ZXY component of phase
𝑝
∗ 𝑍𝑋𝑌𝑠𝑡𝑛
: Standard deviation of the ZXY component of phase

∗ 𝑍𝑌 𝑋 𝑟 : ZYX component of apparent resistivity
𝑟
∗ 𝑍𝑌 𝑋𝑠𝑡𝑛
: Standard deviation of the ZYX component of apparent resistivity

∗ 𝑍𝑌 𝑋 𝑝 : ZYX component of phase
𝑝
∗ 𝑍𝑌 𝑋𝑠𝑡𝑛
: Standard deviation of the ZYX component of phase

∗ 𝑍𝑌 𝑌 𝑟 : ZYY component of apparent resistivity
𝑟
∗ 𝑍𝑌 𝑌𝑠𝑡𝑛
: Standard deviation of the ZYY component of apparent resistivity
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∗ 𝑍𝑌 𝑌 𝑝 : ZYY component of phase
𝑝
∗ 𝑍𝑌 𝑌𝑠𝑡𝑛
: Standard deviation of the ZYY component of phase

– ZTEM data: The 8 data columns are in MT coordinates (X+ north, Y+ East, Z+ down) and consist of the
following in order:
∗ 𝑍𝑋𝑌 𝑟 : Real part of the ZXY component
𝑟
∗ 𝑍𝑋𝑌𝑠𝑡𝑛
: Standard deviation of the real part of the ZXY component

∗ 𝑍𝑋𝑌 𝑖 : Imaginary part of the ZXY component
𝑖
∗ 𝑍𝑋𝑌𝑠𝑡𝑛
: Standard deviation of the imaginary part of the ZXY component

∗ 𝑍𝑌 𝑋 𝑟 : Real part of the ZYX component
𝑟
∗ 𝑍𝑌 𝑋𝑠𝑡𝑛
: Standard deviation of the real part of the ZYX component

∗ 𝑍𝑌 𝑋 𝑖 : Imaginary part of the ZYX component
𝑖
∗ 𝑍𝑌 𝑋𝑠𝑡𝑛
: Standard deviation of the imaginary part of the ZYX component

NOTE: When using the MTB flag for both data, the locations will include both MT and then ZTEM data and must be
in impedances. Therefore, MT data would follow with 8 columns of the ignore flag and ZTEM data would have 16
columns of ignore flag prior to data (see example 3 below).
Examples
The following are two examples of data files.
Example 1: Off-diagonal (ZXY and ZYX) impedance MT data at 3 frequencies (100, 10, and 1 Hz) with 2 observations
each for brevity:

Example 2: ZTEM data at 2 frequencies (30 and 45 Hz) with 3 observations each with a single base station:

Example 3: MT and ZTEM data (combining example 1 and example 2). Note that the MT data comes first and then
the ZTEM data:

5.1. Data
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5.2 Topography
5.2.1 2D GIF topography file
This file is used to define the surface topography of a 2D mesh/model by the elevation at different locations along the
line, primarily for DCIP2D. It should be noted that, in the 2D case, the mesh file is linked to the topography. The
specification of the top elevation, elev0, sets the top of the mesh. In other words, elev0 in the topography is the top
of the mesh and where \( z=0 \). This point is assumed to be the highest point on the topographic surface. Locations
above elev0 on the surface are set to elev0. The elevation is positive up file and thus it can be given in relative values.
For DCIP2D, the topography file must cover the core portion of the mesh where electrodes are placed. The coverage
should ideally extend to both ends of the mesh, otherwise the remaining portion towards the ends will be assumed to
have the same surface elevation in each direction as given at the end points within the file. The topographic surface
is discretized onto the mesh using the elevations at the horizontal nodes that are obtained by linear interpolation from
this file. The 2D topography file has the following general structure:

Parameter definitions:
• N: Number of points defining the topographic profile.
• elev0: The elevation of the top of the 2D mesh. See above for details.
• X𝑖 : 𝑖𝑡ℎ horizontal location.
• elev𝑖 : Elevation (metres) at X𝑖
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Example:
The following is an example of a 2D topography file. There are 10 locations that vary in elevation from 10 to 50 m.
The two locations above 40 m (elev0) will be represented as 40 m of elevation within DCIP2D. The top of the mesh
will also be placed at 40 m.

5.2.2 3D GIF topography file
This file is used to define the surface topography of a mesh/model by the elevation at different locations. Lines starting
with ! are comments. The topography file has the following general structure:

Parameter definitions:
• npt: Number of points defining the topographic surface.
• E𝑖 : Easting of the 𝑖𝑡ℎ point on the surface.
• N𝑖 : Northing of the 𝑖𝑡ℎ point on the surface.
• ELEV𝑖 : Elevation (metres) of the 𝑖𝑡ℎ point on the profile.
5.2. Topography
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The lines in this file can be in any order as long as the total number is equal to npt . The topographic data need not be
supplied on a regular grid. GIF inversion codes assume a set of scattered points for generality and use a triangulationbased interpolation to determine the surface elevation above each column of cells. To ensure the accurate discretization
of the topography, it is important that the topographic data be supplied over the entire area above the model and that
the supplied elevation data points are not too sparse.
NOTE 2: Only the cells completely below the (interpolated) topographic surface are kept. The cells above or at the
topographic surface are removed from the model, although these must still be included in the as if they are a part of
the model. For input model files these cells can be assigned any value. The recovered model produced by inversion
program also includes the cells that are excluded from the model, but these cells will have unrealistic values and be set
(e.g., -100, 1e-8, etc).
Example:
The following is an example of a 3D topography file:

5.2.3 GIF discrete topography file
This file is used specifically with DCIP3D to define the surface topography within a mesh by the integer values of the
number of cells from the top of the mesh to the discretized topographic surface. This format is compatible with any
type of DC/IP 3D data set. This file is usually created with the make_wdat executable found in the DC/IP 3D inversion
package and is required for borehole 3D DC/IP data. The format is:

Parameter definitions:
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• NN: Number of cells in the north (\(NN\) from the mesh)
• NE: Number of cells in the north (\(NE\) from the mesh)
• 𝑖𝑛 : 𝑛𝑡ℎ cell in the easting direction, starting with the west-most cells = 1
• 𝑗𝑚 : 𝑚𝑡ℎ cell in the northing direction, starting with the south-most cells = 1
• 𝑘[𝑖𝑛 , 𝑗𝑚 ]: Number of cells from top of the mesh to the topography
The lines in this file can be in any order as long as the total number is equal to \(NE \times NN \). There are no comments
allowed in this file. The value of \(k[i,j]\) indicates the number of cells above the earth’s surface. If the topography
reached the top row of cells in the vertical direction, then \(k[i,j] = 0\). If all values of \(k\) are zero, the topography
would be at the very top of the mesh (i.e., the situation where no topography is given).
Example:
The following is an example of a discrete topography file:

In this example the topography at \((1,2)\) is higher than at \( (2,2) \) by one cell thickness. The mesh consists of 30
cells in the easting, 40 cells in the northing, and at least 7 cells in the vertical direction. If the topography is above the
mesh, then \(k=0\).

5.3 Meshes
5.3.1 1D Mesh file
This is the file used to define a finite difference mesh for 1D modeling and inversion. In the file, the vertical column
representing the earth is divided into layers. By convention, the z-axis is positive down.
An example of the file structure is as follows:
• Number of segments used to define the vertical partitioning
• Column 1: From there, each line defines the layer thickness.
• Column 2 [OPTIONAL]: Model value corresponding to the 𝑖𝑡ℎ layer

5.3. Meshes
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5.3.2 2D Mesh file
This is the file used to define a finite difference mesh for 2D modelling and inversion. In the file, the x-z plane is divided
into a rectangular grid. By convention, the z-axis is positive down. The mesh can be designed by considering it as
consisting of a core portion representing the region of interest and a padding zone which ensures that the boundary
conditions in the finite difference modelling are handled correctly. In the core portion, the horizontal mesh is mainly
controlled by the experiment grid on which to collect the data, so the mesh partition in this region is usually uniform
given that the data are collected at constant intervals and the cell width is an integer fraction of the station spacing (or
dipole length of the array).
An example of the file structure is as follows:

• Number of segments used to define the horizontal partitioning
• Boundary of the segment in 𝑥−coordinates. The first line has the edged of the mesh (west-most coordinate) and
the next boundary. From there, each line is the boundary for the previous line.
• Number of cells within the segment. The cell size is determined by ([𝑋𝑖 − 𝑋𝑖−1 ]/𝑁 𝑋𝑖 )
• Number of segments used to define the vertical partitioning.
• Boundary of the segment in 𝑧−coordinates. These coordinates are in depth (z+ down). The first line has the top
of the mesh (west-most coordinate) and the next boundary. From there, each line is the boundary for the previous
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line. NOTE: When topography is given, the top of the mesh (Z:math:_0) is set to the in the file. Therefore, it is
encouraged to set Z0 = 0 in all cases for user readability of the thicknesses of cells in the first segment.
• Number of cells within the segment. The cell size is determined by ([𝑍𝑖 − 𝑍𝑖−1 ]/𝑁 𝑍𝑖 )
Example
The following is an example of a 2D mesh:

In the above example, the mesh is (48 × 27) covering from 𝑥 = [−100, 100] and 𝑧 = [0, 300] . There are 9 segments in
the file defining the horizontal partitioning which goes from 𝑥 = −300 to 𝑥 = 300. The region 𝑥 = [−100, 100] has
been divided into 40 equal length cells. Four padding cells of increasing width extend the mesh out to 𝑥 = [−300, 300].
5.3. Meshes
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In depth, there are 14 segments over the depth range 𝑧 = [0, 300]. Note that the bottom depth is considerably larger
than the depth of investigation of the survey. This procedure is carried out automatically in all-default mode. If default
meshing is chosen, the horizontal cell size is set to 1/3 the average electrode spacing. The vertical discretization is set
to accommodate 1:2 vertical to horizontal ratio and the padding is increased by 1.5 times.
DC/IP Notes on the 2D mesh
Generally, at least three cells are recommended between adjacent stations (i.e., per dipole length). In the presence of
topography, one might use a finer partitioning in sections where the topographic relief changes rapidly. This helps to
better approximate the topographic surface using the finite difference mesh. In the presence of surface topography, the
top of the finite difference mesh corresponds to the highest point on the surface. Since the current sources are all on the
surface of the earth, the vertical mesh has thicknesses which generally increase with depth. The cell thickness should
be small near the surface and increase slowly in the upper region that is within the array’s depth of investigation. Finer
partitioning can be used at a depth where there is rapid change in the conductivity for forward modelling or where one
might expect anomalous structures in the inversion. The maximum depth for the mesh should be considerably larger
than the depth of investigation provided by the survey. The thickness of the cells, especially near the surface, should
be determined in reference to the horizontal partitioning so that the cells do not have an extremely large aspect ratio
(width divided by thickness). Cells with extreme aspect ratio tend to degrade the quality of the forward solution and
they can also cause undesirable abrupt changes in the inversion results. It is good practice to keep the aspect ratio of
cells less than 5. Once the core mesh is designed, a set of padding cells is required to extend the mesh horizontally.
Three to five cells whose width progressively increases by a factor of two to three provide sufficient extension so that
the boundary conditions are adequately handled.
It is good practice to generate the mesh and perform a forward modelling using a uniform conductivity model, called
the half-space test. The test for a properly designed mesh is performed by calculating the apparent conductivities from
the uniform conductivity model. The mesh is considered adequate if the modelled responses do not deviate from the
true conductivity by more than a few percent. Otherwise, the mesh should be modified and the test performed again.
This test is valid when there is no topography. However, a mesh designed properly for a model with topography should
pass the half-space test when the mesh is used alone without topography.

5.3.3 3D Mesh file
The mesh defines the model region and has the following structure:

• 𝑁 𝐸: Number of cells in the East direction.
• 𝑁 𝑁 : Number of cells in the North direction
• 𝑁 𝑍: Number of cells in the vertical direction
• 𝐸𝑜 , 𝑁𝑜 , 𝑍𝑜 : Coordinates, in meters, of the southwest top corner, specified in (Easting, Northing, Elevation). The
elevation can be relative to a reference elevation other than the sea level, but it needs to be consistent with the
elevation used to specify the locations, observations, and topography files.
• ∆𝐸𝑛 : 𝑛𝑡ℎ cell width in the easting direction (ordered W to E).
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• ∆𝑁𝑛 : 𝑛𝑡ℎ cell width in the northing direction (ordered S to N).
• ∆𝑍𝑛 : 𝑛𝑡ℎ cell thickness (ordered top to bottom).
The mesh can be designed in accordance with the area of interest and the spacing of the data available in the area. In
general, the mesh consists of a core region which is directly beneath the area of available data, and a padding zone
surrounding this core mesh. Within the core mesh, the size of the cells should be comparable with the spacing of the
data. There is no restriction on the relative position of data location and nodal points in horizontal direction. The
cell width in this area is usually uniform. Beyond the core region, the mesh should be padded with cells that increase
(typically no more than 40% of the previous length).
The vertical position of the mesh is specified in elevation. This is to accommodate the inversion of a data set acquired
over a topographic surface. When there is strong topographic relief, which the user wishes to incorporate it into
the inversion, special care should be taken to design the mesh. A conceptually simple approach is first to design a
rectangular mesh whose top (specified by 𝑍𝑜 ) is just below the highest elevation point, and then to strip off cells that
are above the topographic surface. This is the approach taken in . The number of cells to be stripped off in each column
is determined by the user-supplied topography file. Only the remaining cells will be used in the forward modelling or
included in the inversion as model parameters.
Example
This example shows a mesh that consists of 26 cells in easting, 27 cells in the northing, and 23 cells in the vertical
directions. The top of the mesh is located at 0 m of elevation and the southwest corner is at -350 m easting and -400 m
northing. The cells in the core portion of the mesh are all 50 m × 50 m × 25 m. There are three cells in the padding
zone in every direction except the top of the core mesh.

5.3.4 OcTree mesh file
The ocTree mesh defines the model region, but the underlying mesh is defined as a regular 3D orthogonal grid (referred
to as the “core” grid) where the number of cells in each dimension are 2𝑚1 × 2𝑚2 × 2𝑚3 ,with grid size \( h \). This
underlying mesh is the finest possible, so that larger cells have lengths which increase by powers of 2 multiplied by \(
h \). The file has the following structure:
• 𝑁 𝐸: Number of core cells in the East direction.
• 𝑁 𝑁 : Number of core cells in the North direction
• 𝑁 𝑍: Number of core cells in the vertical direction
• [𝑃 𝑎𝑑𝑑𝑖𝑛𝑔]: Optional input of 6 integers giving the padding in terms of the number of core cells. The integers
in order are: east, west, south, north, bottom, and top. This input is used for viewing the ocTree mesh.
• 𝐸𝑜 , 𝑁𝑜 , 𝑍𝑜 : Coordinates, in meters, of the southwest top corner, specified in (Easting, Northing, Elevation). The
elevation can be relative to a reference elevation other than the sea level, but it needs to be consistent with the
elevation used to specify the locations, observations, and topography files.
• 𝑊𝑒 , 𝑊𝑛 , 𝑊𝑧 : Widths of the core cells in the Easting, Northing, and Vertical directions.
5.3. Meshes
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• 𝑀 : Number of cells in ocTree mesh
• 𝑖𝑛 : 𝑛𝑡ℎ cell location in the grid (easting)
• 𝑗𝑛 : 𝑛𝑡ℎ cell location in the grid (northing)
• 𝑘𝑛 : 𝑛𝑡ℎ cell location in the grid (vertical; positive down)
• 𝑏𝑠𝑧𝑛 : Number of core cells grouped in each direction to create the cell (e.g., 2 would be 8 core cells: 2 x 2 x 2).
The cell size ([e,n,z]) is given by \( [bsz_n * W_e, bsz_n * W_n, bsz_n * W_z] \).
Example
This example shows a mesh that has a core of \( 1024 \times 1024 \times 1024 \) cells at 10-m width in each direction.
The mesh has the optional padding cells given to define the core of the mesh for viewing. There are 3,719,976 total
cells with the first eight being \( 128 \times 128 \times 128 \) core cells in size. The first \( [i,j,k] \) line is located at
top, south-west corner of the mesh.

5.4 Models
5.4.1 1D Model file
See the 1D Mesh file definition for details.

5.4.2 2D Model file
This is the file used to define any model given to . Each file contains the cell values within the model. The number of
cells in the 𝑥− and 𝑧−directions are specified in this file and should coorespond to the values given in the file.
An example of the file structure is as follows:
• 𝑁𝑥 : Number of cells in the horizontal direction
• 𝑁𝑧 : Number of cells in the vertical direction.
• 𝑁𝑖,𝑘 : Value of the model at the i𝑡ℎ cell in the horizontal
direction and k𝑡ℎ cell in depth. When 𝑘 = 1, the cell is at the top of the mesh and 𝑘 = 𝑁𝑧 corresponds
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to the bottom of the mesh. In the horizontal direction 𝑖 = 1 corresponds to the beginning of the line (e.g.,
West) and 𝑖 = 𝑁𝑥 is at the end of the line (e.g., East).
• 𝑋𝑖 : i𝑡ℎ horizontal location
• 𝑒𝑙𝑒𝑣𝑖 : i𝑡ℎ elevation
Example
The following is an example of a model:

In the above example, there are 10 horizontal cells and 3 vertical cell associated with the mesh. The first row is broken
into the first three lines of the file. The second row of the model is given on lines 2-4. The third row of the model is
given on lines 5 and 6. would also read the same model with three rows of ten values.
DC/IP 2D notes
The model is stored in a row format with V1,1 being the top left cell. As shown above, each row of the model, \(
V_{1,k} . . . V_{N_x,k} \) , can be broken down into more than a single line in the file, however, each model row must
start on a new line.
In the presence of topography, the cells above the surface specified by topo.dat represent the air and, therefore, are not
part of the model. For simplicity, however, the files model.con and model.chg must include those cells as defined by
the file. These cells in the model file will be ignored when the model is input to a program. To distinguish these cells,
the user can assign a special value to them, for instance, a very small value (say 10−10 ) for conductivity and a negative
value for the chargeability model. These cells in the output model files from the inversion programs have a conductivity
value equal to 10−8 times the mean conductivity value immediately beneath the surface and a chargeability value of
-1030 .
2D active model file
The active cell model file is a specific type of model that has the same format, but only contains values of -1, 0, or 1.
Default ( option) active cells models place all cells in the model as active, meaning they can be changed during the
inversion and influence the model objective function and data misfit. Cells that are inactive (not allowed to change) and
do not influence the model objective function should be set to 0. Cells that are inactive, but can influence the values of
neighbouring cells through the model objective function should have a value of -1.
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5.4.3 3D Model file
This file contains the cell property values of the model and is the most common of the model files. Inversion models
(forward, initial, reference, recovered, and most lower and upper bound) are in this format. The following is the file
structure of the model file

Each \(m_{i,j,k}\) is the property in the \([i,j,k]^{th}\) model cell. \([i, j, k]=[1, 1, 1]\) is defined as the cell at the top,
south-west corner of the model. The total number of lines in this file should equal \(NN \times NE \times NZ\), where
\(NN\) is the number of cells in the north direction, \(NE\) is the number of cells in the east direction, and \(NZ\) is the
number of cells in the vertical direction. The model ordering is performed first in the z-direction (top-to-bottom), then
in the easting, and finally in the northing.
Active Cells Model: Active cell models are in the same format, but only have values of -1, 0, or 1.
Geology Model: Geology models are the in the same format, but only contain integer values corresponding to their
definitions.
Note: Only the cells completely below the (interpolated) topographic surface are kept within an inversion. The cells
above or at the topographic surface are removed from the model, although these must still be included in the as if they
are a part of the model. For input model files these cells can be assigned any value. The recovered model produced by
inversion program also includes the cells that are excluded from the model, but these cells will have unrealistic values
and be set (e.g., -100, 1e-8, etc).

5.4. Models
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5.4.4 Vector model file
This file contains the three components of property values within the model. The following is the file structure of the
model file

Each \(m^p_{i,j,k}\) is the property in the \([i,j,k]^{th}\) model cell where \(p = x, y, z\) with x-positive easting, ypositive northing, and z-positive down. \([i, j, k]=[1, 1, 1]\) is defined as the cell at the top, south-west corner of the
model. The total number of lines in this file should equal \(NN \times NE \times NZ\), where \(NN\) is the number
of cells in the north direction, \(NE\) is the number of cells in the east direction, and \(NZ\) is the number of cells in
the vertical direction. The model ordering is performed first in the z-direction (top-to-bottom), then in the easting, and
finally in the northing.

5.4.5 Model Norm file
This file contains the four exponent values within the model used to control the sparsity applied on the model and its
gradients [ps px py pz]. The following is the file structure of the model file

Each \(p_{i,j,k}\) is the norm value in the \([i,j,k]^{th}\) model cell \(s\) denotes the l_p-norm on the model, \(x\)
denotes the l_p-norm on the model gradients along the x-axis (Easting), \(y\) denotes the \(l_p\)-norm on the model
gradients along the y-axis (Northing), \(z\) denotes the l_p- norm on the model gradients along the z-axis (Vertical).
Values must be on the interval \(0 \leq p \leq 2\). Indices \([i, j, k]=[1, 1, 1]\) is defined as the cell at the top, south-west
corner of the model. The total number of lines in this file should equal \(NN \times NE \times NZ\), where \(NN\) is
the number of cells in the north direction, \(NE\) is the number of cells in the east direction, and \(NZ\) is the number
of cells in the vertical direction. The model ordering is performed first in the z-direction (top-to-bottom), then in the
easting, and finally in the northing.
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5.4.6 Weights file
This file supplies the user-based weights that acts upon the model objective function. Each set of weights correspond
to the functions (e.g., 𝑤𝑥 ) given in the model objective function. For ease, the weights in geographic coordinates are
provided by the user. The following is the file structure is for the weights file:

Parameter definitions:
• W.S𝑖,𝑗,𝑘 : Cell weights for the smallest model component in the model objective function.
• W.E𝑖,𝑗,𝑘 : Cell weights for the interface perpendicular to the easting direction.
• W.N𝑖,𝑗,𝑘 : Cell weights for the interface perpendicular to the northing direction.
• W.S𝑖,𝑗,𝑘 : Cell weights for the interface perpendicular to the vertical direction.
Within each part, the values are ordered in the same way as in model file, however, they can be all on one line, or
broken up over several lines. Since the weights for a derivative term are applied to the boundary between cells, the
weights have one fewer value in that direction. For instance, the weights for the derivative in easting direction has
(𝑁 𝐸 − 1) × 𝑁 𝑁 × 𝑁 𝑍 values, whereas the number of cells is 𝑁 𝐸 × 𝑁 𝑁 × 𝑁 𝑍.
If the surface is supplied, the cell weights above the surface will be ignored. It is recommended that these weights be
assigned a value of -1.0 to avoid confusion. If null is entered instead of the weights file, then all of the cell weights
will be set equal (1.0).

5.4.7 Geology definition file format
A geology definition file is in either the XYZ or CSV file format. This file describes a geology model defining its
property or properties. GIFtools will assign air values to the integer 0, but air is not required to be given during import.
It must have a column of integers corresponding to the geology model. Other information that may be included are:
1. Property: A value (e.g., 0.001 S/m) for the \( i^{th} \) unit
2. Upper bound: Generic upper bound for the \( i^{th} \) unit
3. Lower bound: Generic lower bound for the \( i^{th} \) unit
4. Ws: Smallest model component of the model objective function for generating weights. A “default” value is 1,
with anything greater than 1 placing more emphasis on the property value and anything less than 1 placing less
empthasis on the given property.

5.4. Models
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Example
Below is a sample geology definition file for two physical properties, density and magnetic susceptibility (also contains
optional upper and lower bounds and a standard deviation column):

The following items are training resources for practitioners - from short recipes to extended walk-through tutorials (A
to Z) to comprehensive workflows.
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CHAPTER

SIX

FUNDAMENTALS OF INVERSIONS

Here, we explain geophysical inversion and describe the
parameters which impact inversion results. To demonstrate the impact of each parameter, we invert synthetic
magnetic survey collected over a susceptible block within
a half-space.

6.1 Geophysical Inversion Basics
What is geophyiscal inversion?
Geophysical inversion is a tool which we can use to recover the subsurface distribution of a physical property
from field-collected data. Each type of geophysical data
may be inverted using one or more inversion algorithms.
What does geophysical inversion recover?
Geophysical inversion recovers a physical property
model which:
• fits the data (field observations), and
• is geologically reasonable (contains plausible structures)
Geophysical inversion does not recover the exact distribution of a physical property; i.e. the true model. There may be
a number of physical property models which satisfy the aforementioned requirements. Therefore, it is up to the user to
set appropriate starting parameters for the inversion.
Example:
The benefits of geophysical inversion are illustrated in the figure on
the right.
• In (a), we see several conductors and resistors buried below
the Earth; i.e. the true model.
• In (b), we see the apparent resistivity data collected by a 2D
DC resistivity survey plotted in pseudo-section.
• In (c), we see the physical property model recovered through
inversion. If the geology is complex, the pseudo-section data
can be very difficult to interpret. In this case, the inversion
results are much easier to interpret.
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When is inversion able to recover a subsurface structure?
Inversion is successful in recovering geological structures when:
• There is a sufficient physical property contrast between the target structure and the surrounding geology
• The data are sensitive to the target structure; i.e. the geophysical response from that structure is observed in the data
• Parameters relevant to the inversion are set appropriately

6.2 The Objective Function
Geophysical inversion recovers a physical property model which fits
the data and has geologically reasonable structures. But how is this
done in practice? The majority of geophysical inversion algorithms
work by minimizing an objective function (𝜑) with respect to the
physical property model (m):
𝜑(m) = 𝜑𝑑 (m) + 𝛽𝜑𝑚 (m)

(6.1)

This is sometimes referred to as “penalty-based optimization”; that is, the objective function is large if the model doesn’t
fit the data and/or has implausible structures. The objective function is comprised of three components:
• data misfit 𝜑𝑑 (m), which is responsible for ensuring the recovered model predicts data that fits the set of field
observations.
• model objective function 𝜑𝑚 (m), which ensures that the recovered model contains plausible geological structures.
• trade-off parameter 𝛽, which weights the relative contribution of 𝜑𝑑 (m) and 𝜑𝑚 (m) towards the objective
function.
Data Misfit:
The Data misfit (𝜑𝑑 ) in (6.1) is given by:
⃦
⃦2
𝜑𝑑 (m) = ⃦W𝑑 [F(m) − d]⃦

(6.2)

where
• F[m] is the forward modeling operator; i.e. an operation that predicts the data for a given physical property
model m.
• d is the set of observed data.
• Wd is a matrix which weights the difference in predicted and observed data by the data uncertainty. The uncertainty acts as an estimate of the standard deviation of random noise on each data point.
The Wd matrix is used for two reasons. 1) If the observed data span several orders of magnitude, we want to make
sure that the inversion doesn’t focus on fitting the large values at the expense of the small values. 2) If the noise on
our data are independent and Gaussian, then the predicted data fits the noise to an appropriate tolerance when 𝜑𝑑
equals the number of data; that is, the inversion fits the signal without fitting the noise (over-fitting). As a result, we
generally stop the algorithm when the data misfit is equal to the number of data (target misfit). Model Objective
Function/Regularization:
The model objective function (𝜑𝑚 ) is where we impose structures on the recovered model. It also acts as a regularizer;
i.e. stabilizes the inversion algorithm. The model objective function can be divided in two sections, the smallness and
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the smoothness:
𝜑𝑚 (m) = 𝜑𝑠𝑚𝑎𝑙𝑙 (m) + 𝜑𝑠𝑚𝑜𝑜𝑡ℎ (m)

(6.3)

𝜑𝑠𝑚𝑎𝑙𝑙 (m) = 𝛼𝑠 ||Ws R𝑠 (m − m𝑟𝑒𝑓 )||22

(6.4)

With:

• 𝜑𝑠𝑚𝑎𝑙𝑙 is the Smallness term. It defines how the model can vary from the reference model m𝑟𝑒𝑓 ((6.4)).
And:
𝜑𝑠𝑚𝑜𝑜𝑡ℎ (m) =𝛼𝑥 ||Wx R𝑥 G𝑥 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑦 ||Wy R𝑦 G𝑦 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑧 ||Wz R𝑧 G𝑧 (m −

(6.5)

m𝑟𝑒𝑓 )||22

• 𝜑𝑠𝑚𝑜𝑜𝑡ℎ is the Smoothness term. it defines how the gradients in each direction, defined by the matrices 𝐺𝑥 , 𝐺𝑦
and 𝐺𝑧 , of the model can vary from the gradient of the reference model ((6.5)).
• The weighting matrices W𝑠 , W𝑥 , W𝑦 and W𝑧 are cell-specific weightings for each of these terms. They can
combine user-defined confidence models with depth or distance weighting.
• the alphas parameters 𝛼𝑠 , 𝛼𝑥 , 𝛼𝑦 , and 𝛼𝑧 control how important each of the four terms are relative to each other
• The sparsity weights R𝑠 , R𝑥 , R𝑦 and R𝑧 are defined by the lp-norms.
• In the UBC codes, the option SMOOTH_MOD_DIFF uses the reference model in all terms, while
SMOOTH_MOD would only use the reference model in the Smallness term.
In this section, we will explore the effect of these different parameters on the recovered model through a susceptible
block in a non-susceptible half-space mapped with a total magnetic ground survey.

6.3 Data
Misfit
and
Uncertainties
Here,
we
discuss
the
importance
of
assigning
6.3. Data Misfit and Uncertainties
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appropriate
uncertainties, the importance of analyzing the data misfit, and present some best-practices. In the objective function, we use
a data misfit term to ensure the inversion recovers a model which can fit the set of field observations. The data misfit
can be expressed as a finite sum:
𝜑𝑑 (m) =

𝑁
∑︁
𝑖=1

𝜑2𝑑,𝑖

=

𝑁
∑︁
𝑖=1

(︃

F[m]𝑖 − 𝑑𝑖
𝜀𝑖

)︃2
(6.6)

where
•
𝑁
is
the
total
number
of
observations
•
𝜑𝑑,𝑖
is
the
data
misfit
for
each
datum
•
𝑑𝑖
is
the
observed
datum
𝑖
•
F[m]𝑖
is
the
pre280
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dicted
datum
for
model
m
•
𝜀𝑖
is
the
uncertainty
on
datum
𝑖
If
we
assume
that
the
noise
on
each
datum
is
independent
and
Gaussian, then the uncertainties 𝜀𝑖 can be thought of as estimations of the standard deviation of the noise on each datum.
Under this assumption, two things should occur if the recovered model fits the data properly:
1)

The
data
misfit
𝜑𝑑 ≈
𝑁,
indicating
the
inversion

6.3. Data Misfit and Uncertainties
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has
fit
the
signal without fitting the noise.
2)

The
individual
data
misfits
when
plotted,
are
incoherent;
that
is, the recovered model does not fit the data well in some areas and poorly in others.
Eq.
(6.6)
is
commonly
represented
as
the
L2norm
of
a
weighted
residual
between the observed data vector (𝑑𝑜𝑏𝑠 ) and the predicted data for a given conductivity model 𝜎, i.e.:
⃦
(︀
)︀⃦2
𝜑𝑑 (m) = ⃦Wd dobs − F[𝜎] ⃦

(6.7)

where 𝑊𝑑 is a diagonal matrix containing the reciprocals of the uncertainties 𝜀 for each measured data point, i.e.:
[︀
]︀
Wd = diag 𝜀−1
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Fig. 2: Data misfits indicating all area of the survey region fit equally (left). Data misfits indicating the central area of
the survey region is fit poorly compared to the rest of the survey region (right).

6.3.1 Why
use
Uncertainties
Uncertainties
are
used
to
weight
the
difference
between
observed
and
predicted data in the data misfit function. This is done for two reasons:
1)

If
the
observed
data
span
sev6.3. Data Misfit and Uncertainties
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eral
orders
of
magnitude,
we
want
to
make sure that the inversion doesn’t focus on fitting the large values at the expense of the small values.
2)

If
the
noise
on
our
data
are
independent
and
Gaussian,
then
the
data
misfit provide a stopping criteria for the inversion. See trade-off parameter.
In
general,
the
uncertainty
on
each
datum
𝑑𝑖
can
be
split
into
two
contributions:
𝜀𝑖 = 𝜀𝑓 𝑙𝑜𝑜𝑟 + 𝐶% |𝑑𝑖 |
where 𝜀𝑓 𝑙𝑜𝑜𝑟 is the “floor value” and 0 < 𝐶% < 1 is a fractional percent. Using a percent uncertainty ensures that data
spanning multiple orders of magnitude are all weighted so that they contribute towards the data misfit equally. That is,
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we do not fit large data values at the expense of smaller values. The floor represents the smallest possible uncertainty
that we may have on the data. The floor also helps to stabilize the inversion; i.e. ensure that there are no uncertainties
such that 𝜀𝑖 ≪ |F[m]𝑖 − 𝑑𝑖 |.

6.3.2 Importance
of
Choosing
Appropriate
Uncertainties
In
the
figure
below,
we
see
the
results
of
three
inversions
to
recover a susceptible block where different sets of uncertainties were applied. The observed data were generated by
adding Gaussian noise with a standard deviation of 4 nT to forward modeled data. Thus in this case, we need only
apply a floor uncertainty to the data.
On
the
left,
the
floor
value
for
all
data
points
is
set
to
6.3. Data Misfit and Uncertainties
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equal
the
standard
deviation of the noise that was added. By applying the correct uncertainties, we are able to recover a reasonable model
which fits the data to an appropriate degree. In the middle, the data uncertainties are underestimated. As a result, the
inversion must put non-geological structures in the recovered model to fit the data. On the right, the data uncertainties
are overestimated. The inversion recovers a plausible model, however, there is a large artifact in the corresponding
data misfit. The large misfits clustered over the susceptible block indicate that the recovered model does fit the data
sufficiently there.

Fig. 3: Appropriate floor (left). Underestimation of floor (middle). Overestimation of floor (right)
Important: After running an inversion, it is always good to plot the data misfit in order to determine if the assigned
level of uncertainty is correct.

6.3.3 Choosing
a
Floor
Value
For
successful
inversion
re-
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sults,
an
appropriate
floor
value
must
be
chosen for the data uncertainties. The optimum floor uncertainty is one that accurately approximates the standard
deviation of the smallest errors on the data. If the floor is too large, then the minimum level of noise on the data is
overestimated and the inversion will not fit small data values to the same degree as larger data values; e.g. it will not
fit the signal associated with small data values. If the floor is too small, then the minimum level of noise on the data is
underestimated and the inversion may fit small data values to a much higher degree than larger data values; e.g. it will
fit noise associated with small data values.
Basic Strategies for Picking a Floor
Floor
from
Background
Response:
Far
away
from
any
significant
geophysical
anomalies,
the
observed
response (background response) for a set of locally clustered measurements should be approximately equal. By examining
the standard deviation of the collection of background data values, we may obtain a plausible estimate for the floor
uncertainty. This approach works better when applied to repeat measurements at the same location.
Floor
from
Sorted
Data:
Another
6.3. Data Misfit and Uncertainties
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technique
for
obtaining
a
floor
uncertainty
is
to
sort
all
data
values from smallest in magnitude to largest. In examining the curve, we choose the point below which we believe
the observed data are attributed solely to the noise and not the signal. This technique is easier when the absolute data
values approach zero sharply.
Distinct
Floor
at
Separate
Times/Frequencies:
The
noise
floor
for
data
at
different
time
channels/frequencies
may
not
be
the
same.
The
reasons for this are not discussed here. As a result, the user may want to specify a unique floor uncertainty for each
time/frequency using any of the two aforementioned approaches.
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6.3.4 Choosing
a
Percent
The
percent
uncertainty
is
especially
important
when
data
values
span
multiple orders of magnitude; thus for potential fields problems, the inclusion of a percent error may not always be
necessary.

6.4 The
Beta
Parameter
(TradeOff)
In
(6.8),
𝛽
is
a
tradeoff
parameter
that
con-

6.4. The Beta Parameter (Trade-Off)
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trols
the
relative
importance of the model smoothness through the model objective function and data misfit function. 𝛽 is scaled to
the total number of input data, and is usually automatically recovered through an optimisation routine that ensures the
target misfit is reached. In the UBC codes, there are four ways of specifing how 𝛽 should be chosen.
𝜑(m) = 𝜑𝑑 (m) + 𝛽𝜑𝑚 (m)

(6.8)

To illustrate how 𝛽 impacts on data misfit and recovered model of the inversion, we introduce below magnetic inversion
example. Here we start magnetic inversion with large 𝛽, and cool down. Both recovered model and data fit are presented
for corresponding beta.

6.4.1 Errors
on
Data
Before
the
inversion
can
proceed,
each
datum
should
have
an
estimate
of uncertainty. Otherwise the inversion will not know how well that datum should be reproduced. Errors on data (i.e.
data reliability) can be thought of in three ways:
•

Are
errors
constant
for
all
data?
(for
example
±4
290
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nT
for
magnetic
data)
•

•

Are
errors
a
percentage
of
data?
(Perhaps
data
are
known
to
be
within
5% of their value)
Or
should
a
combination
be
used?
(for
example
2%
+
3
nT)
Choices
made
about
the
reliability
(er-

6.4. The Beta Parameter (Trade-Off)
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ror)
of
the
data
can
be
significant. If a datum has a measured value of 10, and it is considered to have an error of 10%, then the inversion process
must find a model that is capable of reproducing that datum as any value between 9 and 11.
If
statistics
about
errors
on
the
data
can
be
reliably
estimated,
then
the Chi-factor method of choosing is appropriate. However, what should be done if there is only a poor estimate for
the reliability of data? The GCV or L-Curve methods may be useful in this situation. All three methods are expanded
upon next.

6.4.2 Chifactor
Use
of
Chifactor
to
determine
the
value
of
which
yields
the
optimal
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model
is based upon the assumption that noise and error on the data are random, and that they behave according to a Gaussian
distribution. If this is the case, then the misfit function (explained in the “Optimization” chapter) will have an expected
value of N, the number of data. This allows use to tell the inversion to try a range of values, then chose the model that
results from the inversion which used a value yielding a data misfit equal to N.
In
fact,
it
is
more
useful
to
be
able
to
control
how
close
predicted
data
must match the measured data. So, instead of using a target misfit of N, we can use a target misfit of Chi-factor x N, in
which Chi-factor is a user-specified parameter.
This
allows
the
user
to
make
adjustments
so
that
misfit
is
consistent
with prior knowledge of supplied errors. If data are noisy, or they do not adhere reliably to the normal assumptions
(random, Gaussian, and zero mean), then target misfit may have to be larger than N, so Chi-factor would be specified
as more than 1. If data are quite clean then it may be acceptable to set Chi- factor < 1.

6.4. The Beta Parameter (Trade-Off)
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6.4.3 GCV
The
GCV
(Generalized
Cross
Validation)
approach
to
choosing
when
datum errors are poorly known is attractive because it is a rigorous idea that considers each data point, and the ability
of all the other data points to find a model that reproduces that one data point. The idea is used in many aspects of
applied mathematics, including inversion. It is however very intensive of computing time - perhaps four or more times
the computing time required when using Chi-factor to determine 𝛽.
Here
is
the
idea
underlying
the
GCV
approach.
For
a
range
of
𝛽,
perform a set of inversions to find a model that is least affected by any single data point. The procedure is as follows:
•

Choose
one
value
for
𝛽,
then
perform
one
294
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inversion
for
each
data
point
with
that one data point omitted.
•

•

•

•

Compute
a
misfit
value
for
each
inversion.
Calculate
the
cumulative
misfit
(called
a
cross
validation,
or CV ) for all these inversions at the single chosen. It is a summation over all data points except the current one.
Start
again
using
then
next
𝛽.
When
all
are
6.4. The Beta Parameter (Trade-Off)
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done,
generate
a
graph
of
CV
versus
𝛽.
•

Choose
the
𝛽
with
the
smallest
value
of
cumulative
misfit,
CV.
The
term
Generalized
Cross
Validation
(
GCV
)
refers
to
a
numerically efficient method of computing the CV required by this method. Effectively, the minimum GCV yields the
model that is least affected by any single data point. The only assumptions about noise on data are (i) that each datum
has the same level of noise, (ii) noise is Gaussian and independent, and (iii) the standard deviation of noise on each
datum is unknown.
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6.4.4 LCurve
To
select
𝛽
using
the
Lcurve
approach,
a
series
of
solutions
for a range of 𝛽 values must be generated. The resulting set of 𝜑𝑑 (m) and 𝜑𝑚 (m) values are then plotted to create a
Tikhonov curve. Using log-log axis, this plot is sometimes called an L-curve. In the absence of reliable information
on data errors, an optimal choice formay be made by picking the value that generates the 𝜑𝑑 (m) and 𝜑𝑚 (m) pair at
the point of maximum curvature on this curve. The model corresponding to this particular solution then becomes the
inversion result.
There
is
no
“proof”
that
this
approach
works
all
the
time.
However
it
is
usually
sensible for the following arguments:
•

Small
𝜑𝑚 (m)
is
desirable
since
6.4. The Beta Parameter (Trade-Off)
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kernels
are
generally
smooth
(low
frequency)
and we usually have relatively few of them. In other words, if 𝜑𝑚 (m) were large, the model would have more structure
(larger high frequency components), yet it is usually noise which tends to have high frequencies. Therefore, if model
norms are large, we have probably fitted noise rather than data.
•

•

Small
𝜑𝑚 (m)
may
be
desirable,
but
the
minimum
misfit
must
be
avoided
since that would imply some structure was reproducing noise.
The
compromise
is
to
take
the
values
of
𝜑𝑑 (m)
and
𝜑𝑚 (m)
at
the
“elbow” in the L-curve.
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6.5 The
Alphas
Parameters
The
model
objective
function
consists
of
four
main
components;
one
that
defines how the model can vary from the reference model, and one for each of the allowed gradients in the x, y and z
directions. Each of these four components has a coefficient, denoted by , that controls their relative importance in the
regularization 𝜑𝑚 (m).
𝜑𝑚 (m) =𝛼𝑠 ||W𝑠 R𝑠 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑥 ||W𝑥 R𝑥 G𝑥 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑦 ||W𝑦 R𝑦 G𝑦 (m − m𝑟𝑒𝑓 )||22 +

(6.9)

𝛼𝑧 ||W𝑧 R𝑧 G𝑧 (m − m𝑟𝑒𝑓 )||22
In this example, we demonstrate the effect that each value has on the solution.
As
a
general
rule
of
thumb,
larger
𝛼𝑥 ,
𝛼𝑦
and
𝛼𝑧
results
in
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an
increased smoothing in the corresponding direction, while reducing 𝛼𝑠 results in an overall smoother model.
Tip: In order to get equal contribution from all four components making up 𝜑𝑚 (m), set 𝛼𝑠 = ℎ12 , where h represent
the cell size dimension in the core region. If the mesh cells are not cubic, values should be adjusted accordingly
(smaller h => reduced )
It
is
sometimes
useful
to
think
of
the
values
in
terms
of
length
scales:
√︂
𝐿𝑥 =

𝛼𝑥
,
𝛼𝑠

√︂
𝐿𝑦 =

𝛼𝑦
,
𝛼𝑠

√︂
𝐿𝑧 =

𝛼𝑧
𝛼𝑠

These length scales can be adjusted to reflect a priori information about the general trend expected from the geology.
Important: In most inversion codes, the default values are: [𝛼𝑠 = 1𝑒 − 4, 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1].
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6.6 The
Weighting
Matrices
W
Cellbased
weighting

6.6. The Weighting Matrices W
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matrices
are
used
to
enforce
any
a
priori
information
available
about
the
distribution of model parameters and their gradients. For potential field problems, these matrices also hold a depth or
distance weighting function to counteract the rapid decay in sensitivities.
𝜑𝑚 (m) =𝛼𝑠 ||Ws R𝑠 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑥 ||Wx R𝑥 G𝑥 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑦 ||Wy R𝑦 G𝑦 (m − m𝑟𝑒𝑓 )||22 +

(6.10)

𝛼𝑧 ||Wz R𝑧 G𝑧 (m − m𝑟𝑒𝑓 )||22

6.6.1 The
smallness
matrix
Ws
The
relative
closeness
of
the
final
model
to
the
reference
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model
at
any
location
is
controlled
by the 𝑊𝑠 model. If the interpreter has high confidence in the reference model at a particular region, they can specify
increased amplitude there compared to other regions of the model. The format of 𝑊𝑠 is a standard UBC 3D model.
The default values are 1, giving equal confidence for all cells in the reference model. With GIFTools users can create
weights from geology model in GIFtools (see Create weights from a geologic model ).

6.6.2 The
smoothness
matrices
Wx,
Wy
and
Wz
The
weighting
functions
𝑊𝑥 ,
𝑊𝑦
and
𝑊𝑧
can
be
designed
to
enhance
or
attenuate
gradients
at
various regions in the model. If geology suggests a rapid transition in the model, then a decreased weighting on
particular derivatives of the model will allow for higher gradients there and thus provide a more geologic model that fits
6.6. The Weighting Matrices W
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the data. 𝑊𝑥 , 𝑊𝑦 and 𝑊𝑧 are defined on the faces of each cell. The default values are 1 for all faces. Values less than
1 allow for breaks in the model, while values greater than one forces continuity across cell faces. Face-weighting can
be performed in GIFtools. The UBC utility make_wdat.exe creates a face weights file that has layers of terrain-draped
cells, where wx and wy are modified to force continuity in those directions. This can reduce near-surface artefacts,
e.g. near electrodes.

6.6.3 Depth
or
Distance
Weighting
The
most
common
use
of
the
weighting
matrices
is
to
define
a
depth
or
distance
weighting.
The
sensitivity of signal decays predominantly as a function of depth (for surface/airborne data). The rate of signal decay
depends on the type of signal being modelled. Depth weighting takes this decay into account, ensuring that the
inversion does not preferentially change cells at any one particular depth. Unlike depth weighting, distance weighting
weights the sensitivity of the model based on the radial distance from the observation to each cell, not just the depth.
This is useful when inverting down-hole data, or data that is collected on highly irregular surfaces including extreme
topography or rough airborne drapes.
See
for
examples
the
Gravity
308
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inversion
or
Magnetic
inversion.

6.6.4 Sensitivity
weighting
for
DCIP
inversion
A
recent
advancement
in
inversion
is
the
use
6.6. The Weighting Matrices W
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of
the
sensitivity matrix as weighting.
ws = J𝑎𝑝𝑝𝑟𝑜𝑥 /𝑚𝑎𝑥(J𝑎𝑝𝑝𝑟𝑜𝑥 ) + 𝛿
wx = A𝑓𝑐 𝑥 ws
wy = A𝑓𝑐 𝑦 ws
wz = A𝑓𝑐 𝑧 ws
where ws are the cell-center weights and wx , wy and wz are the cell-face weights, J𝑎𝑝𝑝𝑟𝑜𝑥 are the values from the
𝑓
sensitivity.txt file, values from 𝛿 is a user-defined threhold parameter ([DEFAULT=1e-2]) and A𝑓𝑐 𝑥 , A𝑐 𝑦 , A𝑓𝑐 𝑧 are
averaging operators taking the cell-center values to the respective faces. Those weighting can then be applied to all or
parts of the regularization term. Their effects are illustrated on the figures below (Linear and Log Scale conductivities).
The files to reproduce those figures can be found here.

6.7 Sparse and Blocky Norms
Introduced in v6 of the gravity and magnetics codes, it is now
possible to change the norms in the different part of the regularization independently. In general terms, a small 𝑙𝑝 -norm
applied on the model yields sparse solutions, while small 𝑙𝑝 norm on the gradients yield blocky solutions.
𝜑𝑚 (m) =𝛼𝑠 ||Ws R𝑠 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑥 ||Wx R𝑥 G𝑥 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑦 ||Wy R𝑦 G𝑦 (m − m𝑟𝑒𝑓 )||22 +

(6.11)

𝛼𝑧 ||Wz R𝑧 G𝑧 (m − m𝑟𝑒𝑓 )||22
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Most codes thus far have involved the 𝑙2 -norm which favors
values that are small. Different norms tend to favor models
with fewer non-zero model parameters, potentially resulting in
simpler, more compact solutions. In discrete form, the general
𝑙𝑝 -norm is written as:
‖x(m)‖𝑝𝑝 =

𝑛𝐶
∑︁

|𝑥𝑖 |

𝑝

𝑖=1

which we approximate with a Scaled-IRLS methods as
𝑛𝐶
∑︁

𝑟𝑖 𝑥2𝑖

𝑖=1

where
[︁
]︁(𝑝/2−1)
2
𝑟𝑖 = 𝜖𝑝 (1−𝑝/2) (𝑥𝑖 (𝑘−1) ) + 𝜖2𝑝
such 𝑘 denotes the iteration number and 𝑝 and 𝜖 are sparsity and threshold parameters respectively. A total of 6 variables
can be manually adjusted by the user (𝑝𝑠 , 𝑝𝑥 , 𝑝𝑦 , 𝑝𝑧 , 𝜖𝑠 , 𝜖𝑥𝑦𝑧 ). The choice of 𝑝 and 𝜖 values is made based upon
prior knowledge.

6.7. Sparse and Blocky Norms
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6.8 The
SMOOTH_MOD_DIF
or
SMOOTH_MOD
options
𝜑𝑚 (m) =𝛼𝑠 ||Ws R𝑠 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑥 ||Wx R𝑥 G𝑥 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑦 ||Wy R𝑦 G𝑦 (m − m𝑟𝑒𝑓 )||22 +
𝛼𝑧 ||Wz R𝑧 G𝑧 (m − m𝑟𝑒𝑓 )||22

(6.12)

Introduced in v6 of the gravity and magnetics codes, this toggle controls whether the reference model is used in the
gradient terms of the model objective function.
If
the
reference
model
is

6.8. The SMOOTH_MOD_DIF or SMOOTH_MOD options
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used
in
the
gradient
terms
(SMOOTH_MOD_DIF),
then
sharp
boundaries that are present in the reference model will be preserved. If not used (SMOOTH_MOD), the difference to the
gradient model will still be minimised, but the boundary is allowed to have a smooth transition.

6.9 Data
Weighting
and
Joint
Inversion
Joint
inversion
inverts
two
or
more
datasets
simultaneously
to recover a unifying physical property model. For example, any combination of MT, ZTEM, FDEM or TDEM data
may be inverted jointly to recover a conductivity model. When performing joint inversion, it is important that the data
misfit for each individual dataset is appropriately weighted. If this is not done correctly, the inversion will overfit a
particular dataset at the expense of others; typically the dataset with the largest number of data observations.
To
weight
the
data
appro-
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priately,
we
let
the
total
data
misfit for the inversion (𝜑𝑑 ) be the weighted sum of the data misfits for each dataset, i.e.:
𝜑𝑑 =

(1)
𝑐1 𝜑𝑑

+

(2)
𝑐2 𝜑 𝑑

+ ... =

𝐾
∑︁

(𝑘)

𝑐𝑘 𝜑 𝑑

(6.13)

𝑘=1

where 𝐾 is the total number of datasets, 𝑐𝑘 are the weighting constants and:
⃦ (k) (︀ (k)
)︀⃦2
(𝑘)
𝜑𝑑 = ⃦Wd dobs − F(k) [𝜎] ⃦

(6.14)

Thus for dataset 𝑘:
•

(k)

Wd
is
a
diagonal
matrix
containing
the
reciprocal of the data uncertainties
•

(k)

dobs
is
the
set
of
field
observations
•
F(k)
denotes
the
forward
6.9. Data Weighting and Joint Inversion
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modeling
operator.

6.9.1 Weight
by
number
of
data
Using
this
approach,
we
weight
each
dataset
based
on
the
number
of
field observations. Datasets with more field observations given smaller weighting constants 𝑐𝑘 and visa versa. Let
̃︀ is
𝑁1 , 𝑁2 , 𝑁3 , ... , 𝑁𝐾 be the total number of data observations for datasets 1, 2, 3, . . . , 𝐾, respectively. Where 𝑁
the average number of data observations for all datasets, we let:
𝑐𝑘 =

̃︀
𝑁
𝑁𝑘

The benefits of this approach are as follows:
1.

the
target
data
misfit
for
the
inversion
remains
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the
same; i.e. it is the total number of data observations for all datasets
2.

the
inversion
no
longer
fits
datasets
based
on
the
number
of
data observations
Note: This section was elaborated with the contribution of Mark Grujic
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CHAPTER

SEVEN

COORDINATES, SIGN CONVENTIONS AND UNITS: A QUICK GUIDE

Here we provide a quick guide for the following:
• Coordinates for data locations
• Types and sign conventions for data
• Units for physical properties and data
Some codes may have internal coordinate systems. These details are not important here. This section is focused on the
data that are read and output by each code.

7.1 Coordinates for Data Locations
Here, we define the coordinate systems for data points for each code. In general X is Easting, Y is Northing and Z
is +ve up. The 1D codes are an exception; where -ve Z locations refer to positions above ground and the coordinate
system is left-handed. Certain codes may use a different coordinate system internally. However, the majority of users
will not need to worry about this. Certain codes may use unique data conventions. The users should worry about this.
Type
GUI
Gravity
Gravity
Magnetic
Magnetic
MVI
DC/IP
DC/IP
DC/IP
FDEM
FDEM
FDEM
TDEM
TDEM
TDEM
MT/ZTEM
MT/ZTEM
MT/ZTEM

Name
GIFtools
GRAV3D
GRAV PDE
MAG3D
MAG PDE
MVI
DCIP2D
DCIP3D
DCIPoctree
EM1DFM
EH3D
E3D
EM1DTM
H3DTD
TDoctree
MTZ3D
E3DMT
E3DMT

Versions
All
5.0, 5.1, 6.0
octree
5.0, 5.1, 6.0
octree
3.0
3.1, 5.0
octree
1.0
octree
1.0
octree
1 (2014,2015)
2 (2017)

Easting
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X

Northing
Y
Y
Y
Y
Y
Y
N/A
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y

Z +ve
up
up
up
up
up
up
up
up
up
down
up
up
down
up
up
up
up
up

Details

details
details
details
details

details
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7.1.1 DCIP details
PENDING

7.1.2 EM1DFM and EM1DTM details
The EM1DFM and EM1DTM codes read and write data files where X is Easting, Y is Northing and Z is +ve downward.
Thus Z = -5 m indicates the observation location is 5 m above the surface; even if the surface is not at an elevation
equal to 0 m. When loaded into GIFtools (Z +ve upwards), the Z values are automatically transformed into the correct
elevation values. If EM1DFM or EM1DTM data are modeled from the GIFtools GUI in a scenario where there is
surface topography, the resulting Z (elevation) values in GIFtools will take surface topography into account.

7.2 GIF Data Sign Conventions and Time-Dependency
Here, we define the sign conventions for various data types and the time-dependence for frequency domain codes. If
data are not formatted using the proper convention, it is unlikely that the inversion will be able to fit the data and return
meaningful results.
Important: Make sure you scroll all the way to the right within the table to see all information pertaining to a particular
code.
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Type
Gravity

Name
GRAV3D

Versions
5.0, 5.1, 6.0

Gravity

GRAV PDE

octree

Magnetic

MAG3D

5.0, 5.1, 6.0

Magnetic

MAG PDE

octree

MVI

MVI

3.0

DC/IP

2D DCIP

DC/IP

3D DCIP

DC/IP

DCIP octree

octree

FDEM

EM1DFM

1.0

Sign Convention
+ve data represents +ve
gravity anomalies
+ve data represents +ve
gravity anomalies
+ve data represents +ve
magnetic anomalies (details)
+ve data represents +ve
magnetic anomalies (details)
+ve data represents +ve
magnetic anomalies (details)
E = −∇𝑉 and ∆𝑉 =
𝑉𝑁 − 𝑉𝑀 (details)
E = −∇𝑉 and ∆𝑉 =
𝑉𝑁 − 𝑉𝑀 (details)
E = −∇𝑉 and ∆𝑉 =
𝑉𝑁 − 𝑉𝑀 (details)
• Time-dependency
is +𝑖𝜔𝑡 (details)
• Hx, Hy, Hz with Zaxis pointing downward (details)

FDEM

EH3D

• Time-dependency
is −𝑖𝜔𝑡 (details)
• Hx, Hy, Hz with
z-axis pointing upwards
• Ex, Ey, Ez with
z-axis pointing upwards
• Jx, Jy, Jz with z-axis
pointing upwards

FDEM

E3D

octree

TDEM

EM1DTM

1.0

• Time-dependency
is +𝑖𝜔𝑡 (details)
• H: Dot product of
H and the direction
defined by the receiver’s dipole moment (details)
• dB/dt: Corresponding voltage induced
in the receiver coil
(details)

7.2.
GIF Data Sign Conventions
TDEM
H3DTDand Time-Dependency
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7.2.1 Time-dependency (Fourier convention)
The relationship between a time-dependent function 𝑓 (𝑡) and its corresponding frequency response 𝐹 (𝑖𝜔) is given by
the inverse Fourier transform:
∫︁ ∞
[︀
]︀
1
𝐹 (𝑖𝜔)𝑒±𝑖𝜔𝑡 𝑑𝜔.
𝑓 (𝑡) = F−1 𝐹 (𝑖𝜔) = √
2𝜋 −∞
where the choice in sign of ±𝑖𝜔𝑡 defines the Fourier convention. The choice in Fourier convention ultimately affects
the phase relationship between real and imaginary components of 𝐹 (𝑖𝜔) and how Maxwell’s equations are represented
in the frequency (Fourier) domain. To demonstrate this, let us first show Maxwell’s equations in the time domain:
𝜕b
𝜕𝑡
𝜕d
∇ × h = j +(7.2)
𝜕𝑡
∇×e=−

(7.1)

• Using +𝑖𝜔𝑡 convention: If the inverse Fourier transform is defined using +𝑖𝜔𝑡, then
]︂
[︂
𝑑
𝑓 (𝑡) = 𝑖𝜔𝐹 (𝑖𝜔)
F
𝑑𝑡
and Maxwell’s equations in the frequency domain are:
∇ × E = −𝑖𝜔B

(7.3)

∇ × H = J + (7.4)
𝑖𝜔D
where 𝑒+𝑖𝜔𝑡 is suppressed.
Using −𝑖𝜔𝑡 convention: If inverse Fourier transform is defined using −𝑖𝜔𝑡, then
[︂
]︂
𝑑
F
𝑓 (𝑡) = −𝑖𝜔𝐹 (𝑖𝜔)
𝑑𝑡
and Maxwell’s equations in the frequency domain are:
∇ × E = 𝑖𝜔B

(7.5)

∇ × H = J − (7.6)
𝑖𝜔D
where 𝑒−𝑖𝜔𝑡 is suppressed.
As we can see, the phase relationship between E and B in Faraday’s law is different for each convention; similarly for
H and D in the Ampere-Maxwell law. Thus it is important to know which convention is being used when examining
the electric and magnetic fields for a particular FDEM code.

7.2.2 Magnetics
Total magnetic intensity data:
For total magnetic intensity (TMI) data, the sign of the data is more or less determined by whether the secondary
magnetic field has components parallel or anti-parallel to the Earth’s inducing field; where the Earth’s inducing field
can be at a variety of orientations depending on latitude and regional variations. In this case, a positive data value
generally indicates that the secondary magnetic field has vector components parallel to the Earth’s inducing field; i.e.
it ‘adds to’ the inducing field. In contrast, a negative data value indicates that components of the secondary field are
anti-parallel, or ‘oppose’, the Earth’s inducing field.
Amplitude data:
For amplitude data, a positive value indicates that the magnitude of the total observed magnetic field (Bp + Bs ) is
larger than the Earth’s inducing field (Bp ); i.e. |Bp + Bs | > |Bp |. The opposite is true for negative data values.
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7.2.3 DCIP data
In the electrostatic case, the Ampere-Maxwell equation shows that ∇ × E = 0 and that E can be written as the gradient
of a scalar potential:
E = ±∇𝑉.
By taking the divergence of Faraday`s law and substituting the previous expression, the DC resistivity problem is
ultimately defined by the following expression:
−∇ · 𝜎(±∇𝑉 ) = ∇ · je
As we can see, our choice in the relationship between E and 𝑉 changes the sign convention for the voltage measurements. In the case of UBC GIF codes, we choose E = −∇𝑉 . By this convention, 1) secondary potentials are positive
in the vicinity of positive electric charges and negative in the vicinity of negative electric charges, and 2) positive
potentials are observed near current sources and negative potentials are observed near current sinks.

7.2.4 EM1DFM data
The EM1DFM code models data for a small loop transmitter with dipole moment in the X (Easting), Y (Northing) or
Z (downward) direction, and receiver coils with dipole moments in the X (Easting), Y (Northing) or Z (downward)
direction. Thus a Z oriented transmitter will have a primary field which points downwards. And positive Hz values
indicate fields with vertical components pointing downward. In X and Y however, the primary field and observed field
components are in the Easting and Northing directions, respectively. If working outside the GIFtools framework, it
is important to realize that transmitters, receivers and data are defined in a left-handed coordinate system with Z +ve
downward.
In GIFtools, we define transmitters and receiver for the 1D codes in the X (Easting), Y (Northing) and Z (upward)
directions. So long as the appropriate sign change is applied, the EM1DFM code can be used to model data for
transmitters and receivers defined within GIFtools. Therefore, the appropriate sign change is automatically applied to
EM1DFM data when loaded into/exported from GIFtools.

7.2.5 EM1DTM data
PENDING**

7.2.6 H3DTD and TDoctree data
For most of the data columns (Hx, Hy, Hz, dBx/dt, dBy/dt), the data represent the true anomalous field components in
the coordinate system that defines the data locations; i,e, X (Easting). Y (Northing) and Z (upwards). However, these
codes represent the time-derivative of the vertical component as -dBz/dt.
The sign convention for dBz/dt data can be explained as follows. For coincident loop airborne systems, the true dBz/dt
response observed at the center of the receiver coil is typically negative and decaying during the off-time. However, the
decay curves for this component have historically been plotted as positive and decaying. This is done for two reasons.
1) A positive decay curve is analogous to the strength of a decaying inductive response. 2) The raw voltage induced
within the receiver coil is in fact positive and decaying. This is because the induced EMF is proportional to -dB/dt.
When people first plotted the raw voltages for this component, it was positive and decaying and the convention for
plotting dBz/dt data was born.

7.2. GIF Data Sign Conventions and Time-Dependency
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7.2.7 MT data
Fourier Convention
The NSEM GIF codes are formulated to use a −𝑖𝜔𝑡 convention for the time-dependence. However, this may not match
the convention used by data loaded into GIFtools from other sources. MT data loaded from EDI files generally uses
the MT/EMAP data interchange standard , which is +𝑖𝜔𝑡. If the convention used for the data does not match that of
the code, it is unlikely that the inversion will be able to fit the data and return meaningful results.
We can determine the convention used by the data by examining the data. If data are represented using the +𝑖𝜔𝑡
convention and are in a right-handed coordinate system, then we expect:
√
𝑖𝜔𝜇
where 𝑘 = 𝑖𝜔𝜇𝜎
and 𝑍𝑦𝑥 ∼ −𝑖𝜔𝜇
𝑘
𝑘
• 𝑅𝑒[𝑍𝑥𝑦 ] > 0, 𝐼𝑚[𝑍𝑥𝑦 ] > 0 and 𝜑𝑥𝑦 ∈ [0𝑜 , 90𝑜 ] (∼ 45𝑜 for a half-space)

• at background locations: 𝑍𝑥𝑦 ∼

• 𝑅𝑒[𝑍𝑦𝑥 ] < 0, 𝐼𝑚[𝑍𝑦𝑥 ] < 0 and 𝜑𝑦𝑥 ∈ [−90𝑜 , −180𝑜 ] (∼ −135𝑜 for a half-space)
If data are represented using the −𝑖𝜔𝑡 convention (GIFtools) and are in a right-handed coordinate system (GIFtools),
then for these data we expect:
√
−𝑖𝜔𝜇
and 𝑍𝑦𝑥 ∼ 𝑖𝜔𝜇
where 𝑘 = −𝑖𝜔𝜇𝜎
𝑘
𝑘
• 𝑅𝑒[𝑍𝑥𝑦 ] > 0, 𝐼𝑚[𝑍𝑥𝑦 ] < 0 and 𝜑𝑥𝑦 ∈ [0𝑜 , −90𝑜 ] (∼ −45𝑜 for a half-space)
• at background locations: 𝑍𝑥𝑦 ∼

• 𝑅𝑒[𝑍𝑦𝑥 ] < 0, 𝐼𝑚[𝑍𝑦𝑥 ] > 0 and 𝜑𝑦𝑥 ∈ [90𝑜 , 180𝑜 ] (∼ 135𝑜 for a half-space)
As we can see, to switch from one convention to another we must:
• Multiply the imaginary components of all impedance tensor elements by -1
• Multiply the phase values for all elements of the impedance tensor by -1
Data Convention
MT data represent the entries of the impedance tensor (Z) where:
[︂
𝑍𝑥𝑥
𝑍𝑦𝑥

]︂ [︃ (1)
𝑍𝑥𝑦
𝐸𝑥
=
(1)
𝑍𝑦𝑦
𝐸𝑦

(2)

𝐸𝑥
(2)
𝐸𝑦

]︃ [︃
(1)
𝐻𝑥
(1)
𝐻𝑦

(2)

𝐻𝑥
(2)
𝐻𝑦

]︃−1

MT data for GIF codes uses a labeling convention where X = Northing, Y = Easting and Z = Down. Superscript (1)
denotes fields resulting from plane waves with electric fields polarized along the X (Northing) direction, and (2) denotes
fields resulting from plane waves with with electric fields polarized along the Y (Easting) direction. The labeling of
the impedance tensor elements is given by:
• 𝑍𝑥𝑥 is Z-Northing-Northing
• 𝑍𝑥𝑦 is Z-Northing-Easting
• 𝑍𝑦𝑥 is Z-Easting-Northing
• 𝑍𝑦𝑦 is Z-Easting-Easting
For more on this, see the E3DMT manual
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7.2.8 ZTEM data
Data Convention
ZTEM data represent transfer functions Tzx and Tzy where:
[︃
]︃
[︂ ]︂
(1) (2)
(2) (1)
(︀ (1) (2)
)︀
𝑇𝑧𝑥
(2) (1) −1 −𝐻𝑦 𝐻𝑧 + 𝐻𝑦 𝐻𝑧
= 𝐻𝑥 𝐻𝑦 − 𝐻𝑥 𝐻𝑦
(1) (2)
(2) (1)
𝑇𝑧𝑦
𝐻𝑥 𝐻𝑧 − 𝐻𝑥 𝐻𝑧
ZTEM data for GIF codes uses a labeling convention where X = Northing, Y = Easting and Z = Down. Superscript (1)
denotes fields resulting from plane waves with electric fields polarized along the X (Northing) direction, and (2) denotes
fields resulting from plane waves with with electric fields polarized along the Y (Easting) direction. The labeling of
field elements is such that:
• 𝐻𝑥 is the component of the magnetic field along the Northing direction
• 𝐻𝑦 is the component of the magnetic field along the Easting direction
• 𝐻𝑧 is the component of the magnetic field in the down direction
For more on this, see the E3DMT manual

7.3 Units
Here, we define the physical property and data units used by each code.
Physical Property Definitions:
• 𝜌 : density
• 𝜅 : susceptibility or effective susceptibility
• 𝜎 : conductivity
• 𝜂 : Intrinsic chargeability. If linear approximation is chosen, any convention of intrinsic or integrated chargeability is acceptable. However, it will change the units of the corresponding data.
Fields and Data Types:
• E : Electric field
• J : Current density
• H : Magnetic field intensity (auxiliary field)
• B : Magnetic flux density
• 𝜕B/𝜕𝑡 : Time-derivative of the magnetic flux density
• 𝑍𝑖𝑗 : The ij-th element of the impedance tensor
• 𝑇𝑖 : The x or y component of the ZTEM transfer function
Units Definitions:
• 𝑚𝐺𝑎𝑙 : milliGal
• 𝑇 : Teslas
• 𝑆 : Siemens
• 𝑉 : Volts
• 𝐴 : Amperes

7.3. Units
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• 𝑝𝑝𝑚 : parts per million
Important: Make sure you scroll all the way to the right within the table to see all information pertaining to a particular
code.
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Type
Gravity
Gravity
Magnetic
Magnetic
MVI
DC/IP

Name
GRAV3D
GRAV PDE
MAG3D
MAG PDE
MVI
2D DCIP

Versions
5.0, 5.1, 6.0
octree
5.0, 5.1, 6.0
octree
3.0

Property Units
𝜌 = 𝑔/𝑐𝑚3
𝜌 = 𝑔/𝑐𝑚3
𝜅 = 𝑆𝐼
𝜅 = 𝑆𝐼
𝜅 = 𝑆𝐼
• 𝜎 = 𝑆/𝑚
• 𝜂 ∈ [0, 1] or
other

DC/IP

3D DCIP

• 𝜎 = 𝑆/𝑚
• 𝜂 ∈ [0, 1] or
other

DC/IP

DCIP octree

octree

• 𝜎 = 𝑆/𝑚
• 𝜂 ∈ [0, 1] or
other

FDEM

EM1DFM

1.0

FDEM

TDEM

EH3D

E3D

EM1DTM

octree

1.0

• V/A for DC
data (details)
• V/A and other
for IP data
(details)
• V/A for DC
data (details)
• V/A and other
for IP data
(details)
• V/A for DC
data (details)
• V/A and other
for IP data
(details)

• 𝜎 = 𝑆/𝑚

• A/m

• 𝜅 = 𝑆𝐼

• ppm of primary field

• 𝜎 = 𝑆/𝑚

FDEM

Data Units
mGal
mGal
nT
nT
nT

• % of primary
field

• 𝜎 = 𝑆/𝑚

• E: V/m

• 𝜅
=
𝑆𝐼
(background
only)

• H: A/m

• 𝜎 = 𝑆/𝑚

• E: V/m

• 𝜅
=
𝑆𝐼
(background
only)

• H: A/m

𝜎 = 𝑆/𝑚

• J: A/m 2

• B: nT, 𝜇 T or
nT
• dB/dt: 𝜇 V,
mV or V (details)

TDEM
7.3. Units

H3DTD

• 𝜎 = 𝑆/𝑚

• E: V/m

• 𝜅
=
𝑆𝐼
(background
only)

• H: A/m
• dB/dt: T/s
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7.3.1 DC data units
DC data are represented by the measured voltage (∆𝑉 ) normalized by the transmitter current (𝐼). Thus the units for
DC data are V/A.

7.3.2 IP data units
Generally, IP data are represented by the measured off-time voltage (∆𝑉 (𝑡)) normalized by the transmitter current
(𝐼); which would be in units for V/A. In this case, the user is forward modeling with and inverting for the intrinsic
chargeability (𝜂 ∈ [0, 1]). If the user wishes to implement the linear model approximation, then other definitions of
intrinsic chargeability (mV/V) or integrated chargeability (ms) can be used to define the chargeability. However, the
units for the resulting IP data would no longer be V/A in this case.

7.3.3 EM1DTM data units
The EM1DTM code represents components of the dB/dt response as the induced voltage within an arbitrarily oriented
receiver coil. Where m is the dipole moment for the receiver coil, 𝑉 = m · 𝑑B/𝑑𝑡 (no minus sign) because the
coordinate system is left-handed! Thus a +ve voltage corresponds to a +ve dB/dt response in the direction defining the
dipole moment of the receiver coil (which is also defined in a left-handed coordinate system).

7.3.4 Impedance tensor (MT) data units
MT data represent the entries of the impedance tensor (Z) where:
[︂
𝑍𝑥𝑥
𝑍𝑦𝑥

]︂ [︃ (1)
𝑍𝑥𝑦
𝐸𝑥
=
(1)
𝑍𝑦𝑦
𝐸𝑦

(2)

𝐸𝑥
(2)
𝐸𝑦

]︃ [︃
(1)
𝐻𝑥
(1)
𝐻𝑦

(2)

𝐻𝑥
(2)
𝐻𝑦

]︃−1

where 1 denotes fields resulting from plane waves with an electric field polarized along the x direction, and 2 denotes
fields resulting from planes with with an electric field polarized along the y direction. For a 3D Earth, 𝑍𝑥𝑦 = 𝐸𝑥1 /𝐻𝑥2 .
Where the electric field units V/m and the magnetic field has units A/m, the units for elements of the impedence tensor
is V/A.
Important: MT data generally use a labeling convention wherein X = Northing, Y = Easting and Z = Down.

7.3.5 Transfer functions (ZTEM) data units
ZTEM data represent the entries of a transfer function (T) where:
[︃
]︃
[︂ ]︂
(1) (2)
(2) (1)
(︀ (1) (2)
)︀
𝑇𝑥
(2) (1) −1 −𝐻𝑦 𝐻𝑧 + 𝐻𝑦 𝐻𝑧
= 𝐻𝑥 𝐻𝑦 − 𝐻𝑥 𝐻𝑦
(1) (2)
(2) (1)
𝑇𝑦
𝐻𝑥 𝐻𝑧 − 𝐻𝑥 𝐻𝑧
where 1 denotes fields resulting from plane waves with an electric field polarized along the x direction, and 2 denotes
fields resulting from planes with with an electric field polarized along the y direction. Thus by dimensional analysis,
the units of the transfer function elements 𝑇𝑥 and 𝑇𝑦 are unitless.

328

Chapter 7. Coordinates, Sign Conventions and Units: A Quick Guide

CHAPTER

EIGHT

RECIPES

8.1 Data Processing
8.1.1 NSEM: From raw EDI files to GIF formatted data
Here we provide a recipe for creating GIF formatted natural source electromagnetic (NSEM) data objects from EDI
files. Depending on the forward model/inversion code the user intends to run, additional steps may be required once
the data are loaded. The additional steps are explained in the content below.
Loading the data and simple processing
• Import data from EDI files: The raw EDI data files contain a combination of impedance, apparent resistivity,
phase, ZTEM and other data which can all be loaded. The resulting data object can be an IMPdata or APPdata
object.
• Create different data type (optional): Let us assume the EDI files contain impedance, apparent resistivity, phase
and ZTEM data and that an IMPdata (impedance data) object was created upon loading. This functionality can
be used to create a ZTEMdata or IMPdata object if those data are found in the IMPdata object.
• Correct units: GIFtools makes assumptions regarding the units of data within EDI files and converts data to
standard units used by GIFtools. See data units in EDI files and GIF data units.
• Correct imaginary and/or phase data: If the time-dependence (±𝑖𝜔𝑡) differs between the data being loaded
and the code being used, then imaginary data and phases must be multiplied by -1 using the calculator. The
details of this step are explained further for MT data and ZTEM data.
• Set IO headers
• Assign uncertainties
Important: Before writing data files and attempting to invert MT data, it strongly advised that the data are viewed in
terms of apparent resistivity. This information can be used to determine how resistivity changes with respect to depth,
determine which frequencies are sensitive to your target and design an appropriate mesh.
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Additional Steps
Preparing data for E3DMT version 1 code:
The E3DMT version 1 programing package can forward model and invert both impedance data and ZTEM data. If the
previous steps have been done to obtain an IMPdata object, impedance data can be forward modeling and/or inverted.
However, ZTEM data will require extra steps if a base station is used to measure the Hx and Hy fields. To set up the
base station for ZTEM data:
• Set/reset base station and define base station ID column
• Set ZTEM data type
• Check to ensure IO header set for base ID column
Impedance and/or ZTEM data can now be exported, forward modeled or inverted.
Preparing data for E3DMT version 2 code:
The E3DMT version 2 programing package can forward model and invert either impedance data or ZTEM data. To use
this code, the dimensions of all wire and loop receivers measuring fields must first be defined. This can by performing
the following steps:
• For ZTEM data, steps in “Preparing data for E3DMT version 1 code” can be used to create a base station, which
sets the locations for loop measuring Hx and Hy. If ZTEM data type is set to MTH, then Hx and Hy measurements
happen at the observation locations.
• Set/reset receivers from data locations for MT data or ZTEM data
• Check to ensure IO header set for station ID column
Impedance and/or ZTEM data can now be exported, forward modeled or inverted.

8.1.2 Create Time/Frequency dependent uncertainties from Statistics
Here we provide a recipe for creating time/frequency based uncertainties based on data statistics. This recipe can save
users a tremendous amount of time when dealing with dataset comprising many time/frequency channels with data
spanning several orders of magnitude.
Step 1: Export data statistics
Floor values are generally used to level the contribution of each times/frequencies. We will use statistics to get reasonable values.
• Export -> Statistics
Step 2: Create a column file [% | floor]
• Open the exported file
• Select and copy any of the columns (e.g. median)
Tip: The GIFtools Team recommends to use Sublime Text as text editor. Press shift+rightClick for column
selection.

330

Chapter 8. Recipes

GIFtoolsCookbook Documentation, Release 1.0

Step 3: Create a column file [% | floor]
• Create a new file in your project directory and paste the column
• Add a column corresponding to the desired percentage value

8.2 Forward Modeling Recipes
8.2.1 Forward model data in GIFtools
In this recipe, we step through forward modelling data, starting from a survey file, a topography file, a 3D mesh, and a
physical property model. At the bottom of this page, you will find the files used in this recipe as well as the complete
project and output files. This recipe uses a magnetic survey file and a susceptibility model on a 3D mesh but the steps
are nearly identical for each data and mesh type in GIFtools.
This recipe requires the following steps:
1. Import a survey, topography, a mesh, and a model
2. Create a forward model item in GIFtools
3. Edit the options
4. Write the files
5. Run the forward modelling
6. Import the predicted data
STEP 1: import a survey, a mesh, and a model
Start GIFtools or open an already existing project. Because we will be loading in a few files, it is easiest to set the
working directory to the folder where the files are located and/or where you would like to do the forward model.
The first step is then to import the magnetic airborne survey locations and the topography file. Importation of data
will slightly differ, depending on the file type (GIF format, XYZ, etc). For this example, the magnetic survey file is
structured as a XYZ while the topography file is in GIF format. Both are imported using the following menus:
• For magnetic survey locations: Import → Data → Magnetics → XYZ

8.2. Forward Modeling Recipes
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Fig. 1: Uncertainty file made for a TEMdata object containing 27 tile channels. Assigned 3% uncertainty with adaptive
floor to account for dynamic range across time channels.
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• For topography: Import → Data → Topography → 3D GIF (3D XYZ)

For the magnetic data, we also need to set the inclination, declination, and field strength. This can be done through the
data manipulation menu.
Once the data are loaded, GIFtools will have the two items shown in the project tree on the left:

It’s a good idea to regularly save your project!
Now we import the 3D mesh and import the associated model. To do so, use the menus as following:
• For the 3D mesh: Import → Mesh → 3D
• For the physical property model: Import → Model → Cell centred
We now have 4 items in the GIFtools project tree:
STEP 2: Create a forward model item in GIFtools
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With all files loaded, we are ready to create the forward modelling item. These can be accessed through the menu
structure:
Create → Forward modelling

For the magnetic example in this recipe, we will choose the MAG3D code (version 6.0):
Create → Forward modelling → Magnetics → MAG3D (v6.0)
Choose a directory to write files to and run the forward modelling in. Click “Open”. You will now see the forward
model item in the GIFtools project tree on the left. For this example, it’s called “forward (MAGforward)”. You can
always rename the first part of the name. The second part tells you what type of data is being forward modelled and/or
which code is used.
The info panel shows you which data item, topography, and model are being used. Depending on the code, the info
panel will show other relevant information and parameters.
STEP 3: Edit the options
Each forward modelling item has its own menu which contains the following:
• Working directory (to set or view)
• Edit options
• Copy options
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• Write files
• Run code
• Load (to import predicted data and locations file)
Depending on the code, some other options might be included in the menu, such as “Set version” for magnetics.

Using the menu, select “Edit options”. This brings up a dialog where the different parameters can be set. For the
magnetics example, it looks like:
Set each of the parameters by using the dropdown menus or filling in a value or text field. In the case of our example,
the completed dialog looks like:
Click “Apply” to set the options. You can always access the dialog again through the menu to make changes.
Note: If the forward model has run, GIFtools does not allow you to edit the options anymore. However, you can copy
the options (through the menu), and then change the parameters on the copied item.
Once the options are set, the info panel will update to reflect the set parameters.
STEP 4: Write the files
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Now that the options are set, we can write the files to the working directory. To do this, use the menu for the forward
model item. For our example using magnetics, we use the following menu structure:
Magnetics forward modelling → Write files
Once the files are written, GIFtools pops up a message saying “The supporting files were written.” Click “OK” to close
the message.
If you navigate to the working directory, you will find the supporting files as well as an input file (if the code requires
one. MAG3D doesn’t.)
STEP 5: Run the forward modelling
To run the forward modelling code, use the menu and select Run ``code``. For magnetics, this menu is as following:
Magnetics forward modelling → Run MAGFOR3D
A command window will pop up and the code will start running. In the meantime, you can still interact with GIFtools
to continue working.
Once the forward modelling is done, close the command window. In the working directory, you will find the output
files.
STEP 6: Import the predicted data
The output files can be quickly loaded into GIFtools using the menu structure for the forward modelling item. In the
case of magnetics, this is the menu to load predicted data:
Magnetics forward modelling → Load → Predicted data
Once loaded, the forward modelling item will become a folder and the predicted data will be added to the folder.
For some forward modelling codes, you can also import the locations file:
Magnetics forward modelling → Load → Locations file
Note: One error message that is most likely to appear is one saying that the code isn’t found in the path. When creating
the forward modelling item, GIFtools automatically looks for the code executable and warns you if it cannot find it.

Note: Once the forward model has run, GIFtools does not allow you to edit the options anymore. However, you can
copy the options (through the menu), and then change the parameters on the copied item.
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Example
The magnetics survey file, topography file, field parameter notes, 3D mesh, and susceptibility model along with a
GIFtools project to repeat the above steps to forward model data: download

8.2.2 Forward model magnetic amplitude data in GIFtools
In this recipe, we step through forward modeling magnetic amplitude data, starting from a TMI data file, a topography
file, and a 3D mesh. At the bottom of this page, you will find the files used in this recipe as well as the complete project
and output files.
This recipe requires the following steps:
1. Import the necessary files
2. Invert for an equivalent source model
3. Forward model amplitude data
STEP 1: Import the necessary files
Start GIFtools or open an already existing project. Because we will be loading in a few files, it is easiest to set the
working directory to the folder where the files are located and/or where you would like to do the forward model.
The first step is then to import the magnetic data, the topography file, and the 3D mesh. Importation of data can slightly
differ, depending on the file type (GIF format, XYZ, etc). For this example, the magnetic data and the topography file
are both in GIF format. Both are imported using the following menus:
• For magnetic survey locations: Import → Data → Magnetics → GIF format
• For topography: Import → Data → Topography → 3D GIF (3D XYZ)
• For the 3D mesh: Import → Mesh → 3D
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Note: Note that the mesh does not have any padding in the vertical direction, as required for the equivalent source
problem.
Once the data are loaded, GIFtools will have the three items shown in the project tree on the left. It’s a good idea to
regularly save your project!
Note: If you have a susceptibility model, you can import the model and skip directly to forward modeling the amplitude
data.
Before we can solve for an equivalent source model for this magnetic data, we need to set the I/O for the data and
uncertainties. This means we need to assign uncertainties (link needed).
Use the menu structure to set the uncertainty for the magnetic data:
Data Manipulation → Assign uncertainties
A dialog pops up to add a percentage and/or a floor to each header. We completed the dialog by clicking the Assign
checkbox for the header “B” and using 0 for percentage and 0.5 nT for the floor. Click “OK” to apply the changes. Now
use the menu structure to set the I/O headers for the data:
Data Manipulation → Set I/O headers
For this example, make sure the total-field anomaly is set the “B” and the uncertainty to “B_uncert” by choosing these
from the drop-down boxes. Click “OK” to close the dialog and apply the changes. The info panel for the magnetic data
item will have updated and all minimum data requirements for the inversion are now set (indicated using ** in the info
panel).
STEP 2: Invert for an equivalent source model
Now we can invert for an equivalent source model. To create the equivalent source item, use the menu structure in
GIFtools as following:
Create → Processing → Magnetic equivalent source

Choose a directory to write files to and run the equivalent source in. Click “Open”. You will now see the equivalent
source item in the GIFtools project tree on the left. For this example, it’s called “MagEquivalentSource (MAGequivalentSource)”. You can always rename the first part of the name.
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The info panel shows you which data item, topography, and mesh are being used. In addition, it will show you the
sensitivity filename.

The equivalent source item has its own menu which contains the following:
• Working directory (to set or view)
• Edit options
• Copy options
• Write
• Run
• Load results
It also has a visualization menu. These menus are identical to those for an inversion item so we refer you to the inversion
recipe for more information on each one.
Use the menu and select Edit options. The dialog shown below pops up:
See the MAGES manual (which can be accessed via the GIF documentation page too) for detailed information about
each parameter.
In this example, set the mesh, data, and topography. We will leave the remaining parameters set to the default values.
Click “Apply and write files” to set the changes and write the files to the working directory. A message will appear to
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state that the files have been written. Click “OK”.
Next, use the menu to run the equivalent source. Use the “all” options to run both the sensitivity and the inversion. A
command window will pop up and the code will run. Once finished, close the command window. In GIFtools, use the
menu to load the last result:
Magnetic equivalent source → Load results → Last result. The equivalent source item will become a folder, with
two subfolders (one for predicted data and one for the models).
If you view the model (use the visualization menu for the recovered GIFmodel), you’ll see it is a single layer, just below
the topography.
STEP 3: Forward model amplitude data
The final step is to forward model amplitude data from the equivalent source model. Using the menus, create a forward
modeling item:
Create → Forward modelling → Magnetics → MAG3D (v6.0)

Select the magnetic data (MAGdata) item that we used for the equivalent source calculation. Convert it to an amplitude
data item using the menus:
Data Manipulation → Choose different data type → Magnetic amplitude data

The following dialog will appear to set the I/O headers:
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Unset the data output using the drop-down menus.
Click “OK”. We now have a MAGAMPdata item in the GIFtools project tree.
Select the forward modelling item. Use the menus to edit its options:
Magnetics forward modelling → Edit options
The dialog is the exact same as in the forward modeling recipe. Select the equivalent source model, the amplitude data
item, and the topography. Then click “Apply”.
Use the menu to write the files:
Magnetics forward modelling → Write files
Then use the menu to run the forward model:
Magnetics forward modelling → Run MAGFOR3D
A command window will open up and the code will start running. Once the code has finished, close the command
window. Finally, use the menu to import the predicted data into GIFtools:
Magnetics forward modelling → Load → Predicted data
The forward modelling item will change into a folder, with the predicted data as an item within that folder. Select the
predicted data and view it to see the amplitude data.
Example
The magnetics data file, topography file, and 3D mesh along with a GIFtools project to repeat the above steps to forward
model amplitude data: download
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8.2.3 Forward Model 2D DC and IP Data
In this recipe, we demonstrate the 2-step processes of forward modeling 2D DC and IP data. DC data can be predicted
using a conductivity model alone, however IP data requires both a conductivity and chargeability model. This recipe
has 3 steps:
1. Load files (optional)
2. Predict DC data and load results
3. Predict IP data and load results
Required GIFtools Objects:
• 2D tensor mesh
• 2D topography
• Electrode Locations (A B M N)
• 2D conductivity model
• 2D chargeability model
Download .zip file for a set of example files.
Load Files
• Import 2D tensor mesh
• Import 2D topography (2D GIF format)
• Import 2D DC/IP locations file
• Import conductivity model
• Import chargeability model

Fig. 2: Conductivity (left) and chargeability (right) models download from .zip file
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Predict DC Data and Load Results
To predict DC data and load the results into GIFtools, carry out the following steps:
• Create 2D DC forward modeling object: The forward modeling object is created to provide a single item that 1)
contains all parameters relevant to the forward model and 2) keeps track of which mesh, data locations etc. are
being used in the forward model.
• Set the forward modeling parameters through edit options: Before we can predict data we must define the mesh,
conductivity model, electrode locations, topography and other parameters. This is done through edit options.
• Write files: Once the parameters are set for the forward model, this command is used to write all the input files
for the Fortran code into the specified directory. If you have not set the working (output) directory or would like
to change the working directory, use set working directory.
• Run the forward model: The forward model can be run directly from GIFtools using the forward modeling object.
• Load predicted data: Once completed, GIFtools can be used to load the predicted data. Since the predicted data
are unique to the forward modeling object, the predicted data are loaded into that folder.

Fig. 3: Edit options tabs showing inputs for test example.

Predict IP Data and Load Results
To predict IP data and load the results into GIFtools, carry out the same steps as before:
• Create 2D IP forward modeling object
• Set the forward modeling parameters through edit options: Here, we require both a conductivity and chargeability
model.
• Write files
• Run the forward model
• Load predicted data
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Fig. 4: Edit options tabs showing inputs for test example.
Results

Fig. 5: Pseudo-section DC data (left) and IP data (right) from the test example. Notice the effect of the surface topography on the data points.

8.3 Inversion Recipes
8.3.1 Invert data in GIFtools
In this recipe, we step through inverting data, starting from a data file, a 3D mesh, and a topography file. At the bottom
of this page, you will find the files used in this recipe as well as the complete project and output files. This recipe uses
a magnetic data file and a 3D mesh but the steps are nearly identical for each data and mesh type in GIFtools.
This recipe requires the following steps:
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1. Import a data file, a mesh, and a topography file
2. Create an inversion item in GIFtools
3. Edit the options
4. Write the files
5. Run the inversion
6. Import the recovered models and predicted data
7. View the convergence curve, misfit maps, and more
STEP 1: Import a data file, a mesh, and a topography file
Start GIFtools or open an already existing project. Because we will be loading in a few files, it is easiest to set the
working directory to the folder where the files are located and/or where you would like to do the forward model.
The first step is then to import the gravity data and the topography file. Importation of data will slightly differ, depending
on the file type (GIF format, XYZ, etc). For this example, the gravity data file is structured as a XYZ while the
topography file is in GIF format. We also need to import a 3D mesh. All three are imported using the following menus:
• For gravity data: Import → Data → Gravity → XYZ
• For topography: Import → Data → Topography → 3D GIF (3D XYZ)
• For the 3D mesh: Import → Mesh → 3D

Once the data and mesh are loaded, GIFtools will have three items shown in the project tree on the left:
It’s a good idea to regularly save your project!
Before we can invert this gravity data, we need to set the I/O for the data and uncertainties. This means we need to
assign uncertainties to the data first (link needed).
Use the menu structure to set the uncertainty for the gravity data:
Data Manipulation → Assign uncertainties
A dialog pops up to add a percentage and/or a floor to each header. We completed the dialog as following for the gravity
example, using 0 for percentage and 0.01 for the floor:
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Click “OK” to apply the changes. Now use the menu structure to set the I/O headers for the data:
Data Manipulation → Set I/O headers
For this gravity example, select the vertical gravity anomaly and the uncertainty from the drop-down boxes.

Click “OK” to close the dialog and apply the changes. The info panel for the data item will have updated and all
minimum data requirements for the inversion are now set (indicated using ** in the info panel).
STEP 2: Create an inversion item in GIFtools
With all files loaded and the data properly assigned, we are ready to create the inversion item. These can be accessed
through the menu structure:
Create → Inversion
For the gravity example in this recipe, we will choose the GRAV3D code (version 6.0):
Create → Inversion → Gravity → GRAV3D 6.0
Choose a directory to write files to and run the inversion in. Click “Open”. You will now see the inversion item in the
GIFtools project tree on the left. For this example, it’s called “gravityInversion (GRAVinversion)”. You can always
rename the first part of the name. The second part tells you what type of data is being inverted and/or which code is
used.
The info panel shows you which data item, topography, and mesh are being used. Depending on the code, the info
panel will show other relevant information and parameters.
STEP 3: Edit the options
Each inversion item has its own menu which contains the following:
• Working directory (to set or view)
• Edit options
• Copy options
• Write (to write supporting and input files)
350

Chapter 8. Recipes

GIFtoolsCookbook Documentation, Release 1.0

8.3. Inversion Recipes

351

GIFtoolsCookbook Documentation, Release 1.0

• Run code (or Run → weights, sensitivity, inversion)
• Load results (to import predicted data and recovered models)
Depending on the code, some other options might be included in the menu, such as “Set version” for gravity.

Each inversion item also has a visualization menu, which can be used to view the convergence curve, view the log file,
and view inversion progress. This menu is discussed in Step 7.
Using the menu, select “Edit options”. This brings up a dialog where the different parameters can be set. For the
gravity example, it looks like:
The dialog has at least two tabs. In the case for the gravity example, there are 3. The first tab will ask for the mesh, data,
and topography items, as well as other code specific parameters (such as weighting and wavelets for potential fields).
Set the parameters by choosing from the drop-down menus and/or filling in text boxes. For our gravity example, the
dialog looks as following:
Now, click on the second tab. For the gravity inversion, it’s called “Inversion”:
This tab allows you to set the majority of the input options. Default values are provided as much as possible. For detailed
descriptions of the parameter meanings, check out the manual for the appropriate code on the GIF documentation page
In this example, we are leaving all values as default. Click on the third tab (if there is one). For gravity, it is called
“Blocky model norms”.
This tab allows you to set Lp-Lq specific parameters associated with version 6.0 of the gravity inversion code. For this
example, we are not changing any parameters.
Once satisfied with all the parameters, click “Apply” to set the options or “Apply and write files” to set the options and
write all necessary files to the working directory.
Note: If the inversion has run, GIFtools does not allow you to edit the options anymore. However, you can copy the
options (through the menu), and then change the parameters on the copied item.
STEP 4: Write the files
Now that the options are set, we can write the files to the working directory. To do this, use the menu for the inversion
item. For our example using gravity, we use the following menu structure:
Gravity inversion → Write files → All inversion files
Gravity inversion → Write files → PFWEIGHT Files
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Gravity inversion → Write files → GZSEN3D Files
Gravity inversion → Write files → GZINV3D Files

For the gravity example, use the first option to write all files. Depending on the code, GIFtools will ask you to provide
a filename for in the input file.
Once the files are written, GIFtools pops up a message saying the input file(s) and supporting files were written. Click
“OK” to close the message.
If you navigate to the working directory, you will find the supporting files as well as an input file(s).
STEP 5: Run the inversion
To run the inversion code, use the menu and select Run ``code``. For gravity, this menu is as following:
Gravity inversion → Run → All
Gravity inversion → Run → Weights
Gravity inversion → Run → Sensitivity
Gravity inversion → Run → Inversion
For the gravity example, choose the first option to run all.
A command window will pop up and the code will start running. In the meantime, you can still interact with GIFtools
to continue working.
Once the inversion is done, close the command window. In the working directory, you will find the output files.
STEP 6: Import the recovered models and predicted data
The output files can be quickly loaded into GIFtools using the menu structure for the inversion item. In the case of
gravity, this is the menu to load recovered models and predicted data:
Gravity inversion → Load results → All results
Gravity inversion → Load results → Selected results
Gravity inversion → Load results → Last result
All results will load all iterations. Selected results will pop up a dialog where you can choose which iterations to load.
Last result loads the last iteration only.
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Once loaded, the inversion item will become a folder containing two folders: one for the recovered models, and one for
the predicted data.
For the gravity example, we loaded all results, which looks like the following in GIFtools:

Note: Once the inversion has run, GIFtools does not allow you to edit the options anymore. However, you can copy
the options (through the menu), and then change the parameters on the copied item.
STEP 7: View the convergence curve, misfit maps, and more
Each inversion item has a second menu called “Visualization”. This contains the following options:
Visualization → Convergence curve
Visualization → Log file
Visualization → View progress
The Convergence curve menu item allows you to view a graph of the data misfit and model objective function per
iteration and the Tikhonov curve. For the gravity example, it looks like:
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On the left side of the dialog, you can select a particular iteration and see the beta, model objective function, data misfit,
and chi-factor associated with that iteration. There are also buttons to Show model and Show misfit for that iteration.
Clicking these will bring up the VTK visualization with either the recovered model or the data misfit map.
The Log file option in the visualization menu opens the log file in a text editor.
View progress allows you to view the convergence curve while the inversion is running.
Note: One error message that is most likely to appear is one saying that the code isn’t found in the path. When creating
the inversion item, GIFtools automatically looks for the code executable and warns you if it cannot find it.

Example
The gravity data file, topography file, and 3D mesh along with a GIFtools project to repeat the above steps to invert for
a model: download

8.3.2 Do an equivalent source inversion through GIFtools
Caution: The equivalent source code is currently under review. Beware of topographic effects in the forward data.
In this recipe, we step through an equivalent source inversion using magnetic data, starting from a TMI data file, a
topography file, and a 3D mesh. At the bottom of this page, you will find the files used in this recipe as well as the
complete project and output files. The steps for doing an equivalent source inversion for gravity and gravity gradiometry
are very similar to this.
This recipe requires the following steps:
1. Import the necessary files
2. Invert for an equivalent source model
STEP 1: Import the necessary files
Start GIFtools or open an already existing project. Because we will be loading in a few files, it is easiest to set the
working directory to the folder where the files are located and/or where you would like to do the forward model.
The first step is then to import the magnetic data, the topography file, and the 3D mesh. Importation of data can slightly
differ, depending on the file type (GIF format, XYZ, etc). For this example, the magnetic data and the topography file
are both in GIF format. Both are imported using the following menus:
• For magnetic survey locations: Import → Data → Magnetics → GIF format
• For topography: Import → Data → Topography → 3D GIF (3D XYZ)
• For the 3D mesh: Import → Mesh → 3D
Note: Note that the mesh does not have any padding in the vertical direction, as required for the equivalent source
problem.
Once the data are loaded, GIFtools will have the three items shown in the project tree on the left. It’s a good idea to
regularly save your project!
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Note: If you have a susceptibility model, you can import the model and skip directly to forward modeling the amplitude
data.
Before we can solve for an equivalent source model for this magnetic data, we need to set the I/O for the data and
uncertainties. This means we need to assign uncertainties to the data first assignUncert (link needed).
Use the menu structure to set the uncertainty for the magnetic data:
Data Manipulation → Assign uncertainties
A dialog pops up to add a percentage and/or a floor to each header. We completed the dialog by clicking the Assign
checkbox for the header “B” and using 0 for percentage and 0.5 nT for the floor. Click “OK” to apply the changes. Now
use the menu structure to set the I/O headers for the data:
Data Manipulation → Set I/O headers
For this example, make sure the total-field anomaly is set the “B” and the uncertainty to “B_uncert” by choosing these
from the drop-down boxes. Click “OK” to close the dialog and apply the changes. The info panel for the magnetic data
item will have updated and all minimum data requirements for the inversion are now set (indicated using ** in the info
panel).
STEP 2: Invert for an equivalent source model
Now we can invert for an equivalent source model. To create the equivalent source item, use the menu structure in
GIFtools as following:
Create → Processing → Magnetic equivalent source
Choose a directory to write files to and run the equivalent source in. Click “Open”. You will now see the equivalent
source item in the GIFtools project tree on the left. For this example, it’s called “MagEquivalentSource (MAGequivalentSource)”. You can always rename the first part of the name.
The info panel shows you which data item, topography, and mesh are being used. In addition, it will show you the
sensitivity filename.
The equivalent source item has its own menu which contains the following:
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• Working directory (to set or view)
• Edit options
• Copy options
• Write
• Run
• Load results
It also has a visualization menu. These menus are identical to those for an inversion item so we refer you to the inversion
recipe for more information on each one.
Use the menu and select Edit options. The dialog shown below pops up:

See the MAGES manual (which can be accessed via the GIF documentation page too) for detailed information about
each parameter.
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In this example, set the mesh, data, and topography. We will leave the remaining parameters set to the default values.
Click “Apply and write files” to set the changes and write the files to the working directory. A message will appear to
state that the files have been written. Click “OK”.
Next, use the menu to run the equivalent source. Use the “all” options to run both the sensitivity and the inversion. A
command window will pop up and the code will run. Once finished, close the command window. In GIFtools, use the
menu to load the last result:
Magnetic equivalent source → Load results → Last result. The equivalent source item will become a folder, with
two subfolders (one for predicted data and one for the models).
If you view the model (use the visualization menu for the recovered GIFmodel), you’ll see it is a single layer, just below
the topography.
Example
The magnetics data file, topography file, and 3D mesh along with a GIFtools project to repeat the above steps to
calculate the equivalent source model: download

8.3.3 Invert 2D DC and IP Data
In this recipe, we demonstrate the 2-step processes of inverting 2D DC and IP data. DC data can be inverted without a
background model, however IP data a background conductivity. This recipe has 3 steps:
1. Load files (optional)
2. Invert DC data and load results
3. Invert IP data and load results
Required GIFtools Objects:
• 2D tensor mesh
• 2D topography
• DC data (with uncertainties)
• IP data (with uncertainties)
Download .zip file for a set of example files.
Load Files
• Import 2D tensor mesh
• Import 2D topography (2D GIF format)
• Import DC data
• Import IP data
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Fig. 6: True conductivity (left) and chargeability (right) models we hope to recover.
Invert DC Data and Load Results
To invert DC data and load the results into GIFtools, carry out the following steps:
• Create 2D DC inversion object: The inversion object is created to provide a single item that 1) contains all
parameters relevant to the inversion and 2) keeps track of which mesh, data locations etc. . . are being used in the
inversion.
• Set the inversion parameters through edit options: Before we can invert DC data we must define the mesh, survey
data, topography and inversion parameters. This is done through edit options.

Fig. 7: Edit options tabs showing inputs for test example.

• Write files: Once everything is set for the inversion, this command is used to write all the input files for the Fortran
code into the specified directory. If you have not set the working (output) directory or would like to change the
working directory, use set working directory.
• Run the inversion: The forward model can be run directly from GIFtools using the inversion object.
• Load results: Once completed, GIFtools can be used to the predicted data and models for each iteration. Since
the results are unique to the inversion object, the results are loaded into that folder.
• Examine convergence curves, model and misfit maps: Once the inversion has terminated, it is beneficial to
examine the convergence towards the final model. This analysis will indicate whether the inversion has hit the
target misfit and provide some insight as to whether the assigned data uncertainties were reasonable. The quality
of the recovered model can also be assessed by looking at the model itself or the misfit between the predicted
and observed data.
8.3. Inversion Recipes

365

GIFtoolsCookbook Documentation, Release 1.0

Fig. 8: Convergence curves (left) and recovered conductivity model - 7th iteration (right) for the test example using the
above parameters.
Invert IP Data and Load Results
To invert IP data and load the results into GIFtools, carry out a similar set of steps:
• Create 2D IP inversion object
• Set the inversion parameters through edit options: The inversion requires that the user specify a background
conductivity model.
• Write files
• Run the inversion
• Load results
• Examine convergence curves and model

Fig. 9: Recovered chargeability model - 8th iteration (left) and corresponding normalize data misfit (right). The chargeability was recovered using the conductivity model from the 7th iteration of the DC invesion.
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8.3.4 Explore the model space
In this recipe, we step through inverting data, starting from a data file, a 3D mesh, and a topography file. This recipe
uses a magnetic data file and a 3D mesh but the steps are nearly identical for each data and mesh type in GIFtools.
This recipe requires the following steps:
1. Load the project
2. Create an inversion item in GIFtools
3. Edit the options
4. Write the files
5. Run the inversion
6. Import the recovered models and predicted data
7. Extract sections and compare the results
Example
The GIFtools project used in this recipe can be download here
STEP 1: Load the GIFtools Project
Start GIFtools and open the project provided. Set the working directory to the folder where the files are located and/or
where you would like to do the inversions.
Once the project is loaded, GIFtools will have three items shown in the project tree on the left:

STEP 2: Create an Inversion (Template)
With all files loaded and the data properly assigned, we are ready to create the inversion item. These can be accessed
through the menu structure:
Create → Inversion
For the magnetic example in this recipe, we will choose the MAG3D code (version 6.0):
Create → Inversion → Magnetic → MAG3D 6.0
Choose a directory to write files to and run the inversion in. Click “Open”. You will now see the inversion item in
the GIFtools project tree on the left. For this example, it’s called “magneticInversion (MAG3Dinversion)”. You can
always rename the first part of the name. The second part tells you what type of data is being inverted and/or which
code is used.
The info panel shows you which data item, topography, and mesh are being used. Depending on the code, the info
panel will show other relevant information and parameters.
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STEP 3: Edit the options
The Model Space inversion will iterate through model parameters, but each inversion will use common parameters that
remain fix:
• Working directory (to set or view)
• Edit options
• Copy options
• Write (to write supporting and input files)
• Run code (or Run → weights, sensitivity, inversion)
• Load results (to import predicted data and recovered models)
Depending on the code, some other options might be included in the menu, such as “Set version” for magnetic.

Each inversion item also has a visualization menu, which can be used to view the convergence curve, view the log file,
and view inversion progress. This menu is discussed in Step 7.
Using the menu, select “Edit options”. This brings up a dialog where the different parameters can be set. For the
magnetic example, it looks like:
The dialog has at least two tabs. In the case for the magnetic example, there are 3. The first tab will ask for the mesh,
data, and topography items, as well as other code specific parameters (such as weighting and wavelets for potential
fields).
Set the parameters by choosing from the drop-down menus and/or filling in text boxes. For our magnetic example, the
dialog looks as following:
Now, click on the second tab. For the magnetic inversion, it’s called “Inversion”:
This tab allows you to set the majority of the input options. Default values are provided as much as possible. For detailed
descriptions of the parameter meanings, check out the manual for the appropriate code on the GIF documentation page
In this example, we are leaving all values as default. Click on the third tab (if there is one). For magnetic, it is called
“Blocky model norms”.
This tab allows you to set Lp-Lq specific parameters associated with version 6.0 of the magnetic inversion code. For
this example, we are not changing any parameters.
Once satisfied with all the parameters, click “Apply” to set the options or “Apply and write files” to set the options and
write all necessary files to the working directory.
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Note: If the inversion has run, GIFtools does not allow you to edit the options anymore. However, you can copy the
options (through the menu), and then change the parameters on the copied item.
STEP 4: Write the files
Now that the options are set, we can write the files to the working directory. To do this, use the menu for the inversion
item. For our example using magnetic, we use the following menu structure:
Magnetic inversion → Write files → All inversion files
Magnetic inversion → Write files → PFWEIGHT Files
Magnetic inversion → Write files → MAGSEN3D Files
Magnetic inversion → Write files → MAGINV3D Files

For the magnetic example, use the first option to write all files. Depending on the code, GIFtools will ask you to provide
a filename for in the input file.
Once the files are written, GIFtools pops up a message saying the input file(s) and supporting files were written. Click
“OK” to close the message.
If you navigate to the working directory, you will find the supporting files as well as an input file(s).
STEP 5: Run the Inversions
Sensitivities
Since we want to run multiple inversions based on the same data and mesh, we can save time by calculating the sensitivity matrix only once. We will perform the sensitivity calculations on our Template inversion.
To run the inversion code, use the menu and select Run ``code``. For magnetic, this menu is as following:
Magnetic inversion → Run → Weights
Magnetic inversion → Run → Sensitivity
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Inversions
Once the sensitivity matrix has been written to disk, we are ready to launch the series of inversions.
ModelSpace → Run
The user has the option to run the inversions Locally or on a Remote computer. See Model Space section for the different
options.
STEP 6: Import the recovered models and predicted data
The output files can be quickly loaded into GIFtools using the menu structure for the inversion item. In the case of
magnetic, this is the menu to load recovered models and predicted data:

ModelSpace → Load All
Once loaded, each inversion object will become a folder containing the final model and predicted data.
For the magnetic example, we loaded all results, which looks like the following in GIFtools:

Note: Once the inversion has run, GIFtools does not allow you to edit the options anymore. However, you can copy
8.3. Inversion Recipes
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the options (through the menu), and then change the parameters on the copied item.
Step7: Export sections and compare the results
We now have multiple models that fit the observed data with the target residual. We want to compare these solutions.
GIFtools has the capability to export multiple models on a common section with the Model Extraction tool.
ModelSpace → Export Sections
s

8.4 Other Recipes
8.4.1 Create a geologic model from a plan-view image
GIFtools can import a geologic image and convert it to a geology model. This allows one to create upper and lower
bound models, build weights, and create physical property models based on the geology. This is particularly useful for
inversion of multiple data types in the same area. Below are the steps create a geology model from a plan-view image.
In GIFtools, Import a geologic image. The image should have solid colours indicating geologic zones (see below for
example). The algorithms developed in GIFtools will struggle if annotations are included in the image.
In this example, the image file is called “geology2.tif” and the world file is called “geology2.tifw”. We do not have a
legend file so are not importing one. The topography for this is called “topography.dat”. We also import a 3D mesh
(called “mesh.msh”) into the GIFtools project. The project tree looks like the following:
We can visualize the mesh, and then load in the topography and image over top:
Next, we need to define a legend for the image. If the legend file was not imported with the mesh, either import or
create the image legend through the image menu. This file gives the ID and its corresponding colour code (RGB). In
this example, we have to create the legend. The table then looks like:
Each colour identified in the image has an index and an RGB triplet. If we click OK, the table will close and the info
panel for the geology image will now show a check mark next to “Legend set:”.
Using the mesh, create or use an already existing modelBuilder module (make sure it is on the mesh you want to use
in an inversion or forward modelling). Because in our example, we did not already have a modelBuilder object, we
created one with the 3D mesh and the topography. Then, we started the modelBuilder module.
Click on the modelBuilder item in the project tree and use the following menus to create a geology model from an
image:
Create model → Geology model from → Map image
The following dialog opens up:
Select the image we want to use (in this case, geoglogy2). Then there are a few options on how to create the model:
1. Thickness: Specify a positive value that will be the thickness from the topography downwards. A thickness of 0
will extend the model down 1 cell beneath the topography.
2. Elevation: Specify a value and the model will extend from the topography to the lower elevation value.
3. Surface: Choose a surface item and the model will extend from the topography to the lower surface item.
In this example, we will choose a thickness of 200 m. Click OK.
Once the model has been created, it will appear in the project tree, within the modelBuilder folder. The model will
have the image name followed by “_mod”, which in this case is geology2_mod.
The GEOmodel can be viewed by using the Visualization menu. We see the following:
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The geology model is zero wherever there was no information provided. In this example, the image did not stretch all
the way to mesh extents and the mesh has more cells above and below the thickness of the image specified. Use the
visualization controls to cut off zero values within the model.

Now we see the image, draped over the topography and extended 200 m in depth.
From here, you can use the geology model to create a physical property model (i.e., reference model, initial model,
upper and lower bounds) or create weights.
Example
The files used in this recipe, along with the completed project can be downloaded here.

8.4.2 Use a surface (or surfaces) in an inversion
In GIFtools, surfaces are imported and used to create or edit a geology model. This allows one to set bounds, weights,
and a physical property based on the geology ID. This is particularly useful for inversion of multiple data types in the
same area. Below are the steps to put information from a surface (or surfaces) in an inversion.
NOTE: In future releases of GIFtools, this functionality will be streamlined in a inversion workflow. For now, the
surface(s) and modelBuilder module are required. Below are details of the step required to create reference models,
bounds, etc from a surface.
1. Import a surface or surfaces (import each surface individually). Below is a surface and mesh used in this example.
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2. Create or click an already created modelBuilder module.
3. Within the modelbuilder module use the menu below, even if only using one surface. Create or edit a geology
model using the dialog found through the menu:
Create → Model → Value between two surfaces

Here is contribution from the surface has contributed to the model. Unit 1 is blue (original unit) and Unit 2 is red. The
physical properties, bounds, etc. for these two units is specified through step 5 (geology definition).
5. The following steps are required (in order) due to the fact that the geology model must have a definition.
• Set the geology definition: Create it using the Geology definition → Edit option within the geology model
menu or import the definition.
• Set the definition’s i/o headers to correspond on what is desired to be built (weights, bounds, etc.). Use
the menu from the geology model:
Geology definition → Set i/o headers
• Use the modelBuilder module Build constraints menu and build the models desired for the inversion (e.g.,
Build constraints → Reference model). Add the geology model from the image to the list of models to
use for creation.
– NOTE: To use the geology model to create only smallest component weights follow the steps:
a. Set geology model to the modelBuilder’s geology model using Model Builder → Set model →
Geology
b. Ensure that the modelBuilder has a reference model (MB Reference Model), if not you will have
to set one through the menu above, but with the “Reference” option. If only a weighting based on
the units is desired, the reference model should be constant. This model can be created from the
“Single rock unit” geology model by selecting the GEOmodel and then using the menu Create
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model → From property values. The spatial weights will be influenced if a reference model
is already defined with other information (i.e., borehole discretization).
c. Use the menu Build constraints → Weighting functions → From reference and geology
models.
6. Once the models are built, they can be used in the inversion by selecting the inversion item and editing its
options. Select the models made from the build within modelBuilder with the option on how it should be used
(i.e., reference model, initial model, bounds, weights).

8.4.3 Import TEM data into GIFtools from XYZ or CSV file
GIFtools can import time-domain EM data from a xyz or csv file in a few simple steps. This recipe uses a VTEM data
set from a csv file. The first line in the file should be the data headers. Double check the file formats before starting:
csv file and xyz file.
Note: If you have multiple component data and not all time channels are available for some components, GIFtools can
handle that. This recipe uses an example where the x component data has less time channels than the z component.
Start GIFtools or open an already existing project. Because we will be loading in a number of files, it is easiest to set
the working directory to the folder where the files are located.
To set the working directory: Project → Set properties → Set working directory or use the shortcut command
Control+Shift+D
Now, let’s start importing the TEM data: Import → Data → Time-domain EM
There are several data formats to choose from. In this recipe, we focus on importing from a XYZ or a csv file. The
steps are the same for both data formats. The example used here is from a csv file: Import → Data → Time-domain
EM → CSV file.
The following GUI will pop up:
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Step 1
Click on the “Step 1” button. The following GUI will pop up.
Choose the appropriate headers from the drop-down menus for Easting, Northing, and Elevation. For our example, this
is X, Y, and DEM.
Next, add in the time channel information. This can be done in two ways: (1) Manually add the time channel information
by clicking the plus or minus buttons to increase or decrease the number of time channels. Then the time can be entered
in the second column. (2) Alternatively, you can load a text file that contains the time channels, as shown below.
To load in a file with the time channels, click “Load text file” and select the desired file. The GUI will update with the
number of times and the time channels. In the case of our example, there are 45 time chanels, ranging from 0.021 to
10.667 ms.
Note: These units will have to be changed before inversion of the data, but this can easily be done using the Data
manipulation menu once the data is loaded into GIFtools.
The final step is to select the number of data groups. For this example, there are 4: the horizontal and vertical components of the time derivative of the magnetic field (dB/dt) and the magnetic field (B), In our example, these are denoted
as SFx, SFz, BFx, and BFz in the headers of the csv file. Click the plus or minus buttons to increase or decrease the
desired number of data groups.
Once this information is entered, our GUI looks like:
Click OK and move on to Step 2.
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Step 2
With Step 1 complete, the GUI shows the number of data types selected. For our example, that’s 4 data groups. Select
the first data type to specify from the drop down menu. It will be called “Data type 1”. Click the “Specify type” button
and the following window will appear:
Here, you can change the header name for this data group from “Data type 1” to your desired name. For our example,
we’ve chosen “SFz”. There are 2 ways to assign the header for each time channel:
1. Click on the empty cell below “Header” and a drop-down menu will appear. Select the desired header name.
Repeat for each time channel. If there is no header associated for a particular time channel (i.e., there is no data
associated with that time channel), leave the header field blank. For our example, the first header is “SFz[4]”, as
shown below:
2. The faster method is click the “Load headers” button and select a file containing all the headers. The file format
for the headers is shown below for two of the four data groups in our example. The headers in these files are
SFz[4]-SFz[48] and BFz[4]-BFz[48]. This automatically fills in the header column, as shown in the second
figure below.
In the case where there are more time channels than headers, leave a blank line in the header file, as shown below.
This will then not associate a header with that time channel and assign a dummy value as the data value when finished
loading into GIFtools. In our example, there is only x component data for time channels 20-48, so the header file
contains the headers SFx[20]-SFx[48] with blank lines above the first header.
Once the headers have been added for this data group, click OK. You should now see that the first data group’s name
has been updated (if you changed it) and it has been assigned.
Repeat these steps for any remaining data types and then move on to Step 3.
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Step 3
When all data types are assigned in Step 2, any remaining data columns detected in the file will appear as miscellaneous
data in Step 3. The figure below shows what this looks like for our example. Here, you can select additional data to
import. In our case, we’ve selected 4 additional columns of data, as shown below.
Note: If the data columns contain anything other than numbers, importation may not succeed. For this reason, we are
not importing the column “Line” above because the data in the csv file are of the format “L000”.

Load the data
When everything is selected as desired, click OK to load in the time-domain EM data into GIFtools.
Tip: Depending on the size of the file, loading the data may take some time!
After the data has been loaded, the TEMdata object will appear in the GIFtools GUI, as shown below.
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Additional notes and tips
Tip: The TEM data is now loaded into GIFtools but the transmitter information has not been added. See the recipe
for adding transmitters to TEM data.

Tip: If any figures are too small to read, right-click and open the image in a new tab!

8.4.4 Add transmitter information to a TEM data object
After a time-domain EM data from a csv or xyz file has been imported into GIFtools, the transmitter information is still
missing in the TEMdata object. This recipe steps through adding in the transmitter information in three different ways:
1. Loading a file
2. Creating airborne EM (AEM) coincident loop sources
3. Creating AEM offset loop sources
To add transmitters to a TEM data object, use the menus: TEM data → Add transmitters and select the desired
method.
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Loading a transmitter file
The transmitter file uses a “block” format. The types of EM transmitters available are:
• Large-loop,
• Line-current,
• Dipole, and
• Loop
Refer to the EM transmitter formats page for detailed information. Each transmitter will have its own “block” in the
transmitters file.
Add AEM coincident loop sources
The second option is to add coincident loop sources and when selected, the following dialog pops up:
The first field requires the radius of the loop transmitter in meters. The second field asks for the normal angle from the
vertical of the transmitter. This can either be provided as a value (in degrees) or as a column from the data object (for
example, in the case where the angle changed during survey collection and was recorded). The third field requests the
azimuth angle from north. This is again a value (in degrees) or a column selected from the data object.
Click ok to assign the transmitters to the TEMdata object.
Note: If you have a large data set, it may take some time to calculate all the transmitter locations and assign them!
There is also a video that shows this functionality: video tutorial
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Add AEM offset loop sources

The fields for the radius, normal angle from the vertical, and the azimuth angle from north require the same information
as described for the coincident loop above.
The bearing of the survey lines can be calculated directly from the data or provided from a column. The bearing should
be in degrees.
The along-line, cross-line, and vertical offsets are values given in meters. The vertical offset is the vertical distance
between the transmitter and the receiver. If the transmitter is above the receiver, this value should be positive. The
along-line offset is how much the transmitter is in front of the receiver (positive in meters) or behind the receiver
(negative in meters). The cross-line offset describes how much the receiver is to either side of the line. The following
diagram shows the along-line (A) and cross-line (C) offset definitions:
Click ok to assign the transmitters to the TEMdata object.
There is also a video that shows this functionality: video tutorial
Note: If you have a large data set, it may take some time to calculate all the transmitter locations and assign them!
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Fig. 10: The figure shows the along-line (A) and cross-line (C) offsets for a transmitter (blue circle) and a receiver (red
dot) along a flight line (black). The thick arrows indicate the flight direction along the line.
Additional notes and tips
Note: When creating AEM offset loop sources, you can double check that the location of the source is correct. Do
this by viewing the sources and receivers in the VTK viewer. Click Sources in the control panel to view the source
locations.

Tip: If you have a large data set loaded into GIFtools and plan to downsample the data before inversion, it is recommended to first downsample and then assign transmitters to safe computation costs.

8.4.5 Create a geology model from an isosurface
In GIFtools, a geologic model can be generated from any physical property model (e.g., a density contrast model or
a conductivity model). This recipe outlines the steps to create a geologic model based on isosurfaces from a physical
property model.
Open GIFtools and if desired, set the working directory.
In this recipe, the example uses a 3D mesh and a susceptibility model. Import the 3D mesh and then import the
corresponding model.
View the model and decide what the physical property values are for the isosurfaces(s). The figure below shows the
example model used in this recipe.
For this example, there will be a single isosurface at 0.002 SI. This means this geologic model will have two units:
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1. Background (cells with susceptibility between 0 and 0.002 SI)
2. Anomaly (cells with susceptibility 0.002 SI and up)
To create a geology model, we need to create a ModelBuilder module. In this example, we generate an active model
from the susceptibility model: Model → Create → Active topography model from air values

GIFtools will ask for the value of the air cells in the selected model, which here is -100. A tolerance is also requested.

An active model can be generated in other ways too. To create active cells models from a mesh, see this page.
The figure below shows the active model, with values of 1 for active cells (below topography) and 0 for inactive cells
(above topography).
Now, start Modelbuilder.
To create a geologic model from an isosurface: Create model → Geology model from → GIF models.
The following window will pop up:
The first panel in the window deals with the models that are currently in the project. The available models are shown
on the left, and in this case, there is only 1 model in the project, called “vtemAmp”. To choose the model, highlight
it and click the right arrow to move it to the right. In case for log-spaced models (e.g., conductivity), click the check
button for “Specify log-spaced models”.
The second panel provided options on how to group or cluster cells in the model. K-means and Fuzzy C-means are
algorithms that will choose the boundaries for different groups. The third option is to provide a set of user defined
boundaries. For each method, the number of groups is required. In this example, we choose “User defined boundaries”
and 2 for the “Number of groups”.
The last panel asks for a new model name. In this example, we will call the geologic model “geomod”. The figure
below shows the completed window for this example:
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Click OK. Then pops up the following window:

In this window, we define the upper and lower boundaries for each of the groups. Here, group 1 will be the background
and group 2 will be the anomaly. Thus, the maximum value for group 1 will be 0.002 SI. The minimum value will be
a small enough value such that all cells with a value lower than the max are included. We choose -10000. For group 2,
the minimum value is 0.002 SI. We want to include all cells than have a susceptibility higher than the minimum so we
will set to maximum to 10000 to ensure we have all those cells.
The window then looks like:

Click OK to set the group values. A new GEOmodel will appear in the Model Builder folder with the name we gave it.
Note: The number of units in the new GEOmodel is 3! How come? We had only defined 2 groups. If the model is
now viewed, there are indeed 3 units. Unit 1 is the background (less than 0.002 SI), unit 2 is the anomaly (greater than
0.002 SI), and unit 0 are the cells above the topography (air cells).
The geologic model contains three units (1 = background, 2 = anomaly, and 0 = air). The boundary between units 1
and 2 occurs where the susceptibility model was 0.002 SI. The following figures show a cross-section and plan view
through the geologic model.
This final figure shows the anomalous unit when the air and background units are cut-off.
Now we have a geologic model that was based on the isosurface of a physical property model. We can look at the
geology definition for this model: Geology Model → Geology definition → Edit, which brings up the following
window.
The geology definition shows the minimum and maximum values for each unit.
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8.4.6 Create a physical property model from a geologic model
In GIFtools, a geologic model can be edited to generate a physical property model. This recipe goes through the steps to
do so. To start, a GEOmodel is required. A geology model can be created in Model Builder (e.g., from an isosurface).
The example being used throughout this recipe is based on a GEOmodel created from an isosurface of a susceptibility
model. This particular geologic model contains three units: (0) air, (1) the background, and (2) the anomalies, as shown
in the figure below.

Any geology model will have a geologic definition. To edit the definition, use the menu for the geology model: Geology
Model → Geology definition → Edit.

This brings up the following window:
Currently, there are no physical properties assigned to each of the units. The units have the header “Index” and in this
example there are 3. Click on “Add column” to add a column for physical properties. A window will appear, prompting
for the name of the new column:
Enter the desired name. For this example, the name used is “susValue”. Click “Value” if the column will contain
numbers (e.g., conductivity values) or “String” if the column will contain words (e.g., rock names). Here we are
interested in physical property values so we click “Value”. The window will close and the new column appears in the
geology definition, as shown below:
Now we can add values to the new column “susValue”. In this case, we are assigning susceptibility values.
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1. Index 0: 0 SI → air
2. Index 1: 0 SI → background
3. Index 2: 0.003 SI → anomalies

Tip: Make sure to hit “Tab”, hit “Enter”, or click in another cell to register each value in the appropriate cell.
Let’s add a second column for a different physical property. Repeat the above steps to add a column, name it, and assign
the values. For this example, the second column is called “conValue” and contains the following conductivity values:
1. Index 0: 1E-8 S/m → air
2. Index 1: 0.005 S/m → background
3. Index 2: 0.1 S/m → anomalies
The table will now look like this:

Click OK when finished and the geology definition table will close.
The next step is to set the I/O header for the physical property. With the GEOmodel highlighted, use the menu: Geology
Model → Geology definition → Set I/O headers.
This brings up a window to set or change the I/O headers for the Geology ID, Property, Lower Bound, Upper Bounds,
and Smallest model component. The drop down menus for each header will show the available geology definitions,
including the two we just created (susValue and conValue).
For Property, select the desired geology definition. In our example, we’ve chosen conValue. Click OK when done.
The window will close and the info panel for the GEOmodel will update, reflecting that the property has been set to
conValue:
Now we can create the physical property model. There are two ways to do this.
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1. With the GEOmodel highlighted, use the menu to create a model: Geology Model → Create model → From
property values. This adds a GIFmodel to the Model Builder folder. In our example, the name of the GIFmodel
is geomod_conValue.

2. The second way directly exports the physical property model. With the GEOmodel highlighted, use the menu:
Geology Model → Export → Active property. A window asking for the desired filename and file location will
pop up. Navigate to where you want to save the model and click Open.
Note: Note that the name of the model is automatically that of the GEOmodel, even though we are exporting the active
property! However, the suffix is “mod”, indicating a GIFmodel rather than a GEOmodel (which, when exported, has
the suffix “geo” and an accompanying definition file with the suffix “def”).

Note: When exporting an active property model, the model will not appear as an item in the Model Builder folder.
The model can be imported into GIFtools using the import functionality.
To generate the physical property model for a different property (e.g., susValue), navigate the menu to set the I/O headers
for the GEOmodel. For “Property”, select a different property. In this case, we set susValue instead of conValue. Click
OK. The info panel for the GEOmodel will be updated as following:
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To create the physical property model, repeat the above steps. Using the first method will generate “geomod_susValue
(GIFmodel)” in the Model Builder folder and the second method will allow the model to be directly exported.

When visualizing the model (in this case, the susceptibility model in MeshTools 3D), we see the anomalous units with
a susceptibility of 0.003 SI in a zero background.
Example
Continue with the example from the recipe on creating a geologic model and create physical property models using
this recipe.
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Example
This download also allows you to step through the recipe on creating a geologic model from a geologic image and then
use this recipe to create a physical property model.

8.4.7 Create weights from a geologic model
In GIFtools, a geologic model can be used to create cell-based weights and face weights. This recipe goes through the
steps to do so. To start, a GEOmodel is required. A geology model can be created in Model Builder (e.g., from an
isosurface).
The example being used throughout this recipe is based on a GEOmodel created from an isosurface of a susceptibility
model. This particular geologic model contains three units: (0) air, (1) the background, and (2) the anomalies, as shown
in the figure below.

We will first create cell-based weights and then also face weights to show the difference. To create a weights folder,
click on the Model Builder object in GIFtools and use the menu:
• Cell-based weights (Ws): Build constraints → Weighting functions → From only a geology model → Smallest model (Ws)
• Face weights (Wx, Wy, Wz): Build constraints → Weighting functions → From only a geology model →
Face weights

Weights act upon the model objective function and can thus influence the recovered model in the inversion. The model
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objective function is written as following:
∫︁
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The number of values for Ws is the same as the number of model cells (nx*ny*nz), where each cell is assigned a
weight. For face weights, there is a weight on each cell face or each boundary between cells. Thus, the weights have
one fewer value in that direction. For example, the weights for the derivative in the x-direction, described by Wx, has
(nx-1)*(ny)*(nz) values.
The default value for cell-based weights and face weights is 1.
Tip: A cell-based weight that is less than 1 will allow the model to deviate from the reference model while a cell-based
weight greater than 1 will force the model to stay close to the reference model.

Tip: A face weight that is less than 1 will create a sharp boundary between those cells. A face weight that is greater
than 1 will avoid sharp boundaries between those cells. The larger the deviation from 1, the more pronounced the
differences will be. For example, a face weight of 0.0001 will produce a sharper boundary than a face weight of 0.1.

Tip: Finding the “right” weighting values takes a bit of playing around and is dependent on the problem and the
desired outcome.

Create cell-based weights
We will first assign weights to the different unit within the geology model. To do so, click on the geology model and
use the menu to navigate: Geology Model → Geology definition → Edit.

This brings up the geology definition (shown below), containing different columns which are dependent on how the
model was created. In this case, the model was generated using an isosurface. There are additional columns from this
geology model was used to generate a property model.
8.4. Other Recipes
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Add a column by clicking “Add column”. This brings up a window to enter the column name. “Cancel” will exit out of
the window. There are two types of column that can be added. “Value” creates a column for numeric values (such as
physical property values or weight values). “String” creates a column for non-numeric values (such as geologic rock
names, unit names, or notes). We are naming our new column “WS” and clicking on “Value”. The window will close
and the new column will appear in the geology definition.

Recall that unit 2 is the anomalous body. We will assign that a weight of 0.0001 and the other units (air and background)
a weight of 1.

Then click OK to close the geology definition window. The next step is to set the I/O header for the Ws weights. To
do so, click on the geology model and use the menu to navigate: Geology Model → Geology definition → Set I/O
headers.
The following window appears and shows that nothing is set for the Ws. Use the drop menu to select the appropriate
column, which in our case is “WS”.
Then click OK. The info panel for the geology model will reflect the change and show what property has been assigned
to Ws.
As described above, use the menu to build smallest model (Ws) weights.
The following window will appear to select the desired geology model:
For this example, we select the model “geomod”, which is a geologic model created from an isosurface. Then click
OK. A new folder called “MB Weighting functions (GIFweight)” appears under Model Builder:
The folder contains two weighting functions:
• geomod (GIFmodel): This is the cell-based weights function we just created. It has the same name as the geology
model we used to create it.
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• cell-face weights (FACEmodel): This is the face weight object. Because we did not create any specific face
weights, all values will be 1.
To view the cell-based weights, click on the model and use the menu: Visualization → VTK view. Use the scroll bar
or boxes to cut remove cells that have a value of 1. We then see where we assigned smaller weights:

To use these weights in an inversion, create an inversion object and edit the inversion options. For the weights, select the
weighting folder we just created and GIFtools will write out the weights in the correct format for that specific inversion
and code.
Create face weights
To create face weights, select Model Builder and use the menu as described earlier. Select “Face weights”.
The following window will appear to select the desired geology model:
For this example, we select the model “geomod”, which is a geologic model created from an isosurface. Then click
OK.
The following window appears:
We can either create face weights based on property values or unit values. Recall that for this property model, we have
susceptibility and conductivity values assigned to each unit from when we created a property model.
With “Use property values” selected, GIFtools requires a Log10 spread between the weights. For example, a value of
2 means a weight difference of 100 between different units.
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In this case, we will use unit values to determine our face weights. When “Use unit values” is selected, GIFtools requires
a weight value between units. In this case, we will use 1E-4 to create sharp boundaries between the background and
anomaly in our geology model.

Click OK to apply and close the window. A second GIFweight folder appears under Model Builder.

The folder contains two weighting functions:
• cell weights (GIFmodel): This is the cell-based weights object. Because we did not create any specific cell-based
weights, all values will be 1.
• geomod_grad (FACEmodel): This is the face weight object we just created. It has the same name as the geology
model we used to create it plus a suffix of “_grad”.
To view the face weights, click on the model and use the menu: Visualization → VTK view/edit. GIFtools will ask if
values of 1 should be ignored. Select “Yes” as this makes visualization of non-unity values much easier.
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The model shows face weights along the air/background interface and at the background/anomaly interface as those
were the units defined in the geology model:

Slice through the top to see the weights around the edge of the anomaly. The face weights form a shell on the boundary
of the background and anomaly.
To use these weights in an inversion, create an inversion object and edit the inversion options. For the weights, select the
weighting folder we just created and GIFtools will write out the weights in the correct format for that specific inversion
and code.
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Using both cell-based and face weights
Note that the steps in this recipe created TWO weighting folders. If we want to use both cell-based weights and face
weights in an inversion, select one of the last weighting folders (which has the generated face weights) and use the
menu: Weighting functions → Set model → Cell weighting.

The following window will appear:

Select the desired model, which in this case is “Model BuilderMB Weighting functionsgeomod”. Then click OK. The
model has been copied and added to this weighting folder and the info panel now shows that “geomod” is set for the
cell-based weights.
In an inversion, selected this weighting folder will write out both non-unity cell-based (Ws) weights and non-unity face
weights.
Alternatively, we could have selected the first weighting folder and used the menu: Weighting functions → Set model
→ Face weighting to add the FACEmodel.
Tip: Whichever way you add one weighting object to the other, it can quickly become confusing which weighting
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folder contains what. We recommend renaming folders from “MB Weighting functions” to something specific to
prevent confusion when selecting folders in an inversion’s options.

Note: You cannot delete weighting folders while they are being used by Model Builder. You can change which
weighing folder it is using by clicking “Model Builder” and using the menu: Model Builder → Set Model → Weights.
In the window that appears, select the desired weighting folder. The info panel shows which functions are set (another
reason to rename weighting folders!). Weighing folders that are not set by Model Builder can be deleted.

Note: You cannot delete a GIFmodel and FACEmodel that are set within a weighting folder. Once a different model
is set (as done above with the cell-based weights), an un-set model can be deleted.

8.4.8 Create a waveform for a TEM data set
In this recipe, we go through the steps to create a waveform for a TEM dataset. For the TDoctree and H3DTD codes,
the same wave file is used for all transmitters. The discretization of the waveform is not trivial and this recipe aims to
help step through creating an appropriate waveform.
The discretization of the waveform in the on-time and discretization of the off-time is of great importance. A new
factorization of the modelling matrix is required whenever the stepping time (∆𝑡) is changed. The most computationally
efficient discretization is when a single value of ∆𝑡 can be used for the full time range of interest. Most systems consists
of an on-time portion (exponential, half-sign, ramp, etc) followed by an off-time. The on-time portion of the waveform
may be modelled using a large value of ∆𝑡. Data acquired in the off-time often spans a few decades of time, as shown
below.
Maxwell’s equations must be time-stepped with relatively small values of ∆𝑡. The stepping time region begins one
decade prior to the user-defined earliest time, and extends until the latest data time is defined. It is divided into logarithmic segments, usually a decade in length. Each segment is time-stepped with a uniform ∆𝑡 (linearly spaced).
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Fig. 11: Example: off-time steps (blue) shown vs actual off-time data acquisition time gates for a VTEM system (red)
Generally 10-15 steps are adequate for each decade in time. The total computation time depends upon the number of
factorizations, the number of time steps, and the number of transmitters.
GIFtools has a utility to assist the user in generating a wave file. This utility is based on the original Fortran utility
called “Wavebuilder.exe”. The utility can be accessed once a TEM data set has been loaded into GIFtools. Use the
menu to navigate to the waveform menu, as shown below:
TEM data → Waveform

The waveform menu has five items:
1. Create exponent on; ramp off
2. Create step off
3. Import
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4. View
5. Export
Below we go through each of these menu items.
Importing an existing waveform
The “Import” function allows you to import an existing waveform file in GIF format. GIF format for a waveform is as
follows:

The file consists of two columns where the first column is time (seconds) and the second column is current (amperes).
These time should be relative to the time channels in the data. The on-time pulse can be in the negative domain, as
shown in the example above. Also in the example above, we see that current shut-off occurs at 0 seconds and the current
remains at 0 in the off-time.
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Such a file can be imported into GIFtools using the menu: TEM data → Waveform → Import
Creating a waveform with an exponential on-ramp, linear off-ramp
The first waveform we will create has an exponential on-ramp, following by a linear off-ramp in the on-time part of
the waveform. This is a general expression that can approximate the waveform for many systems. Using the waveform
menu, select the first item “Create exponent on; ramp off” to open the following dialog.

The dialog consists of three parts: “Times”, “Discretization”, and “On-time variables”. Let’s first look at the “Times”
part.
The minimum time and maximum time denote the minimum and maximum time channel values obtained from the
TEMdata object. GIFtools will automatically subtract a decade from the minimum value to ensure there is at least one
decade of time before the first time channel. The maximum value can be the same as the last time channel for H3DTD.
The field for “time = 0” indicates the time for current shut-off, which in the example is 0 seconds.
The second part of the dialog defines the discretization of the waveform in the off-time. The number of segments is the
number of logarithmically spaced segments and the number of samples per segment is the linearly spaced sampled per
each segment.
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The third part of the dialog defined the on-time portion of the waveform. The on-time portion has an exponential rise
in current, followed by a linear ramp-off. The ramp-on is defined by the following expression:
𝐼 = 1 − 𝑒𝑥𝑝(−𝛼𝑡/𝑇 ),
where 𝐼 is the current (amperes), 𝑎 is the user-defined exponential decay coefficient (“exponent slope” in the dialog), 𝑇
is the user-defined length in time of the exponential ramp-on (“exponent time” in the dialog), and 𝑡 is the time (seconds).
Thus, the exponential ramp is defined for 0 < 𝑡 < 𝑇 . For later time, the waveform is a linear ramp-off and its length
is defined in the box “ramp time” in the dialog. The end of the ramp is adjusted so that it corresponds to “time = 0”.
The dialog has two more fields to set the number of samples for the exponential part and the number of samples for the
off-ramp part.
For this example, we complete the dialog as following:

Click the view button to view the waveform using these parameters:
GIFtools shows the on-time and off-time parts of the created waveform. The on-time part is plotted on a linear time
scale while the off-time is plotted on a logarithmic time scale. The vertical axis in both is the current amplitude, which
is zero for the off-time and shows the exponential ramp-on and linear ramp-off for the on-time.
1. The end of the on-time (or current shut-off) is specified by the “time = 0” field from the dialog, which was 0 in
this case.
8.4. Other Recipes
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2. The exponential on-ramp defined by the equation above and the parameters “exponent slope” and “exponent
time” specified in the dialog. The number of segment points was also defined in the dialog (in this example, we
used 10).
3. The linear off-ramp defined by the parameter “ramp time” in the dialog. The number of segment points was also
defined in the dialog (in this example, we used 5).
4. The maximum current is 1 A since data for GIF codes should be normalized by the current.
5. In the off-time, we see the “number of segments” (defined as 3 in this example) and the “samples per segment”
(defined as 7 in this example).
Close the viewing window and edit the waveform parameters, if needed. Once satisfied, click OK to set the waveform
for the TEMdata object.
Creating a step-off waveform
The first waveform that can be created within GIFtools is a step-off function. This is a reverse Heaviside function and
the simplest waveform to model. No actual geophysical system uses this exact waveform; however, recorded signals can
often be deconvolved to conform to this waveform type. Peak current (maximum current) data are generally sampled
only in the logarithmic domain. Using the waveform menu, select the second item “Create step off” to open the following
dialog.
The dialog consists of two parts: “Times” and “Discretization”. Note that this dialog is almost identical to the dialog
to create an exponential on-ramp/linear off-ramp waveform but simpler as here, we do not need any information for the
on-time part. Let’s first look at the “Times” part.
The minimum time and maximum time denote the minimum and maximum time channel values obtained from the
TEMdata object. GIFtools will automatically subtract a decade from the minimum value to ensure there is at least one
decade of time before the first time channel. The maximum value can be the same as the last time channel for H3DTD.
The field for “time = 0” indicates the time for current shut-off, which in the example is 0 seconds.
The second part of the dialog defines the discretization of the waveform in the off-time. The number of segments is the
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number of logarithmically spaced segments and the number of samples per segment is the linearly spaced sampled per
each segment.
For this example, we complete the dialog as following:
Click the view button to view the waveform using these parameters:
GIFtools shows the on-time and off-time parts of the created waveform. The on-time part is plotted on a linear time
scale while the off-time is plotted on a logarithmic time scale. The vertical axis in both is the current amplitude, which
is zero for the off-time and shows a single point for the on-time.
1. The on-time is defined as a single point at “time = 0” with a current of 1 A.
2. In the off-time, we see the “number of segments” (defined as 3 in this example) and the “samples per segment”
(defined as 7 in this example).
Close the viewing window and edit the waveform parameters, if needed. Once satisfied, click OK to set the waveform
for the TEMdata object.
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Viewing a waveform
To view a waveform that has been assigned to a TEMdata object, use the menu: TEM data → Waveform → View
Exporting a waveform
To export a waveform to be used with H3DTD or TDoctree, use the menu: TEM data → Waveform → Export

8.4.9 Create an octree mesh using a Fortran utility
Each of the GIF octree codes comes with a utility to create an octree mesh. As of Version 2.1, the Fortran utilities
to create octree meshes can be used through GIFtools. The figure below shows the menu structure for the available
utilities.

The components to generate an octree mesh are generally the same, regardless of which code the mesh is generated for.
The required files are:
• survey locations
• topography
This recipe steps through creating an octree mesh, starting from importing the necessary data, to setting the options,
and running the Fortran utility. In addition, we explain the different parameters required for the octree mesh and the
generated output files.
Note: The manuals for the octree codes explain the required parameters in detail for the create mesh utilities and
will provide more technical information than is provided in this recipe. See the GIF documentation page to find the
appropriate manual.
The example used in this recipe uses a magnetic airborne survey. The example files and complete project are available
for download at the bottom of this page.
8.4. Other Recipes
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Step 1
Start GIFtools or open an already existing project. Because we will be loading in a few files, it is easiest to set the
working directory to the folder where the files are located and/or where you would like to generate the octree mesh.
The first step is then to import the magnetic airborne survey locations and the topography file. Importation of data
will slightly differ, depending on the file type (GIF format, XYZ, etc). For this example, the magnetic survey file is
structured as a XYZs while the topography file is in GIF format. Both are imported using the following menus:
• For magnetic survey locations: Import → Data → Magnetics → XYZ
• For topography: Import → Data → Topography → 3D GIF (3D XYZ)

For the magnetic data, we also need to set the inclination, declination, and field strength. This can be done through the
data manipulation menu.
Once the data are loaded, GIFtools will have the two items shown in the project tree on the left:
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Save the project!
Step 2
With the data imported, we can create the octree mesh utility. To do so, use the menus and choose the appropriate code.
For this example, we are using Magnetics (PDE):

GIFtools will prompt you to choose a working directory for the mesh creation. Pick a location and click Open in the
dialog. You will then see the create mesh item added to the GIFtools project tree:

At this point, the data object and topography have not been assigned. The info panel also shows which versions are
currently supported. As well, we see that not all properties are set yet.
The menus for the create octree mesh utilities all look the same. Using the magnetics example, the menu allows you to
change the working directory, set the data object, edit the utility options, run the utility, and load the output files.
Select Set data object from the menu. For magnetics, the following dialog appears:
For other methods, you will see similar dialogs to select the appropriate data type. For example, for TDoctree, you will
be asked to select a TEMdata object.
8.4. Other Recipes
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Select the desired data set and click OK. The info panel will update, showing the selected data set.

Now use the menu again and select Edit options. This brings up the following dialog:
For some utilities, GIFtools will try to pre-fill the text boxes based on the assigned data. These should always be
reviewed!
Choose the type of topography: value or an object. If a value, enter the value in the text box. If an object, select the
item from the drop-down menu or browse for a GIF formatted file.
In addition, for this utility, there is a check box to choose Approximate topography. This option allows you to control
the number of cells that are used to define topography in the padding cell region. If left unchecked, the utility will
use “good topography”, meaning the topography will be defined very accurately in the padding region using a large
number of fine cells. If checked, the utility will approximate the topography using a smaller number of coarser cells.
The next part is to set the core parameters for the mesh. The east width, north width, and thickness describe the
dimensions of the smallest cells in the mesh.
The RX cells #1 gives the number of smallest cells around each receiver. Then RX cells #2 gives the number of
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second-smallest cells around the set of smallest cells described by RX cells #1. The second-smallest cells are twice
as big as first (for example, 2*east width). Finally, RX cells #3 gives the number of third-smallest cells around the
receiver. These cells are four times as big as the smallest cells (for example, 2*2*east width). These parameters allow
you to control how quickly the cell sizes expand around the receiver.
The next part describes the depth of investigation (DOI) for the core mesh. The first value (DOI #1) is the depth below
topography that should be filled with the smallest cells. Then, DOI #2 is the thickness below DOI #1 that should be
filled with the second-smallest cells. Finally, DOI #3 is the thickness below DOI #2 that should be filled with the
third-smallest cells. These parameter allow the user to control how quickly the cell sizes expand in depth.
The bottom part of the dialog deals with the padding parameters. The padding parameters are given in meters for the
east-west, south-north, bottom, and top (air) directions.
Additionally, there is a checkbox at the bottom of the dialog, depending on the utility used. For potential fields, the
checkbox gives the option to start with small cells (checked) or start with large cells (unchecked). In general, it is
better to start with large cells and allow the code to refine the mesh as needed. If checked, the initial mesh will be with
the smallest cell sizes, which can create a mesh with a very large number of cells and slow down the utility computation.
For other codes like E3D and TDoctree, there will be a checkbox to shift data above discretized topo. This creates
a locations file with survey locations on the surface of the Earth and prevents ground receivers/transmitters from being
below the Earth due to the discretization of the topography.
For the example here, we have completed the dialog with the following parameters:
Once all parameters are configured, click OK. If needed, you can use the menu to edit options, see the input parameters
you provided, and change them if desired.
After clicking OK, the dialog will close and the info panel will be updated so show the topography used. At this point,
the info panel shows that all properties have been set (changed from a red no to a black yes).
Save the project!
Step 3
With all parameters set, we are ready to run the utility. Use the menu again and select Run utility. A dialog will pop
up to show that it is running.
When done, the dialog will close and if all goes well, a new dialog will appear, saying the utility ran successfully. Click
OK.
To import the generated files, use the menu and select Read output files. This loads the files from the working directory
into GIFtools. In general, there are four files that are imported into GIFtools from a create octree mesh utility:
• octree_mesh : the generated octree mesh (meshOctree)
• active_cells_topo : an ACTIVEmodel item that has 0’s above topography and 1’s below. This file will likely also
be required when running an octree forward modelling or inversion.
• 3D_mesh : a mesh3D item that is the same extents as the octree mesh but contains only the smallest cells.
Warning: this mesh is likely very large and we do not recommend using it.
• 3D_core_mesh: a mesh3D item that is comprised of the smallest cells with its extents just covering the core
portion of the octree mesh. Tip: this mesh can be useful for building models onto and then interpolating onto
the octree mesh. Tip: this mesh can also be useful to transfer octree models onto to then export and visualize in
software programs that don’t support octree meshes/models.
For the magnetic example used in this recipe, GIFtools looks as following after loading the files into GIFtools:
Save the project!
Example
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The magnetics survey file, topography file, and field parameter notes along with a GIFtools project to repeat the above
steps to create an octree mesh using the Fortran utility: download

8.4.10 Assign elevation from height and topography surface
In this recipe, we assign elevation values to a data object using flight height information and a topography surface
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CHAPTER

NINE

A TO Z EXAMPLES

What is this?
A to Z examples is a collection of step by step tutorials for completing projects using GIFtools - from forward modeling
to inversion, and everything in between. Each tutorial is broken down into a set of linear steps that make use of the
recipes. All tutorials and relevant files are available for download. By completing the tutorials from A to Z, you will
rapidly become proficient users of GIFtools and the large library of UBC-GIF codes.
Tutorials are organized by geophysical method:

9.1 A to Z Examples for Gravity
Here, A to Z examples relevant to the processing, interpretation and inversion of gravity data are presented.
These tutorials are:

9.1.1 Processing Gravity Data
Here, we show how GIFtools can be used to carry out processing steps relevant to gravity data such as:
• Free-air correction
• Simple terrain correction

Fig. 1: Gravity data after latitude and free-air correction (left). Background gravity (middle). Final gravity anomaly
data (right).

443

GIFtoolsCookbook Documentation, Release 1.0

Setup for the Processing Exercise
• Download the demo
• Open GIFtools
• Set the working directory
Tip:
• Steps (without links) are also included with the download
• Requires at least GIFtools version 2.1.3 (Oct 2017) (login required)

Import files
In addition to raw geophysical data, you may have access to topographical information. If this information
is available to you, it can be imported into GIFtools.
• Import the topography data (3D GIF format)
• Import raw gravity data (GIF format with data in mGal)
Tip:
• Use Edit → Rename to change what objects in GIFtools are called
• For any data object, edit the data headers. We set the raw gravity data to “G_raw”
• Raw data were generated synthetically using the best-available density model for TKC and “unprocessing” the data.

Latitude and Free-Air Correction
Generally, this processing step has been done by the client. However to demonstrate some basic functionality within GIFtools, we will perform simple latitude (𝑔𝑙 ) and free-air (𝑔𝑓 𝑎 ) corrections on the raw gravity
data (𝑔𝑟𝑎𝑤 ) such that.
𝑔𝑐𝑜𝑟𝑟 = 𝑔𝑟𝑎𝑤 − 𝑔𝑙 + 𝑔𝑓 𝑎 .
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The latitude correction accounts for all of the mass contained within the reference ellipsoid approximation
of the Earth. Generally a distinct latitude correction is applied for every survey location. However we will
only be applying a constant value correction to the data; wherein we assume all survey locations are at a
latitude of 64 𝑜 N.
The latitude correction (Int’l grav. formula 1967) in mGal is given by
[︀
]︀
∆𝑔𝑙 = 978 031.8 × 1 + 0.0053024 𝑠𝑖𝑛2 𝜑 − 0.0000059 𝑠𝑖𝑛2 (2𝜑)

(9.1)

= 982217.559014 mGal at TKC
(9.2)
The free-air correction accounts for the fact that the latitude correction is weaker the further you are from
the Earth. GIFtools will be used to apply a specific free-air correction to each observation. The following
expressions can be use to compute the latitude and free-air corrections. The free air correction: in mGal
is given by:
∆𝑔𝑓 𝑎 = 0.3086 × 𝐸𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛(𝑚)
To apply these corrections to the raw data, carry out the following steps using the constant calculator:
• With the latitude correction provided (982217.559014 mGal) remove this value from the raw data
and create a new column. Carry all decimal places!
• Compute the free-air correction that must be added to each survey location.
• Apply the free-air correction.
Tip: To keep track of data columns, remember to edit data headers.

Fig. 2: Raw gravity data (left). Free-air correction based on elevation (middle). Gravity data after latitude and free-air
correction (right).

Topography and Regional Geology Correction
At this point, we have accounted for all gravity contributions from matter that lies below a surface elevation
of 0 m; e.g. the latitude and free-air corrections. We must now remove the background gravity contribution
from all regional mass that lies above 0 m elevation. If the topography is flat, you may choose to use a
slab correction. Here, we show how GIFtools can remove the background contribution while taking into
account the regional topography.

9.1. A to Z Examples for Gravity
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Create a Mesh
Here, we create a mesh which defines the regional geology. The mesh should extend vertically downward
to an elevation of 0 m. We do not want to pad below this depth because we have already accounted for the
mass lying below 0 m. The mesh should extend as far as possible horizontally so that gravity contributions
outside the survey area are accounted for.
• Create a mesh using gravity data with the following parameters:
– Don’t forget to apply topography when creating the mesh!
– Core cell widths = 25 m
– Extent above = 0 m
– Depth of investigation = 425 m
– Padding = 2000 m on each side, 0 m in depth
– Padding factor = 1.2
Tip: Here, the mesh does not extend exactly to an elevation of 0 m. For the purposes of the exercise, this
is fine. In practice however, it would be wise to extend the mesh to exactly 0 m because you have accounted
for all mass below that elevation already.
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Fig. 3: Mesh for use in background gravity removal.
Create Active Cells from Topography
Here, we account for the local topography. Since air cells contribute negligibly towards the observe data,
we do not need to include them when modeling the background gravity.
• Using your gravity data, create an active cells model from topography. Choose ‘from tops of cells’
Create a Constant Density Model
At TKC, we know that the kimberlite pipes are within a granitoid host. We will assume a background
density of 2.7 g/cc and create a background physical property model.
• Using the active cells model, create a constant geological model
• Assign a value of 2.7 g/cc for the background cells through edit geology definitions. You may also
want to set I/0 headers and/or rename headers
• Create a physical property model (GIF model) from the geological model
Predict Background Gravity and Load to GIFtools
We now have all the items necessary to forward model the background gravity contribution.
• Create Grav3D forward model through create forward modeling
• Select the forward modeling object and edit options to link
– GIF Model
– Data locations
– Topography
• Write files
• Run GZFOR3D
9.1. A to Z Examples for Gravity
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Fig. 4: Constant density model for removing background gravity.
• Load predicted data
Remove the Background Gravity
To remove the background gravity from your data:
• Use add data from another GRAVdata object to add the background gravity to the gravity data object
where you are doing your processing
• Use the Calculator to subtract the background data; which should result in just the gravity anomaly
remaining

Fig. 5: Gravity data after latitude and free-air correction (left). Background gravity (middle). Final gravity anomaly
data (right).
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9.1.2 Forward Modeling and Hypothesis Testing
Here, we simulate synthetic data based on a surface geology map and compare it to the observed gravity
data. A reasonable match ensures that our current geological understanding is able to explain the cause of
the anomaly.
Tip: The same workflow can be used to predict magnetic data for an arbitrary susceptibility or magnetic
vector model.

Fig. 6: A synthetic density model (left). Predicted data from the model (middle). Difference between predicted and
observed (right).

Setup for the Forward Modeling Exercise
If you have completed the tutorial “Processing Gravity Data”:
• Open your final GIFtools project
• Set the working directory (if you want to change it)
If you have NOT completed the previous tutorial, you must complete the following steps:
• Download the demo
• Open GIFtools
• Set the working directory
Tip:
• Steps (without links) are also included with the download
• Requires at least GIFtools version 2.1.3 (Oct 2017) (login required)

9.1. A to Z Examples for Gravity
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Import files
In addition to geophysical data, you may have access to topographical information and/or geological surface
maps/cross-sections. If this information is available to you, it can be imported to GIFtools. Here, we have
surface topography and files which define several geological units through surface mapping.
• Import the topography data (3D GIF format). This was imported in the previous exercise
• Import field observed gravity anomaly data (GIF format with data in mGal). This was the final result
of the previous exercise
• Import the geology image and link to topography (Image is plane view)
• Create a legend for the geological units in the image
Tip:
• Use Edit → Rename to change what objects in GIFtools are called
• For any data object, edit the data headers. We set the gravity anomaly data to “Gravity (mGal)”
• Observed gravity anomaly data were generated synthetically using the best-available density model
for TKC.

Fig. 7: Topography imaged in VTK (left). Plan-view image for surface geological mapping (middle). Gravity anomaly
data in mGal (right).
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Create a Survey
Ultimately, we would like to predict gravity anomaly data for a model of our choosing and compare it
against a set of field observations. To accomplish this, we must first create a survey; which has the same
properties as the actual survey that was performed. To create the survey, there are two approaches:
Approach 1: Survey at exact locations
Using this approach, we will be able to predict gravity data at the EXACT same locations as the field
observations. Later on, this will allow us to compute the difference between the predicted and observed
data. Steps are as follows:
• Make a copy of the gravity data
• Through Set I/O headers, remove the I/O header for gravity anomaly data column by setting it to
blank
• Delete the data columns for any preexisting gravity data (data cannot be deleted if it has an assigned
I/O header)
Approach 2: Custom locations
• Create simple survey
– Set the survey type as ‘Gravity’
– Link the survey to the known topography at TKC
– Set the height above topography to 10 m
– Set the following parameters:
∗ Easting origin = 556,600
∗ Northing origin = 7,133,200
∗ Bearing = 0
∗ Line length = 1,500
∗ Number of survey lines = 15
∗ Data spacing = 20
∗ Line spacing = 100
Tip:
• Since the survey parameters are exactly known, approach 1 and approach 2 produce the same thing.
• Both the observed gravity and survey are ‘gravity data’ objects. Thus they have the same properties
and undergo identical actions.
• Edit data headers was used to make the colourbar titles the same in the plot below.
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Fig. 8: Data location from observed data file (left). Data locations for synthetic survey (right).
Create Mesh from Gravity Survey
To predict field data, we must define the domain by creating a mesh. GIFtools can create meshes based on
the data locations and the local topography.
• Create mesh from gravity data
– Don’t forget to apply topography when creating the mesh!
– Core cell widths = 25 m
– Extent above = 0 m
– Depth of investigation = 400 m
– Padding = 500 m on each side, 1000 m in depth
– Padding factor = 1.2
Tip: There are other ways to make meshes. If available, you could import a pre-existing mesh or create
and OcTree mesh.

Create Models
In this step, we design a density model for the geological structure we think will explain the data. We will
show that test models can be made quickly using a priori geological information, as opposed to creating a
model comprised of uniform blocks. At TKC, we know:
1. The surface topography
2. The gravity anomaly is likely caused by the presence of kimberlite pipes
3. The surface distribution of geological units obtained from geological mapping
4. The approximate density of kimberlites relative to the host
However, we don’t know:
1. How far down the kimberlites extend
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Fig. 9: Mesh created from survey and viewed in VTK. Gravity anomaly data from the survey have been imported at
their locations.
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2. The thickness of any of the kimberlite pipes as a function of depth
3. The thickness of the overlying till
Create Active Cells Model from Topography

Regions above the topography have an effective density of 0 and do not contribute towards the gravitational pull experienced at observation locations. For potential field problems, we MUST ensure that data
locations lie outside the region of active cells (e.g. within the air cells). Here, we will use the topography
data to create an active cells model.
• Creating active cell model from topography. Choose ‘from tops of cells’
Create Density Model through Model Builder
Now that we have topography, a mesh, and an active cells model, we can create a geological model. To
approximate pipe-like structures, we will use the horizontal distributions of each geological unit (obtained
from the plan-view image), and project these units down to a desired depth. We will then assign density
contrast values to all geological units. Once the geological model has been created, we will output a
physical property model which can be used in the forward model. To accomplish this, apply the following
steps:
• Start modelBuilder
• Create geology model from plan-view image (Use a thickness of 200 m)
• Set physical propert values for units in the newly created GEO model (The approximate density
contrast values for the kimberlites and till relative to the host is found here). Units should be g/cc.
You may also want to set I/0 headers and/or rename headers
• Create GIF model from the physical properties in the GEO model
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Fig. 10: Geological model created with each colour representing a different units (left). Density contrast in g/cc relative
to host (right).
Forward Model the Data
We now have all the objects we need to create the files for the forward model and run the fortran code.
This is accomplished by carrying out the following steps:
• Create Grav3D forward model through create forward modeling
• Select the forward modeling object and edit options to link
– GIF Model
– Data locations
– Topography
• Write files
• Run GZFOR3D
Load Predicted Data and Compare Against Observed Data
Here, we compare the observed data to the predicted data from our forward model. We will also show how
the difference between both datasets can be computed and plotted.
• Load predicted data
• Using add data from another object, add the observed data to the predicted gravity data
• Using Calculator, subtract the predicted data from the observed data
• View the data (observed, predicted and difference) from the final data object you created
Tip: Edit data headers to avoid confusion between predicted and observed data.
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Fig. 11: Observed data (left). Predicted data (middle). Observed - predicted (right).
Results
• Our synthetic model produces gravity anomalies of similar size and character.
• The northern portion of the largest anomaly does not match between predicted and observed gravity
data
• The predicted data over-estimates the maximum anomaly amplitude
• Our synthetic model explains the data, but the margins of various kimberlite facies and their density
distributions remain unresolved.

9.1.3 Inverting Corrected Gravity Data
Prelude
Here, we show how GIFtools can be used to invert gravity anomaly data. We consider the case where we
have a set of field observations and some a priori knowledge of the local geology; for this example, we
know the anomaly is produced by the TKC kimberlites. We assume that all necessary corrections have
been applied to the raw gravity data; see the processing gravity data exercise. The goal of this exercise is
to invert the gravity anomaly data to recover the optimum density model. Several inversion will be run to
show the impact of reference models and various penalty terms on the final inversion result.
Tip: The same workflow can be used to invert magnetic data for an arbitrary susceptibility or magnetic
vector model.

Setup for the Inversion Exercise
If you have completed the tutorial “Forward Model Gravity Data and Compare Against Field Observations”:
• Open your final GIFtools project
• Set the working directory (if you want to change it)
• Import the true density model
If you have NOT completed the previous tutorial, you must complete the following steps:
• Download the demo
• Open GIFtools
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• Set the working directory
• Import the true density model
• Carry out these steps from the forward modeling exercise:
– Import files into GIFtools
– Create a mesh from the survey data
– Create an active cells model and a synthetic geological model from topography and surface mapping
Tip:
• Steps (without links) are also included with the download
• Requires at least GIFtools version 2.1.3 (Oct 2017) (login required)

Assign Uncertainties and Set I/O Headers
Assigning appropriate uncertainties to the data is necessary for running stable and successful inversions
with GIFtools. Because the observed gravity data were generated synthetically, we will add random noise
before assigning the uncertainties. Because the statistics of the noise are known, they can be used to assign
the correct uncertainties. Complete the following steps:
• Add Gaussian random noise (Percent = 0, Floor = 0.005)
• Assign uncertainties to G_noisy (Percent = 0, Floor = 0.005)
• Set I/O headers to ensure the elevation, observed data and uncertainty columns are set
correctly

Fig. 12: Synthetic gravity anomaly data (left). Gravity anomaly data with noise (middle). Uncertainties on noisy data
(right).
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Unconstrained Smooth Inversion
Here, we perform the most basic type of gravity anomaly inversion. No a priori information is used in the
inversion. Default inversion parameters use least-squares penalties on the model and its gradients. As a
result, we expect the inversion to recover a smooth model. To run the inversion and view results:
• Create a gravity inversion object
• Edit the inversion parameters
– Sensitivity Tab: set mesh, observed data and topography
– Inversion Tab:
∗ Set the active cells
Note: As a general best practice, in the absence of a priori information,
𝛼 values should be set such that all components of the regularization have
equal weight. Based on the core mesh discretization used in this problem:
[︀ 1 ]︀2
= 0.0016, 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1
𝛼𝑠 = 𝑑𝑥
– Blocky model norms: leave all as default
– Apply and write files when finished
• Run the inversion
• Import inversion results
• View the results.
Note: The user is encouraged to:
• Compare predicted and observed data and examine the misfit
• Lay the observed data over the final model to see if observed anomalies match the distribution of recovered densities
• Lay the geological image over the final model to see if the inversion results agree with
geological surface mapping

Fig. 13: Observed data (left). Data predicted with final model (middle). Misfit with colour scale set to +/- 0.005 (right).
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Fig. 14: True model with only non-zero density contrasts (left). NW slice of recovered model (middle). EW slice
through southern anomaly (right).
Results
• Generally, the data predicted using the recovered model matches the shape and character of the
observed anomalies
• However, large misfits are clustered around the locations of recovered structures
• The general distribution of density contrasts is recovered through inversion
• By using the default set of inversion parameters however, we recovered a very smooth density contrast model
• Because the inversion was set to recover a smooth model, the inversion placed positive density
contrast values (red) around the outside of the recovered structures
Inversion with Hard Constraints
Here, we show the impact of reference models on the final inversion result. Two inversion will be run one using SMOOTH_MOD and one using SMOOTH_MOD_DIFF. Both inversions are constrained with
the model that was made using the geological surface map (see here). To complete this exercise:
• Create a new gravity inversion object
• Edit the inversion parameters
– Sensitivity Tab: set the mesh, observed data and topography
– Inversion Tab:
∗ set the active cells
[︀ 1 ]︀2
∗ set 𝛼𝑠 = 𝑑𝑥
= 0.0016, 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1
∗ set the reference and starting models using the model you created from the
surface mapping
∗ under the reference model option, choose either *SMOOTH_MOD* or
*SMOOTH_MOD_DIF*
– Blocky model norms: leave all as default
– Apply and write files when finished
• Run the inversion
• Import inversion results
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• View the results
Note: The user is encouraged to:
• Examine the differences in recovered models using SMOOTH_MOD and
SMOOTH_MOD_DIF
• Examine the differences in data misfit for data predicted using SMOOTH_MOD and
SMOOTH_MOD_DIF inversions

Fig. 15: Data misfit thresholded at +/- 0.005 for the unconstrained smooth model (left), SMOOTH_MOD (middle) and
SMOOTH_MOD_DIF (right).

Results
• All three inversion match the data fairly well but with some anomalously high misfits over the location of the kimberlites.
• SMOOTH_MOD imposes the structures of the reference model but allows smooth gradients
• SMOOTH_MOD_DIFF imposes the structures and gradients of the reference model
Inversion with Soft Constraints
Here, we show how compact and blocky models can be recovered by changing certain inversion parameters.
Smooth models are recovered when the compactness parameter (p) and the set of blockiness parameters
(q) are set to a value of 2. By decreasing the compactness parameter value, we recover models that have
a smaller number of non-zero values; that is, models which fit the observed data using more compact
structures. By decreasing the blockiness parameter value, we recover models that have a smaller number
of non-zero gradients; that is, models which fit the observed data using structures that have very sharp
edges. To complete this exercise:
• Create a new gravity inversion object
• Edit the inversion parameters
– Sensitivity Tab: set the mesh, observed data and topography
– Inversion Tab:
∗ set the active cells
[︀ 1 ]︀2
∗ set 𝛼𝑠 = 𝑑𝑥
= 0.0016, 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1
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Fig. 16: Reference model from geological unit image (top-left). Model recovered using unconstrained smooth inversion
(top-right). Model recovered using SMOOTH_MOD (bottom-left). Model recovered using SMOOTH_MOD_DIF
(bottom-right).
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∗ leave the reference and initial models as default values
– Blocky model norms: set p-values and use default Lp/Lq scaling (try
different combinations)
– Apply and write files when finished
• Run the inversion
• Import inversion results
• View the results.
Note: The user is encouraged to:
• see how changes in the compactness parameter (p) affect recovered models
• see how changes in the blockiness parameters (q) affect recovered models

Fig. 17: Inversion results for various soft constraints.
For each A to Z example, a brief overview of the tutorial is provided along with its relevance to practical
problems.
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9.2 A to Z Examples for Magnetics

Here, we provide A to Z examples relevant to the processing and inversion of magnetic data in the presence
of remanence. The effects of remanence has long been recognized as an obstacle for the geological interpretation and modeling of magnetic data. This is especially true in the case of TKC. Our tutorial covers
three inversion approaches and compares their respective solutions:

9.2.1 Magnetic Susceptibility:
Purpose
To demonstrate the basic steps for inverting TMI magnetic data using the induced magnetization assumption; i.e. no remanent magnetization. This exercise is meant to emulate a greenfield exploration project
where topography and magnetic data are available. Here, we start with topography and synthetic magnetic
data from the current best TKC susceptibility model.
Note:
• Link to MAG3D documentation
• Click on any figure to enlarge

Downloads
Example
• Download the demo . All files required for this example are located in the sub-folder “MagSusc”.
• Requires at least GIFtools version 2.1.3 (Oct 2017) (login required)
• Requires MAG3D v6.0
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Step by step
• Step 1: Setup
– Start a GIFtools project
– Set the working directory
– Import the topography data from file TKCtopo.dat.
• Step 2: Survey and Data
– Import magnetic data in XYZ format. The data being imported are TMI data from the
file TKC_magSynthetic_Survey.xyz.
Tip: Assign the Easting and Northing (X, Y), but leave elevation empty. Make sure you load
in both the ralt and B_igrf variables

Fig. 18: Import window
– Set the inducing field parameters for the newly created magnetic survey:
∗ Field strength (IGRF) = 59,850 nT
∗ Inclination = 83.3 degrees
∗ Declination = 19.5 degrees
– Set the IO headers for the observed data column “B_igrf”
464
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– Remove the IGRF from the TMI data; IGRF field strength is 59850 nT.
– In the newly created data object, create elevation column for Mag data using the topography and known flight height (40 m). Set the Z column to this new elevation using Set
the IO headers
– Assign floor uncertainty of 1 nT to all TMI data
Note:
• The observed magnetic data can now be exported in GIF format.
• At least two anomalies are easily identified.
• Note the large trend in the data coming from the NE.

Fig. 19: Observed data
• Step 3: Processing

• Create a mesh from the observed data
– To reproduce this example, use the parameters specified in the figure on the right

• Create an inversion object (MAG3D 6.0)
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Fig. 20: Mesh parameters
• Edit the options
– Panel 1: Set mesh, observed data and topography. Leave sensitivity options as default.
– Panel 2: Adjust 𝛼 parameters (see figure)
– Click Apply and write files

Tip: As a general best practice, in the absence of a priori information, 𝛼 values should be set such that
all components of the regularization have equal weight. Based on the core mesh discretization used in this
[︀ 1 ]︀2
[︀ ]︀2
problem: 𝛼𝑠 = 𝑑𝑥
and 𝛼𝑧 = 21 .
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Fig. 21: Inversion options
• Step 4: Run the inversion
– Run all the files
– Import the inversion results
– View the convergence curves

Note: Note the linear anomalies recovered on the edges of the core mesh that extend beyond the region of
interest. These features are due to the regional signal captured by our survey. We can improve our result
with the instructions in Step 5.

Fig. 22: Recovered susceptibility model
• Step 5: De-trend and re-run
– Using the Mag data object, compute the first-order polynomial trend
– Using the Calculator, remove the polynomial trend from your data
– Set the IO header for data column to be the detrended data
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– To create an inversion object with the same parameters as a previous one, use create a
new inversion copy
– Write all files to inversion directory
– Repeat Step 4
Note: Note the large negative lobe along the NE edge of the southern mag anomaly.

Synthesis

Fig. 23: De-trended data
• We have recovered a susceptibility model that honors the data within the target misfit.
• Considering a near-vertical inducing field, at least two features should raise some serious flags regarding the presence of remanence.
1. The kimberlite pipe appears to be plunging towards SW, and a secondary susceptible structure
presents outside the region of interest and plunges to the East.
2. The data residual map shows correlated signal near the main anomaly, indicating a poor fit for
the large negative anomaly.

9.2.2 Magnetic Amplitude Inversion
Purpose
Amplitude data are weakly sensitive to the orientation of magnetization. As a result, the interpretation of
amplitude data can be added to the information gained by interpreting TMI data.
Here, we demonstrate the basic steps for forward modeling and inverting magnetic amplitude data. We use
GIFtools to create an amplitude data object. Next, amplitude data are predicted using a synthetic model.
We then use inversion to recover the synthetic model. Original work on amplitude inversion comes from
our colleagues at CSM .
Note:
• Link to MAG3D documentation
• Click any figure to enlarge
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Fig. 25: Recovered susceptibility model
Downloads
Example
• Download the demo . All files required for this example are located in the sub-folder “MagAmp”.
• Requires at least GIFtools version 2.1.3 (Oct 2017) (login required)
• Requires MAG3D v6.0

Step by step
Tip: If you have already completed the Magnetic Susceptibility Inversion demo, you may advance directly
to Step 3. Use the final de-trended data as your data column and use the final recovered model from Step
5 of the previous exercise to predict amplitude data.
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Fig. 24: Data residual
• Step 1: Setup
– Start a GIFtools project
– Set the working directory
– Import the topography data from file TKCtopo.dat
– Import the mesh from file TKC_magSynthetic.msh
– Import the model from file model_for_amp.mod

• Step 2: Survey and Data
– Import the processed TMI data in
TKC_magSynthetic_Survey_noIGRF.mag.
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Fig. 26: Calculated amplitude
data
• Step 3: Processing
– By default, magnetic data are interpreted as being TMI data. For GIFtools to work with
amplitude data, we must create a magnetic amplitude data object using change data type
– To create some amplitude data, we will forward model data from an existing model
– Once imported, remember to assign uncertainties (1nT floor) and set I/O headers
– Create an inversion object (MAG3D 6.0)
∗ Edit the options
· Panel 1: Fill out Sensitivity Options
· Panel 2: Adjust 𝛼 parameters
· Click Apply and write files
Tip: Alternatively if you have already completed the Magnetic Susceptibility Inversion demo, you can
copy the inversion object and transfer the inversion parameter

Fig. 27: Inversion options
• Step 4: Run the inversion
– Run all the files
– Import the inversion results
– View the convergence curves
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Note: The recovered effective susceptibility model shows a near-vertical anomaly, in good agreement
with the conceptual idea of a vertical kimberlite pipe.

• Step 5: Repeat the inversion with sparsity ([0, 2, 2, 2])
– Copy the previous inversion object
– Set the sparsity parameters ->
– Import the inversion results
– View the convergence curves

Synthesis
• We have recovered a compact effective susceptibility model that honors the amplitude data and
resembles the shape of vertical kimberlite pipe.
• Unlike in the TMI inversion results, secondary susceptible structures are not generated in the recovered model in order to fit the data.
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9.2.3 Magnetic Vector Inversion (MVI)
Purpose
Here, we demonstrate the basic steps for the Magnetic Vector Inversion in both Cartesian (MVI-C) and
Spherical (MVI-S) coordinates. We then demonstrate how a cooperative inversion approach (amplitude +
MVI-C) can be used to improve the MVI-C solution. Finally we show the advantages of using a sparse
MVI-S code.
Note: Link to MVI documentation

Downloads
Example
• Download the demo All files required for this example are located in the sub-folder “MVI”.
• Requires at least GIFtools version 2.25 (July 2018) (login required)
• Requires MVI v3.0 (13062018)
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Fig. 29: The true model we will attempt to recover.
Step by step
Tip: If you have already completed either the Magnetic Susceptibility Inversion or the Magnetic Amplitude
Inversion demo, you may advance directly to Step 3
• Step 1: Setup
– Start a GIFtools project
– Set the working directory
– Import the topography data from file TKCtopo.dat
– Import the mesh from file TKC_magSynthetic.msh
• Step 2: Survey and Data
– Import the processed TMI data in
TKC_magSynthetic_Survey_noIGRF.mag.
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Fig.
Sparsity
rameters

28:
pa• Step 3: Processing (NEED IMAGE OF PANELS FILLED OUT)
– Create an inversion object (MVI v3.0)
– Edit the options
∗ Panel 1: Fill out Sensitivity Options (must use MVI data)
∗ Panel 2: Fill out according to the figure on the right
∗ Click Apply and write files
• Step 4: Run the inversion: MVI-Cartesian
– Run all the files
– Import the inversion results
– View the convergence curves

Fig. 31: Recovered model from MVI inversion
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Note:
• The magnetic vectors with the highest amplitude are located on the eastern margin of the anomaly.
• Although the direction of magnetization is smoothly changing, the average orientation appears to be
pointing downward and towards east.
• We can try to improve this result in two different ways
1. Re-run cooperatively with the sparse magnetic amplitude model
2. Run the MVI-Spherical code with sparsity constraints

ALTERNATE ENDING #1: Cooperative Magnetic Inversion (CMI)
In this inversion, we will use the compact model obtained in the Magnetic Amplitude Inversion demo to
constrain the smooth MVI-C result.
• Copy the inversion object from MVI-C
• Create a cell weighting model w
– Load the final amplitude inversion model file
– Normalize the amplitude model by its maximum value:
m𝑎𝑚𝑝 /𝑚𝑎𝑥(m𝑎𝑚𝑝 )

w

=

– Add a small threshold value: w = w + 1𝑒 − 2
– Apply an inverse power function: w = w−1
– Assign the cell weights

Fig. 32: Cell weights derived from the effective susceptibility model.
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• Write all files
• Run the inversion
• Import the last inversion result

Fig. 33: Sparse CMI model

ALTERNATE ENDING #2: Sparse MVI-Spherical
In this inversion, we will use the spherical transformation to apply sparsity on the amplitude and angles
independantly. The user is invited to try different combination of norms to test the range of solutions.
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Fig. 30: Edit options panel 2 for MVI
inversion
•
• Copy the previous inversion object
• Change the inversion mode to Spherical
• Change the sparsity parameters ->
• Write all files
• Run the inversion
• Import the last inversion result
Synthesis
We have recovered three magnetic vector models with the following features:
• The MVI-C model was successful in locating the the magnetic kimberlite despite the presence of
remanence. Due to the smoothness constraint, the magnetization direction changes throughout the
anomaly, making difficult to distinguish a shape or overall trend.
• The Cooperative MVI-C and compact amplitude model dis a better job in imaging a compact body.
The magnetization orientation resemble much closely the true model inside the pipe. The horizontal
position of the maximum anomaly appears to be slightly shifted West of the true model. This is due
assumptions made in the amplitude inversion.
• The sparse MVI-S inversion was arguably the most accurate in recovering both the position and
magnetization orientation. Sparsity on the amplitude forced a compact anomaly, while blocky orientation angles allowed for rapid changes in the magnetization direction.
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Fig. 34: Sparse MVI-S model

9.3 A to Z Examples for EM1DFM

Here, we demonstrate the interpretation of FEM data through both independent 1D inversions and with
a laterally constrained pseudo-3D inversion approach. Although full 3D FEM inversion algorithms have
been developed, computing resources and processing time are often limiting factors. Meanwhile 1D and
laterally constrained pseudo-3D inversion approaches are computationally fast algorithms and capable
of recovering bulk information about 3D conductivity and susceptibility structures. The tutorial for the
EM1DFM inversion code is split into three parts:
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9.3.1 Specifying Parameters for FEM Sounding Inversion

Here, we detail the process of defining the survey parameters used in EM1DFM inversions.
For GIF formatted 1D FEM data, the survey parameters are automatically read into GIFtools.
For XYZ and CSV files however, the survey information must be specified by the user. In this
exercise, we:
• Define the data columns being imported from a XYZ data file
• Set transmitter, receiver and elevation information
• Assign uncertainties to the data
Setup for the Exercise
• Download the demo
• Open GIFtools
• Set the working directory
Tip:
• Steps (without links) are also included with the download
• Requires at least GIFtools version 2.2 (login required)

Import files
In addition to raw geophysical data, you may have access to topographical information. If this
information is available, it can be imported into GIFtools.
• Import raw FEM data (XYZ format as an FEMsounding).
• Import topography data (3D GIF format)
• Import 1D mesh (layers file)
• Import surface layer (3D GIF format)
Tip:
• Use Edit → Rename to change what objects in GIFtools are called
• For any data object, edit the data headers.

480

Chapter 9. A to Z Examples

GIFtoolsCookbook Documentation, Release 1.0

• Raw data were generated synthetically using the best-available conductivity model for
TKC and the E3Doctree code.
• The standard deviation of Gaussian noise added was determined from the uncertainties
used to invert real FEM data collected over TKC.

Add Transmitter, Receiver and Elevation Information

Since the raw data were formatted according to the XYZ format, the transmitter and receiver
information for the airborne survey must be set manually. Additionally, only an altitude column was provided in the raw data. Therefore, we must use the topography and altitude information to determine the elevation of each data point.
• Create elevation from surface topography
– Click at surface and use the altitude data column from the FEMsounding object
– Set i/o header for Z to the elevation column you just created
• Add transmitters to set the locations of the transmitters relative to the current xyz data
locations. Use the following parameters:
– Dipole moment = 1 Am 2
– Set Rotation angle as “Relative to bearing” and set bearing to calculate
– Along-line offset = 0 m
– Cross-line offset = 0 m
– Set vertical offset as altitude column from data object
• Add receivers to set the locations of the receivers relative to the transmitter locations.
Use the following parameters:
– Dipole moment = 1 Am 2
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– Set Rotation angle as “Relative to bearing” and use the bearing column that was
calculated when adding transmitters
– Along-line offset = 15 m
– Cross-line offset = 0 m
– Set vertical offset as altitude column from data object
• Set data normalization to ppm
Assign Uncertainties
Before inverting the data, we must assign uncertainties. The role of uncertainties in the inversion process is described in the inversion fundamentals section. Because real and imaginary
components of the observed response each span different magnitudes, and the errors on the
data may vary as such, distinct floor and percent uncertainties will be computed for each frequency.
• Use assign frequency-dependent uncertainties to create data columns containing the
data uncertainties. Use the following floor and percent values for both the real and
imaginary data:
– 1000 Hz = 2 ppm floor + 0%
– 5000 Hz = 5 ppm floor + 0%
– 25000 Hz = 15 ppm floor + 0%
• Set i/o headers for all fields. Files used in the inversion cannot be written until this is
performed.
Note:
The uncertainties for this exercise are the same as the uncertainties used to invert real
FEM data collected over TKC. If the applied uncertainties are correct:
• The recovered model will not fit the data too heavily in certain regions at the
expense of others
• The recovered model will not fit the data too heavily at certain frequencies at the
expense of others
• the recovered model will fit the real and imaginary components of the data equally
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9.3.2 Static and Adaptive 1D Inversion
Here, FEM data are inverted using both static and adaptive 1D inversion approaches. The
adaptive approach takes into account surface topography whereas the static approach does
not. In either case, every transmitter is associated with a distinct sounding location. A 1D
model is then recovered independently for each sounding location; see the EM1DFM package
overview for further explanation. The set of recovered 1D models are visualized on a 3D mesh.
Static and adaptive 1D inversion algorithms are a computationally fast way to obtain depth
and horizontal location information about conductive/resistive and magnetically susceptible
targets.
As part of this exercise, the user will:
• Set relevant inversion parameters
• Invert the field observations using a set of 1D conductivity models (susceptibility models can be included)
• Interpret inversion results generated from 1D inversions
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Setup for the Exercise
If you have completed the tutorial “Specifying Parameters for FEM Sounding Inversion”:
• Open your preexisting GIFtools project
• Set the working directory (if you would like to change it)
If you have NOT completed the previous tutorial and would like to start here, complete
the following steps:
• Download the demo
• Open GIFtools
• Set the working directory
• Import em1dfm data file: Assets\FEM1D.obs (1D FEM GIF format data in ppm)
• Import the topography data (3D GIF format)
• Create elevation from surface topography
– Set elevation at 40 m above topography
– Set i/o header for Z to the elevation column you just created.
– Import 1D mesh (layers file)
Note: The uncertainties for this exercise are the same as the uncertainties used to invert real
FEM data collected over TKC.
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Real (left) and quadrature (right) components of synthetic FEM data collected over TKC
Static 1D FEM Inversion

Here, the set of FEM data are inverted using the static 1D approach. This approach does not
consider surface topography.
Setup the inversion
• Create an EM1DFM inversion object and set the output directory
• Set the EM1DFM inversion parameters under edit options:
– Global tab:
∗ Set mesh from drop-down menu
∗ Set observed data from drop-down menu
∗ Mode: static 1D
∗ Model options: for this example, data are inverted strictly for a conductivity model
∗ Solver options: leave as default
∗ Trade-off Mode: select discrepancy principle (computes 𝛽 using a
line search)
– Conductivity tab:
9.3. A to Z Examples for EM1DFM
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∗ Set alpha_s = 0.04 and alpha_z = 1 (since layer thickness is 5 m)
– Susceptibility tab:
∗ Leave as default or customize (if being used)
– Click apply and write all files
Note:
• GIFtools will immediately convert the 1D layers to a 3D mesh using the smallest data
separation to define the x-y cell size.
• If you chose not to write the files from the edit options menu, you may do so through
write inversion files

Run Inversion and Load Results
• Run inversion
• Load results
• View the results
Discussion

Fig. 35: Conventional 1D inversion
The inverted 1D conductivity models are automatically geo-referenced in 3D for visualization
and interpretation. Interpolated data misfit maps for each data components are show below.
We note the following features
• Two regions of higher conductivity showing as arc conductors.
• Mostly uncorrelated residual misfit map.
Note that all 1D models extend vertically to the top of the mesh, even though the observation
stations were acquired at different heights. It is therefore expected that the relative depth of
the anomalies may not be representative of true 3D variations.
Normalized data misfits for the real (left) and quadrature (right) components of the magnetic
field
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Adaptive 1D FEM Inversion

Fig. 36: Recovered 1D conductivity
models
Here, the set of FEM data are inverted using the adaptive 1D approach. In this case, surface
topography is used to position the vertical locations of recovered 1D models relative to one
another; i.e. the surface of each 1D model should correspond with the surface location.
Setup the inversion
• Create another EM1DFM inversion using copy options
• Click on the newly created EM1DFM inversion object and set the output directory
• Use edit options to verify and apply the current set of inversion parameters:
– Make sure the mesh and observed data are properly set
– Make sure alpha_s = 0.04 and alpha_z = 1
– Set the topography from the drop-down menu
– Notice that the inversion parameters are identical to the previous inversion
that was run
– Apply and write all files
Run Inversion and Load Results
• Write inversion files
• Run inversion (select desired input file)
• Results for this algorithm are automatically loaded into GIFtools
• View the results
Note: Since the inversion mesh changes as a function of sounding location, each inversions
are started in series. The overall inverse process will take more time than with the static case.

9.3. A to Z Examples for EM1DFM

489

GIFtoolsCookbook Documentation, Release 1.0

Discussion

Fig. 37: Adaptive 1D inversion
While the recovered conductivity values are nearly identical to those in the static case, we
have recovered a pseudo-3D model that honours topography. Individual 1D models can be
interpreted as a group while also considering geological information that may be available.
From the set of recovered models, we see that:
• compact targets are recovered as arc-shaped conductors due to the 1D assumption
• the inversion recovered a thin layer over the entire area of investigation, which appears
to be slightly more conductive than the background.

Fig. 38: Recovered 1D models with topography
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9.3.3 Laterally Constrained 3D Inversion
Here, frequency-domain data are inverted using the laterally constrained 3D inversion approach. Just like in the previous exercise, every 1D model is associated with a distinct sounding location (see EM1DFM package overview). However lateral constraints are added such
that the set of recovered 1D models are smooth horizontally and can ultimately be constrained
and interpreted in 3D. The laterally constrained 3D inversion algorithm is a computationally
fast way to invert FEM data while taking into account both vertical and horizontal variability
of the Earth. The final model recovered by this algorithm is fully 3-dimensional.
As part of this exercise, the user will:
• Set relevant inversion parameters
• Invert the field observations using a set of laterally constrained 1D conductivity models
(susceptibility models can be included)
• Interpret the inversion results generated by the algorithm
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Setup for the Exercise
If you have completed the tutorial “Static and Adaptive 1D Inversion”:
• Open your preexisting GIFtools project
• Set the working directory (if you would like to change it)
If you have NOT completed the previous tutorial and would like to start here, complete
the following steps:
• Download the demo
• Open GIFtools
• Set the working directory
• Import em1dfm data file: Assets//FEM1D.obs (1D FEM GIF format data in ppm)
• Import 1D mesh (layers file)
• Import the topography data (3D GIF format)
• Create elevation from surface topography
– Set elevation at 40 m above topography
– Set i/o header for Z to the elevation column you just created.
Note: The uncertainties for this exercise are the same as the uncertainties used to invert real
FEM data collected over TKC.
Real (left) and quadrature (right) components of synthetic FEM data collected over TKC
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Laterally Constrained 3D FEM Inversion

Here, the set of FEM data are inverted using the laterally constrained 3D approach.
Setup the inversion
If you have completed the tutorial “Static and Adaptive 1D Inversion”:
• Click on a preexisting EM1DFM inversion object and copy options
• Click on the newly created EM1DFM inversion object to set the output directory
• Set any necessary EM1DFM inversion parameters under edit options:
– Make sure the mesh, observed data and topography are properly set!
– Mode: Laterally constrained 3D
∗ Max distance = 1000 m
∗ Number of stations = 10
∗ Smoothing parameter = 200
∗ Other parameters left as default values
– Use the Fix Trade-off mode
∗ Initial beta = 1000
∗ Cooling factor = 5
∗ Global Iterations = 5
9.3. A to Z Examples for EM1DFM
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∗ Other parameters left as default values
• Click Apply
If you have NOT completed the previous tutorial and are starting here:
• Create an EM1DFM inversion object and set the output directory
• Set the EM1DFM inversion parameters under edit options using the parameters specified in the bullet list above
• Click Apply
Note: If you chose not to write the files from the edit options menu, you may do so through
write inversion files

Run Inversion and Load Results
• Run inversion
• Results are loaded automatically for this algorithm
• View the misfit map
Discussion

The lateral constraints strategy comes with many advantages:
• Neighboring 1D conductivity models are more consistent
• Conductivity structures are interpolated in 3D, possibly highlighting trends in the model
and easing the interpretation.
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• Possible to employ a 𝛽-cooling strategy similar to the 3D inversion code.
The use of a global measure of data fit allows us to assess the convergence of the algorithm
through the usual convergence curve window.
Ideally we would like to test the hypothesis of a conductive overburden in 3D, as well as to
impose bounds on the conductivity values. which we covered in the next section.

Fig. 40: Convergence curves
Note: After the fifth iteration, the global misfit begins to increase due to the 3D smoothing
of the recovered conductivity model. The user should consider re-running the inversion with
different smoothing parameters in order to test the stability of the solution.

Geological Constraints: Hypothesis Testing
It is well known that at TKC, there is a till overburden covering a portion of the survey area.
As a final example we will impose 3D geological constraints on the laterally constrained 1D
inversions. The geological constraints assume we have some a-priori information about the
distribution and thickness of the overlying till. To apply geological constraints, we first need
to create the reference conductivity model from a surface:
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Creating a Reference Model
Here, we use surface topography and a surface object to define the upper and lower surfaces
of the till layer, respectively. We then assign reasonable physical property values for the till
and background. To accomplish this task, we use the model builder module.
• Import the surface file provided (TillLayer.topo)
• Select one of the 3D mesh objects created from a previous inversion and create active
model from topography. Use from tops of cells.
• Select the active cells model and create a model builder module
• Create model using surfaces with the following parameters to create an initial
physical property model:
– Top surface as topography
– Bottom surface as surface object
– Value as physical property value (set as 10−4 S/m)
– Destination model as New Model and provide a name (RefMod)
• Setting physical property values for the active background cells in the newly
created model can with the same functionality. Open the Create model using
surfaces window and use the following parameters
– Top surface as surface object
– Bottom surface as Value (−1000 m)
– Value as physical property value (set as 10−5 S/m)
– Destination model as the physical property model you just created
This model can be used as a reference model and constrain the final recover conductivity
model.
Setup the inversion
• Click on the last EM1DFM inversion object and copy options
• Click on the newly created EM1DFM inversion object and set the output directory
• Use edit options to verify and apply the current set of inversion parameters
– Make sure the mesh and observed data are properly set
– Set the topography from the drop-down menu
– Notice that the inversion parameters are identical to the previous inversion
that was run
• Within edit options Conductivity tab, set:
– Initial model as best-fitting halfspace
– Reference model as the model created in the previous subsection and choose
“SMOOTH_MOD_DIF”
• Upper and lower bounds for the recovered model can be set if desired
• Apply and write all files

498

Chapter 9. A to Z Examples

GIFtoolsCookbook Documentation, Release 1.0

Fig. 41: Till layer defined within the reference model.
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Run Inversion and Load Results
• Run inversion
• Results are loaded automatically for this algorithm
• View the misfit map
Discussion
This final solution differs from the previous inversion in that:
• A sharp gradient is preserved along the base of the till layer
• The upper conductivities are more consistent ≈ 104 Ω · 𝑚
• The top of the kimberlite pipes is at the right depth
The reader is invited to run multiple inversions with various smoothing parameters and data
uncertainties to explore the range of solutions. It is important to keep in mind that the true
model is 3D and cannot be characterized by the 1D assumption. We did however manage to recover a first order estimate for the horizontal positions of the kimberlite pipes and background
conductivity structures.

Fig. 39: Recovered 1D models with topography and lateral constraints
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Fig. 42: Recovered 1D models with geological constraints
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9.4 A to Z Examples for EM1DTM
Here, we demonstrate the interpretation of TEM data through both independent Laterally constrained
pseudo-3D inversion approach. We will make use of the latest inversion routines developed by the opensource community: SimPEG + empymod . The tutorial for the EM1DTM inversion code is split into two
parts:

9.4.1 Specifying Parameters for TEM Sounding Inversion

Fig. 43: Sections through the true 3D conductivity model
Here, we detail the process of defining the survey parameters used in EM1DTM inversions.
For GIF formatted 1D TEM data, the survey parameters are automatically read into GIFtools.
For Geosoft XYZ and CSV files however, the survey information must be specified by the user.
In this exercise, we:
• Define the data columns being imported from a column data file
• Set transmitter, receiver and elevation information
• Assign uncertainties to the data
Setup for the Exercise
• Download the demo
• Open GIFtools
• Set the working directory
Attention:
• Requires at least GIFtools version 2.26 (login required)
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Import files
We will begin by importing all the necessary information:
• Import raw TEM data from the file TKCdata_VTEM.xyz. Import data as Time-Domain
EM → XYZ → TEM sounding (recipe)
– Under channel information, import the time channels from the file VTEMtimes.
dat. Only 1 data groups so this does not need to be specified.
– When specifying headers, choose load file and use VTEMheader.txt. Don’t forget to specify header name.
• Set IO header for the data column as the newly created dB/dt column
• Import topography data from the file TKCtopo.dat (3D GIF format)
• Import 1D mesh from the file layer.msh (layers file)
Tip:
• Use Edit → Rename to change what objects in GIFtools are called
• For any data object, edit the data headers.
• Raw data were generated synthetically using the best-available conductivity model for
TKC and the TDoctree code.

Set Survey Information

Since the raw data were formatted in CSV format, the transmitter and receiver information for
the airborne survey must be set manually. Additionally, only an altitude column was provided
in the raw data. Therefore, we must use the topography and altitude information to determine
the elevation of each data point.
• Create elevation from surface topography
9.4. A to Z Examples for EM1DTM
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– From the TKCdata_VTEM data object use the ralt data column to shift the location vertically.
– Set i/o header for Z to the elevation column you just created
• Add transmitters to set the locations of the transmitters relative to the current xyz
data locations. For the coincident loop system used for the survey we set the following
parameters:
– Loop transmitter with radius of 10 m
– Along-line offset = 0 m
– Cross-line offset = 0 m
– Set vertical offset as altitude column (ralt) from TEMsounding object
• Add receivers to set the locations of the receivers relative to the transmitter locations.
Use the following parameters:
– Dipole moment = 1 Am 2
– Along-line offset = 0 m
– Cross-line offset = 0 m
– Set vertical offset as altitude column (ralt) from data object
• Set data normalization to Volts. This determines the data units written to the observations file and interpreted by the EM1DTM code.
• Set time normalization to seconds
• Import and set waveform using the file VTEM.wave (3D format)
Important: In keeping with a commonly used convention, we have chosen to plot -dBz/dt to
show a positive decaying response; thus dBz/dt for a coincident loop system is negative and
decaying in the universal coordinate system used by GIFtools. When loading TEM which are
not already in GIF format, it is important that the sign of the vertical response is correct.

Assign Uncertainties
Before inverting the data, we must assign uncertainties. The role of uncertainties in the inversion process is described in the inversion fundamentals section. Because the observed
response spans multiple orders of magnitudes of all time channels, and the errors on the data
may vary as such, distinct floor and percent uncertainties will be computed for each time
channel.
• Assign uncertainties from file Uncertainties.data
• You can review the uncertainty with the GUI to verify your work.
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Note: The uncertainties for this exercise are based on the response over the gackground model
so that the recovered model will not fit the dat too heavily in certain regions at the expense of
others
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9.4.2 Laterally Constrained 1D Inversion
Here, time-domain data are inverted using the laterally constrained 3D inversion code developed by the open-source community in Python. Just like the AtoZ Frequency EM1D example,
individual 1D inversions are constrained laterally such that the set of recovered 1D models are
smooth horizontally and can ultimately be constrained and interpreted in 3D. The collaborative work invested in SimPEG and empymod has improved the lateral 1D inversion in many
ways:
• Avoids the slow read/write of the legacy EM1DTM file format
• Parallelized forward modeling
• Efficient digital filtering scheme (empymod)
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As part of this exercise, the user will:
• Set relevant inversion parameters
• Invert the field observations using a set of laterally constrained 1D conductivity models
(susceptibility models can be included)
Setup for the Exercise
If you have NOT completed the previous tutorial and would like to start here, complete
the following steps:
• Download the demo
• Open GIFtools
• Set the working directory
• Import
EM1DTM
formatted
sets/TKCdata_VTEM_EM1DTM.dat

data

from

the

file

As-

• Import 1D mesh (layers file)
• Import the topography data (3D GIF format)
• Create elevation from surface topography
9.4. A to Z Examples for EM1DTM
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– Set elevation at 40 m above topography
– Set i/o header for Z to the elevation column you just created.
• Import and set waveform
• Assign uncertainties from file Uncertainties.dat
1D TEM Inversion

Here, the set of TEM data are inverted using the laterally constrained 1D approach.
Setup the inversion
• Create an em1dtm inversion object and set the output directory
• Click on the newly created em1dtm inversion object to set the output directory
• Set any necessary em1dtm inversion parameters under edit options:
– Global tab:
∗ Mode panel: set to laterally constrained 3D
∗ Make sure the mesh, observed data and topography are properly set!
∗ Trade-off mode panel: Use ‘discrepancy’ mode
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∗ Other parameters left as default values
– Conductivity tab:
∗ Leave the initial and reference conductivity to best-fitting halfspace
– Click Apply (NOT Apply and write)
Note: You do NOT need to write all files, as the data and inversion parameters will be passed
on to Python as HDF5 file. This will save time by avoiding to read/write the legacy EM1DTM
file format

Run Inversion and Load Results

• Run inversion (SimPEG)
– Inversion progress will be displayed in a command prompt
– Results will be loaded automatically at the end of the inversion
• View the model
• View the misfit map
The lateral constraints strategy comes with many advantages:
• Neighboring 1D conductivity models are more consistent
• Conductivity structures are interpolated in 3D, possibly highlighting trends in the model
and easing the interpretation.
• Possible to employ a 𝛽-cooling strategy similar to the 3D inversion code.
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Congratulation, you have recovered two pipe-like bodies by inverting Time-Domain EM data
in 1D with the open-source inversion routines SimPEG + empymod! You are invited to try
the Python algorithm on the AtoZ FEM1D example
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9.4.3 Mesh Validation for TDoctree v2
Here, the model obtained in the previous exercise AtoZ Time-Domain 1D is used to assess the
validity of an octree mesh used by the TDoctree v2 inversion code.
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Important: Before continuing, make sure you have downloaded and installed the required Python libraries. Visit the Python Installation page for more details.

9.5 A to Z Examples for DCIP 2D/3D
In this activity, we will simulate and invert DC Resistivity data over the synthetic TKC conductivity model.
We demonstrate how to batch 2D inversions and use the result in a subsequent 3D inversion.

9.5.1 Survey Design and Forward Simulation

Here, we show how to create a simple dipole-dipole DC Resistivity survey over a conductivity model and
run the forward simulation.
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Setup for the Exercise
• Download the demo
• Open GIFtools
• Set the working directory
Tip:
• Requires at least GIFtools 2.26 (login required)

Create Overlapping surveys
In order to compare the resolving capabilities of different survey configurations, we will generate two sets
of line data with the following specifications:
Use the DCIP Survey Designer

Survey Type
Transmitters/Receivers
IP Type
Dimension
Centroid
Bearing
Line Length (m)
Line Spacing (m)
Nb. lines
Electrode Spacing (m)
Nb. Receivers

Block 1
DC
pole-dipole
Apparent Chargeability
3D
557250 E, 7134000 N
45∘
1500
300
5
60
20

Block 2
DC
pole-dipole
Apparent Chargeability
3D
557400 E, 7133600 N
90∘
1500
100
5
60
20

Note: The survey do not contain elevation information. We will let the code set the vertical position based
on the discretized topography.
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Merge the surveys

• Since we are creating two separate surveys, the lineID assigned to Block 1 and 2 will be
repeated. We will add a constant to the line ID so that they are all unique identifiers.
– Add constant value to Block 2 lineID property (+ 5)
• Select Block 1 and combine block 2 to form one large survey.
– Data Manipulation → Add Data → Merge other DCIP3D data
– Rename the combine object DCSurveyFull
Forward model DC data
• Create a DC Forward object
• Edit input options
– Set Locations to DCSurveyFull
– Set Topography to TOPOdata and select TKCtopo
– Set Conductivity to TKC_condModel
• Write files
– Select Surface Data Format
• Run the forward simulation
• After completion, Load the predicted data
Forward model IP data
• Convert the DC3Ddata to an IP3Ddata object object
• Create a IP Forward object
• Edit input options
– Set Locations to DCSurveyFull
– Set Topography to TOPOdata and select TKCtopo
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– Set Conductivity to TKC_condModel
• Write files
– Select Surface Data Format
• Run the forward simulation
• After completion, Load the predicted data

9.5.2 2D Inversion

In this section, we will invert the simulated data in 2D as a pre-processing step for the 3D inversion.
Setup for the Exercise
• Download the demo
• Open GIFtools
• Set the working directory
Tip:
• Requires at least GIFtools 2.26 (login required)

Extract 2D data objects
In the previous simulation section, we have generated a DC3Ddata object, which we first want to invert in
2D:
• Assign simple uncertainties
– % = 15
– floor = 0.05
• Set the data/uncertainties
• Copy the LineID from the DC3Ddata object
9.5. A to Z Examples for DCIP 2D/3D
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• Seperate the survey lines
– Export the 2D topography at 20 m resolution.
Explore the model space

Before attempting to invert all data, it is good practice to test different assumptions on a single line. First
let’s test different reference conductivity values by running a series of 2D inversions.
• Create a DC2Dinversion object to serve as a template
– Set 𝛼𝑠 = 0.0025, 𝛼𝑥 = 𝛼𝑧 = 1
– Select data from Line 7 (directly above the conductive kimberlite)
• Create a Model Space object
• Edit the Model Space inversion options and set mref over a range [1𝑒 − 5, 1𝑒 − 2, 4]𝑖𝑛𝑙𝑜𝑔𝑠𝑝𝑎𝑐𝑒
• Write All and Run
• Upon completion, Load the results First to target and Extract model section
[OPTIONAL]
-Create a DOI using two of the recovered models
Note: Changing the reference conductivity value can drastically change the solution at depth, which can
be used to estimate the Depth-of-Investigation (DOI) of a geophysical experiment.

Run a Batch Inversion
We have a total of 10 DC2Ddata objects that would like to invert. Rather than manually inverting each
line, we will make use of the Batch Inversion object to speedup the process.
• Create a DC2Dinversion object to serve as a template
– Set 𝛼𝑠 = 0.0025, 𝛼𝑥 = 𝛼𝑧 = 1
– Set the reference conductivity to 1𝑒 − 4 S/m
• Create and edit a Batch Inversion
• Run all
526

Chapter 9. A to Z Examples

GIFtoolsCookbook Documentation, Release 1.0

• Upon completion, load all results First to targets
Merge and interpolate models
While we can view each inversion result on their respective 2D mesh, in this section we will bring together
the 2D models into our 3D mesh for later use.
• Merge results using the DCSurveyFull lineID property as reference
– Right-click on the ` BatchInversion
– Click Merge all
– Select the 3D original mesh
– Select the DC3Ddata object generated in the DC3DForward
– Check that line IDs are correct
– Click OK to proceed

Note:
• We have recovered conductive anomalies consistent across lines.
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• The chosen best-fitting half-space conductivity might be slightly too high due to the thin conductive
overburden. The user is invited to repeat the experiment with different background conductivity
values.
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9.5.3 3D Inversion

Purpose
In this section, we will invert the simulated data in 3D with three strategies:
• Case 1: Unconstrained inversion
• Case 2: Sensitivity weighted inversion
• Case 3: Inversion with 2D starting model
Note: Link to DCIP3D documentation

Downloads
Example
• Download the demo
• Requires at least GIFtools 2.26 (login required)
• Requires DCIP v5

Step by step
Tip: If you have already completed either the Survey Design and Simulation or the 2D Inversion demo,
you may advance directly to the Unconstrained Inversion Section
• Step 1: Setup
– Start a GIFtools project
– Set the working directory
– Import the topography data
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• Step 2: Survey and Data
– Import the DC data in UBC format
Case 1: Unconstrained Inversion
As a first step, we invert the simulated data with a purely unconstrained approach.
• Create an inversion object (DC3Dinversion)
– Edit the options
∗ Panel 2: Adjust 𝛼 parameters: 𝛼𝑠 = 0.0025, 𝛼𝑥 = 𝛼𝑧 = 1
∗ Click Apply and write files
– Run the inversion

Case 2: Sensitivity weighted inversion
The result obtained with the unconstrained approach appears to be dominated by the source-receiver position, with most of the conductivity anomalies recovered near the survey lines. In order to reduce this
geometric bias, we will incorporate sensitivity-based weights.
• Copy the inversion object from the previous example
• Load the sensitivity file generated by DCINV3D
• Create sensitivity weight
• Write All and Run
Note: This solution is an improvement over the purely unconstrained as lower conductivity anomalies are
recovered at the electrodes, while the conductive kimberlites are better recovered

532

Chapter 9. A to Z Examples

GIFtoolsCookbook Documentation, Release 1.0

Case 3: Inversion with 2D starting model
In the third case, we will incorporate the stiched 2D model in the 3D inversion through a starting and a
reference model.
To create a full 3D model from the merge 2D models created in the merging step, the steps are:
• Right-click on the merged model
• Select Edit -> Fill/Interpolate no-data-value (see the documentation)
• Keep the default parameters and enter 1e-8 as no-data-value and choose the Log interpolation
Then you can use that model as starting and reference model:
• Copy the inversion object from Case 2
• Set the reference and starting model
• Write All and Run
Note: We have once again improved the solution, and the iteration process is a lot quicker since we are
starting with a model closer to the final solution.

9.6 Natural Source Electromagnetics (MT and ZTEM)
This A to Z example tackles practical aspects of preparing and inverting natural source EM data (MT
and/or ZTEM) using GIFtools. Here the user begins with a set of EDI formatted MT survey files and
Geosoft XYZ formatted ZTEM survey files. The user will load the into the GIFtools framework, interpret
the data and invert the data with two OcTree codes (E3DMT versions 1 and 2). The goal of this exercise
is to recover a conductive kimberlite pipe which lies under a moderately conductive overburden.
Once finished, the user will be familiar with:
• The coordinate systems and Fourier convention generally used for MT and ZTEM data
9.6. Natural Source Electromagnetics (MT and ZTEM)
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• Basic interpretation of MT data through apparent resistivities
• Creating OcTree meshes based on survey geometry
• Practical strategies for inverting natural source data with the E3DMT codes
• Differences between E3DMT versions 1 and 2
• How to jointly invert MT and ZTEM data using GIFtools
The full A to Z example is split into 4 parts:

9.6.1 Importing, Interpreting and Preparing NSEM Data
For this exercise, we:
• Import impedance tensor data in EMAP standard format from a set of EDI files
• Import ZTEM data from a Geosoft XYZ formatted file
• Convert impedance tensor data to apparent resistivities for interpretation
• Apply uncertainties to impedance tensor and ZTEM data
Setup for the Exercise
• Download the demo
• Open GIFtools
• Set the working directory
Important: Requires GIFtools v2.29 or later.
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Import Files
• Import MT data from EDI files. EDI files are in the folder assets/MTdata_EDI. Data are in standard
EDI format (Northing-Easting-Down), which is also used by GIF codes.
• Import ZTEM data from Geosoft XYZ. The data file is named ZTEMdata_XYZ.dat and is in the assets
folder. Data are in the GIF data format (Northing-Easting-Down).
– There are two frequencies (60 Hz and 360 Hz)
– There are 4 data groups (TZXR, TZXI, TZYR, TZYI)
• Once loaded, make sure to set IO headers for all MT and ZTEM data.
• Pro tip: To avoid confusion between location and data coordinate systems, use the set data headers
tool to define location columns as Easting, Northing and Elevation.
Important: In this case, MT and ZTEM data are in a widely used coordinate system which matches that
of the GIF codes; see GIF data format conventions. If a non-standard coordinate system is being used in
the EDI files, it is imperative the user transform the data to GIF within GIFtools before inverting. This
can be done by changing data headers, multiplying certain columns by -1 and/or re-setting io Headers. To
get addition background information on the coordinate systems used by the E3DMT codes, see the theory
sections of the version 1 and version 2 manuals.

MT data
Interpretation through apparent resistivity
By examining the impedances, apparent resistivities and phases, we can determine if the units of the data
are correct and whether the data are in GIF format.
• Use VTK to image the off-axis impedance tensor elements 𝑍𝑥𝑦 and 𝑍𝑦𝑥 . Notice that when looking
at the background response:
– 𝑍𝑥𝑦 data are in the lower-right-hand corner of the complex plane 𝑍𝑦𝑥 data are in the upperleft-hand corner of the complex plane
– This is consistent with data that is in GIFtools format
• Convert impedances to apparent resistivity and phase
• Use VTK to image the apparent resistivities derived from the off-axis impedance tensor elements
(image on log-scale). When looking at 𝑍𝑥𝑦 and 𝑍𝑦𝑥 for all frequencies we found that:
– the near surface resistivity of the background (∼ 200 Ω𝑚) is less than the resistivity of the
background at depth (∼ 1000 Ω𝑚).
– the MT anomaly is caused by a conductor (𝜌𝑎 ∼ 102 Ω𝑚) and that the conductor does not
extend to the surface.
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Fig. 44: Real (left) and imaginary (right) components of impedance tensor elements 𝑍𝑥𝑦 and 𝑍𝑦𝑥 at 60 Hz in V/A.

Fig. 45: Apparent resistivities for 𝑍𝑥𝑦 at frequencies 60 Hz (left), 360 Hz (middle) and 1500 Hz (right). Apparent
resistivity data shows the anomaly as being cause by a conductor.
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Assigning uncertainties
Assigning appropriate uncertainties to the data is necessary for running stable and successful inversions
with GIFtools. For this exercise, we will apply simple uncertainties.
• Use assign simple uncertainties to generate uncertainties for the data. For all data apply uncertainties
of 0.0025 V/A + 5%.
• Ensure that IO headers are set for all uncertainties.
Important: To demonstrate the E3DMT codes, we have chosen to apply simple uncertainties. In practice,
we must ensure that we do not overfit certain frequencies and locations at the expense of others.

Creating an OcTree mesh
With OcTree utilities, we can create an OcTree mesh based on the survey geometry. Here we create an
OcTree mesh from MT data.
• Create an E3DMT mesh utility and create a directory for any output files.
• Select the newly created object (E3DMT mesh utility) and set data as the MT data you loaded
• Edit options. Use the following parameters:
– Background resistivity: 1,000 Ω𝑚
– Topography: set as 400 m and select Approximate topography button
– East width = 50 m, North width = 50 m, Thickness = 30 m
– RX cells 1 = 8, RX cells 2 = 4 and RX cells 3 = 2
– DOI 1 = 600, DOI 2 = 480, DOI 3 = 480
– East padding = 6000 m, North padding = 6000 m, Down padding = 4000 m, Air padding =
6000 m
• Run the utility
• Load results
Note: To generate the OcTree mesh with E3DMT version 2 utilities, we would need to first define receivers
from data locations.

Important: For this example, mesh parameters were set such that we had flat topography which did
not intersect any padding cells. In practice, we must ensure the topography is sufficiently discretized.
Otherwise, source terms computed in the code are not accurate. This will lead to artifacts in the inversion
even if the padding distance is sufficient. A good way check is to look at the active cells model.

Important: By choosing flat topography, we have ensure all measurements are exactly on the surface of
the discretized topography. If topography is used, the data locations must be projected onto the discretized
topography. Failure to do so may result in electric field measurements being collected in the air.
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Fig. 46: OcTree mesh. 103,391 total cells.
ZTEM data
Interpretation and Setting Base Station
By examining the data, we can determine if they are in GIF format.
• Use VTK to image the ZTEM data. Notice that proximal to a compact body:
– The anomalous values in 𝑇𝑧𝑥 lie to the North and South of the pipe; whereas the anomalous
values in 𝑇𝑧𝑦 lie to the East and West of the pipe. For a base station which lies away from any
lateral conductivity changes, this is consistent with the GIF codes.
– When comparing real and imaginary data, the sign of the anomalies of opposite, indicating a
Fourier convention of 𝑒−𝑖𝜔𝑡 . This is consistent with GIF codes.
• Geosoft XYZ data files do not contain the base station location so we must define it. Thus:
– Set base station at Easting = 556,600 m, Northing = 7,132,800 m and Elevation = 400 m.
– Set ZTEM data type to MTT. If this is not done, horizontal fields are measured at the observation locations and not at the base station.
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Fig. 47: Z-axis tipper measurements at 60 Hz. It is important to note that the ‘X’ in TZXR data refers to the Northing
direction! ‘R’ refers to real component and ‘I’ refers to imaginary component.
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Assigning uncertainties
Assigning appropriate uncertainties to the data is necessary for running stable and successful inversions
with GIFtools. For this exercise, we will apply simple uncertainties.
• Use the GUI to assign uncertainties to each component and frequency of the data seperately. Assign
a floor equal to 5% the maximum value in amplitude for each component and for each frequency.
The uncertainties we chose are tabulated below.
• Ensure that IO headers are set for all uncertainties.
Component
TZXR
TZXI
TZYR
TZYI

𝜖 at 60 Hz
0.0025
0.001
0.0037
0.0015

𝜖 at 360 Hz
0.0038
0.0006
0.0049
0.0012

Important: To demonstrate the E3DMT codes, we have chosen to apply simple uncertainties. In practice,
we must ensure that we do not overfit certain frequencies and locations at the expense of others.

Creating an OcTree mesh
Here we generate an OcTree mesh from the ZTEM survey geometry.
• Create an E3DMT mesh utility and create a directory for any output files.
• Select the newly created object (E3DMT mesh utility) and set data as the ZTEM data you loaded
• Edit options. Use the following parameters:
– Background resistivity: 1,000 Ω𝑚
– Topography: set as 400 m and select Approximate topography button
– East width = 50 m, North width = 50 m, Thickness = 30 m
– RX cells 1 = 8, RX cells 2 = 4 and RX cells 3 = 2
– DOI 1 = 600, DOI 2 = 480, DOI 3 = 480
– East padding = 6000 m, North padding = 6000 m, Down padding = 4000 m, Air padding =
6000 m
• Run the utility
• Load results
Important: For this example, mesh parameters were set such that we had flat topography which did
not intersect any padding cells. In practice, we must ensure the topography is sufficiently discretized.
Otherwise, source terms computed in the code are not accurate. This will lead to artifacts in the inversion
even if the padding distance is sufficient. A good way check is to look at the active cells model.

Note: To generate the OcTree mesh with E3DMT version 2 utilities, we would need to first define receivers
from data locations.
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Fig. 48: OcTree mesh. 110,307 total cells.

9.6.2 Inverting MT Data
Here, we invert synthetic impedance tensor data using E3DMT versions 1 and 2. When inverting
impedances, the E3DMT codes have a tendency to place conductive artifacts proximal to the receivers.
To overcome this obstacle, we demonstrate a basic approach for limiting artifacts through the use of interface weights.
Important: The MT data are in GIF format; see GIF data conventions page. This means the locations are
Easting-Northing-Elevation. The data convention however is defined X = Northing, Y = Easting and Z =
Down. Failure to recognize this will cause incorrect interpretation of the data. To get addition background
information on the coordinate systems used by the E3DMT codes, see the theory sections of the version 1
and version 2 manuals.

Setup for the Exercise
If you have completed the tutorial “Importing, Interpreting and Preparing NSEM Data”:
• Open your pre-existing GIFtools project
• Set the working directory (if you would like to change it)
If you have NOT completed the previous tutorial and would like to start here, complete the following
steps:
• Download the demo
• Open GIFtools
• Set the working directory
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• Import the observed data in E3DMT version 1 format. The data file is MTdata_v1.obs and is found
in the assets folder (Impedance tensor data in V/A)
• Load OcTree mesh. Found in the folder assets/octree_model_mt.
• Load active cells model. Found in the folder assets/octree_model_mt.
• Load true model. Found in the folder assets/octree_model_mt.
Pro tip: To avoid confusion between location and data coordinate systems, use the set data headers tool
to define location columns as Easting, Northing and Elevation.

Fig. 49: Real (left) and imaginary (right) components of impedance tensor element 𝑍𝑥𝑦 at 60 Hz in V/A. Data shows
that 𝑍𝑥𝑦 lies in the lower-righthand quadrant of the complext plane. This is consistent with the desired format in
GIFtools.
Important: Data were generated using E3DMT version 2 and a block model approximating TKC. To
keep things simple, a constant topography of 400 m. Uncertainties of 0.0025 ± 5% were added to all
impedance tensor measurements.
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Fig. 50: Apparent resistivities for 𝑍𝑥𝑦 at frequencies 60 Hz (left), 360 Hz (middle) and 1500 Hz (right). Apparent
resistivity data shows the anomaly as being cause by a conductor.
Reducing Artifacts through Interface Weighting
When inverting MT data, the E3DMT codes have a tendency to place conductive structures near receiver
locations due to the sensitivity of the data to those cells. Here, we generate interface weights to counteract
this problem. By forcing lateral smoothness within the top few layers of cells, we can limit the artifacts
and force the inversion to place conductive structures at the appropriate depths.
• Create and interface weights utility
• Use edit options and set the following parameters:
– set the OcTree mesh
– set as log model
– set topography as the active cells model
– set 3 layers of surface weights with values 10, 5, and 2.5 in decreasing order
– Face value = 0.01
– Face tolerance = 0.01
• Run the utility
• Load results
E3DMT Version 1
Let us now invert the impedance tensor data using E3DMT version 1.
• Create E3DMT version 1 inversion object
• Use edit options to set the inversion parameters
– Basic Tab:
∗ Select the impedance data
∗ Set mesh
∗ Set topography to active cells model
∗ No background susceptibility
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∗ 1D conductivity of 0.001 S/m (which we inferred from apparent resistivity maps)
∗ Use Iterative solver unless you have sufficient RAM to use Direct solver.
– Model Options Tab:
∗ Set Beta cooling schedule to ‘custom by clicking button’. Use beta max = 1, beta
min = 1e-8 and reduction factor = 0.25
∗ Set
Chi
Factor
=
0.8
since
E3DMT
version
1
uses
a
non-standard
measure
of
data
misfit;
see
manual
<https://e3dmt.readthedocs.io/en/e3dmt/content/theory.html#data-misfit>
∗ alpha S = 1e-10, alpha E = 1, alpha N = 1 and alpha Z = 2.56 (to recover smoothest
model and balance gradient terms based on cell dimensions)
∗ Use the weights object to add additional weights
∗ Set the active cells topo as the active model cells
∗ Set initial model as 0.001 S/m
∗ Set reference model as 0.001 S/m
∗ Set role in model objective function to SMOOTH_MOD_DIF
• Click Apply and write files
• Run the inversion
• Load results
• View convergence
The results of the inversion are shown below. We are able to recover conductive pipe and the moderately
conductive overburden. The conductivty of the overburden is also recovered (𝜎 ≈ 0.005 S/m). We are
also able to recover the approximate depth to the pipe (~100 m) and the pipe’s general shape.
The inversion reaches target misfit after 3 iterations. The model norm is discontinuous because the current
model is set to be the reference model for the next beta value. The recovered model is able to reproduce the
observed anomaly quite well. And misfit map indicated we are fitting each component of the data evenly.

Fig. 51: Recovered model at iteration 3. EW cross-section (left), NS cross-section (centre), horizontal slice (right).
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Fig. 52: True model. EW cross-section (left), NS cross-section (centre), horizontal slice (right).

Fig. 53: Convergence curve shows that inversion reaches target misfit. The model norm is discontinuous because the
reference modeled is updated at each iteration.

9.6. Natural Source Electromagnetics (MT and ZTEM)

545

GIFtoolsCookbook Documentation, Release 1.0

Fig. 54: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑍𝑥𝑦 at 60
Hz.
E3DMT Version 2
Let us now invert the impedance tensor data using E3DMT version 2. Unlike version 1, version 2 requires
that user define the receiver which measure the fields.
• Click the impedance data object and set receivers from locations. Use the following values:
– Easting width = 2 m
– Northing width = 2 m
– Vertical width = 2 m
– Dipole length = 10 m
• Create E3DMT version 2 inversion object
• Use edit options to set the inversion parameters
– Basic Tab:
∗ Select the impedance data
∗ Set mesh
∗ Set topography to active cells model
∗ No background susceptibility
∗ 1D conductivity of 0.001 S/m (which we inferred from apparent resistivity maps)
∗ Use Iterative solver unless you have sufficient RAM to use Direct solver.
– Model Options Tab:
∗ Set Beta cooling schedule to ‘custom by clicking button’. Use beta max = 1, beta
min = 1e-8 and reduction factor = 0.25
∗ Set Chi Factor = 1
∗ alpha S = 1e-10, alpha E = 1, alpha N = 1 and alpha Z = 2.56 (to recover smoothest
model and balance gradient terms based on cell dimensions)
∗ Use the weights object to add additional weights
∗ Set the active cells topo as the active model cells
∗ Set initial model as 0.001 S/m
∗ Set reference model as 0.001 S/m

546

Chapter 9. A to Z Examples

GIFtoolsCookbook Documentation, Release 1.0

∗ Set role in model objective function to SMOOTH_MOD_DIF
• Click Apply and write files
• Run the inversion
• Load results
• View convergence
The results of the inversion are shown below. We are able to recover conductive pipe and the moderately
conductive overburden. The conductivty of the overburden is also recovered (𝜎 ≈ 0.005 S/m). We are
also able to recover the approximate depth to the pipe (~100 m) and the pipe’s general shape.
The inversion reaches target misfit after 3 iterations. The model norm is discontinuous because the current
model is set to be the reference model for the next beta value. The recovered model is able to reproduce the
observed anomaly quite well. And misfit map indicated we are fitting each component of the data evenly.

Fig. 55: Recovered model at iteration 3. EW cross-section (left), NS cross-section (centre), horizontal slice (right).

Fig. 56: True model. EW cross-section (left), NS cross-section (centre), horizontal slice (right).
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Fig. 57: Convergence curve shows that inversion reaches target misfit. The model norm is discontinuous because the
reference modeled is updated at each iteration.

Fig. 58: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑍𝑥𝑦 at 60
Hz.
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9.6.3 Inverting ZTEM Data
Here, we invert synthetic ZTEM data using E3DMT versions 1 and 2. When Tipper data, the E3DMT
codes have a tendency to place conductive artifacts proximal to the receivers. To overcome this obstacle,
we demonstrate a basic approach for limiting artifacts through the use of interface weights.
Important: The ZTEM data are in GIF format; see GIF data conventions page. This means the locations are Easting-Northing-Elevation. The data convention is defined X = Northing, Y = Easting and Z =
Down. Failure to recognize this will cause incorrect interpretation of the data. To get addition background
information on the coordinate systems used by the E3DMT codes, see the theory sections of the version 1
and version 2 manuals.

Setup for the Exercise
If you have completed the tutorial “Importing, Interpreting and Preparing NSEM Data”:
• Open your pre-existing GIFtools project
• Set the working directory (if you would like to change it)
If you have NOT completed the previous tutorial and would like to start here, complete the following
steps:
• Download the demo
• Open GIFtools
• Set the working directory
• Import the observed data in E3DMT version 1 format. The data file is ZTEMdata_v1.obs and is
found in the assets sub-folder (ZTEM data are unitless)
• Load OcTree mesh. Found in the folder assets/octree_model_ztem.
• Load active cells model. Found in the folder assets/octree_model_ztem.
• Load true model. Found in the folder assets/octree_model_ztem.
Pro tip: To avoid confusion between location and data coordinate systems, use the set data headers tool
to define location columns as Easting, Northing and Elevation.
Important: Data were generated using E3DMT version 2 and a block model approximating TKC. A table
containing the uncertainties added to the data can be found here .

E3DMT Version 1
Let us now invert the ZTEM data using E3DMT version 1.
• Create E3DMT ver 1 inversion object
• Use edit options to set the inversion parameters
– Basic Tab:
∗ Select the ZTEM data
∗ Set mesh
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Fig. 59: Z-axis tipper measurements at 60 Hz. It is important to note that the ‘X’ in TZXR data refers to the Northing
direction! ‘R’ refers to real component and ‘I’ refers to imaginary component.
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∗ Set topography to active cells model
∗ No background susceptibility
∗ 1D conductivity of 0.001 S/m
∗ Use Iterative solver unless you have sufficient RAM to use Direct solver.
– Model Options Tab:
∗ Set Beta cooling schedule to ‘custom by clicking button’. Use beta max = 0.8, beta
min = 1e-8 and reduction factor = 0.25
∗ Set Chi Factor = 0.5 since E3DMT version 1 uses a non-standard measure of data
misfit; see manual
∗ alpha S = 1e-10, alpha E = 1, alpha N = 1 and alpha Z = 2.56 (to recover smoothest
model and balance gradient terms based on cell dimensions)
∗ Set the active cells topo as the active model cells
∗ Set initial model as 0.001 S/m
∗ Set reference model as 0.001 S/m
∗ Set role in model objective function to SMOOTH_MOD_DIF
• Click Apply and write files
• Run the inversion
• Load results
• View convergence
The results of the inversion are shown below. We are unable to recover the moderately conductive overburden as ZTEM data are not sensitive to layered structures. Despite only inverting data at 2 frequencies, we
are generally able to recover the shape of the pipe. The maximum conductivity of the recovered structure
is notably higher than the true conductivity of the pipe.
The inversion reaches target misfit after 4 iterations. The model norm is discontinuous because the current
model is set to be the reference model for the next beta value. The recovered model is able to reproduce
the observed anomaly but underestimates its amplitude.

Fig. 60: Recovered model at iteration 4. EW cross-section (left), NS cross-section (centre), horizontal slice (right).
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Fig. 61: True model. EW cross-section (left), NS cross-section (centre), horizontal slice (right).

Fig. 62: Convergence curve shows that inversion reaches target misfit. The model norm is discontinuous because the
reference modeled is updated at each iteration.
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Fig. 63: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑇𝑧𝑥 at 60
Hz.
E3DMT Version 2
Let us now invert the ZTEM data using E3DMT version 2. Unlike version 1, version 2 requires that user
define the receiver which measure the fields.
• Click the impedance data object and set receivers from locations. Use the following values:
– Easting width = 2 m
– Northing width = 2 m
– Vertical width = 2 m
• Create E3DMT ver 2 inversion object
• Use edit options to set the inversion parameters
– Basic Tab:
∗ Select the impedance data
∗ Set mesh
∗ Set topography to active cells model
∗ No background susceptibility
∗ 1D conductivity of 0.001 S/m (which we inferred from apparent resistivity maps)
∗ Use Iterative solver unless you have sufficient RAM to use Direct solver.
– Model Options Tab:
∗ Set Beta cooling schedule to ‘custom by clicking button’. Use beta max = 0.8, beta
min = 1e-8 and reduction factor = 0.25
∗ Set Chi Factor = 1
∗ alpha S = 1e-10, alpha E = 1, alpha N = 1 and alpha Z = 2.56 (to recover smoothest
model and balance gradient terms based on cell dimensions)
∗ Set the active cells topo as the active model cells
∗ Set initial model as 0.001 S/m
∗ Set reference model as 0.001 S/m
∗ Set role in model objective function to SMOOTH_MOD_DIF
• Click Apply and write files
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• Run the inversion
• Load results
• View convergence
The results of the inversion are shown below. We are unable to recover the moderately conductive overburden as ZTEM data are not sensitive to layered structures. Despite only inverting data at 2 frequencies, we
are generally able to recover the shape of the pipe. The maximum conductivity of the recovered structure
is notably higher than the true conductivity of the pipe.
The inversion reaches target misfit after 4 iterations, but we have chosen to show the model at iteration
3 (chi factor of 1.005). The model norm is discontinuous because the current model is set to be the
reference model for the next beta value. The recovered model is able to reproduce the observed anomaly
but underestimates its amplitude.

Fig. 64: Recovered model at iteration 3. EW cross-section (left), NS cross-section (centre), horizontal slice (right).

Fig. 65: True model. EW cross-section (left), NS cross-section (centre), horizontal slice (right).
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Fig. 66: Convergence curve shows that inversion reaches target misfit. The model norm is discontinuous because the
reference modeled is updated at each iteration.

Fig. 67: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑇𝑧𝑥 at 60
Hz.

9.6. Natural Source Electromagnetics (MT and ZTEM)

555

GIFtoolsCookbook Documentation, Release 1.0

9.6.4 Joint MT/ZTEM Inversion
Here, we jointly invert synthetic MT and ZTEM data using E3DMT versions 1 and 2. When inverting
impedances and Tipper data, the E3DMT codes have a tendency to place conductive artifacts proximal to
the receivers. To overcome this obstacle, we demonstrate a basic approach for limiting artifacts through
the use of interface weights.
Important: The MT and ZTEM data are in GIF format; see GIF data conventions page. This means
the locations are Easting-Northing-Elevation. The data convention is defined X = Northing, Y = Easting
and Z = Down. Failure to recognize this will cause incorrect interpretation of the data. To get addition
background information on the coordinate systems used by the E3DMT codes, see the theory sections of
the version 1 and version 2 manuals.

Setup for the Exercise
If you have completed the tutorial “Importing, Interpreting and Preparing NSEM Data”:
• Open your pre-existing GIFtools project
• Set the working directory (if you would like to change it)
If you have NOT completed the previous tutorial and would like to start here, complete the following
steps:
• Download the demo
• Open GIFtools
• Set the working directory
• Import the observed data in E3DMT version 1 format. The MT data file (MTdata_v1.obs) and the
ZTEM data file (ZTEMdata_v1.obs) are found in the assets sub-folder. MT data are in units V/A
and ZTEM data are unitless.
• Load OcTree mesh. Load the one found in the folder assets/octree_model_ztem.
• Load active cells model. Load the one found in the folder assets/octree_model_ztem.
• Load true model. Load the one found in the folder assets/octree_model_ztem.
Pro tip: To avoid confusion between location and data coordinate systems, use the set data headers tool
to define location columns as Easting, Northing and Elevation.
Important: Data were generated using E3DMT version 2 and a block model approximating TKC. Uncertainties of 0.0025 ± 5% were added to all impedance tensor measurements. A table containing the
uncertainties added to the ZTEM data can be found here .
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Fig. 68: Real (left) and imaginary (right) components of impedance tensor element 𝑍𝑥𝑦 at 60 Hz in V/A. Data shows
that 𝑍𝑥𝑦 lies in the lower-righthand quadrant of the complext plane. This is consistent with the desired format in
GIFtools.

Fig. 69: Impedence data converted to apparent resistivities for 𝑍𝑥𝑦 at frequencies 60 Hz (left), 360 Hz (middle) and
1500 Hz (right). Apparent resistivity data shows the anomaly as being cause by a conductor.
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Fig. 70: Z-axis tipper measurements at 60 Hz. It is important to note that the ‘X’ in TZXR data refers to the Northing
direction! ‘R’ refers to real component and ‘I’ refers to imaginary component.
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E3DMT Version 1
Let us now invert the MT and ZTEM data using E3DMT version 1.
• Create E3DMT ver 1 inversion object
• Use edit options to set the inversion parameters
– Basic Tab:
∗ Hold ctrl and select the MT and ZTEM data
∗ Set mesh
∗ Set topography to active cells model
∗ No background susceptibility
∗ 1D conductivity of 0.001 S/m
∗ Use Iterative solver unless you have sufficient RAM to use Direct solver.
– Model Options Tab:
∗ Set Beta cooling schedule to ‘custom by clicking button’. Use beta max = 0.8, beta
min = 1e-8 and reduction factor = 0.25
∗ Set Chi Factor = 0.5 since E3DMT version 1 uses a non-standard measure of data
misfit; see manual
∗ alpha S = 1e-10, alpha E = 1, alpha N = 1 and alpha Z = 2.56 (to recover smoothest
model and balance gradient terms based on cell dimensions)
∗ Set the active cells topo as the active model cells
∗ Set initial model as 0.001 S/m
∗ Set reference model as 0.001 S/m
∗ Set role in model objective function to SMOOTH_MOD_DIF
• Click Apply and write files
• Run the inversion
• Load results
• View convergence
The results of the inversion are shown below. We are able to recover the moderately conductive overburden from MT information as well as the conductive pipe from both the MT and ZTEM. The maximum
conductivity of the recovered structure is notably higher than the true conductivity of the pipe.
The inversion reaches target misfit after 4 iterations but we have chosen the model recovered at iteration
3 (chi factor = 0.58). The model norm is discontinuous because the current model is set to be the reference model for the next beta value. The recovered model is able to reproduce the observed anomaly but
underestimates its amplitude. Misfit maps show that we are fitting both datasets relatively evenly.
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Fig. 71: Recovered model at iteration 3. EW cross-section (left), NS cross-section (centre), horizontal slice (right).

Fig. 72: True model. EW cross-section (left), NS cross-section (centre), horizontal slice (right).
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Fig. 73: Convergence curve shows that inversion reaches target misfit. The model norm is discontinuous because the
reference modeled is updated at each iteration.

Fig. 74: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑍𝑥𝑦 at 60
Hz.
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Fig. 75: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑇𝑧𝑥 at 60
Hz.
E3DMT Version 2
Let us now invert the ZTEM data using E3DMT version 2. Unlike version 1, version 2 requires that user
define the receiver which measure the fields.
• Click the impedance data object and set receivers from locations. Use the following values:
– Easting width = 2 m
– Northing width = 2 m
– Vertical width = 2 m
• Create E3DMT ver 2 inversion object
• Use edit options to set the inversion parameters
– Basic Tab:
∗ Hold ctrl and select the MT and ZTEM data
∗ Set mesh
∗ Set topography to active cells model
∗ No background susceptibility
∗ 1D conductivity of 0.001 S/m (which we inferred from apparent resistivity maps)
∗ Use Iterative solver unless you have sufficient RAM to use Direct solver.
– Model Options Tab:
∗ Set Beta cooling schedule to ‘custom by clicking button’. Use beta max = 0.8, beta
min = 1e-8 and reduction factor = 0.25
∗ Set Chi Factor = 1
∗ alpha S = 1e-10, alpha E = 1, alpha N = 1 and alpha Z = 2.56 (to recover smoothest
model and balance gradient terms based on cell dimensions)
∗ Set the active cells topo as the active model cells
∗ Set initial model as 0.001 S/m
∗ Set reference model as 0.001 S/m
∗ Set role in model objective function to SMOOTH_MOD_DIF
• Click Apply and write files
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• Run the inversion
• Load results
• View convergence
The results of the inversion are shown below. We are able to recover the moderately conductive overburden from MT information as well as the conductive pipe from both the MT and ZTEM. The maximum
conductivity of the recovered structure is notably higher than the true conductivity of the pipe. Despite
inverting for the smoothest model, the inversion need to place more sparse structures nearer to the Earth’s
surface to fit both the MT and ZTEM data. It is possible that our mesh is too coarse to recover a smooth
model that explains both datasets.
The inversion reaches target misfit after 6 iterations but we have chosen the model recovered at iteration
3 (chi factor = 1.06). The model norm is discontinuous because the current model is set to be the reference model for the next beta value. The recovered model is able to reproduce the observed anomaly but
underestimates its amplitude. Misfit maps show that we are fitting both datasets relatively evenly.

Fig. 76: Recovered model at iteration 3. EW cross-section (left), NS cross-section (centre), horizontal slice (right).

Fig. 77: True model. EW cross-section (left), NS cross-section (centre), horizontal slice (right).
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Fig. 78: Convergence curve shows that inversion reaches target misfit. The model norm is discontinuous because the
reference modeled is updated at each iteration.

Fig. 79: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑍𝑥𝑦 at 60
Hz.
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Fig. 80: Predicted data (left), observed data (centre) and normalized misfit (right) for the real component of 𝑇𝑧𝑥 at 60
Hz.
However, much of the functionality provided within GIFtools is applicable to multiple methods (e.g. adding geological
constraints to inversions).
Tip: To alter a step in any of the tutorials (e.g. use an OcTree mesh instead of a tensor mesh), search the recipes
section or try the search bar.

A to Z: Synthetic TKC
For consistency, A to Z examples for each geophysical method consider the same geological model; the Tli Kwi Cho (TKC) kimberlite
complex in NWT, Canada. The UBC-GIF Team has worked extensively on the TKC area. For background about the deposits, the geophysical surveys, and the outcome (including a combined petrophysical model), see the Case History on EM Geosci.
The TKC kimberlite complex has been surveyed with a variety of
systems (see here) and drilled extensively. As a result, we have a
very good understanding of the geological units which make up the
deposit, their margins and their physical properties. The average density, susceptibility and electrical conductivity for geological units at
TKC is shown in the table below.

Fig. 81: 7-step process applied to TKC kimberlite complex

9.6. Natural Source Electromagnetics (MT and ZTEM)
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Unit
Granitic
Host
XVK/DO18
Kimberlite/HK
HK/DO-27
VK/DO-27
PK/DO-27
Till

𝜌
[g/cc]
0

𝜅
[SI]
0

-0.24

Remanence
x

𝜎
[mS/m]
x

𝜂
[ms]
x

0.002 x

x

x

-0.24

0

x

x

x

-0.24
-0.24
-0.24
0

0.006
0.003
0.003
0

x
x
x
x

x
x
x
x

x
x
x
x

• PK: pyroclastic kimberlite
• HK: hypabyssal kimberlite
• VK: volcaniclastic kimberlite
• XVK: xenocryst-rich volcaniclastic kimberlite
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TEN

COMPREHENSIVE WORKFLOWS

This section of the GIFtools cookbook is meant to provide practical tutorials for inverting field-collected data. Generally, the user will start with topography and geophysical data in a standard format. The ultimate goal is to invert the
field collected data and recover a model that can be used for interpretation. Successful inversion of geophysical data
using the UBC-GIF framework requires:
• Understanding geophysical anomalies produced by basic structures
• Importing geophysical data and topography into GIFtools
• Transforming data from other conventions to the UBC-GIF convention
• Basic interpretation of the data
• Assigning appropriate uncertainties
• Designing an appropriate mesh
• Inverting the data with reasonable parameters
• Assessment and interpretation of inversion results
List of Comprehensive Workflows:

10.1 Comprehensive Workflows: TMI Magnetics
Author: Devin C. Cowan
Published: February, 2022
Requires GIFtools v3.0 or later
Here, we present a general workflow for loading, interpreting, processing and inverting total magnetic intensity (TMI)
magnetic data. We begin with TMI data in a basic XYZ format. Our goal is to process and invert the TMI data to
recover a 3D magnetic susceptibility model for a local survey area. For this tutorial, we have both local and regional
datasets; the later of which can be used to constrain the local-scale inversion if available. You may work with the
tutorial datasets provided or use your own data:
• Download the tutorial data
We would like to thank Glencore , and especially Daryl Ball, for providing the local survey data used to create this
comprehensive workflow. The regional-scale data were queried from the Natural Resources Canada Geoscience Data
Repository for Geophysical Data .
Tutorial Sections
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Fig. 1: Regional and local TMI anomaly data (above). Local susceptibility models recovered with inversion using
various norms (bottom).

10.1.1 Understanding TMI Anomalies
TMI stands for total magnetic intensity. In order to properly interpret and invert TMI data, it is important to first understand what is being measured by the sensor and the characteristic anomalies produced by basic magnetized structures.
Here, we define TMI data and describe the magnetic anomalies produced by a compact magnetized block within a
homogeneously magnetized host.
Defining TMI Anomaly Data
Let B represent the total magnetic field at some point in space. We can decompose this quantity into two parts:
B = B0 + Ba
where B0 represents the background field and Ba represents the anomalous field. The background field is generally
defined according to the international geomagnetic reference field or a set of time-dependent base station measurements.
The anomalous field represents the fields produced by local magnetized structures of interest.
During a TMI survey, a sensor is used to measure the amplitude of the total magnetic field at each survey location. I.e.:
|B| = |B0 + Ba |
We do not know the exact direction of the anomalous contribution Ba . However, we assume that anomalous fields
are much smaller than and mostly aligned with the Earth’s field; i.e. we assume components of the anomalous field
perpendicular to the Earth’s field are negligible. Under these assumptions, the TMI anomaly data can be obtained by
subtracting the amplitude of the background field from the total field measurements as follows:
^ 0 ≈ |B| − |B0 |
𝑑𝑡𝑚𝑖 = Ba · B
Therefore TMI anomaly data represent the projection of the anomalous field along the direction of the Earth’s
magnetic field.
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TMI Anomalies over a Susceptible Block
Here, we discuss the impact of the orientation of the Earth’s inducing field as well as remanent magnetization on TMI
anomalies. For this example, a block (0.25 SI) is located within a homogeneous background (0.01 SI). The horizontal
and vertical dimensions of the block are all 300 m, and the top of the block is at a depth of 100 m. The receivers are at
a constant height of 100 m and a horizontal spacing of 40 m is used.

Fig. 2: Susceptibility model in units SI (left). Observation locations and horizontal extent of target (right).

Anomalies for Different Inclination Angles
The GIF below demonstrates that different inclination angles for the Earth’s inducing field produce different TMI
anomalies. For this example, the declination was fixed at 0 degrees and the intensity was fixed at 55,000 nT. On the
leftmore figure, we see the shape of the TMI for the current inducing field orientation. And on the rightmost figure,
we see the TMI anomaly from South to North; the bold black line indicates the anomaly for the current inducing field
orientation, the dashes gray lines denote the anomalies for all other orientations.
From the GIF, we see that:
• the peak anomaly amplitude isn’t necessarily located directly over the target. This is only true for near-vertical
inducing fields (high latitudes)
• despite removing the IGRF (background field), the anomaly does not go to 0 away from the target. This is because
the host rock contributes to the anomaly; i.e. we have not removed regional effects.
• the peak amplitude is larger for more vertical inducing fields.
• the peak amplitude is negative for near-horizontal inducing fields (low latitudes)

Anomalies for Different Declination Angles
As shown below, different declination angles for the Earth’s inducing field produce different TMI anomalies. The
inclination was fixed at 60 degrees and the intensity was fixed at 55,000 nT. From the figures below we see that in the
case of purely induced magnetization, the TMI anomaly will align with the declination angle of the Earth’s inducing
field.
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Anomalies Including Remanent Magnetization
Here, we discuss the impact of remanent magnetization on the shape and amplitude of TMI anomalies. For all the
figures below, the Earth’s field had an inclination of 60 degrees, a declination of 0 degrees and a field intensity of
55,000 nT.
• The leftmost figure illustrates the TMI anomaly for purely induced magnetization (no remanence).
• In the middle figure, vertical remanent magnetization has been added to the block such that its magnitude is equal
that of the induced magnetization.
• In right-most figure, remanent magnetization in the x-direction has been added to the block such that its magnitude is equal that of the induced magnetization.
These figures show that significant remanent magnetization can impact the magnitude and location of the peak anomaly
as well the shape of the anomaly itself. When examining TMI anomaly data to infer the presence of remanent magnetization, there are some basic questions one can ask:
• Does the TMI anomaly produced by this structure line up with the declination angle of the Earth’s field?
• Plot the TMI profile over the target along the direction of the Earth’s declination angle. Does this plot have the
general shape you would expect if the magnetization were purely induced?
Please note that in practice, it can be very difficult to infer the presence of remanent magnetization directly by examining
observed TMI data; especially in complex geological environments. Remanent magnetization is commonly identified
by performing a reduction to pole or by examining the output of an inversion that assumes purely induced magnetization.
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Equivalent Source Methods
In the absence of strong demagnetizing fields, the anomalous magnetic field is defined as the solution to a Green’s
function. From Blakely (1995):
∫︁
1
𝜇0
∇∇
· M(rs ) 𝑑𝑣
Ba (r) =
4𝜋 𝑉
|r − rs |
Equivalent source methods are a result of Green’s third identity, which states: the potential field at any point within
region can be obtained from fields defined on a surface enclosing that region. No knowledge of the source is required.
To obtain the field at a particular location, we simply need a sufficient number of field measurements on a surface
enclosing that location.
In practice, we assume that our field collected data provides a sufficient characterization of the fields on our theoretical
enclosing surface. We then use geophysical inversion to recover a susceptibility model that fits our observed data
exactly; i.e. an ‘equivalent source’ model. With the equivalent source model, we can predict the data at different
locations and for different inducing field orientations.
Reduction to Pole
Reduction to pole is a method for using magnetic data collected at lower latitudes to compute the data if were collected
in the presence of a vertical inducing field. At high latitudes, the Earth’s inducing field is nearly vertical and TMI
anomalies are much easier to interpret. The locations of the targets are clear and dipolar anomalies can be used to infer
the presence of magnetic remanence.
Reduction to pole is carried out by first inverting to recover an equivalent source model. Next, the data are forward
modeled using the equivalent source model for an inducing field with an inclication of 90 degress. For TMI magnetic
data collected over a set of UXOs at low latitude, the results of a reduction to pole are shown below.

10.1. Comprehensive Workflows: TMI Magnetics
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Upward Continuation
Field collected data (especially at the surface) may have short wavelength (high spatial frequency) signals or noise that
are not produced by targets of interest; making interpretation difficult. Furthermore, finer mesh cells are required for
geophysical inversion to accurately characterize these higher frequency signals. Upward continuation is a method for
removing erroneous short wavelength signals from the data by computing the data as if it were collected at a higher
elevation.
Equivalent source models can be used to upward continue field collected data. The steps are as follows:
1) Estimate the background signal; i.e. the very long wavelength signals attributed to regional or larger scale structures that cannot be fully captured in the observed data. The background signal is generally estimated by a
constant value or by fitting the background TMI data with a low order polynomial.
2) Subtract the background signal from the observed data.
3) Invert the background removed data to obtain an equivalent source model
4) Use the equivalent source model to predict the data at a higher elevation (using the same inducing field)
5) (Optional) Add the background signal back to the data. This is only required independently collected datasets
(e.g. local and regional) must be levelled.
For data collect at a height of 1 m, we demonstrate upward continuation for a block within a halfspace that also contains
an unknown broad regional structure. The data map indicates this regional feature produces a roughly 1000 nT anomaly
within our survey area. 1000 nT is subtracted from the data before upward continuing, then re-added as a final step.
For a profile along the Northing direction, we plot the true TMI data (lines) that would be measured at different heights
as well as data that were upward continued (dots).

Why the removal of the background signal is crucial:
• The equivalent source model tends to place larger amplitude structures in the padding cells if the background
signal is not first removed from the data. The effect of these structures increases the more the data are upward
continued.
• The signal produced by a large deep regional structure and a thin horizontal layer do not decay identically as a
function of elevation. If one does not remove the background signal prior to upward continuing, the amplitude
of the upward continued regional signal will be underestimated (see below.)

572

Chapter 10. Comprehensive Workflows

GIFtoolsCookbook Documentation, Release 1.0

10.1.2 Loading TMI Data and Cursory Interpretation
The first step in any project is to load field collected data and visualize it. Here, we load TMI data, assign and remove
the background magnetic field, and visualize the TMI anomaly data.
The regional tutorial data acquired from the Natural Resources Canada database have been significantly processed to
create a composite dataset. These are TMI anomaly data with a uniform spacing of 200 m in the Easting and Northing
direction, and a constant flight height of 305 m. The TMI anomaly data are also defined for a uniform inducing field for
a given date. Regional data are not required to complete this exercise. However, they can be used to better understand
regional-scale magnetic anomalies and constrain local inversion results.
The local tutorial data were collected on the Earth’s surface on the back of a Skidoo. The original TMI data were
collected along many North-South lines with an average line spacing was 50 m; although this spacing is not uniform
throughout the local survey area. To view the TMI anomaly, we will need to remove the Earth’s inducing field from
the original TMI data.
Important: Requires GIFtools v3.0 or later.

Starting Your Project
• Open GIFtools
• Set the working directory
Import Files
Important: If you are working with your own dataset and you do cannot acquire regional scale data, you can still
complete this tutorial; although you will not be able to implement certain techniques.
Here, we import the TMI and topography datasets. Local and regional tutorial data are in a general XYZ format but
the same functionality is available for CSV or UBC-GIF formatted data. To import the TMI data and topography:
• Import local and regional topography data (XYZ format).
topo_regional.xyz.
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• Import local and regional TMI magnetic data (XYZ format).
mag_regional.xyz.

These files are called mag_local.xyz and

Defining Earth’s Inducing Field
Note: If the data file is UBC-GIF format, the file contains the properties for defining the Earth’s field. And these
properties are automatically assigned upon loading the data file.
In this step, we define the inclination, declination and intensity of the Earth’s magnetic field for any magnetic data
object. There are several ways to obtain this information:
• From the field report or commented lines in a data file
• From data columns in the survey file defining the inclination, declination and field intensity for each survey point.
• From the historical international geomagnetic reference field .
For UBC-GIF codes, we generally assume the Earth’s inducing field does not vary significantly within the survey region.
That is, the induced magnetization computed in every cell are all parallel to one another. To assign the inclination,
declination and intensity:
• If inclination, declination and intensity columns are provided, use view statistics and determine their average
values.
• Assign the field parameters
The regional tutorial data provided by NRCan were processed such that they corresponded to a survey carried out
June 5th, 2020. The dataset also assumes a constant flight height of 305 m (elevation ~900 m based on local topography
of ~600 m). Using historical IGRF data from the National Centers for Environmental Information , we obtained the
following properties for the Earth’s field at the regional scale:
• intensity = 57363 nT
• inclination = 80.24 deg
• declination = -22.35 deg
For the local tutorial data, we were provided with inclination, declination and field intensity columns. Using view
statistics and taking the mean values, we obtained:
• intensity = 58266 nT
• inclination = 81.26 deg
• declination = -28.44 deg
Note: During the time between the collection of the local and regional datasets, the Earth’s field may have change
significantly. The impact this has on necessary processing steps is discussed later in the tutorial.
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Removing the Background Field
The background field may be defined using base station measurements (which contain regional signals) or as the Earth’s
inducing field (which does not). We must remove the background field from the total field measurements in order to
obtain the TMI anomaly data. There are two ways in which this can be done using GIFtools:
• If the background field (base station or IGRF) is provided in a column, the column calculator can be used to
subtract the background field from the total field.
• Or use remove IGRF to subtract the inducing field defined in the previous step of the tutorial.
For the regional tutorial data, this step was not necessary since the data are already TMI anomaly. However you may
choose to rename the data column B_anomaly to be consistent.
For the local tutorial data, we subtracted the Earth’s field from the total field using the column calculator. You maybe
choose to call the new data column B_anomaly. Note that regional and local information are contained within the
resulting data column because only the Earth’s field was removed.
Cursory Interpretation
• To view the data, you may select any data object and plot with VTK
Regional tutorial data:
The topography, TMI anomaly data and spatial coverage of the regional-scale data are plotted below. The background
values for the regional data are clearly negative, indicating we are in the ‘low’ produced by an extremely large-scale
feature. Using a red outline, we have marked the data coverage of the local survey area. The local TMI anomaly data
are part of a set of WSW to ENE trending features.
Regional data are used to characterize regional features that impact the TMI anomaly data observed within a local
survey site. To allow for better characterization of relevant regional anomalies, we have chosen to crop the regional
dataset (outlined in yellow). In order words, we are removing regional TMI anomalies we feel do not impact the TMI
anomalies observed within the local survey area.
To crop the regionall data:
• Plot with VTK data viewer
• Click the ‘Edit’ tab, click a selection method and select the set of data you wish to keep
• Click the ‘Simple Edit’ tab. Select ‘Data not highlighted’ and ‘Delete locations’. The provide a name for the new
data object that is created when you click ‘Apply’.
Local tutorial data:
The local topography and TMI anomaly data are shown below. The topography ranges from an elevation of 540 m to
670 m. The local tutorial data were collected at the surface. Some extremely high amplitude signals were measured
and the range of the color scale needed to be fixed between -2000 nT and 10000 nT to outline the anomaly. The main
TMI anomaly appears to be trending from WSW to ENE; consistent with regional features.
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Fig. 3: Regional topography (left) and TMI anomaly (right). Red outline denotes the local survey region. Yellow
outline denotes cropping of regional data.
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Downsampling the Data
The along-line sampling rate for both surface and airborne surveys is generally higher than is necessary to accurately
characterize target anomalies. Furthermore, 3D potential field inversions cannot fit the data if multiple data points lie
above a single cell; implying you may consider some aspects of mesh design during this step. Here, we downsample
the local magnetic data based on a desired minimum spacing.
• Downsample by distance
For the local tutorial data, we downsampled to a minimum spacing of 25 m. This is roughly equal to half the average
line spacing for the local magnetic survey. This reduced the total number of data points from 101,679 to 11,192.
Downsampling to 25 m was able to greatly reduce the number of data without filtering out coherent higher frequency
signals we are attributing to magnetized structures.
The regional tutorial data has already been gridded to a spacing of 200 m and does not need to be downsampled.

10.1.3 Equivalent Source Inversion
Here, we provide the steps for performing an equivalent source inversion within the GIFtools framework. Equivalent
source inversion is a method for recovering an equivalent source model from potential field data. An equivalent source
model represents a source distribution that fits the observed data exactly, and can be used to compute the expected
potential field(s) for other locations/field orientations. In magnetics, equivalent source models are used to:
• compute the TMI anomaly data for a vertical inducing field (reduction to pole)
• compute the TMI anomaly data at higher elevations (upward continuation)
Regarding the tutorial data, we recover an equivalent source model for the local surface-collected TMI anomaly
data. In the following tutorial section, this model is used to upward continue the data in order to remove problematic
high-frequency signals. For the regional magnetic data, we will not need to carry out an equivalent source inversion.
A reduction to pole is also not necessary, as the Earth’s inducing field is fairly vertical (~80 degrees inclination).
Background Signal Removal
As discussed in the understanding anomalies section, equivalent source models are not able to accurately characterize
very long wavelength signals (i.e. the background signal). To recover an equivalent source model that accurately
characterizes local-scale anomalies, we must first remove the background signal from the local TMI anomaly data. In
the case of upward continuation, this signal can be added back afterwards so long as the inducing field remains roughly
the same. We begin by:
• plotting the data with VTK
From here, there are several approaches you can take to determine the background signal from the TMI anomaly data
column:
• Option 1: Examine the values away from any obvious anomalies on the standard data map. Pro tip: Click the
‘Plot Contours’ tab. Set background colour to black and axes and labels to white. This will allow you to hover
the cursor over data points and see the values in the bottom-left corner of the data map
• Option 2: Click the ‘Profiler’ tab. Here you can plot the anomaly values along a user-defined path
• Option 3: fit a polynomial to a set of selected points. A detailed description of this can be found in the polynomial
detrending section of the tutorial.
Once you have determine the background contribution, subtract it from the original TMI anomaly data and define a
new column (B_anomaly_shifted) using the column calculator.
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For the local tutorial data, we felt a constant value of -375 nT adequately characterized the background signal. Therefore 375 nT were added to the original data column to create a column we call B_anomaly_shifted. These ‘shifted’ data
are inverted to recover the equivalent source model.

Fig. 4: Original local TMI anomaly data scaled between -1000 nT and 1500 nT (left). Profile oriented along the
declination angle (right).

Generating a Mesh and Defining Active Cells
Here, we define the mesh and the cells on which our local equivalent source model will live. In this case, our equivalent
source model will consist of several layers of cells which follow the local topography. We are not trying to recover
realistic structures from the data. We are simply recovering a model which fits the data exactly.
Generate a mesh:
• Create 3D mesh under the ‘Create’ drop-down menu
• Cell size: set the cell size for the core mesh cells. Cell dimensions CANNOT be larger than the minimum horizontal spacing between data points. A cells size that is 0.5-0.8 times the minimum horizontal spacing generally
works.
• Horizontal Extent: under ‘Choose Object’, select the local magnetic data object then click ‘calculate limits’.
This defines your core mesh region
• Vertical Extent: Add a thickness equal to 2-4 layers of cells
• Padding Parameters: Do not pad in the vertical direction. Pad out sufficiently in the horizontal. Larger padding
thicknesses are required if you are upward continuing significantly.
Define active cells layer:
• Select the newly created mesh and create active cells from topography
• Choose the associate topography object
• Use the ‘tops of cells’ option to define the cells lying below the surface
• Click the ‘create active cells layer’ box and set the depth below the surface to which you want cells to be active
in the equivalent source inversion.
For the local tutorial data, the following properties were used to create the mesh. When creating the active cells
model, we set the depth to 80 m. Given a vertical cell size of 20 m, we are creating a layer of cells that is 4 cells thick.
The final mesh size using local tutorial data was 733,410 cells. However the number of active cells was 293,163.
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Applying Uncertainties
The uncertainties used for equivalent source inversion are not the uncertainties that will be used to recover our final
susceptibility model. Here, we apply a set of ad hoc uncertainties. For example, a floor uncertainty of 1 nT can be
applied to all data. These uncertainties are almost certainly are not representative of the true level of uncertainty on the
data, but this is okay.
We do not want an equivalent source model that overfits the background at the expense of fitting magnetic anomalies.
As a result, we do not advise assigning percent uncertainties to the data. Furthermore, we may select certain regions
and assign a lowever floor uncertainty; ensuring we fit the data in these regions sufficiently.
For the local tutorial data, we defined the uncertainties as follows:
• We assigned a floor uncertainty of 1 nT to all data using assign uncertainties
• At locations in the region of our target anomaly, we replaced the uncertainties with a floor value of 0.25 nT. This
was done by:
– Plotting the data with VTK
– Setting the anomaly data to be our currently viewed data
– Clicking the ‘Edit’ tab and selecting the points we want changed
– Going back to othe ‘View’ tab and setting the currently viewed data to be the uncertainties (VERY IMPORTANT!!!)
– Clicking the ‘Edit’ tab followed by the ‘Simple Edit’ tab.
– You can now choose to modify the currently selected data. We chose to replace the selected data with 0.25
nT
Important: Whatever data are currently being plotted will be modified. If you do not switch from anomaly data to
uncertainties under the ‘View’ tab before replacing values, you will be replacing data values in the wrong column!!!

Important: If you have not already done this, use set i/o headers to set the X, Y, Z, data and uncertainty columns.
Recall that you want to invert the SHIFTED anomaly data.
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Setting Up and Running the Inversion
We can now perform the local equivalent source inversion on the shifted TMI anomaly data.
• Create a MAG3D v6.0 inversion object
• Use edit options to set the inversion parameters
• Click Apply and write files
• Run weights
• Run sensitivities
• Run inversion
• Load final result
For the local tutorial data, the following inversion parameters were used.

Discussion of Inversion Parameters
Note: The parameters chosen for inversion of the tutorial data were experimentally derived. The numbers used here
worked well for inverting this dataset but should not necessary be used as general default values!
Regarding sensitivity weighting:
For equivalent source inversion, there is no need to apply the sensitivity weighting typically used in potential field
inversion. In fact, it is easier for the inversion to fit the data with a layer if sensitivity weighting is NOT applied. To
accomplish this, we do not use the default weighting. We set the Exponent to equal 0 and the contant R0 to be some
positive contant. By doing this, all of the weights in our weights model will be equal to 1.
Regarding chi factor:
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The goal of the of the equivalent source inversion is to recover a model that fits the data as well as possible. To
accomplish this, we set the target chi factor to something much smaller than 1 (e.g. 0.01 in this case).
Regarding the alpha parameters:
As we learned in the upward continuation section of understanding anomalies, structures recovered in the padding cells
impact upward continued data at greater elevations. Our approach was not to enforce any assumptions on the values
in the padding cells by setting 𝛼𝑠 = 1e-8 (something very small). This is known as recovering the ‘smoothest model’;
a model which does not depend on the reference model. Ideally, any very-long period signals that weren’t completely
removed prior to inversion will be accounted for by smooth features that continue into the padding.
Regarding the starting model:
A starting model of 0.0001 SI was chosen. This is done because a starting model of 0 SI will not produce a step direction
for updating the model at the first iteration. Thus in practice, we assign something small whenever our reference model
is equal to 0.
Regarding active cells:
Don’t forget to use your active layer cells model to set the active cells in the inversion.
Regarding the bounds:
For equivalent source inversion, we simply need a model that fits the data as well as possible. No constraints are
required for the positivity or magnitude of the recovered ‘susceptibilities’. By setting the bounds to [-9999, 9999] we
are essentially solving an unbounded inverse problem.
Analyzing Outputs
Convergence
As a first step, examine the convergence curve. We want to be sure that our equivalent source model globally fits the
data to the desired chi factor. If the inversion does not reach the target data misfit:
• Your cell size is too large
• You set extremely small uncertainties or an extremely small chi factor for the target misfit.
For the local tutorial data, we set a chi factor of 0.01. Given that we inverted 11,192 data, the corresponding target
data misfit is ~112. The figure below shows the convergence of the equivalent source inversion for the local tutorial
data. Our inversion reaches the target data misfit for the chi factor assigned.
• View convergence
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Data Misfit
Here, we ensure that predicted data from the equivalent source model accurately reproduces the observed anomaly.
The predicted data object can be used to examine the observed data, predicted data, misfit and normalized misfit.
For the tutorial data, the anomaly is fit to the same degree as the background; i.e. we are not overfitting the background.
Some locations appear to have much higher frequency signals that weren’t quite fit with the equivalent source model.
But the misfit is still very small and this is not concerning.

Recovered Model
For the local tutorial data, the equivalent source model is shown below. The values have been scaled between -1 and
1. We can see the features of the observed anomaly in the recovered model. And smooth background features continue
into the padding.

Fig. 5: Local equivalent source model
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10.1.4 Upward Continuation and Reduction to Pole
Here, we show how equivalent source models can be used to compute the expected TMI anomalies for other locations/field orientations. Some examples include:
• computing the TMI anomaly data for a vertical inducing field (reduction to pole)
• computing the TMI anomaly data at a higher elevation (upward continuation). Also, at the elevation corresponding to a regional dataset.
• computing amplitude data from TMI anomaly data
For the local tutorial data, an equivalent source model recovered in the previous section. Here, we upward continue
the local data to in order to remove problematic high-frequency signals. For the regional data, we will not need to carry
out an equivalent source inversion.
Gridding (Optional)
Survey lines are not perfectly straight and station spacings not necessarily uniform. If desired, the user can upward
continue or perform the reduction to pole such that the result is defined on a set of uniformly gridded points. Some
things to keep in mind are:
• you cannot use this gridding technique to interpolate to a finer horizontal spacing. The smallest wavelength
signal contained in the data is limited by the station and line spacing of the survey. So when creating the set of
gridded points, the same line spacing and station spacing must be used.
• you cannot use this gridding technique to ‘fill in’ regions where you do not have data coverage.
• in general, we do not invert gridded data, unless they have been sufficiently upward continued. When in doubt,
preserve the original horizontal locations when upward continuing.
To create a gridded survey object for upward continuation or reduction to pole:
• Use the create magnetic survey utility to define a gridded survey at the desired height above the surface topography
• Use assign the field parameters to define the desired inducing field (e.g. vertical for reduction to pole)
For the local tutorial data: the minimum line spacing for the original TMI anomaly data was 50 m. And prior to
equivalent source inversion, the local TMI anomaly data were downsampled to have a minimum spacing of 25 m. As a
result, a uniform grid with a line spacing of 50 m and a station spacing of 25 m was created. The bearing for the survey
lines was 0 degrees (Northing). The origin, line length and number of survey lines were determined by the orignal
magnetic data object. We aren’t sure what the ideal height for upward continuation was, so we created gridded data
objects at several heights (50 m, 100 m and 305 m above surface topography).
Important: In order to compare and level the local and regional TMI anomaly data, we are upward continuing the
local data using the regional data’s inducing field. We are also upward continuing to the same height (305 m).
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Upward Continuation/Reduction to Pole
Note: If you want to preserve the horizontal locations (no gridding), simply make a copy of the original data object
and alter the elevation column and/or inducing field.
To carry out the upward continuation or reduction to pole:
• Create forward modeling object
• Use edit options to define the following properties
– The mesh and equivalent source model
– The survey
– The lower bound is left blank!!!
• Write the files
• Run the forward model
• Load the results when complete
• For upward continuation, remember to remove the DC shift from any predicted data. We call this column
B_anomaly_unshifted.
Note: If you have regional data, you will need to upward continue the local data to 1) a desired flight height for
local-scale inversion, and 2) the height at which the regional data were collected.
For the local tutorial data, upward continued TMI anomaly data at flight heights of 50 m, 100 m and 305 m are shown
below BEFORE the removal of the 375 nT shift. As expected the TMI anomaly is broader, smoother and has lower
peak amplitude at higher elevations. Upward continued data to an elevation of 50 m may still contain some higher
frequency signals that aren’t fully characterized with the current line/station spacing. So moving forward, we plan to
use data upward continued to 100 m in our local scale inversion.

Fig. 6: Local TMI anomaly data upward continued to gridded locations at 50 m, 100 m and 305 m above the Earth’s
surface. Note that the data in these plots have NOT been unshifted.
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10.1.5 Polynomial Detrending and Levelling
Polynomial detrending is used to remove the background signal (i.e. very long wavelength signals) from the data in
order to more accurately characterize local magnetic anomalies; see the image below. Failure to remove the background
signal from magnetic data prior to inversion can result in artifacts and structures which mischaracterize local anomalies.
Levelling is sometimes required when you have both local and regional scale data collected during different surveys.
Here, the levelling is a DC shift that is added to one of the datasets, so that the background values for both datasets are
comparable in the same region.
Depending on the data you have available, there are two cases:
• Case 1: You only have local data (no regional data). In this case, polynomial detrending is applied directly to
the local data prior to inversion. Here, we assume that contributions from regional and/or nearby structures can
be approximated by a low-order polynomial and removed.
• Case 2: You have both local and regional scale data. Polynomial detrending is applied to the regional data only.
Levelling between local and region datasets is applied if needed. And the detrended regional data is used later
to remove regional trends (the background signal) from the local dataset prior to inversion.
Detrending: General Approach
The general approach for polynomial detrending is to select the set of data points which are part of the ‘background’;
i.e. away from any local-scale anomalies. Then to fit these data with a low-order polynomial. Within the GIFtools
framework, the steps are as follows:
1. Plot the data with VTK. Under ‘current data’, select the data column you wish to detrend.
2. Click the ‘Edit’ tab. Under ‘Data selection’, click one of the selection options and start to select data on the data
map. For the rectangular option, you can hold Ctrl and append multiple selections
3. Click the ‘Regional fit’. Here you can
• Fit the highlighted or not highlighted data
• Choose the order to the polynomial used to fit these points (usually 0th or 1st or polynomial)
• Provide the name for the output data column
4. Then click ‘OK’ to create the resulting data column with the polynomial defined at all survey locations.
5. Close the VTK plotting
6. Use column calculator to subtract the polynomial from the data
7. Reopen the VTK plotting to examine result. Results can be examined with data maps, or by examining individual
profiles (‘Profiler’ tab)
Important:
• Classifying data points as being part of the background or as being part of the anomalous signal is a subjective
process.
• Magnetic anomalies produce anomalous lows as well. These locations should not be classified as background!
• Even after polynomial detrending is applied, there may be background regions with negative data values that
cannot easily be fit with a strictly positive susceptibility model. In this case, you may detrend with a different
polynomial fit OR apply a small DC shift.
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Detrending and Levelling Tutorial Data
Regional Tutorial Data
For the regional magnetic data, a 1st order polynomial was used to fit the set of selected background points; creating
a column we call poly1. We were careful not to include any small scale anomalies or obvious lows. The polynomial
indicates a significant linear trend along the NNE direction. The 1st order polynomial was subtracted from the TMI
anomaly data to create a column called B_anomaly_detrended. A profile roughly along the same direction as the Earth’s
declination is shown below. The 1st order polynomial generally does a good job of detrending the data. However, we
noticed some background regions had coherent negative values. During a preliminary regional magnetic inversion, we
found it difficult for the data to be fit by a strictly positive susceptibility model. As a result, we applied a DC shift of
+30 nT to the regional data after detrending to create a column B_anomaly_detrended_shift30nT.

Fig. 7: Polynomial detrending applied to regional tutorial data.
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Local Tutorial Data
Consider the local TMI anomaly data that were upward continued to 100 m and then unshifted (background signal added
back); whose column we call B_anomaly_unshifted. For this exercise we are interested in comparing final inversion
results when regional data are available, and when they are not. To accomplish this we:
• used a 1st order polynomial to fit the background, then subtracted the polynomial data column to obtain a data
column we are calling B_anomaly_detrended. This data column will be inverted to recover a local susceptibility
model in the case where regional data are not available.
• applied a levelling constant of +380 nT to all upward continued and unshifted TMI anomaly data (i.e.
B_anomaly_unshifted) to produce a column we call B_anomaly_levelled. We will remove regional trends from
this data with the help of regional data prior to inverting.
We can see that locally, the change in the ‘background response’ is much smaller than the amplitude of the TMI
anomaly. Along the profile, B_anomaly_detrended and B_anomaly_levelled are more or less the same. Also note that
the regional 1st order polynomial trend and the local 1st order polynomial trend are not aligned along the same gradient;
implying the coarse regional background is not a good characterization of the background locally.

Fig. 8: Polynomial detrending applied to local tutorial data.
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10.1.6 Data Interpretation (including remanence)
At this point, upward continuation, reduction to pole and/or polynomial detrending methods have been applied in order
to better characterize target anomalies; both local and regional (if available). Prior to inversion, data maps and profiles
can be used to:
• roughly estimate the depth to structures based on anomaly half-width
• infer the presence of significant magnetic remanence
• estimate the minimum station spacing required to constrain target anomalies
• estimate data uncertainties from closely spaced along-line data
For the regional tutorial data, the detrended TMI anomaly column (B_anomaly_detrended) is most relevant for
interpretation. And for the local tutorial data, we may examine polynomial detrended (B_anomaly_detrended) or
levelled (B_anomaly_levelled) TMI anomaly data.
Anomaly Half-Width
More deply buried targets produce broader and
smoother magnetic anomalies. As a result, there is a
direct correlation between the depth to a magnetized
body and the anomaly it produces. Where ℎ is the
flight height and 𝑥1/2 is the width of the anomaly at
half its implitude, the depth to a magnetized body is
given by:
Dipole: 𝐷 ≈ 𝑥1/2 − ℎ
1
Pole: 𝐷 ≈ 𝑥1/2 − ℎ
2
Obviously the majority of targets are not magnetic
poles or dipoles. However magnetic dipoles are useful
for approximating the anomalies from compact bodies and magnetic poles are good for approximating the
anomalies from vertically buried pipe-like strucutres.
Using these simple relationships, one can roughly estimate the lower extent of the core mesh region and better understand the scale of the TMI anomalies observed within
the survey region. Beware that you can overestimate the depth of the anomaly if it is caused by a shallower and wider
structure.
For the regional tutorial data, the polynomial detrended TMI anomaly data are shown below; whose data column
we called B_anomaly_detrended. The half-width is crudely labeled for two distinct anomalies. For each anomaly, the
half-width is ~900 m. Given the flight height of the regional survey is assumed to be 305 m, the half-width formula for
a magnetic dipole suggests a burial depth of ~600 m.
For the local tutorial data, the half-width for the polynomial detrended TMI anomaly data was ~600 m for data upward
continued to 100 m above the surface. Using this data, the burial depth assuming a magnetic dipole is ~500 m.
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Fig. 9: Regional TMI anomaly data that has been detrended with a 1st order polynomial.
Remanence
In the remanence portion of the understanding anomalies section, we learned that:
• purely induced magnetization produces TMI anomalies that are oriented along the direction of the Earth’s declination angle.
• observed TMI anomalies that differ significantly from the expected anomalies produced by strictly induced magnetization are likely contaminated with remanent magnetization.
So one way to infer remanence is to compare the observed data to the expected anomaly for purely induced magnetization.
Regarding the local tutorial data: the inducing field is practically vertical (inclination of 80.35 degrees), thus we
generally don’t expect large negative regions on either side of a large positive anomaly; especially for data collected at
sufficient height. The data map for levelled TMI anomaly data (B_anomaly_levelled) showed a significant ‘low’ region
to the northwest of the target and a smaller ‘low’ region to the southeast. With complex geologies, it is possible these
anomalies are produced strictly by induced magnetization; as the anomaly roughly aligns with the declination angle.
At this juncture, we cannot confidently infer magnetic remanence.

Fig. 10: Levelled local TMI anomaly data at 100 m flight height.
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10.1.7 Uncertainties
Here, we provide a basic approach for assigning uncertainties to TMI anomaly data. Uncertainties and data misfit as
they relate to geophysical inversion is presented in the fundamentals of inversion.
General Approach
Note: When the inversion is complete, we will be able to assess whether the estimated uncertainties on our data were
appropriate. If not, the inversion will need to be re-run with a new set of uncertainties.

Percent vs. Floor Uncertainty
Uncertainties assigned to magnetic data should generally be defined using floor uncertainties. This floor value
may be obtained from information about the sensor, or from the standard deviation of a localized cluster of background
data points (before any downsampling); which may be as little as 1 nT. If a percent uncertainty is included, much larger
uncertainties are applied to large anomalous values; i.e. the data characterizing the target anomaly. And the recovered
model will likely underfit the amplitude of the observed anomaly and overfit the background.
In the presence of more compact large amplitude anomalies, it may be difficult for the inversion to converge to the
target misfit if basic floor uncertainties are assigned. In this case, a floor value equal to some small percent of the largest
observed anomaly value can be assigned. A reasonable estimate is 0.25%-2% the size of the largest observed anomaly
value.
Below, we show the normalized misfit maps resulting from the inversion of synthetic TMI anomaly data for 2 different
sets of uncertainties. On the left, a uniform floor uncertainty was assigned to the data. We can see there are no
coherent artifacts in the normalized misfit map, indicating the anomaly and background are fit equally. On the right,
the uncertainties consisted of a floor and a percent. The coherent artifact in the misfit map shows that the anomaly is
underfit relative to the background.
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Fitting Anomalies Better
When a uniform floor uncertainty is applied to the data, it is still possible for the recovered model to overfit the background and underfit anomalies. This generally occurs when the reference model is a good characterization of the
background. In other words, the background is already well-fit by the reference model and we do not need to fit the
anomaly very well in order for the inversion to reach the target misfit. To remedy this, we sometimes select regions
of the data in close proximity to magnetic anomalies and apply a lower floor uncertainty to these regions. Something
between 0.1 - 0.5 times the background floor uncertainty usually works.
Uncertainties Assigned to Tutorial Data
For the regional tutorial data, we looked at the the largest observed TMI anomaly value after the data were detrended
using a 1st order polynomial (B_anomaly_detrended). The largest value was ~1800 nT. We assumed that globally, the
level of uncertainty was roughly 0.5% the largest anomaly value (or about 9 nT). Preliminary inversion attempts using
a simple floor uncertainty recovered models which underfit the observed anomalies. To remedy this, a background
uncertainty of 12 nT was assigned to the background region, a floor uncertainty of 6 nT was assigned to the region
containing the magnetic anomalies, and a floor uncertainty of 3 nT was assigned to all anomalous values above 300 nT.
We found the 3 nT uncertainty was necessary to fit the largest observed anomaly values.

Fig. 11: Regional detrended TMI anomaly data (left). Uncertainties used for regional magnetic inversion (right)
For the local tutorial data, we plan on inverting TMI anomaly data for a flight height of 100 m. We looked at the
the largest observed anomaly value after the TMI anomaly data were shifted and upward continued; roughly ~4100
nT. We assumed that globally, the level of uncertainty was roughly 0.5% the largest anomaly value (or about 20 nT).
Preliminary inversion attempts using a simple floor uncertainty recovered models which underfit the observed anomaly.
To remedy this, a background uncertainty of 20 nT was assigned to the background region and a floor uncertainty of
10 nT was assigned to the region containing the TMI anomaly.
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Fig. 12: Magnetic anomaly shifted and upward continued to 100 m (left). Uncertainties used for local magnetic inversions (right)

10.1.8 Mesh Design
Here, we describe a general approach for designing tensor meshes for TMI inversion.
Downsampling
Downsampling was first introduced in the Loading TMI Data and Cursory Interpretation section of the tutorial. Downsampling was applied to the local tutorial data to increase the minimum spacing between data points without filtering
out any coherent signals from magnetized structures. This enabled us to perform an equivalent source inversion on a
mesh whose cells were reasonably sized.
Here, downsampling is performed for the same reason. Memory requirements for potential field inversion are linearly
proportional to mesh size. By downsampling appropriately, we can invert the data on a coarser mesh since we have
increased the minimum data spacing.
• Downsample by distance
For the local tutorial data, we downsampled to a minimum distance of 50 m. This is equal to the average line spacing
of the original field-collected skidoo data. For the data being inverted (upward continued to 100 m), this minimum
spacing accurately characterizes the observed TMI anomaly.
General Approach
To create a tensor mesh based on survey geometry:
• Create 3D mesh under the ‘Create’ drop-down menu
• Cell size: set the cell size for the core mesh cells.
• Horizontal Extent: under ‘Choose Object’, select the magnetic data object then click ‘calculate limits’. This
defines your core mesh region
• Vertical Extent: Depth of your core mesh region under surface topography
• Padding Parameters: Do not pad in the upward direction, as air cells are not used when modeling potential
fields
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Here are some rules of thumb for generating tensor meshes for magnetic inversion:
Depth of core mesh region: As mentionned in the interpretation section, the depth to a magnetized body is correlated
with the width of the anomaly it produces. To estimate the depth of the core mesh region, use the half-width formula
on any notable TMI anomalies then determine the corresponding burial depths. The bottom of the core mesh region
should be 1-2 times the largest burial depth; ensuring that a significant portion of the target does not end up in the
padding.
Minimum cell dimension: The dimensions of the cells in the core mesh region depend on the smallest spatial frequency
contained within the data. When data are very smooth and contain lower spatial frequencies, coarser meshes can be
used and the inversion will demonstrate reasonable convergence. If data contains significant higher frequency signals,
more cells are required between each data point in order for the inversion to converge appropriately; i.e. reach target
misfit with a geologically reasonable model.
Ideally, the line spacing and flight height will have been chosen with some consideration to the magnetic anomalies
produced by local structures. In general, the minimum horizontal cell width should be at AT MOST 75% the smallest
distance between data points. Never have 2 data points lying above the same cell!!! And if possible, 2-3 cells between
each data point is ideal.
Padding: Padding is required to fit any remaining longer period signals that remain in the data. The longest spatial
period signal that can be characterized by the data is equal to the dimensions of the survey area. As a result, the thickness
of the padding should be 0.5-2 times the width of the survey region. For tensor meshes, we pad out exponentially to
reduce the total number of mesh cells. An expansion factor of 1.1-1.3 is ideal. Do not exceed a padding factor of 1.5!!!
Meshes for Tutorial Data
Regional Mesh
For regional-scale inversion, the following parameters were used to generate the mesh.
Depth of core mesh region: 1200 m was 2x the burial depth using the half-width formula.
Minimum cell dimensions: Since the regional data are gridded to 200 m spacing, we chose a minimum cell dimension
of 80 m (2.5 cells per station).
Padding: We chose to define the mesh boundary 10 km from the survey region in every direction. Based on our bestpractices, this could be seen as a bit of an underestimation (survey region is 45 km by 45 km). But assuming we have
removed the very-long period signal from the regional data, this was acceptable.
Local Mesh
For local-scale inversion, the following parameters were used to generate the mesh.
Depth of core mesh region: 1000 m was 2x the burial depth using the half-space formula.
Minimum cell dimensions: Since the data were downsampled to a minimum spacing of 50 m, we chose a minimum
cell dimension of 20 m (2.5 cells per station).
Padding: We chose to define the mesh boundary 4 km from the survey region in every direction. Based on our bestpractices, this was reasonable given a survey area of 4.5 km by 4.5 km.
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10.1.9 Least Squares Inversion
Here, we provide general instructions for setting up and running magnetic inversions within the GIFtools framework.
For both the local and regional (if available) datasets, we will perform a least-squares inversion. The choice in inversion
parameters and their impact on the recovered model are discussed.
Running a Least-Squares Inversion
The steps for setting up and running the magnetic inversion are as follows:
• Create a MAG3D v6.0 inversion object
• Use edit options to set the inversion parameters
• Click Apply and write files
• Run weights
• Run sensitivities
• Run inversion
• Load results for desired iterations
Inversion Parameters for Tutorial Data
For the regional tutorial data, the following inversion parameters were used.

For the local tutorial data, the following inversion parameters were used.
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Discussion of Tutorial Inversion Parameters
Note: The parameters chosen for inversion of the tutorial data set were experimentally derived. The numbers used
here worked well for inverting this dataset but should not necessary be used as general default values!
Regarding sensitivity weighting:
Default parameters for sensitivity weighting are applied. The role of sensitivity weighting in potential field inversion
is discussed in fundamentals of inversion.
Regarding chi factor:
By setting a chi factor of 1, you are assuming that you have accurately characterized the global level of uncertainty
on the data. If you have over-estimated the uncertainties, the inversion will reach target misfit and terminate before
recovering a model that accurately fits the data. By setting the chi factor to 0.5, we are able to view models further
along the Tikhonov curve. This can be used to adjust the level of uncertainty on subsequent inversions.
Regarding the starting model:
A starting model of 0.0001 SI was chosen. This is done because a starting model of 0 SI will not produce a step direction
for updating the model at the first iteration. Thus in practice, we assign something small whenever our reference model
is equal to 0.
Regarding the alpha parameters:
There are a couple of approaches one can take here. The first is carrying out the ‘smoothest model inversion’. For
the smoothest model inversion, we set 𝛼𝑠 to something very small (e.g. 1e-10). By doing so, we recover a model
which does not depend on the reference model (smallness term). The inversion is purely driven by the data and does
not assume any a-priori information. The second option is to balance the relative emphasis on fitting the smallness
and smoothness terms in the model objective function. Equal balance is expected when 𝛼𝑠 ≈ 1/ℎ2 , where ℎ is the
minimum cell width.
For both the local and regional inversions, we set 𝛼𝑠 = 1e-4. Since the reference model is 0 SI, the recovered model
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cannot have very large values and must be sufficiently smooth. Here we assume that polynomial detrending adequately
removed any longer period signals from the data. And as such, we do not want smooth large-scale features recovered in
the padding cells; something which can happen by inverting for the smoothest model. By setting 𝛼𝑠 sufficiently large,
the padding cells in the recovered model will be essentially equal to the reference model (0 SI) if they are not sensitive
to the data.
Regarding the bounds:
Here, we set a lower bound of 0 SI to enforce a positivity constraint on the recovered susceptibility model. We replaced
the upper bound of 1 SI to something very large in case there is very strong induced magnetization.

10.1.10 Examining Inversion Outputs
Here, we demonstrate a common practice for examining the output of the inversion code. This includes examining the
convergence, the data misfit and the recovered model. Before looking at recovered models, the user is strongly urged
to examine the convergence of the algorithm first. By examining the convergence, we can:
• see if the inversion is able to reach target misfit
• infer whether the target misfit is reasonable; i.e. did we globally over or under-estimate the uncertainties on our
data
We then assess how well a given recovered model explains the data by looking at the predicted data, observed data and
normalized data misfit maps. From this we can determine whether:
• the predicted data fits the amplitude, shape and character of observed TMI anomalies
• the assigned uncertainties were reasonable
• the inversion must be re-run with a new set of uncertainties
Only when the convergence and data misfit are acceptable can we infer geological structures from recovered models.
Regional Inversion
Here, we discuss the results of the regional-scale inversion. Recall that we inverted polynomial detrended regional data
(B_anomaly_detrended).
Convergence
Once the inversion has completed (or during the inversion), we can examine the convergence with:
• View convergence
The convergence curve for our example inversion is shown below. Note that we inverted 7,872 data points. Thus a chi
factor of 1 corresponds to a data misfit of 7,872. According to the figure:
• Although the inversion did not reach target misfit (chi-factor of 0.5), it did converge roughly to a chi-factor of 1
(after 8 iterations). Misfit maps will need to be examined before we can confirm the global level of uncertainty
on the data was correct.
• For larger trade-off parameters, it is possible for the next iteration to produce a recovered model that minimizes
the total objective function but does not result in a decrease in data misfit. This is likely what happened between
iteration 5 and 6.
• The background TMI anomaly for the original TMI anomaly data column was clearly negative, and was removed
using polynomial detrending and a DC shift of 30 nT. However if negative background signals are not propertly
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removed, the inversion may not be able to fit the observed data with a strictly positive and/or geologically reasonable susceptibility model. We will need to examine the misfit maps and recovered models to validate whether
polynomial detrending and a 30 nT shift worked effectively.

Data Misfit
According the convergence curve, the recovered model at iteration 8 has a good change of explaining the data without fitting the noise. To be sure however, we must examine the observed data, predicted data and data misfit for the
corresponding model. Here are some good questions to ask during this step:
• Does the recovered model reproduce the observed TMI anomalies accurately?
• Are there obvious coherent features in your misfit map? If so, this indicates you may be over-fitting certain
regions at the expense of others and you must assign new uncertainties and re-run the inversion.
For the regional inversion, here are some things we noticed:
• The recovered model appears to reproduce the observed anomalies very well. This was made possible, in part,
by assigning smaller uncertainties to regions containing large TMI anomalies.
• Larger normalized misfits are observed in proximity to larger observed anomalies (seen below). However, the
data misfit map (observed minus predicted) will show the background is not drastically overfit relative to the
observed anoalies.
• There is a region in the Southwest where negative anomaly values were a little underfit (circle in the normalized
misfit below). You may choose to reduce the uncertainties in this region and run the inversion again, or shift the
observed data up if you feel the data cannot be fit with a positive susceptibility model as is. For this tutorial, we
are not overly concerned about the region in the Southwest and we will assume the recovered model adequately
reproduces the observed data.
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Recovered Model
The recovered model at the 8th iteration is shown below. A cut-off of 0.05 SI has been applied and the padding cells
have been remove to view only the structures constrained by the data. The recovered model contains a set of WSW to
ENE trending features; similar to what was observed in the data.

Local Inversion (Polynomial Detrended)
Here, we discuss the results of the local data inversion; where polynomial detrending was used to remove regional
features (B_anomaly_detrended).
Convergence
Once the inversion has completed (or during the inversion), we can examine the convergence with:
• View convergence
The convergence curve for our example inversion is shown below. Note that we inverted 7,371 data points. Thus a chi
factor of 1 corresponds to a data misfit of 7,371. According to the figure:
• Although the inversion did not reach target misfit (chi-factor of 0.5), it did converge roughly to a chi-factor of
1 (after 8 or 9 iterations). Misfit maps will need to be examined before we can confirm the global level of
uncertainty on the data was correct.
• Similar to the regional inversion, the data misfit increased between iteration 5 and 6 before continuing to reduce.
• The background TMI anomaly for the regional data was clearly negative and removed using polynomial detrending. However if negative background signal is not propertly removed, the inversion may not be able to fit
the observed data with a strictly positive and/or geologically reasonable susceptibility model. We will need to
examine the misfit maps and recovered models to validate whether polynomial detrending worked effectively.
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Data Misfit
According the convergence curve, the recovered model at iteration 9 has a good change of explaining the data without
fitting the noise. For the local inversion, here are some things we noticed:
• The recovered model appears to reproduce the observed TMI anomalies very well. This was made possible, in
part, by assigning smaller uncertainties to regions containing TMI anomalies.
• Larger normalized misfits are observed in proximity to larger observed anomalies (seen below). However, the
data misfit map (observed minus predicted) will show the background is not drastically overfit relative to the
observed anoalies.

Recovered Model
The recovered model at the 9th iteration is shown below. A cut-off of 0.2 SI has been applied and the padding cells
have been remove to view only the structures constrained by the data.
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Comparing Local and Regional Inversion
Here, we examine regional and local inversion results within the local survey area. The general shape and orientation
of the recovered structure using each dataset is similar. However, the structure recovered from regional data is larger,
smoother and significantly lower in amplitude. This is because the regional data are defined at an elevation of 305 m
and at a spacing of 200 m; whereas local data were defined at an elevation of 100 m and at a spacing of 50 m. The
regional scale data do not contain some of the higher spatial frequencies contained in the local survey data. And as a
result, the regional data cannot be used to characterize the recovered structure to the same degree.

10.1.11 Scooped Regional Removal and Local Inversion (Optional)
Note: If you have not acquired and inverted regional data, this technique will not be be possible.
Here, our goal is to use a regional susceptibility model recovered from regional TMI anomaly data to constrain our
local scale magnetic inversion. In detrending and levelling tutorial data, we defined a data column in the local upward
continued data object that was levelled with the regional data; which we called B_anomaly_levelled. And in mesh
design we defined the meshes on which our local and regional models would live. Using the ‘scooping’ technique, we
remove the contribution from all material within the regional model that lies outside the bounds of the local mesh. If
done correctly, all magnetized material that is unaccounted for should lie within the local mesh.
Scooped Regional Removal
The first step is to create a ‘scooped’ regional model. To do this:
• Make a copy of your recovered regional model
• Determine the Easting, Northing and Elevations defining the boundaries of your local mesh
• With add rectangular block, add a 0 SI block to the copy of the regional model using the margins of the local
mesh
For the tutorial, we illustrate the active cells for the regional model and the active cells for the resulting ‘scooped’
regional model below.
Next, we forward model the contribution from the scooped regional model at local survey locations. For the local
tutorial data, we are forward modeling at a set of upward continued data locations for an elevation of 100 m. To do
this we:
• Downsample the data if necessary. Like in our original local tutorial inversion, we must downsample the data to
a minimum spacing of 50 m.
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Fig. 13: Active cells for the regional model (left). Active cells for the scooped regional model (right).
• Create forward modeling object
• Use edit options to define the following properties:
– Use the regional mesh and scooped regional model
– Use the local magnetic data object to define the survey locations
– The lower bound is left blank!!!
• Write the files
• Run the forward model
• Load the results when complete. Let’s refer to the predicted data column as B_scooped
Finally, we remove the scooped regional contribution from the local data. To do this:
• Use import data from another MAGdata object to import the scooped data column to the other data object. The
size and locations defined in both data object must match!!!
• Use column calculator to subtract scooped data column (B_scooped) from levelled TMI anomaly data
(B_anomaly_levelled). We refer to this column as B_regional_detrended.
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Reference Model for Local Inversion
To constrain the local inversion with the regional model, we create a reference model by interpolating the regional
model to the local mesh. By first creating active cells models, we ensure that we do not interpolate air/inactive cells to
the local mesh. This is done by:
• create active cells from topo for the regional mesh using regional topography
• create active cells from topo for the local mesh using local topography
• Interpolating regional model to local mesh:
– Create interpolate tensor mesh to tensor mesh utility
– Edit options. We chose ‘linear’ model and ‘smooth’ interpolation
– Run
– Load the output model. This is your local reference model.
For the tutorial, the regional model interpolated to the local mesh is shown below.

Running Local Inversion
Prior to setting up and running the local inversion, set the observed data to the correct column using set IO headers
(B_regional_detrended). The steps for setting up and running an inversion are the same as before, except different
parameters are used. The input parameters for the local inversion after regional removal are as follows:
The steps for setting up and running the magnetic inversion are as follows:
• Create a MAG3D v6.0 inversion object
• Use edit options to set the inversion parameters
• Click Apply and write files
10.1. Comprehensive Workflows: TMI Magnetics
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• Run weights
• Run sensitivities
• Run inversion
• Load results for desired iterations

Starting and reference model:
Here, the reference model interpolated from our regional model is set as both the starting and reference models in the
inversion. This is common practice for a non-zero reference model. And by setting reference model as the starting
model, we can examine the data misfit that corresponding to the reference model; i.e. at iteration 0.
Alpha parameters:
We want to constrain the local inversion with the reference model. As a result, the value for 𝛼𝑠 must be significant;
i.e. not the smoothest model. For a minimum cell size of 20 m, 𝛼𝑠 = 1/202 = 0.0025 would place equal emphasis on
the smallness and smoothness terms. As discussed in comparing local and regional inversion results, the regional data
do not contain some of the higher spatial frequencies contained in the local survey data. And as a result, the regional
inversion produces broader, smoother and lower amplitude structures. Since our confidence in the structures obtained
from the regional inversion is not overly high, we chose to set 𝛼𝑠 = 0.0001; thus constraining the inversion with the
reference model, but only moderately.
Role of reference model:
When defining the role of the reference model in constraining the recovered model, we have two choices:
• SMOOTH_MOD: the reference model is in the smallness term only. This options preserves the structures in the
reference model but does not preserve sharp boundaries.
• SMOOTH_MOD_DIF: the reference model is in the smallness and smoothness terms. This option preserves
structures in the reference model including their boundaries.
Because we do not have as much confidence in the boundaries inferred from the regional inversion, we chose the
SMOOTH_MOD option. In combination with our choice in alpha parameters, we are moderately constraining the
inversion with the reference model without assuming anything about the boundaries of recovered structures.
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Comparing Polynomial Detrended and Regional Removed Models
The inversion reaches a chi-factor of 1 after 8 iterations. Below, we show the local recovered model when polynomial
detrending is used and when regional scooping is used to account for the regional signal. For the tutorial data, the
recovered models are effectively the same. It is likely that polynomial detrending was sufficient in removing the regional
signal, and any localized magnetized bodies lying outside the local survey region have minimal impact on the target
anomaly.

10.1.12 Sparse-Norm Inversion
For magnetic inversion using UBC-GIF codes, sparse norm inversion can be used to recover compact and/or blocky
structures. The ability to recovered structures with sharper boundaries marks a major improvement over classic leastsquares inversion; which recoveres smooth structures with smeared boundaries. The fundamentals of inversion section
provides useful background information.
Here, we demonstrate how to setup and run sparse-norm inversions using the GIFtools framework. We also provide
several inversion examples for our local tutorial data. We will invert the same data as in the previous section; i.e. the
B_regional_detrended data column.
L1-Norm Inversion
Here, we use the L1 norm to define the smallness and smoothness terms in the model objective function. The inversion
parameters used for the local tutorial inversion are shown below. In the ‘Sensitivity’ and ‘Inversion’ panels, the inversion
parameters have not been changed. The ‘Blocky model norms’ panel is used to set the parameters for sparse-norm
inversion.
Below, we see the convergence when sparse norms are used. The first part of the convergence curve shows the code
performing a standard least-squares inversion until target misfit is reached. During the second portion of the curve, we
introduce the sparse-norms and the code applies an iteratively-reweighted least-squares (IRLS) algorithm until final
convergence is reached. Note that for the first few IRLS iterations, you will observe an increase in data misfit.
The final recovered model using the L1-norm is shown below.
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Models for Different Norms
As a third example, we invert using an L2-norm on the smallness term and L0-norms on the smoothness terms. This
represents a case where recovered susceptibilities should all be similar to the reference model. However, we can have
very sharp boundaries. A comparison between the L2-inversion, L1-inversion, and this L2-L0-L0-L0 inversion are
shown below.

10.2 Comprehensive Workflows: DC and IP
Author: Devin C. Cowan
Published: August, 2020
Here, we present a general workflow for loading, interpreting and inverting directed current resistivity (DC) and induced
polarization (IP) data. We begin with UBC-GIF formatted data files for the DC and IP data. However, instruction is
given in the case the data are in XYZ format. Our goal is to invert the data to recover both a 3D conductivity model
and a 3D chargeability model. You may work with your own data or the tutorial dataset provided here:
• Download the tutorial data
The tutorial data were collected in order to delineate ore-bearing rock units at Mt. Isa, Queensland, Australia. The
data were originally inverted as part of the paper 2-d and 3-d ip/resistivity inversion for the interpretation of isa-style
targets (Rutley et al., 2001)
Tutorial Sections

10.2.1 Understanding DC and IP Data
In order to properly interpret DC and IP data, it is import to first understand the characteristics of the anomalies due
to basic structures. We also need to understand the nature of DC and IP data. Here, we investigate the DC signatures
produced by compact conductors and resistors. We also consider the IP signature when the conductor is also chargeable.
The knowledge gained here can be used to infer a realistic background model and the locations of anomalous structures
from DC/IP data.
For this section, we will simulate DC and IP data over a resistive block (𝜎 = 0.001 S/m) to the West and a conductive
block (𝜎 = 0.1 S/m) to the East within a moderately conductive background (𝜎𝑏 = 0.01 S/m). The background and
resistor are non-chargeable but the conductor has been given an integrated chargeability of 𝜂 = 100 ms. Both blocks
extend from a depth of 50 m to a depth of 250 m and extend infinitely in the North-South direction. Data are simulated
for dipole-dipole, pole-dipole and dipole-pole electrode configurations.
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Fig. 14: Conductivity model (left) and chargeability model (right).
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DC Resistivity
The DC resistivity technique injects electrical current at electrodes A and B and measures the difference in electric
potential between electrodes M and N. Electrode A is generally designated the +ve current electrode (associated with a
positive electric potential) and B is the -ve current electrode (associated with a negative electric potential). Electrodes
M and N are referred to as the potential electrodes.

DC Data and Anomalies
For UBC-GIF codes and most other modeling software, DC data are defined as the measured difference in electric
potential (voltage) between electrodes M and N normalized by the source current, i.e.:
𝑑𝐷𝐶 =

∆𝑉
𝑉𝑀 − 𝑉𝑁
=
𝐼
𝐼

For a homogeneous Earth, the data depend on the electrode geometry and the resistivity (𝜌):
[︂
]︂
𝜌
1
1
1
1
∆𝑉
=
−
−
+
𝑑𝐷𝐶 =
𝐼
2𝜋 𝑟𝐴𝑀
𝑟𝐵𝑀
𝑟𝐴𝑁
𝑟𝐵𝑁
where 𝑟𝐴𝑀 is the distance between electrodes A and M; likewise for the other terms. It should be noted that depending
on the convention of your current and potential electrodes, measured voltages can be positive or negative.
Below, we see DC data in pseudo-section for our example conductivity model for 3 standard electrode configurations.
Note that:
• the data values decrease in magnitude as the electrode spacing increases. This is expected based on our expression
for defining DC data.
• data sensitive to conductors will manifest as an anomalous decrease in the magnitude of the normalized voltage.
And data sensitive to resistors will manifest as an anomalous increase in the magnitude of the normalized voltage.
This is consistent with our definition of DC data.
• the anomalous structures corresponding to each electrode configuration have different shapes. This is expected
given the data are dependent on the electrode geometry.
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Apparent Resistivity
Apparent resistivities are a good way to interpret DC data. They can be computed easily and they represent the data in
a way that negates the impact of electrode spacing on the magnitude of the data. The apparent resistivity is given by:
𝜌𝑎 =

𝑑𝐷𝐶
∆𝑉
=
𝐺
𝐼𝐺

where
𝐺=

[︂
]︂
1
1
1
1
1
−
−
+
2𝜋 𝑟𝐴𝑀
𝑟𝐵𝑀
𝑟𝐴𝑁
𝑟𝐵𝑁

By computing apparent resistivities, you can:
• estimate the background resistivity of your survey region
• locate the general position of anomalous conductive and/or resistive targets
Below, we see apparent resistivities for our example conductivity model for 3 standard electrode configurations. Note
that:
• for data that are only sensitive to the background, the apparent resistivity is equal to the true background resistivity
(𝜌𝑏 = 1/𝜎𝑏 = 100 Ω𝑚 ).
• data sensitive to the conductor results in lower apparent resistivities and data sensitive to the resistor results in
higher apparent resistivities.
• since the data are dependent on the electrode geometry, so are the apparent resistivities.
• the horizontal and vertical position of signatures in the pseudo-section are correlated with the locations of their
respective anomalous bodies.
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Induced Polarization
When collecting DC (and IP) data, repeated measurements are acquired by applying a duty cycle for the source current.
When the Earth is chargeable, a decaying voltage is observed during the off-time. The off-time decaying voltage
is referred to as the IP response. The decay rate and magnitude of the IP response depends on the dimensions and
character of the chargeable body and the electrode geometry. For reference:
• 𝑉𝑚 is the observed voltage for a steady-state current
• 𝑉𝜎 is the instantaneous increase or decrease in voltage attributed to DC resistivity
• 𝑉𝑠 is the magnitude of the IP contribution for a steady-state current

Chargeability Definitions
IP data can be somewhat confusing, as there are multiple definitions of chargeability used in practice. In addition,
a multiplication factor may be applied so that chargeability values are more easy to work with. The most common
definitions of chargeability are:
1. Intrinsic Chargeability: The intrinsic chargeability is the ratio between the IP voltage just after shutoff and the
steady-state voltage, i.e.:
𝑉𝑠
𝑉𝑚

𝜂=

If we were to apply a steady-state current, the intrinsic chargeability defines the fraction of observed voltage attributed
to the IP effect.
By the previous expression, we expect 0 ≤ 𝜂 ≤ 1 and for 𝜂 to be unitless. However since 𝑉𝑠 ≪ 𝑉𝑚 even for chargeable
rocks, intrinsic chargeability values are commonly provided in units of mV/V; ie. multiplied by a factor of 1000 so
that numbers are larger.
2. Integrated Chargeability:
The integrated chargeability is meant to define the magnitude and decay behaviour of the IP response over a range of
off-times that typically exhibit the IP response. The integrated chargeability is given by:
𝜂=

1
𝑉𝑚

∫︁

𝑡2

𝑉 (𝑡) 𝑑𝑡
𝑡1

where 𝑡1 and 𝑡2 denote the times over which the measured voltage is integrated. Once again the true values are small,
so we typically represent the integrated chargeability in units of ms as opposed to seconds.
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IP Data
IP data are generally represented as apparent chargeabilities (𝜂𝑎 ) or as secondary potentials (𝜑𝑠 ) attributed to the IP
response. IP data can be challenging to work with because there are multiple definitions for the physical property. To
remedy this, data are generally inverted using a linearized formulation.
Let ℱ[𝜎] be the forward modeling operation that computes the DC electric potentials due to a conductivity model.
According to the theory section of the DCIP OcTree manual, the secondary potentials attributed to IP are given by:
𝜑𝑠 = ℱ[𝜎(1 − 𝜂)] − ℱ[𝜎]
where 𝜂 is the intrinsic chargeability. And the apparent chargeability is given by:
𝜂𝑎 =

ℱ[𝜎(1 − 𝜂)] − ℱ[𝜎]
ℱ[𝜎(1 − 𝜂)]

To handle any definition and normalization for the chargeability model/data, the linearized forward model is given by:
⎧
𝜑𝑖 [𝜎]
⎨𝐽𝑖𝑗 = 𝜕𝜕 ln[𝜎
for dIP = 𝜑𝑠
𝑗]
[︀
]︀
dIP = 𝐽 𝜂 where
𝜕
ln𝜑
[𝜎]
𝑖
⎩𝐽 =
for dIP = 𝜂𝑎
𝑖𝑗
𝜕 [𝜎𝑗 ]
Note that the linearized operator J only depends on the background electrical conductivity model and not on the
chargeability. As a result:
• Any definition or normalization of apparent or intrinsic chargeability can be used for apparent chargeability
data. The inversion will recover a model that is defined using the same convention as the data.
• If secondary potential data are being modeled, the user must use intrinsic chargeability with 0 ≤ 𝜂 ≤ 1 or
normalize the data before inverting.
Below, we see apparent chargeability data for our example chargeability model for 3 standard electrode configurations.
Note that:
• the apparent chargeabilities fall within the range of values defined by the true chargeability model
• data sensitive to the chargeable body manifests as higher apparent chargeabilities and data away from the chargeable body manifests as small apparent chargeability values
• since the data are dependent on the electrode geometry, so are the apparent chargeabilities
• the horizontal and vertical positions of signatures in the pseudo-section are correlated with the locations of their
respective anomalous bodies
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Effects of Conductivity Models on IP Inversion
Successful IP inversion requires an accurate background conductivity model. That is because the background conductivity model is used to construct the forward modeling operator J.
Here we invert the apparent chargeability data for the practice example. On the left, we show the set of background
conductivity models that were used. On the right, we show the recovered chargeability models. From the figure below,
we see that:
• the best result is obtained if the true conductivity model is used for the background model.
• if the background conductivity model is generally similar to the true conductivity model, you will recover the
region of largest chargeability with manageable artifacts. Depending on the quality of your background conductivity model, you may recover a reasonable chargeability model.
• a homogeneous background model may place the region of highest chargeability in the correct location. However, the magnitude of the anomalous chargeable body may be incorrect and there will almost certainly be major
artifacts.
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10.2.2 Loading 3D DC/IP Data and Cursory Interpretation
The first step in any project is to load field collected data and visualize it. Here, we will assume the data are in UBC-GIF
formatted observation files. However, we will explain how to load data which are in XYZ format. The tutorial data
consists of 10 East-West lines of DC/IP data collected using a MIMDAS system.
Our goal is to load the 3D DC/IP data and visualize it in a meaningful way. DC/IP data can be a little challenging to
visualize, as the measurements are not defined at distinct locations. If the dataset is comprised of a set of 2D DC/IP
profiles, then each line can be plotted as a 2D pseudo-section.
Important: Requires GIFtools v2.31 or later.

Starting Your Project
• Open GIFtools
• Set the working directory
Import Files
Here, we import the DC, IP and topography data. The tutorial data are in 3D UBC-GIF format. If you have data of
the same format:
• Import topography data (XYZ format). The data file is named topo.xyz.
• Import 3D DC data as an observed data format file. The data file is named DCdata.dat.
• Import 3D IP data as ‘any format’. The data file is named IPdata.dat.
• If the elevations of the electrodes are not defined in the data file, we strongly advise that you apply topography.
Data in XYZ or CSV format can be imported together or separately into GIFtools. In this case, GIFtools will require
the user to select the columns corresponding to electrode positions and data. If DC and IP data are loaded into a single
data object, the user can:
• Create IP data object from DC data object or visa versa
• Set IO headers to define the columns correctly
• If the elevation of the electrodes is not defined, you can apply topography. This is not necessary if the surface
topography is flat.
Note: If data are UBC-GIF observed data format, the file will contain uncertainties. As part of this tutorial, we will
discuss aspects of assigning appropriate uncertainties to the data.
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Fig. 15: Tutorial data consists of 10 West to East DC/IP survey lines including topography.
Normalized Voltage to Apparent Resistivity
UBC-GIF codes define DC data as the measured voltage normalized by the transmitter current in units of V/A. If your
data are raw voltages, you must normalize the data by the source current. To do this:
• Use the column calculator to divide the raw voltage column by the source current column.
• Set the IO header for voltage data to the normalized voltage column.
Much can be gained by interpreting the data as apparent resistivities. Depending on your original data file, you may
have voltage and/or apparent resistivity data. To convert between apparent resistivities and normalized voltages for
your DC3Ddata object:
• Compute geometric factor
• Transform between normalized voltage and apparent resistivity
UBC-GIF codes accept many definitions and normalizations for IP data, including intrinsic chargeability, integrated
chargeability and secondary potential. If you would like to eventually view the data as apparent chargeabilities, select
the IP3Ddata and:
• Compute geometric factor. Subsequent transform of the data is not required.
Important: If the elevations for electrode locations are not set, GIFtools will assume the surface topography is flat.
This will impact the plotted locations of the apparent resistivity/chargeability data.
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Assigning Survey Line Numbers
If your data object has a column containing the line IDs, this step is not required. Data from UBC-GIF formatted data
files does not contain line ID information. This information must be set manually. To create a line ID column:
• Add a constant column of 1s to the data object and name it LineID.
• Open the VTK viewer
– In the control menu, set the Current data drop down menu to plot LineID. You will see all values being
plotted are equal to 1.
– Click the Edit tab, then click one of the data selection icons. When clicked, you can select data on the plot.
If unselected, you will shift and rotate the plot.
– Click the Simple edit tab. Select Replace value and unselect the create new column box.
– For each survey line:
∗ Select the corresponding data points
∗ Enter an integer in the Value text field for that survey line
∗ Click the Apply button
– Close the windows when finished. If you re-open the VTK viewer, you can check to see if the line IDs
were assigned properly.

Fig. 16: Assigning line ID through VTK.

Create 2D Survey Lines
Note: If you have a good estimate of your uncertainties for the entire 3D dataset, you may choose to assign them before
creating 2D profiles. See the assigning uncertainties section. If uncertainties have been assigned, the uncertainties
column will be carried over when creating the 2D profiles.
Since we are unable to plot apparent resistivities/chargeabilities in 3D in a meaningful way, we must separate the data
into a set 2D profiles. This is not possible without a data column which defines each line ID. To parse the 3D DC and/or
IP datasets into a suite of 2D profiles:
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• Convert DC/IP 3D data to 2D from line ID
• Select the LineID column and make sure to apply topography if relevant
• For the tutorial data, we used a sampling of 5 m
If the potential electrode measurements are on either side of the source electrodes, you will not be able to plot 2D
pseudo-sections without data points being plotted on top of one another. The tutorial data was collected by a MIMDAS
system which contains both pole-dipole and dipole-pole data. To separate the data:
• Select any of the newly created 2D data objects
• And under the data manipulation drop-down menu, select split data → based on electrode geometry
Cursory Interpretation
For the tutorial data, the normalized voltage, apparent resistivity and apparent chargeability pseudo-sections for profile 1 (most Northern) are shown below. Since the dipole-pole and pole-dipole data have different sensitivities to the
same structures, we see the pseudo-sections are not identical. Both datasets generally show a range of apparent resistivities spanning 4 orders of magnitude. A dominant resistive structure exists within the Western portion of the survey line.
Whereas in the Eastern portion of the survey, there is a more conductive structure that may extend to significant depth.
Both the dipole-pole and pole-dipole data show a notable IP signature near the middle of the survey line. However, the
signatures manifest different in the dipole-pole and pole-dipole pseudo-sections.
• To view the data, you may select any data object and plot with VTK

Fig. 17: Normalize voltage pseudo-sections for Line 1 (log-scale).

10.2.3 Assigning Uncertainties
At this point, we assume the data are loaded into GIFtools, that our DC data are in V/A, and that our IP data are
represented as integrated or intrinsic chargeabilities. Here, we provide a basic approach for assigning uncertainties
to DC resistivity and IP data. The role of uncertainties in geophysical inversion is presented in the fundamentals of
inversion. When assigning uncertainties, we want to ensure we fit the anomalies and not the background. We also want
to ensure we fit each area of the survey region evenly. To assign a percent plus a floor uncertainty to the data:
• Assign simple uncertainties
Note: You may decide to apply uncertainties to the full 3D data set or to 2D profiles individually.
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Fig. 18: Apparent resistivity pseudo-sections for Line 1 (log-scale).

Fig. 19: Apparent chargeability pseudo-sections for Line 1 (log-scale).
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Normalized Voltage Data
In the basic anomalies: understanding voltage data section, we learned that:
• measured voltages are smaller in magnitude when the electrode spacing is larger because the currents at the
potential electrodes are weaker.
• measured voltages are smaller in magnitude when the geology is more conductive.
• larger electrode spacings are used to measure data that are sensitive to deeper structures.
The opposite of the previous three statements is also true.
The role of the percent uncertainty is to ensure we do not prioritize fitting resistive structures (higher voltages) at the
expense of conductive structures (lower voltages). This can happen if only a floor uncertainty is applied. Assigning a
percent uncertainty between 5% and 10% is common. But the ideal percent uncertainty will depend on the range of
measured voltages and the data quality. It is not uncommon to assign uncertainties of 20% if the data are very noisy.
A floor uncertainty is used to ensure the inversion does try to over-fit data with a poor signal to noise ratio. The signal
to noise ratio generally becomes worse as the electrode spacing is increased and the measured voltages become too
small for the instrument to measure accurately. If you do not assign a floor value, you may end up over-fitting these
data. However if the floor you set is too large, you will not fit the data which are generally sensitive to deeper structures.
For the tutorial data set, we assigned uncertainties of 2e-5 V/A + 5%. For reference, the normalized voltages and
uncertainties for Line 1 are plotted on pseudo-section below. The data and corresponding uncertainties are plotted on
the same scale.

Fig. 20: Normalize voltage pseudo-sections for Line 1 (log-scale).

Chargeability Data
In the basic anomalies: understanding voltage data section, we learned that:
• IP data depends on the DC data
• the IP response is negligible unless we are in the presence of a chargeable structure
If only a percent uncertainty is applied, the inversion will fit the background instead of fitting IP anomalies. That is
why an appropriate floor uncertainty is important. The floor uncertainty is set based on what the user believes is the
“background IP response”. The user may also choose the floor as being some percent of the maximum data value.
A percent uncertainty is added if the IP anomalies are noisy and/or there are some anomalously high apparent chargeabilities. Without including a percent uncertainty, it may be difficult to fit the data with geologically reasonable models
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Fig. 21: Uncertainties in pseudo-sections for Line 1 (log-scale).
in this case. Ultimately, the user is encourage to first assign a floor uncertainty, then add a percent if they feel it is
necessary.
For the tutorial data set, we assigned uncertainties of 2ms + 5%. For reference, the IP data and uncertainties for Line
1 are plotted on pseudo-section below. The data and corresponding uncertainties are plotted on the same scale.

Fig. 22: Apparent chargeability pseudo-sections for Line 1 (log-scale).

10.2.4 Create, Run and Load 2D Inversion
In Loading 3D DC/IP Data and Cursory Interpretation we showed how to create a set of 2D profile lines from standard
3D DC or IP data. Here, we show how to independently invert any of the profiles using the 2.5D formulation. If geological structures strike perpendicular to the profile line, the recovered 2D model will offer a reasonable approximation
if 3D effects are limited.
In this portion of the comprehensive workflow, we focus on:
• A general approach for 2D tensor mesh design
• Creating, running and loading results for 2D DC/IP inversions
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Fig. 23: Uncertainties in pseudo-sections for Line 1 (log-scale).
Define 2D Tensor Mesh
A 2D mesh must be defined on which the recovered conductivity and chargeability models will live. The mesh is also
required for modeling the fields. When designing a 2D mesh for 2D DC/IP simulations, the general rules are as follows:
• The minimum horizontal cell width dx depends on the minimum electrode spacing. Generally you would like to
have 2.5 to 4 cells between each electrode.
• The minimum vertical cell width dz is generally between dx/2 and dx.
• The depth of the core mesh region depends on the maximum electrode spacing (or length of the survey line).
For dipole-dipole surveys, the depth should be at least 1/2 the maximum electrode spacing. For pole-dipole and
dipole-pole surveys, the core mesh region should be 1/2 to 1 times the maximum electrode spacing.
• The X coordinate generally defines the along line spacing as opposed to a real geographic coordinate. Thus your
first electrode is almost certainly defined at X = 0 m. Keep this in mind when defining the horizontal extent of
the core mesh region.
• The padding thickness should be 1-2 times the depth of the core mesh.
To design a 2D mesh:
• Create 2D tensor mesh.
For the tutorial data:
• The minimum electrode distance was 50 m. We chose to set dx = dz = 15 m.
• The largest electrode separation was 2000 m. Since the data contain dipole-pole and pole-dipole, we set the core
mesh to extend 2000 m below the surface.
• The horizontal limits of the mesh were set to -400 m and 2400 m. Thus the core mesh extends 400 m horizontally
past the first and last electrodes.
• All padding, except in the air, was set to 2000 m with an expansion factor of 1.3.
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Fig. 24: 2D tensor mesh for tutorial data. The total number of cells was 33,100.
2D DC Inversion
We can now use the DCIP2D package to invert DC data for a single profile line. To accomplish this:
• Create a 2D DC inversion object and select a working directory when prompted
• Use edit options to set the parameters for the inversion.
• Click Apply and write files when finished. At this point, GIFtools will open a command line and compute the
sensitivity weighting. Please wait for this to finish.
• When the sensitivity weighting has been completed, you may run the inversion
• When the inversion is completed, you have several options for loading results

Fig. 25: Parameters used for independent 2D inversion of tutorial data (line 1).
Note: The parameters chosen for inversion of the tutorial data set were experimentally derived. The numbers used
here worked well for inverting this dataset but should not necessary be used as general default values!
For the tutorial data, use the Northernmost survey line (line 1). Parameters changed from their default value are
shown below.
• Basic Tab:
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– Set the 2D mesh as your mesh object
– Set the observed data and keep as surface format
– When creating 2D survey lines, 2D topography objects were created. Use the associated topography object
here.
• Advanced Tab: Parameter 1
– Trade-off parameter: We set to Default and set the max number of iterations to 20
– Solver: the maximum number of iterations for the CG solve was increased to 30
– Length scales: Choose Alphas and set alpha S = 1e-6 and alpha X = alpha Z = 1
• Advanced Tab: Parameter 2
– Reference model: Set to 0.01 S/m and set the role in the model objective function to ALL_DERIVATIVES
– Starting model: Set to 0.01 S/m
For synthetic modeling, we know the uncertainties on our data. With real data, we cannot be 100% sure that we have
correctly estimated the uncertainties. We set the trade-off parameter to Default in order to see the entire Tikhonov
curve and not make assumptions about the target misfit.
The starting and reference models were chosen from the distribution of apparent resistivity values observed in pseudosection. alpha S was set very low because the reference model is almost certainly not a reasonable first approximation
of the true resistivity structure. Thus were are providing a starting model for the inversion and letting the data constrain
the result. This is known as inverting for the smoothest model.
2D IP Inversion
We can now use the DCIP2D package to invert the IP data for a single profile line. To accomplish this:
• Create a 2D IP inversion object and select a working directory when prompted
• Use edit options to set the parameters for the inversion.
• Click Apply and write files when finished. At this point, GIFtools will open a command line and compute the
sensitivity weighting. Please wait for this to finish.
• When the sensitivity weighting has been completed, you may run the inversion
• When the inversion is completed, you have several options for loading results

Fig. 26: Parameters used for independent 2D inversion of tutorial data (line 1).
Note: The parameters chosen for inversion of the tutorial data set were experimentally derived. The numbers used
here worked well for inverting this dataset but should not necessary be used as general default values!
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For the tutorial data, use the Northernmost survey line (line 1). Parameters changed from their default value are
shown below. The edit options GUI for the 2D IP inversion is nearly identical to that of the 2D DC inverion.
• Basic Tab:
– Set the 2D mesh as your mesh object
– Set the observed data and keep as surface format
– Set the background conductivity model as the recovered model from your 2D DC inversion (we chose
iteration 12)
– When creating 2D survey lines, 2D topography objects were created. Use the associated topography object
here
• Advanced Tab: Parameter 1
– Trade-off parameter: Set to Default and set the max number of iterations to 10 (convergence for IP is fast)
– Length scales: Choose Alphas and set alpha S = 1e-6 and alpha X = alpha Z = 1
– Solver: the maximum number of iterations for the CG solve was increased to 30
– Bounds: Set Lower = 0 and Upper = 1e6
• Advanced Tab: Parameter 2
– Reference model: Set to 0 ms and set the role in the model objective function to ALL_DERIVATIVES
– Starting model: Set to 0.01 ms
For synthetic modeling, we know the uncertainties on our data. With real data, we cannot be 100% sure that we have
correctly estimated the uncertainties. We set the trade-off parameter to Default in order to see the entire Tikhonov
curve and not make assumptions about the target misfit. The IP inversion converges quickly so we can reduce the max
number of iterations parameter.
alpha S was set very low because the reference model is almost certainly not a reasonable first approximation of the
true resistivity structure. Thus were are providing a starting model for the inversion and letting the data constrain the
result. This is known as the smoothest model. We set a lower bound of 0 to force the recovered chargeabilities to be
positive. Because we do not have an upper bound for the inversion, we set the value to something very large.
The background conductivity model is chosen as the recovered model from the 2D DC inversion. Discussion regarding
how this model was chosen is covered on the next page. In general, we are looking for chargeable structures in a nonchargeable background. As a result, the reference model was set to 0. To ensure a non-zero model update at the first
iteration, a very small value (1e-2) is chosen for the starting model.

10.2.5 Analyzing 2D Inversion Results
To fully comprehend the inversion results we must examine the convergence, the data misfit and the recovered models. Before looking at recovered models, the user is strongly urged to examine the convergence of the algorithm first
(Tikhonov curve). By examining the convergence, we can:
• see if the inversion is able to reach target misfit
• infer whether the target misfit is reasonable; i.e. did we globally over or under-estimate the uncertainties on our
data
We then assess how well a given recovered model explains the data by looking at the predicted data, observed data and
normalized data misfit maps. From this we can determine whether:
• the predicted data fits the amplitude, shape and character of observed data structures
• the estimated uncertainties were balanced and that all data a fit evenly
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• the inversion must be re-run with a new set of uncertainties
Only when the convergence and data misfit are acceptable can we infer geological structures from recovered models.
2D DC Tutorial Data (Line 1)
Convergence
Once the inversion outputs have been loaded (done in the inversion section )
• View convergence
The Tikhonov curve for our tutorial inversion is shown below. According to the figure:
• the inversion reaches a chi-factor of 1 after 12 iterations.
• the data misfit is decreasing over the course of the beta cooling schedule, except for at iteration 13.
• the inversion is able to reach target misfit (chi-factor = 1)

Fig. 27: Tikhonov curve.

Data Misfit
According the Tikhonov curve, the recovered model at iteration 12 has a good chance of explaining the data without
fitting the noise if the estimate of our uncertainties is correct. To be sure however, we must examine the observed data,
predicted data and data misfit for the corresponding model. Here are some good questions to ask during this step:
• Are the prominent anomaly features identified in the observed data also found in the predicted data?
• Are there obvious coherent features in the normalized misfit maps? If so, this indicates you are over-fitting certain
regions at the expense of others and that you must assign new uncertainties and re-run the inversion.
For iteration 12, we used the split data based on electrode geometry to separate the dipole-pole and pole-dipole data
once again. For each electrode configuration, we see the predicted data, observed data and normalized misfit below.
For this survey line, we saw that:
• Data structures in the dipole-pole and pole-dipole data are well reproduced.
• The dipole-pole and pole-dipole are are fit relatively equally.
• The normalized misfits generally lie within a range of [-2, 2].
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• The highest normalized misfit values are associated with higher voltage measurements. This could be cause by
a) over-estimating the floor uncertainty and/or b) underestimating the percent uncertainty.
Overall we are satisfied with how well iteration 12 reproduces the data so we will continue. If you are not satisfied, it
is advised to adjust the uncertainties and re-invert the data.

Fig. 28: Predicted data, oberved data and normalized data misfit (dipole-pole). Predicted data are plotted on the same
scale. Normalized misfits are plotted on a colorscale from -2 to 2.

Fig. 29: Predicted data, oberved data and normalized data misfit (pole-dipole). Predicted data are plotted on the same
scale. Normalized misfits are plotted on a colorscale from -2 to 2.

Recovered Conductivity Model
The conductivity model recovered at the 12th iteration is shown below. According to the recovered model:
• The range of recovered conductivity values spans many orders of magnitude.
• There is an extremely conductive structure near X = 1500 m and a secondary conductive structure at X = 950 m.
• There is a very resistive structure East of X = 700 m.

630

Chapter 10. Comprehensive Workflows

GIFtoolsCookbook Documentation, Release 1.0

Fig. 30: Recovered model at iteration 12.
2D IP Tutorial Data (Line 1)
Once the inversion outputs have been loaded (done in the inversion section )
• View convergence
The Tikhonov curve for our tutorial inversion is shown below. According to the figure:
• the Tikhonov curve begins to flatten significantly after iteration 4 (chi-factor = 1.6). This indicates we may have
under-estimated our uncertainties.
• the data misfit is decreasing over the course of the beta cooling schedule.
• the inversion is able to reach target misfit between iterations 5 and 6 (chi-factor = 1)

Fig. 31: Tikhonov curve.
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Data Misfit
According the Tikhonov curve, the recovered model at iteration 5 has a good chance of explaining the data without
fitting the noise. This is assuming we have accurately estimated the uncertainties on our data. To be sure however,
we must examine the observed data, predicted data and data misfit for the corresponding model. Here are some good
questions to ask during this step:
• Are the prominent anomaly features identified in the observed data also found in the predicted data?
• Are there obvious coherent features in the normalized misfit maps? If so, this indicates you are over-fitting certain
regions at the expense of others and that you must assign new uncertainties and re-run the inversion.
For iteration 5, we used the split data based on electrode geometry to separate the dipole-pole and pole-dipole data
once again. For each electrode configuration, we see the predicted data, observed data and normalized misfit below.
For this survey line, we saw that:
• Data structures in the dipole-pole and pole-dipole data are reasonably well reproduced.
• Normalized misfits generally lie within a range of [-2, 2].
• The highest normalized misfit values are associated with anomalous apparent chargeability values. This could
be caused by a) under-estimating the floor uncertainty and/or b) over-estimating the percent uncertainty.
For this exercise, we will not assign new uncertainties and re-run the inversion. In practice however, you may choose
to decrease the percent uncertainty on the pole-dipole data.

Fig. 32: Predicted data, oberved data and normalized data misfit (dipole-pole). Predicted data are plotted on the same
scale. Normalized misfits are plotted on a colorscale from -2 to 2.

Fig. 33: Predicted data, oberved data and normalized data misfit (pole-dipole). Predicted data are plotted on the same
scale. Normalized misfits are plotted on a colorscale from -2 to 2.
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Recovered Chargeability Model
The chargeability model recovered at the 5th iteration is shown below. According to the recovered model:
• The model at iteration 5 fits the data appropriately. However, the structures in this model were less geologically
plausible than observed in iteration 4. This suggests the ideal chi factor is somewhere between that of the 4th
and 5th iteration.
• The secondary conductive structure at X = 950 m appears to be chargeable but the primary conductive structure
at X = 1500 m is not.

Fig. 34: Recovered model at iteration 5.

10.2.6 Batch 2D Inversion
The user may choose to assign distinct uncertainties to each line of 2D DC/IP data and invert the respecitve lines
independently. If the same set of parameters is to be used for each DC/IP line however, the inversions can be run as
part of a batch. The batch inversion works well if 1) you have run test inversions on one or more survey lines and, 2)
both the uncertainties and chi-factor are reasonable. Here, we demonstrate how to run a batch inversion for all DC and
IP survey lines.
2D DC Batch Inversion
Defining an Inversion Template
Here, we define the parameters that will be used when inverting each survey line. To create the template:
• Create a new 2D DC inversion object and select a working directory when prompted. It is important
that you create a new inversion object for this.
• Use edit options to set the parameters for the inversion.
• Click Apply. Do not write the files.
For the tutorial data, we used the same parameters as before; except for the trade-off parameter which
was set to Discrepancy option with a chi-factor of 1.
Note:
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• You will need to enter placeholders for the data and topography, but they will be ignored during the batch inversion.
• If you are confident in your misfits and chi-factor, use the Discrepancy option when defining the trade-off parameter.

Performing the Batch Inversion
To set up and run the batch inversion, apply the following under the Batch Inversion menu:
• Set inversion template to the 2D DC inversion object you created
• Set the 2D DC data objects (the data object for each survey line). If applicable, GIFtools will prompt you to
select the associated topography objects.
• Create/Write all 2D inversion objects. If sensitivity weighting is being applied, GIFtools will automatically
compute the sensitivity weights. Please allows this step to finish before doing anything else.
• Run inversions
Results
If the Discrepancy option was used, the user believes the chi-factor is the same for all survey lines. You can use
functionality under the Batch Inversion menu to:
• Load the final model or the first to reach the chi-factor for all 2D inversions.
If the Default option was selected for the trade-off parameter, the user believes the chi-factor for each survey line
could be different. For each 2D inversion object, the user must analyze the inversion results and choose a final model
according to the Analyzing 2D Inversion Results section of this tutorial.
Interpolation to 3D Mesh
Once you have completed the batch inversion, it is benefitial to compare the set of recovered 2D models side by side.
You may also want to interpolate the 2D slices to approximate 3D geometries. Here, we interpolate the set of recovered
2D models onto a 3D tensor mesh. We start by creating a 3D tensor mesh on which the 2D slices can live. Next, we
place the set of 2D models onto the 3D mesh. Finally, we interpolate the 2D slices to create a 3D model.
1. Creating the mesh:
• Create 3D tensor mesh
– Use the 3D DC data object to calculate limits of the core mesh region
– Make any adjustments to parameters
– Click OK
For the tutorial data, the set of parameters used to create the 3D mesh is shown in the image below.
Important: The user is strongly urged to:
• Set dx and dz to match the values used for constructing the 2D mesh. And let dx = dy.
• Remove any padding unless it is important for interpretation.
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Fig. 35: Parameters used to create 3D tensor mesh.

2. Placing 2D slices on the 3D mesh
Once the 3D mesh has been created, select any of the Batch Inversion objects and:
• Merge all to interpolate to 3D mesh.
For the tutorial data, we see the set of recovered 2D conductivity models below.
3. Interpolate 2D slices to create 3D model
To gain insight with regards to 3D structures, you may want to interpolate the 2D slices to create the fully 3D model.
To do this, you can use an inverse distance interpolation:
• Fill no data values with inverse disctance interpolation
For the tutorial data, the parameters used for the interpolation and the final 3D model are shown below.
2D IP Batch Inversion
The process for creating and running a 2D IP batch inversion is nearly identical to that of a 2D DC batch inversion.
When prompted, the batch inversion will ask you for the associated set of 2D DC inversion objects. This is done to
assign a background conductivity model for each IP inversion.
For the tutorial data, we used the same parameters as before when creating the template for the batch inversion; except
for the trade-off parameter which was set to Discrepancy option with a chi-factor of 1. The 2D slices were places on
the same 3D mesh, then interpolated to obtain the 3D chargeability model.
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Fig. 36: 2D conductivity models with Discrepancy and a chi-factor of 1.

Fig. 37: Interpolation parameters and interpolated 3D conductivity model for tutorial data.
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Fig. 38: 2D chargeability models with Discrepancy and a chi-factor of 1.

Fig. 39: Interpolation parameters and interpolated 3D chargeability model for tutorial data.
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10.2.7 OcTree Mesh Design
Here we provide a basic approach for mesh design when inverting DC/IP data. Mesh design for DC/IP problems depend
on both the maximum and minimum electrode spacing. We explain how to create an OcTree mesh based on DC/IP
survey geometry. We also explain the reasoning for the parameter values entered for the tutorial data. We can create
OcTree meshes from DC/IP surveys with the following utility:
• create OcTree mesh with DC/IP utilities
Once you have created the object, complete the following steps:
1) Set the data object corresponding to the survey
2) Define the mesh using Edit Options
3) Run the utility
4) Load results. The files loaded will include a data file data_Z.txt wherein the surface electrodes have been projected to the discrete surface topograpy.
For the tutorial data, the parameters set in Edit Options are shown below. For definitions of the parameters, consult
the DCIP octree manual .

Fig. 40: Parameters used to define the mesh for the field dataset using DCIP OcTree mesh utility.
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Comments on Choosing Parameters
File format: Since all electrodes are located on the Earth’s surface (i.e. no borehole), we use the surface option to
project all electrodes to the disrete surface topograpy. If we had borehole data, we would use the general file format
option.
Minimum cell size: The minimum cell size is determined by the minimum electrode spacing. To have sufficient
accuracy, you must have at least 2.5 to 4 cells between each electrode.
Core region discretization: Thickness 1 should be used to discretize the region with the largest currents. For dipoledipole data, this should be 30% to 50% the size of the largest electrode spacing. For pole-dipole or dipole-pole data,
this should 75% to 100% the size of the largest electrode spacing. If you let Thickness 1 be on the smaller side, make
sure Thickness 2 is equal or greater than Thickness 1.
Padding cell expansion: The extent of the mesh depends on the largest electrode spacing. The thickness of the padding
should be about 2-3 times the length of the largest electrode spacing.
Number of cells around Rx: The number of fine mesh cells near receivers must be sufficiently large to model the
electric potentials near electrodes accurately. It is important to set RX cells #1 to be between 4 and 8.
Make polygon: This parameter controls the horizontal extent of the core mesh region. In practice, the distance between
any electrode and the horizontal edges of the core mesh region should be 2-3 times larger than the smallest electrode
spacing.

10.2.8 Project Electrodes to Discrete Surface
When creating an OcTree mesh, the output included at data file data_Z.txt wherein all surface electrodes have already
been projected to the discrete surface topography. So if you are only working with DC data, and you used the DC data
(with data and uncertainties) to create the mesh, simply use data_Z.txt as the observations file in your DC inversion.
However if you have DC and IP data, you still need to project the IP electrodes to the discrete surface topography.
Here we provide the standard approach for creating a new DC/IP data object where the surface electrodes have been
projected to the discrete surface topograpy. For the tutorial, we apply the utility to the IP data. To create the utility:
• create surface electrodes utilities
Once you have created the object, complete the following steps:
1) Define the data and other parameters using Edit Options
2) Run the utility
3) Load results
For the tutorial data, the parameters set in Edit Options are shown below. Since we do not have borehole data, we
used the surface format. For definitions of the parameters, consult the DCIP octree manual .

10.2.9 DC OcTree Inversion: Weights and Reference Models
Weights are used to reduce artifacts causes by the sensitivity of the data to cell near electrodes. Starting and reference
models can be used to constrain the data with a-priori information. In this section we demonstrate how to:
• Create near-surface interface weights
• Create sensitivity weights for the DC inversion
• Create a starting/reference model from the batch 2D inversion result
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Fig. 41: Parameters used when running the utility.
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Important: The ideal weights for DC inversion is very problem-dependent. And as of yet, there isn’t fool-proof recipe
for constructing these weights. We will, however, describe a reasonable set of starting parameters for these utilities.
We generally encourage the user to implement interface weights OR sensitivity weights but NOT both; unless they are
very confident in how it will impact their inversion result.

Near-Surface Interface Weighting
When inverting DC data, the code has a tendency to place conductive structures near electrode locations due to the
sensitivity of the data to those locations. One way to counteract this problem is to generate interface weights. By
forcing lateral smoothness within the top few layers of cells, we can limit near-surface artifacts and force the inversion
to place conductive structures at the appropriate depths. The rule of thumb is to define 2-4 layers. From the top layer
down, the weighting value should decrease exponentially by a factor of 2-3; e.g. [20, 10, 5].
Near-surface interface weights are simple to implement and fairly intuitive to understand. However this approach
for reducing the aforementioned artifacts has its pros and cons. When the lateral variation in near-surface electrical
conductivity is smooth, this approach is ideal. Essentially, the near-surface geology matches the regularization you are
imposing. Therefore you can reduce the artifacts without compromising the inversion’s ability to fit the data. When the
lateral variation in near-surface electrical conductivity is highly variable, you are imposing a regularization that fights
against your inversion’s ability to fit the data. When excessive near-surface interface weighting is applied, the inversion
will have a very difficult time reaching target misfit. Limited testing also suggests near-surface interface weighting is
less effective when the topography is very rough.
To create interface weights:
• Create and interface weights utility
• Use edit options and set the following parameters:
– set the OcTree mesh
– set the model
– set as log model for DC inversion
– set topography as the active cells model
– set number of layers and corresponding weights
– for inhomogeous background models, set the face value and face tolerance
• Run the utility
• Load results
For the tutorial data, we set 2 layers of interface weights with values of 10 and 4. Earlier attempts to invert the data
used larger interfaces weights and more layers, however the inversion struggled to reach target misfit in this case. It
was thought that by applying very large interface weights, we were not able to recover near-surface inhomogeneities
that exist in the true conductivity model.

10.2. Comprehensive Workflows: DC and IP

641

GIFtoolsCookbook Documentation, Release 1.0

Sensitivity Weighting for DC Inversion
Important: Since the initial creation of the sensitivity weights utility, analytic methods for computing the average
sensitivities and RMS sensitivities have been added. In practice, we suggest using these methods over the approximate
methods.
Sensitivity weighting is another approach for reducing near-surface artifacts at the location of electrodes. For this
approach, we approximate the root mean squared sensitivities for a given conductivity model and use them to construct cell weights. The cell weights counteract the inversion’s natural inclination to place conductive structures at the
locations of highest sensitivity; i.e. at the electrode locations.
This approach is better suited when the topography is rough; compared to interface weighting. The user should keep
several things in mind when using sensitivity weights. 1) For the DC octree code, the sensitivities are approximated
with Hutchinson’s method because it is too time-consuming to compute the true sensitivities. The user will need to
apply a smoothing factor to reduce ‘pixelation’ in the cell weights model. If the sensitivity weighting is too large, the
inversion may place artifacts in the space between surface lines. Generally, we suggest setting the number of samples
to be 5-20, using a truncation factor of 0.05-0.2 and to smooth 1-4 times.
To create a cell weights model for the DC inversion using the sensitivities, do the following:
• Create a DCIP sensitivity weights utility
• Use edit options to set the parameters and click Apply
• Write the input files
• Run sensitivities
• Run sens2weights
• Load results
For the tutorial data, the input parameters and sensitivity weights are shown below. In this case, we set the truncation
factor to 0.25. In earier inversion attempts, we found that large sensitivity weights forced near-surface conductive
structures to collect in the space between surface lines instead of pushing them to an appropriate depth.
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Starting/Reference Model from Batch 2D Inversion
In the 2D batch inversion section, we generated a 3D conductivity model by interpolating the set of 2D slices. If we have
confidence in the structures recovered from the batch 2D inversion, we may want to use it as a starting and/or reference
model. To do this, we must interpolate the 3D tensor model onto the OcTree mesh we generated in the previous section
. To accomplish this, we use:
• Interpolate with nearest neighbour
For the tutorial data, the parameters used and the resulting OcTree model are shown below. When nearest neighbour
was used for the padding cell options, the padding in the reference model contained large anomalous structures that
impacted the predicted data and created obvious artifacts in the inversion result. When using set padding to constant ,
the large discontinuity created at the edge of the core mesh region greatly impacted the regularization. The inversion
tried to smooth this out at the expense of evenly fitting the data. It was only by using the decay to constant option that
artifacts were minimized and acceptable convergence was observed.

Fig. 42: Interpolation parameters and reference/starting conductivity model on OcTree mesh for tutorial data.

10.2.10 General DC OcTree Inversion
Here we present the standard steps for completing a DC OcTree inversion and performing a general analysis of results.
The steps are organized as follows:
1. Set up, run and load inversion results
2. Examine the convergence
3. Examine the data misfit
4. Examine the recovered model
Important: The inversion parameters chosen for this exercise work well for the tutorial data. However, the optimum
choice in inversion parameters is problem-dependent. The parameters chosen here should not be blindly chosen to
invert other datasets.
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Create, Run and Load Inversion
We can now invert DC data using the DCIP OcTree package. To do this:
• Create a DC OcTree inversion object
• Use edit options to set the inversion parameters
• Click Apply and write files
• Run the inversion
• Load results
For the tutorial data, the following parameters were used in the inversion. A thorough discussion of the input parameters and their impact on the final inversion result is discussed in the DC OcTree Inversion using Weights and Reference
Models section. For now, we invert to recover the smoothest model with modest near-surface interface weights.

Fig. 43: Parameters used to invert the tutorial dataset.

Convergence
Once the inversion has completed:
• View convergence
For the tutorial data, the Tikhonov curve is shown below on a semilog-y plot. According to the figure and the log
file:
• the inversion reaches target misfit (chi-factor = 1 in this case) between beta iteration 9 and 10; recall that there
are several Gauss-Newton iteration for each beta. And the algorithm is converging over the course of the beta
cooling schedule.
• There isn’t an obvious place in which the curve ‘flattens out’, indicating the choice in optimum model is a little
subjective.
• We will need to examine the data misfits and recovered models to determine the quality of our result.
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Data Misfit
According the Tikhonov curve, the recovered model at iteration 9 has a good chance of explaining the data without fitting
the noise. To be sure however, we must examine the observed data, predicted data and data misfit for the corresponding
model. Here are some good questions to ask during this step:
• Are the prominent anomaly features identified in the observed data also found in the predicted data?
• Are there obvious coherent features in the normalized misfit maps? If so, this indicates you are over-fitting certain
regions at the expense of others and that you must assign new uncertainties and re-run the inversion.
• Are the ranges of normalized misfits for each for each survey line balanced? If not, you may need to adjust the
uncertainties and re-run the inversion.
For the tutorial data, we have both pole-dipole and dipole-pole data along each survey line. To examine the misfit
maps, we needed to:
1. Assign line IDs to the DC3D predicted data object
2. Create 2D survey lines from line ID and split the pole-dipole and dipole-pole data based on electrode geometry.
3. Plot with VTK to examine observed data, predicted data and normalized misfit.
For line 5, the predicted data reproduces the field observations quite well. Normalized misfits lie within [-2, 2]. The
misfit map for the pole-dipole data shows relatively uncorrelated errors but the dipole-pole misfit map shows some
small coherent features. We will not do it here, but the user is encouraged to examine the misfit maps for other survey
lines.

Fig. 44: Predicted data, observed data and normalized data misfit (dipole-pole) for the 5th survey line. Predicted data
are plotted on the same scale. Normalized misfits are plotted on a color scale from -2 to 2.
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Fig. 45: Predicted data, observed data and normalized data misfit (pole-dipole) for the 5th survey line. Predicted data
are plotted on the same scale. Normalized misfits are plotted on a color scale from -2 to 2.

Recovered Model
For the tutorial data, the conductivity model recovered at the 9th iteration is shown below at 3 depths. According to
the recovered model:
• We can see some near-surface inhomogeneity but it is not highly pixelated. Since the inversion would not converge when large interface weights were applied, we have likely applies reasonable interface weighting for this
problem
• There is a large NS conductor between X = 12,000 m and 12,500
• There is a large resistive unit West of X = 11,500 m
• The electrical resistivities lie within the range of apparent resistivities observed and lie within the known range
of electrical resistivities for these units

Fig. 46: Recovered model at iteration 9.
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10.2.11 DC OcTree Inversion using Weights and Reference Models
The final inversion result depends strongly on the regularization parameters, reference/starting model and on the weighting provided. Here, we
• invert the data for several cases
• discuss the choice in input parameters, models and weightings for each inversion, and
• compare the inversion results
Smoothest Inversion with Near-Surface Interface Weights
The parameters chosen for this inversion approach are meant to recover a model that is constrained by the data, not
constrained by any a-priori information, and limits near-surface artifacts with near-surface lateral smoothing.
Discussion of Parameters

Fig. 47: Parameters used to invert for the smoothest model using interface weights.
Beta cooling schedule: The custom cooling schedule was determined by using Default for cursory inversion. We
determined the range of beta values in which the inversion started to converge and used it for subsequent inversions.
Weighting constants (alpha S, E, N, Z): To recover the smoothest model, we set alpha S = 1e-6 (or something else
very small). By doing this, the contribution of the smallness term in the model objective function becomes negligible.
By setting alpha E = 0.5, alpha N = 8 and alpha Z = 1, we wanted the recovered model to be very smooth in the NS
direction and somewhat less smooth in the EW direction. Our goal for the smoothness was to smooth out artifacts
associated with EW survey lines and to recover geological structures that trended NS (known at the survey site).
Initial and reference models: Based on the range of apparent resistivities observe in the data, a reference and starting
model of 0.01 S/m was chosen.
Role of mref in model objective function: Since alpha S is extremely small, the smallness term is negligible. However,
by choosing Update reference model throughout, the inversion will replace the reference model with the current model
for each new beta value. And by setting SMOOTH_MOD_DIF, the inversion will attempt to preserve the derivatives
(interfaces and smooth areas) that are evolving over the course of the inversion.
Interface weights: Earlier attempts to invert the data used larger interfaces weights and more layers, however the
inversion struggled to reach target misfit in this case. It was thought that by applying very large interface weights, we
were not able to recover near-surface inhomogeneities that exist in the true conductivity model.
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Discussion of Results
The conductivity model recovered at the 9th iteration is shown below at 3 depths. According to the recovered model:
• We can see some near-surface inhomogeneity but it is not highly pixelated. Since the inversion would not converge when large interface weights were applied, we have likely applies reasonable interface weighting for this
problem.
• There is a large NS conductor between X = 12,000 m and 12,500.
• There is a large resistive unit West of X = 11,500 m
• The electrical resistivities lie within the range of apparent resistivities observed and lie within the known range
of electrical resistivities for these units.
Without a-priori information, the inversion was able to produce a model which adequately recovers the expected conductive and resistive structures.

Fig. 48: Recovered model at iteration 9.

Smoothest Inversion with Sensitivity Weights
The parameters chosen for this inversion approach are meant to recover a model that is constrained by the data, not
constrained by any a-priori information, and limits sensitivity-based artifacts through sensitivity weighting.
Discussion of Parameters
Beta cooling schedule: The custom cooling schedule was determined by using Default for cursory inversion. We
determined the range of beta values in which the inversion started to converge and used it for subsequent inversions.
Weighting constants (alpha S, E, N, Z): To recover the smoothest model, we set alpha S = 1e-6 (or something else
very small). By doing this, the contribution of the smallness term in the model objective function becomes negligible.
By setting alpha E = 0.5, alpha N = 8 and alpha Z = 1, we wanted the recovered model to be very smooth in the NS
direction and somewhat less smooth in the EW direction. Our goal for the smoothness was to smooth out artifacts
associated with EW survey lines and to recover geological structures that trended NS (known at the survey site).
Initial and reference models: Based on the range of apparent resistivities observe in the data, a reference and starting
model of 0.01 S/m was chosen.
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Fig. 49: Parameters used to invert for the smoothest model using sensitivity weighting.
Role of mref in model objective function: Since alpha S is extremely small, the smallness term is negligible. However,
by choosing Update reference model throughout, the inversion will replace the reference model with the current model
for each new beta value. And by setting SMOOTH_MOD_DIF, the inversion will attempt to preserve the derivatives
(interfaces and smooth areas) that are evolving over the course of the inversion.
Sensitivity weights: Earlier attempts to invert the data used a smaller truncation value so that we had very large cell
weights in the region of high sensitivity. However we found that large sensitivity weights forced near-surface conductive
structures to collect in the space between surface lines.
Discussion of Results
The conductivity model recovered at the 9th iteration is shown below at 3 depths. According to the recovered model:
• The near-surface shows much more prominent near-surface artifacts than the previous inversion.
• Here the sensitivity weighting was not high enough to push conductive structures to their correct depth, but was
high enough to push conductive structures laterally away from the electrodes.
• There is a large NS conductor between X = 12,000 m and 12,500 but it is clustered significantly nearer to the
surface.
• There is a large resistive unit West of X = 11,500 m that is recovered fairly well.
• The electrical resistivities lie within the range of apparent resistivities observed and lie within the known range
of electrical resistivities for these units.
Without a-priori information, the inversion was able to generally reproduce the features of the previous inversion. However, the sensitivity weights applied were not able to mitigate near-surface artifacts are successfully as the near-surface
interface weighting. The inversion result also clusters conductors too near to the surface. We have less confidence in
this results, and attempts to invert IP data will likely produce and incorrect chargeability model.
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Fig. 50: Recovered model at iteration 9.
Inversion Constrained by Reference Model
The parameters chosen for this inversion approach are meant to recover a model that is constrained by a-priori information in the form of a reference model but also explains the data sufficiently.
Discussion of Parameters

Fig. 51: Parameters used to constrain the inversion with the reference model.
Beta cooling schedule: The custom cooling schedule was determined by using Default for cursory inversion. We
determined the range of beta values in which the inversion started to converge and used it for subsequent inversions.
Weighting constants (alpha S, E, N, Z): Where dh is the cell dimension, and assuming alpha E = alpha N = alpha Z
= 1, the impact of the smallness and smoothness on the model objective function is thought to be somewhat balanced
when alpha S ∼ 1/𝑑ℎ2 . Here we set alpha S = 0.001 to balance the smallness and smoothness. We let alpha N = 4 to
encourage smoothness in the NS direction.
Initial and reference models: Here we use the OcTree model that was interpolated from the batch 2D inversion results.
Role of mref in model objective function: Here we use SMOOTH_MOD. This implies we want to preserve structures
in the reference model but NOT the gradients. Our thought was that the 2D inversion result generally placed anomalous
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structures in the correct areas. However, the exact dimensions and locations were distorted due to interpolation and 3D
effects. We attempt to reduce this distortion by Updating reference model throughout.
Interface weights: Since the interface weights worked well for the smoothest inversion with interface weights , we
used the same interface weights here to reduce near-surface artifacts.
Discussion of Results
The conductivity model recovered at the 10th iteration is shown below at 3 depths. According to the recovered model:
• We can see some modest artifacts due to the reference model but in general this results matches that of the
smoothest inversion with interface weights.
• There is a large NS conductor between X = 12,000 m and 12,500.
• There is a large resistive unit West of X = 11,500 m
• With less emphasis on NS smoothing, it is more likely that we can recover the NS margins of anomalous features
using the reference model.
With a reference model, the inversion was able to produce a model which has more well-defined margins for each unit;
whereas the smoothest inversion does not.

Fig. 52: Recovered model at iteration 10.

Largest Conductor for Each Inversion
Here, we plot the reference model and recovered models for a cutoff of 𝜎 > 1 S/m. We notice 2 important things here:
1. That unlike the reference model and other inversions, the inversion with sensitivity weights clusters the conductor
much nearer to the surface.
2. Large conductive structures observed in the Western portion of the reference model are not reproduced by any
of the inversion results and are likely artifacts.
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10.2.12 IP OcTree Inversion: Weights and Reference Models
Weights are used to reduce artifacts causes by the sensitivity of the data to cell near electrodes. Starting and reference
models can be used to constrain the data with a-priori information. In this section we demonstrate how to:
• Create near-surface interface weights
• Create sensitivity weights for the IP inversion
• Create a starting/reference model from the batch 2D inversion result
Important: The ideal weights for IP inversion is very problem-dependent. And as of yet, there isn’t fool-proof recipe
for constructing these weights. We will, however, describe a reasonable set of starting parameters for these utilities.
We generally encourage the user to implement interface weights OR sensitivity weights but NOT both; unless they are
very confident in how it will impact their inversion result.

Near-Surface Interface Weighting
When inverting IP data, the code has a tendency to place conductive structures near electrode locations due to the
sensitivity of the data to those locations. One way to counteract this problem is to generate interface weights. By
forcing lateral smoothness within the top few layers of cells, we can limit near-surface artifacts and force the inversion
to place chargeable structures at the appropriate depths. The rule of thumb is to define 2-4 layers. From the top layer
down, the weighting value should decrease exponentially by a factor of 2-3; e.g. [20, 10, 5].
Near-surface interface weights are simple to implement and fairly intuitive to understand. However this approach for
reducing the aforementioned artifacts has its pros and cons. When the lateral variation in near-surface chargeability
is smooth, this approach is ideal. Essentially, the near-surface geology matches the regularization you are imposing.
Therefore you can reduce the artifacts without compromising the inversion’s ability to fit the data. When the lateral
variation in near-surface chargeability is highly variable, you are imposing a regularization that fights against your
inversion’s ability to fit the data. When excessive near-surface interface weighting is applied, the inversion will have a
very difficult time reaching target misfit. Limited testing also suggests near-surface interface weighting is less effective
when the topography is very rough.
To create interface weights:
• Create and interface weights utility
• Use edit options and set the following parameters:
– set the OcTree mesh
– set the model
– set as log model for DC inversion
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– set topography as the active cells model
– set number of layers and corresponding weights
– for inhomogeous background models, set the face value and face tolerance
• Run the utility
• Load results
For the tutorial data, we set 2 layers of interface weights with values of 10 and 4 (same as in the DC inversion).
Earlier attempts to invert the data used larger interfaces weights and more layers, however the inversion struggled to
reach target misfit in this case. It was thought that by applying very large interface weights, we were not able to recover
near-surface inhomogeneities that exist in the true conductivity model.
Sensitivity Weighting for IP Inversion
Important: Since the initial creation of the sensitivity weights utility, analytic methods for computing the average
sensitivities and RMS sensitivities have been added. In practice, we suggest using these methods over the approximate
methods.
Sensitivity weighting is another approach for reducing near-surface artifacts at the location of electrodes. For this
approach, we approximate the root mean squared sensitivities for a given model and use them to construct cell weights.
The cell weights counteract the inversion’s natural inclination to place chargeable structures at the locations of highest
sensitivity; i.e. at the electrode locations.
This approach is better suited when the topography is rough; compared to interface weighting. The user should keep
several things in mind when using sensitivity weights. 1) For the IP octree code, the sensitivities are approximated with
Hutchinson’s method because it is too time-consuming to compute the true sensitivities. The user will need to apply a
smoothing factor to reduce ‘pixelation’ in the cell weights model. If the sensitivity weighting is too large, the inversion
may place artifacts in the space between surface lines. Generally, we suggest setting the number of samples to be 5-20,
using a truncation factor of 0.05-0.2 and to smooth 1-4 times.
To create a cell weights model for the IP inversion using the sensitivities, do the following:
• Create a DCIP sensitivity weights utility
• Use edit options to set the parameters and click Apply
• Write the input files
• Run sensitivities
• Run sens2weights
• Load results
For the tutorial data the input parameters and sensitivity weights are shown below.
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Starting/Reference Model from Batch 2D Inversion
In the 2D batch inversion section, we generated a 3D chargeability model by interpolating the set of 2D slices. If we
have confidence in the structures recovered from the batch 2D inversion, we may want to use it as a starting and/or
reference model. To do this, we must interpolate the 3D tensor model onto the OcTree mesh we generated in an earlier
section . To accomplish this, we use:
• Interpolate with nearest neighbour
For the tutorial data, the parameters used and the resulting OcTree model are shown below. When nearest neighbour
was used for the padding cell options , the padding in the reference model contained large anomalous structures that
impacted the predicted data and created obvious artifacts in the inversion result. When using set padding to constant ,
the large discontinuity created at the edge of the core mesh region greatly impacted the regularization. The inversion
tried to smooth this out at the expense of evenly fitting the data. It was only by using the decay to constant option that
artifacts were minimized and acceptable convergence was observed.

10.2.13 General IP OcTree Inversion
Here we present the standard steps for completing an IP OcTree inversion and performing a general analysis of results.
The steps are organized as follows:
1. Set up, run and load inversion results
2. Examine the convergence
3. Examine the data misfit
4. Examine the recovered model
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Fig. 53: Interpolation parameters and reference/starting chargeability model on OcTree mesh for tutorial data.
Create, Run and Load Inversion
We can now invert DC data using the DCIP OcTree package. To do this:
• Create an IP OcTree inversion object
• Use edit options to set the inversion parameters
• Click Apply and write files
• Run the inversion
• Load results
For the tutorial data, the following parameters were used in the inversion. A thorough discussion of the input parameters and their impact on the final inversion result is discussed in the DC OcTree Inversion using Weights and Reference
Models section. For now, we invert to recover the smoothest model with modest near-surface interface weights.
Convergence
Once the inversion has completed:
• View convergence
For the tutorial data, the Tikhonov curve is shown below. According to the figure and the log file:
• the inversion converges over the course the cooling schedule.
• the inversion reaches target misfit (chi-factor = 1 in this case) between iteration 2 and 3, at which point the
curve begins to ‘flatten’; recall that there are several Gauss-Newton iteration for each beta. And the algorithm is
converging over the course of the beta cooling schedule.
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Fig. 54: Parameters used to invert the field dataset.
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Data Misfit
According the Tikhonov curve, the recovered model at iteration 3 has a good chance of explaining the data without fitting
the noise. To be sure however, we must examine the observed data, predicted data and data misfit for the corresponding
model. Here are some good questions to ask during this step:
• Are the prominent anomaly features identified in the observed data also found in the predicted data?
• Are there obvious coherent features in the normalized misfit maps? If so, this indicates you are over-fitting certain
regions at the expense of others and that you must assign new uncertainties and re-run the inversion.
• Are the ranges of normalized misfits for each for each survey line balanced? If not, you may need to adjust the
uncertainties and re-run the inversion.
For the tutorial data, we have both pole-dipole and dipole-pole data along each survey line. To examine the misfit
maps, we needed to:
1. Assign line IDs to the IP3D predicted data object
2. Create 2D survey lines from line ID and split the pole-dipole and dipole-pole data based on electrode geometry.
3. Plot with VTK to examine observed data, predicted data and normalized misfit.
For line 5, the predicted data reproduces the field observations well but slightly under-fits the amplitude of the IP
anomaly in the dipole-pole data. Normalized misfits lie within [-2, 2]. The misfit map for the pole-dipole data shows
uncorrelated errors but the dipole-pole misfit map shows some small coherent features associated with under-fitting
the anomaly amplitude. We will not do it here, but the user is encouraged to examine the misfit maps for other survey
lines.

Fig. 55: Predicted data, observed data and normalized data misfit (dipole-pole) for the 5th survey line. Predicted data
are plotted on the same scale. Normalized misfits are plotted on a color scale from -2 to 2.

Fig. 56: Predicted data, observed data and normalized data misfit (pole-dipole) for the 5th survey line. Predicted data
are plotted on the same scale. Normalized misfits are plotted on a color scale from -2 to 2.
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Recovered Model
For the tutorial data, the chargeability model recovered at the 3rd iteration is shown below at 3 depths. According to
the recovered model:
• We can see some effects at the surface due to the sensitivity of the data to the electrodes, but it is manageable.
• Several prominent chargeable features are observed in the Z = 349 m slice.
• The large resistor to the West is non-chargeable
• The large NS conductor does not exhibit chargeability

Fig. 57: Recovered model at iteration 3.

10.2.14 IP OcTree Inversion using Weights and Reference Models
The final inversion result depends strongly on the regularization parameters, reference/starting model, background
conductivity model and on the weighting provided. Here, we
• invert the data for several cases
• discuss the choice in input parameters, models and weightings for each inversion, and
• compare the inversion results
Smoothest Inversion with Near-Surface Interface Weights
The parameters chosen for this inversion approach are meant to recover a model that is constrained by the data, not
constrained by any a-priori information, and limits near-surface artifacts with near-surface lateral smoothing.
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Discussion of Parameters

Conductivity Model: We used the conductivity model presented in the smoothest DC inversion with interface weights
section
Weighting constants (alpha S, E, N, Z): To recover the smoothest model, we set alpha S = 1e-6 (or something else
very small). By doing this, the contribution of the smallness term in the model objective function becomes negligible.
By setting alpha E = 1, alpha N = 4 and alpha Z = 1, we wanted to smooth out artifacts associated with EW survey
lines but did not want to excessively force NS smoothness in recovered chargeability structures.
Initial and reference models: Here, we assume that we are looking for chargeable bodies within a non-chargeable
background. As a result, the reference model is set to zero. The inversion cannot produce a model update for a 0 model.
As a result, the starting model is set to something sufficiently small.
Bounds: Chargeability is a strictly positive physical property. As a result we set a lower bound of 0. The upper bound
is made redundant by choosing a value much larger than the range of apparent chargeabilities. Note that DC inversion
does not have this problem because we invert for the log-conductivity which can be negative.
Role of mref in model objective function: Since alpha S is extremely small, the smallness term is negligible. However,
by choosing Update reference model throughout, the inversion will replace the reference model with the current model
for each new beta value. And by setting SMOOTH_MOD_DIF, the inversion will attempt to preserve the derivatives
(interfaces and smooth areas) that are evolving over the course of the inversion.
Interface weights: Earlier attempts to invert the data used larger interfaces weights and more layers, however the
inversion struggled to reach target misfit in this case. It was thought that by applying very large interface weights, we
were not able to recover near-surface inhomogeneities that exist in the true conductivity model.
Discussion of Results
The chargeability model recovered at the 3rd iteration is shown below at 3 depths. According to the recovered model:
• We can see some near-surface inhomogeneity but it is not highly pixelated.
• Several compact chargeable bodies are recovered.
• The range of recovered chargeabilities lies within the range of values for the apparent chargeability data.
Without a-priori information, the inversion was able to produce a model which adequately recovers plausible chargeable
structures.
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Fig. 58: Recovered model at iteration 3.
Smoothest Inversion with Sensitivity Weights
Discussion of Parameters

Conductivity Model: We used the conductivity model presented in the smoothest DC inversion with sensitivity weights
section
Weighting constants (alpha S, E, N, Z): To recover the smoothest model, we set alpha S = 1e-6 (or something else
very small). By doing this, the contribution of the smallness term in the model objective function becomes negligible.
By setting alpha E = 1, alpha N = 4 and alpha Z = 1, we wanted to smooth out artifacts associated with EW survey
lines but did not want to excessively force NS smoothness in recovered chargeability structures.
Initial and reference models: Here, we assume that we are looking for chargeable bodies within a non-chargeable
background. As a result, the reference model is set to zero. The inversion cannot produce a model update for a 0 model.
As a result, the starting model is set to something sufficiently small.
Bounds: Chargeability is a strictly positive physical property. As a result we set a lower bound of 0. The upper bound
is made redundant by choosing a value much larger than the range of apparent chargeabilities. Note that DC inversion
does not have this problem because we invert for the log-conductivity which can be negative.
Role of mref in model objective function: Since alpha S is extremely small, the smallness term is negligible. However,
by choosing Update reference model throughout, the inversion will replace the reference model with the current model
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for each new beta value. And by setting SMOOTH_MOD_DIF, the inversion will attempt to preserve the derivatives
(interfaces and smooth areas) that are evolving over the course of the inversion.
Sensitivity weights: A standard truncation factor (= 0.05) was used when generating the sensitivity weights for the IP
inversion.
Discussion of Results
The chargeability model recovered at the 2nd iteration is shown below at 3 depths. According to the recovered model:
• Because the quality of the DC inversion for the sensitivity weights approach was poor and contained artifacts,
the quality of the IP inversion was poor and contained artifacts.
• Sensitivity to the near-surface resulted in chargeable bodies of lower amplitude being placed there.
It should be obvious this result in unsatisfactory.

Fig. 59: Recovered model at iteration 2.

Inversion Constrained by Reference Model
Discussion of Parameters
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Conductivity Model: We used the conductivity model presented in the DC inversion constrained with reference model
section
Weighting constants (alpha S, E, N, Z): Where dh is the cell dimension, and assuming alpha E = alpha N = alpha Z
= 1, the impact of the smallness and smoothness on the model objective function is thought to be somewhat balanced
when alpha S ∼ 1/𝑑ℎ2 . Here we set alpha S = 0.001 to balance the smallness and smoothness. By setting alpha E =
1, alpha N = 4 and alpha Z = 1, we wanted to smooth out artifacts associated with EW survey lines but did not want to
excessively force NS smoothness in recovered chargeability structures.
Initial and reference models: Here we use the OcTree model that was interpolated from the batch 2D inversion results.
Role of mref in model objective function: Here we use SMOOTH_MOD. This implies we want to preserve structures
in the reference model but NOT the gradients. Our thought was that the 2D inversion result generally placed anomalous
structures in the correct areas. However, the exact dimensions and locations were distorted due to interpolation and 3D
effects. We attempt to reduce this distortion by Updating reference model throughout.
Interface weights: Since the interface weights worked well for the smoothest inversion with interface weights , we
used the same interface weights here to reduce near-surface artifacts.
Discussion of Results
The chargeability model recovered at the 3rd iteration is shown below at 3 depths. According to the recovered model:
• We can see some near-surface artifacts due to the reference model but they are not excessive.
• Several compact chargeable bodies are recovered in generally the same location as in the smoothest inversion
with sensitivity weights.
• The range of recovered chargeabilities lies within the range of values for the apparent chargeability data but they
are a little larger than the values recovered for the smoothest inversion with interface weights.
With this approach, we have recovered a model with the combined characteristics of the reference model and smoothest
model.

Fig. 60: Recovered model at iteration 3.
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Largest Chargeable Structure for Each Inversion
Here, we plot the reference model and recovered chargeability models on the same scale. Because the scale is linear
and the range of recovered chargeabilities varies between models, the cutoff for each model is different. We notice
several important things here:
1. Because the quality of the DC inversion for the sensitivity weights approach was poor and contained artifacts,
the quality of the IP inversion was poor and contained artifacts.
2. The location of the highest chargeability anomaly is consistent amongst all models.
3. Variations in smoothest model and geologically constrained model (mref) indicate some of the recovered chargeable features are not overly robust. And perhaps, some of the artifacts present in the reference model were not
eliminated while performing the OcTree inversion.

10.3 Comprehensive Workflows: Magnetotellurics
Author: Devin C. Cowan
Published: March, 2020
Here, we present a general workflow for loading, interpreting and inverting magnetotelluric (MT) data. We begin with
MT data in EMAP standard EDI file format. Our goal is to invert the data to recover a 3D conductivity model. You
may work with the tutorial dataset provided or your own data:
• Download the tutorial data
These data were acquired from a Geoscience Australia public database . We would like to acknowledge Geoscience
Australia and Geological Survey of Queensland for allowing us to use this dataset to complete the tutorial. To reduce
computation time and memory requirements, we have chosen to start with a subset of the original dataset.
Tutorial Sections

10.3.1 Understanding MT Anomalies
In order to properly interpret magnetotelluric (MT) data, it is import to first understand the shape and characteristics
of the anomalies due to basic structures. Here, we investigate the MT anomalies produced by compact conductors and
resistors. The knowledge gained here can be used to determine the coordinate system and sign convention for field
collected data, and the operations required to transform the raw impedance data into UBC-GIF format.
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Impedance tensor (MT data) definition
The magnetotelluric technique records the horizontal components of the electric field (𝐸𝑥 and 𝐸𝑦 ) and the horizontal
components of the magnetic field (𝐻𝑥 and 𝐻𝑦 ) at the Earth’s surface. These field measurements are then used to
compute a quantity which is directly dependent on the Earth’s conductivity. If the Earth is a half-space, then for a
plane-wave source whose electric field is polarized along the x-axis:
√︂
𝐸𝑥
−𝑖𝜔𝜇
𝑍𝑥𝑦 =
=
𝐻𝑦
𝜎
For a 3-dimensional Earth, magnetotelluric data are defined by the impedance tensor. The impedance tensor can
be defined using the ratios of electric and magnetic field components in both the x and y directions for 2 orthogonal
plane-wave polarizations; one polarization with the electric field along the x-axis and one polarization with the electric
file along the y-axis. Where the impedance tensor Z is a 2 by 2 matrix:
(10.1)

Z = EH−1
such that:
[︂
𝑍𝑥𝑥
𝑍𝑦𝑥
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𝐻𝑦

]︃−1
(10.2)

and 1 and 2 refer to fields associated with plane waves polarized along two perpendicular directions.
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Impedances over a compact conductor
Let us work in the UBC-GIF data convention; where X is Northing, Y is Easting, Z is +ve downward and a −𝑖𝜔𝑡 Fourier
convention is used. The real and imaginary components of the 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 and 𝑍𝑦𝑦 anomalies over a conductive
block are shown below. The conductor is buried at a depth of 500 m. Its East-West dimension is 2000 m and its NorthSouth dimension is 1000 m. The background conductivity is 0.001 S/m and the conductivity of the block is 0.1 S/m.
If your data are in the UBC-GIF convention, then over a conductor:
• 𝑍𝑥𝑦 data will be in the lower-right quadrant of the complex plane and 𝑍𝑦𝑥 data will be in the upper-left quadrant;
unless data are collected near major 3D structures. For more detail on this, see data conventions for MT .
• the amplitude of the 𝑍𝑥𝑦 and 𝑍𝑦𝑥 components decreases.
• 𝑍𝑥𝑦 and 𝑍𝑦𝑥 data are sensitive to the conductor, whereas 𝑍𝑥𝑥 and 𝑍𝑦𝑦 data are only sensitive to the edges of 3D
structures.

Fig. 61: From left to right: real component of 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 and 𝑍𝑦𝑦 at 100 Hz over a conductor.

Fig. 62: From left to right: imaginary component of 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 and 𝑍𝑦𝑦 at 100 Hz over a conductor.

Impedances over a compact resistor
Let us work in the UBC-GIF data convention; where X is Northing, Y is Easting, Z is +ve downward and a −𝑖𝜔𝑡
Fourier convention is used. The real and imaginary components of the 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 anomalies over a resistive block
are shown below. The resistor is buried at a depth of 500 m. Its East-West dimension is 2000 m and its North-South
dimension is 1000 m. The background conductivity is 0.001 S/m and the conductivity of the block is 0.00001 S/m. If
your data are in the UBC-GIF convention, then over a resistor:
• 𝑍𝑥𝑦 data will be in the lower-right quadrant of the complex plane and 𝑍𝑦𝑥 data will be in the upper-left quadrant;
unless data are collected near major 3D structures. For more detail on this, see data conventions for MT .
• the amplitude of the 𝑍𝑥𝑦 and 𝑍𝑦𝑥 components increases.
• 𝑍𝑥𝑦 and 𝑍𝑦𝑥 data are sensitive to the resistor, whereas 𝑍𝑥𝑥 and 𝑍𝑦𝑦 data are only sensitive to the edges of 3D
structures.
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Fig. 63: From left to right: real component of 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 and 𝑍𝑦𝑦 at 100 Hz over a resistor.

Fig. 64: From left to right: imaginary component of 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 and 𝑍𝑦𝑦 at 100 Hz over a resistor.
Apparent resistivity maps and sounding curves
Apparent resistivities are a good way to interpret MT data and they can be easily computed. From impedance tensor
data, apparent resistivities can be computed using 𝑍𝑥𝑦 or 𝑍𝑦𝑥 at each frequency. The formula for computing the
apparent resistivity is given by:
𝜌𝑎𝑝𝑝 =

⃒ ⃒2
⃒𝑍𝑖𝑗 ⃒
𝜔𝜇

where 𝑖 ̸= 𝑗

By computing apparent resistivities, you can:
• estimate the background resistivity of your survey region
• determine how the resistivity of an area changes with respect to depth, as different frequencies are sensitive to
different depths
• more easily identify potential conductive and/or resistive targets
Below, we show the apparent resistivities at 10 Hz, 100 Hz and 1000 Hz over both a conductor and a resistor. We see
that at the highest frequency, the skin depth is small and we are not sensitive to the block. At lower frequencies, we
see deeper and we become sensitive to the block. If the block is conductive, we see an anomalous decrease in apparent
resistivity. And it the block is resistive, we see an anomalous increase in apparent resistivity.
MT systems collect data over a large range of frequencies. It is common to plot the apparent resistivities for a particular
station as a function of frequency. This log-log plot is known as a sounding curve. An example is shown below.
At the highest frequency (smallest skin depth), the apparent resistivity is roughly 50 Ohm-meters. Between 50 Hz
and 1000 Hz, we see that as we lower the frequency (and look deeper), we become more sensitive to a conductive
structure. Below 50 Hz, the apparent resistivities increase as we become more sensitive to a deeper structures. Using a
1D interpretation of this sounding curve, we may assume that we have a moderately conductive surface geology about
a more conductive structure which is on top of a resistivity basement. It should be noted that at lower frequencies,
apparent resistivities are increasingly impacted by the effects of 3D structures.
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Fig. 65: Apparent resistivities derived from 𝑍𝑥𝑦 at 10 Hz (left), 100 Hz (middle) and 1000 Hz (right) over a conductor.

Fig. 66: Apparent resistivities derived from 𝑍𝑥𝑦 at 10 Hz (left), 100 Hz (middle) and 1000 Hz (right) over a resistor.

Fig. 67: Sounding curve for a single data location.
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Impedance data and coordinate conventions
Impedance data are generally defined using the UBC-GIF convention; X is Northing, Y is Easting and Z is +ve
downward**. But what if they are not? How does this affect the shape and sign of the corresponding anomalies? We
have chosen 2 examples to demonstrate the effects of the data convention. We will use the same conductive block model
from earlier.
Impedance data are sometimes defined such that X is Easting, Y is Northing and Z is +ve upward. This is a natural
way to define vector quantities but it is not the standard for impedance data. When comparing this convention with the
UBC-GIF convention, you will notice that we have the same 4 data images, except the order is different. If the data
columns are not labeled correctly, you will not be able to successfully invert the data with UBC-GIF codes.
There are other instances when the contractor will measure and compute the impedances for an orientation of their
choosing. Below, we show the same data over a conductor in the case that X is Northeast, Y is Southeast and Z
is down. You will notice that for the block, the anomalies line up with the Northeast and Southeast. Generally the
contractor will correct these data and provide impedances in a standard coordinate system.

Fig. 68: Real component of 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 using UBC-GIF convention.

Fig. 69: Real component of 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 where X is Easting, Y is Northing and Z is Up.

Fig. 70: Real component of 𝑍𝑥𝑥 , 𝑍𝑥𝑦 , 𝑍𝑦𝑥 and 𝑍𝑦𝑦 where X is Northeast, Y is Southeast and Z is down.
Note: The ability to transform from the contractor’s data convention to UBC-GIF convention has been built into
GIFtools. We will demonstrate this in the workflow.
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Important: Tutorial data were acquired from a Geoscience Australia public database . We would like to acknowledge
Geoscience Australia and Geological Survey of Queensland for allowing us to use this dataset to complete the tutorial.
To reduce computation time and memory requirements, we have chosen to start with a subset of the original dataset.

10.3.2 Loading and Transforming Field Data into GIF Convention
The first step in any project is to load field collected data and visualize it. Impedance data are challenging to work with
for several reasons. First, they are computed by applying a non-trivial operation to the components of the measured
fields. Second, impedance data are sometimes represented in a non-standard coordinate system.
Here, we will assume that you have some processed EDI formatted impedance data. The goal is to transform these
data into UBC-GIF convention so that we can work within the GIFtools framework. Using contractor information and
GIFtools, we will show how this is possible.
Important: Requires GIFtools v2.30 or later.

Starting Your Project
• Open GIFtools
• Set the working directory
Import Files
Note: If you do not have EDI formatted data from which to work with, you may download tutorial data . It is from
this dataset that we will demonstrate the workflow.
Here, we import the impedance data and topography.
• First, import topography data (XYZ format). The data file is named MTtopo.xyz.
• Next, import impedance data from EDI files. For this step, you must know before-hand if your data are defined
Northing-Easting-Down or Easting-Northing-Up. This will ensure your data columns are appropriately labeled
after being loaded into GIFtools. The EDI files for the tutorial example are in the EDIfiles folder. If you are using
the tutorial data:
– We are loading data at 100 frequencies between 0.00034 Hz and 10400 Hz. Certain frequencies may be
missing at certain stations.
– You can choose to load all variables. But for this example you only need: FREQ, ZROT, ZXXR, ZXXI,
ZXYR, ZXYI, ZYXR, ZYXI, ZYYR and ZYYI.
– You assume the data are in UBC-GIF convention.
• Once loaded, make sure to set IO headers for all impedance data columns.
• Pro tip: To avoid confusion between location and data coordinate systems, use the set data headers tool to define
location columns as Easting, Northing and Elevation.
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Asserting Data are in UBC-GIF Convention
Now that we have loaded the data and set the IO headers, we can take a first look at our data. Here, we determine if the
impedance data are in UBC-GIF format. If not, we must apply the appropriate transformation.
From the understanding anomalies section, we know that UBC-GIF formatted impedance data has 𝑍𝑥𝑦 and 𝑍𝑦𝑥 values
located in the lower-right and upper-left quadrants of the complex plane, respectively. So the first step is to examine
the real and imaginary components of 𝑍𝑥𝑦 and 𝑍𝑦𝑥 . We suggest carrying out the analysis at frequencies between 10
Hz and 1000 Hz. Here are some things to consider:
• If the sign of the real and imaginary components of 𝑍𝑥𝑦 are the same (also for 𝑍𝑦𝑥 ), then your data are currently
in a +𝑖𝜔𝑡 Fourier convention. To fix this, you must multiply the ZXXI, ZXYI, ZYXI and ZYYI columns by -1.
This can be done with the basic calculator.
• If 𝑍𝑥𝑦 and 𝑍𝑦𝑥 values are not located in the appropriate quadrants of the complex plane, you chose the wrong
change of coordinates option when importing EDI standard MT data. In this case, it is better to re-import the
data using the correct option.
Below, we see the real and imaginary components of 𝑍𝑥𝑦 and 𝑍𝑦𝑥 at 115 Hz for our tutorial data set. According to the
plots, 𝑍𝑥𝑦 and 𝑍𝑦𝑥 values are located in the lower-right and upper-left quadrants of the complex plane, respectively.
This means they are in UBC-GIF format and we can move to the next step.

Fig. 71: From left to right: ZXYR, ZXYI, ZYXR and ZYXI at 115 Hz.

Rotating Impedance Tensor Data
It is standard practice for contractors to provide impedance data defined in the Easting and Northing directions or visa
versa. This is true even if the electric and magnetic fields themselves were not measured along the Easting and Northing
directions. So long as the horizontal fields were each measured along 2 orthogonal directions, you can transform the
impedance tensor data into an Easting-Northing-Up or Northing-Easting-Down convention. This step is generally
carried out by the contractor during initial data processing.
In rare instances, the impedance data may be provided by the contractor where X and Y are defined along two arbitrary (but orthogonal) directions. You may also choose to represent the impedance data this way to highlight certain
geological features.
Once loaded into GIFtools, you can rotate the impedance tensor data using built-in functionality:
• Rotate impedance tensor
Example: Let’s assume that your data are in UBC-GIF format, but X is defined towards the Southeast (bearing 135
degrees from North), Y is defined towards the Southwest (90 degrees clockwise from X) and Z is positive downward.
To rotate your data such that X = Northing, Y = Easting and Z = down, you would apply a rotation of -135 degrees.
Note: The dataset used for this tutorial did not need to undergo a rotation.
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10.3.3 Apparent Resistivities and Data Preparation
At this point, we assume the data are loaded into GIFtools and that our impedance tensor values are defined in the standard UBC-GIF convention. It is difficult to gain information about the Earth’s electrical resistivity from impedances.
That is why the initial interpretation of the data is generally done using apparent resistivities. We will provide a basic
interpretation for our tutorial data set.
When looking at your data for the first time, you will notice that 1) you have data at many frequencies, and 2) the range
of frequencies spans many orders of magnitude. For the tutorial data set, we have data at 100 frequencies from 0.00034
Hz to 10400 Hz. It is impossible to invert all of the data at once. As a result, we must extract a reasonable set of
frequencies that are sensitive to the target. We will discuss this here.
Examining Apparent Resistivities
Computing apparent resistivities
If you have set IO headers for the impedance data, it is easy to compute apparent resistivities. Apparent resistivities
can be used to estimate the background conductivity and verify that the units of your impedances are correct. If your
impedance data are not in the correct units, the range of values for the apparent resistivities will not be reasonable. To
use this functionality:
• Compute apparent resistivities from impedances
Interpreting apparent resistivity maps
Below, we see the apparent resistivity maps obtained from the 𝑍𝑥𝑦 component at 2.03 Hz, 22.5 Hz, 229 Hz and 2200
Hz. The range of apparent resistivity values is reasonable (1 Ω𝑚 - 10000 Ω𝑚 ), indicating the impedance data are
likely represented in the correct units for UBC-GIF codes. The maps indicate:
• the near surface is conductive (inferred from high frequencies)
• at depth, the Earth is resistive towards the Southwest and conductive in the East
• nearly identical signatures were observed in the apparent resistivities computed from the 𝑍𝑦𝑥 component

Fig. 72: From left to right: apparent resistivity maps obtained from the 𝑍𝑥𝑦 component at 2.03 Hz, 22.5 Hz, 229 Hz
and 2200 Hz.
Interpreting sounding curves
Below, we see sounding curves for the apparent resistivities computed from the 𝑍𝑥𝑦 component. We observe that:
• In the Southwest, the Earth is more conductive near the surface and more resistive at depth
• In the East, the Earth is more conductive at depth and less conductive at the surface
• the Earth is generally more resistive towards the Southwest
• at low frequencies, it is difficult to make an interpretation, as the data are more contaminated by 3D effects
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Fig. 73: Sounding curves for 3 locations: Northeast (black), center (red) and Southwest (blue).
Frequency-Based Extraction
Because we cannot invert the data at all frequencies, we must decide which frequencies are sensitive to the target.
Furthermore, we generally don’t need all of the frequencies within our chosen range. To reduce computational demand,
we extract and invert the data at a select set of frequencies. Some things we may consider during this step:
• Assume the target is a compact conductor/resistor. We have inferred its horizontal position from apparent resistivity maps or prior knowledge. We can look at the sounding curves over the potential target to determine which
frequencies are sensitive.
• We want to learn about the basement geology and the near surface geology is well-constrained. We should use
low frequencies.
Using GIFtools, we can extract data at a subset of the total range of frequencies. To do this:
• Frequency-based extraction of data
For the tutorial data, we extracted the data at 4 logarithmically spaced frequencies from 2.34 Hz to 460 Hz.
Important: As a general rule, our extracted data should be at frequencies that span a maximum of 3 orders of
magnitude. This ensures the smallest cells in the mesh can adequately model the highest frequency. And ensures we
can create a large enough mesh adequately model the lowest frequency.
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Defining Receivers
E3DMT v1 models the electric and magnetic fields at discrete points whereas E3DMT v2 allows the user to define the
receivers. If you intend to invert data with E3DMT v2, this step is required. To define the electric and magnetic field
receivers, we use the following functionality:
• Set/reset receivers from data locations
Our approach:
According to the contractor, the electric field dipoles had lengths of 100 m. Phoenix MTC-150L coils were used to
measure the magnetic fields. Receivers measuring the magnetic fields are much smaller than the cell dimensions being
used to model the fields. If the contractor does not provide you with the coil receiver’s dimensions, you may choose a
value such as 1 m or 4 m. We used the following parameters to fill the fields:
• Hx, Hy receiver width: 4 m
• Hx, Hy number of segments: 4
• Ex, Ey receiver length: 100 m
• Ex, Ey number of segments: 4
• Orientation from Nothing (deg): 0 (since data are defined Northing-Easting-Down)
Note: If the loop receivers are square, choose the number of segments to be 4. GIFtools will define the loop as a
square with side length equal to the value specified.

10.3.4 Assigning Uncertainties
Here, we provide a basic approach for assigning uncertainties to impedance data. The role of uncertainties in geophysical inversion is presented in the fundamentals of inversion. When assigning uncertainties, we want to ensure we fit the
anomaly and not the background. We also want to ensure we fit each component and frequency equally.
To examine sorted data and apply uncertainties:
• Use the GUI for applying frequency-dependent uncertainties.
Percent Versus Floor Uncertainty
Off-Diagonal Impedances (ZXYR, ZXYI, ZYXR and ZYXI):
For off-diagonal impedance tensor data (ZXYR, ZXYI, ZYXR and ZYXI), the range of data values is significantly
different for each component and for each frequency. In general:
• impedances at higher frequencies are larger in magnitude than impedances observed at lower frequencies.
• for an individual component, the data can span multiple orders of magnitude.
• off-diagonal impedance data values are non-zero unless there is significant 3D structure effects.
Therefore the uncertainties applied to off-diagonal impedance data should be dominated by a percent; as opposed
to a floor which assigns equal uncertainty to all data values.
Since the magnitude of the data is frequency-dependent, it is obvious we much assign frequency-dependent uncertainties. But what about balancing the uncertainties between each component? For this, we consider the apparent resistivity
formula:
⃒ ⃒2
⃒𝑍𝑖𝑗 ⃒
𝜌𝑎𝑝𝑝 =
where 𝑖 ̸= 𝑗
𝜔𝜇
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For a given frequency, this formula states that small 𝑍𝑥𝑦 and small 𝑍𝑦𝑥 values correspond to small apparent resistivities.
So if you apply only a floor uncertainty to the impedance data, you would be over-fitting resistive structures and underfitting conductive structures.
Diagonal Impedances (ZXXR, ZXXI, ZYYR and ZYYI):
Diagonal impedances are impacted by 3D effects. In the absence of 3D effects, the diagonal impedances are theoretically equal to zero. If you were to apply only a percent uncertainty to the data, you would over-fit the background values
and under-fit the anomalies. Therefore, the uncertainties applied to diagonal impedance data should be dominated
by a floor. For simple geologies:
• ZXXR, ZXXI, ZYYR and ZYYI data at a particular frequency may or may not span the same range of values.
If not, you may need to apply a different floor to each component and/or frequency.
Note: When the inversion is complete, we will be able to assess whether the estimated uncertainties on our data were
correct. If not, the inversion will need to be re-run with a new set of uncertainties.

General Approach
Off-Diagonal Impedances (ZXYR, ZXYI, ZYXR and ZYXI):
It is common to apply uncertainties of 5% - 10% as a first estimate. You may choose to apply higher or lower percentages
to different frequencies if you believe the data are more or less noisy, respectively. We may also add a very small floor
to the uncertainties in the rare case there are data approximately equal to zero.
Diagonal Impedances (ZXXR, ZXXI, ZYYR and ZYYI):
There are a few options for choosing the floor uncertainty values for each component at each frequency:
1) The user may take some fractional percents of the largest anomalous value and use that as the floor.
2) The user may sort the data by absolute value, and choose a threshold at which the data values contain an insignificant amount of signal and are dominated by noise.
Since the diagonal impedances do less to constrain the inversion result than the off-diagonal components, it is best to
over-estimate the uncertainties for ZXXR, ZXXI, ZYYR and ZYYI rather than to under-estimate the uncertainties. To
ensure that off-diagonal impedances are driving the inversion, sometimes very large uncertainties are applied to the
diagonal impedances.
Uncertainties for Tutorial Data
Off-Diagonal Impedances (ZXYR, ZXYI, ZYXR and ZYXI):
For off-diagonal impedance components, we applied both a percent and a floor. For all components and for all frequencies, the percent uncertainty was 10%. Choosing a floor was more involved.
From the higher frequency data, we saw significant fluctuations in the apparent resistivities corresponding to the nearsurface. We felt that the uncertainty in the apparent resistivities was roughly 1 Ω𝑚. To convert this to impedances, we
used the apparent resistivity formula. So for each frequency, the floor is given by:
𝜀(𝑓 ) =

√︀

2𝜋𝜇𝑓 (1Ω𝑚)

This resulted in floor uncertainties of: 0.0043, 0.01, 0.025 and 0.06 V/A. Essentially, the floor uncertainties ensures
we do not try to fit the fluctuations in the very high conductivities which are likely at the Earth’s surface.
When inverting these data for the first time, we did not apply this floor. We found that our inversion did not converge,
we over-fit the near surface and we did not recover resistive structures very well.
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Fig. 74: Option 1 for choosing uncertainties (left). Option 2 for choosing uncertainties (right).
Diagonal Impedances (ZXXR, ZXXI, ZYYR and ZYYI):
For diagonal impedance components, we applied a floor uncertainty equal to 5% the maximum value. This was done
separately for each component and for each frequency.
Erroneous Data:
In both the diagonal and off-diagonal components, there were obvious erroneous data. To keep the tutorial simple,
we did not address this. As a result, we will likely over-fit these data values. In practice, you make choose to remove
the erroneous data or individually apply a very large uncertainty to them. To switch an individual datum to NaN or to
assign a large uncertainty, you can manually edit each datum though:
• Table viewer

10.3.5 Mesh Design
Here we provide a basic approach for mesh design when inverting MT data. The field data provided was collected
in a region with minimal topography. However, we will complete this step assuming we must account for significant
topography.
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Skin Depth
For frequency-domain data, an important step is to compute the minimum and maximum skin depth for the data you
want to invert; e.g. the data sensitive to structures you would like to recover. The skin depth depends on frequency and
the electrical resistivity/conductivity:
√︂
√︂
𝜌
1
= 500
𝛿 ≈ 500
𝑓
𝜎𝑓
The background resistivity can be obtained from the apparent resistivity maps and sounding curves.
Our Approach:
According to the apparent resistivity maps and sounding curves, the Earth is fairly conductive. Over the range of
frequencies we are inverting, we estimated a background resistivity of 20 Ω𝑚. From the skin depth formula:
• 𝛿𝑚𝑖𝑛 = 104 m
• 𝛿𝑚𝑎𝑥 = 1462 m
Create Mesh
Here, we explain how to create an OcTree mesh based on MT survey geometry. We also explain the reasoning for the
parameter values entered. We can create OcTree meshes from MT surveys with the following utilities:
• create OcTree mesh with E3DMT utilities
• create OcTree mesh with E3DMT v2 utilities
Once you have created the object, complete the following steps:
1) Set the data object corresponding to the survey
2) Define the mesh using Edit Options
3) Run the utility
4) Load results
For the field data provided, we chose to create the mesh using E3DMT v2 utilities. This was done because we are able
to define the dipole and loop receivers. The parameters set in Edit Options are shown below along with reasoning for
several important choices. For definitions of the parameters, consult the E3DMT or E3DMT v2 manual.
Minimum cell width (vertical): The minimum vertical cell width is determined primarily by the smallest skin depth.
If the topography is flat and the geology is relatively simple, the minimum vertical cell width can be roughly 10%-20%
the minimum skin depth. For the tutorial data set, a minimum vertical cell width of 25 m was chosen.
Minimum cell width (horizontal): The minimum horizontal cell width is usually determined by the station spacing.
It is good to have a least 3 cells between each station. For the tutorial data, the station spacing is roughly 2 km. Since
the source is a vertically propagating plane-wave, we can discretize much more coarsely in the horizontal than in the
vertical. However there are limits to this. To balance mesh size and ensure we model the fields correctly, we chose a
minimum horizontal cell width of 250 m.
Max. topo cell: Even if the topography is significant, we do not want to over-discretize in regions far away from the
survey, as the fields there do not greatly impact the data. As a result, this parameter was set to a larger number. If you
want to more finely discretize the topography, set this to 8, 4, or even 2. E3DMT v1 does not have this option.
Padding cell expansions: The extent of the mesh depends on the largest skin depth. The mesh should extend 2-3 times
the largest skin depths from the survey region in all directions. Because OcTree meshes pad out so effectively, setting
this to be very large does not add many additional cells.
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Fig. 75: Parameters used to define the mesh for the field dataset using E3DMT v2 mesh utility.
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Core region discretization: Thickness 1 *should be used to discretize the region sensitive to the highest frequencies
(2-3 smallest skin depths). *Thickness 2 and 3 should be used to discretize the additional regions sensitive to he lower
frequencies. Thickness 1 + Thickness 2 + Thickness 3 should be roughly equal to at least 1 largest skin depth.
Number of cells around Rx: The number of fine mesh cells near receivers does need to be as large for natural source
EM modeling as is does for controlled source EM modeling. Fields associated with natural sources are are much
smoother. You can make the mesh a much more reasonable size by taking advantage of this, however sufficient discretization is still required to model the fields accurately.
Make polygon: For UBC-GIF v2 codes, this parameter controls the horizontal extent of the core mesh region. In
practice, this should be 1-2 times the smallest skin depth.
Shift data: We chose to shift the data locations so that receivers lie on the discretized topography. If you fail to do
this, you may be measuring electric fields in the air. See important notices below.
Important: If you choose to shift data for E3DMT v2 utilities, the mesh utility will create a receivers file. When
loading output, a new data object is created under the mesh utility. All the receivers are organized to measure the fields
at the appropriate places. But if you are concerned, you can repeat the steps in the data preparation section .

10.3.6 MT Inversion
Here, we provide the steps for setting up and running an inversion with E3DMT or E3DMT v2. We then discuss some
important aspects of choosing inversion parameters.
Reducing Artifacts through Interface Weighting
When inverting MT data, the E3DMT codes have a tendency to place conductive structures near receiver locations
due to the sensitivity of the data to those cells. Here, we generate interface weights to counteract this problem. By
forcing lateral smoothness within the top few layers of cells, we can limit the artifacts and force the inversion to place
conductive structures at the appropriate depths.
• Create and interface weights utility
• Use edit options and set the following parameters:
– set the OcTree mesh
– set as log model
– set topography as the active cells model
– set number of layers and corresponding weights (choose something exponentially decreasing. We chose
100, 20, and 4)
– Face value = 0.01
– Face tolerance = 0.01
• Run the utility
• Load results
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Create, Run and Load Inversion
We can now invert MT data using E3DMT v1 or v2.
• Create E3DMT v1 or v2 inversion object
• Use edit options for v1 or v2 to set the inversion parameters
• Click Apply and write files
• Run the inversion
• Load results
For the dataset provided, we chose to invert using E3DMT v2, as we were able to define the receiver loops. Things
are effectively the same for E3DMT v1. The parameters used are shown below. Note that we must choose the data
object that has shifted locations relative to discretized topography.

Fig. 76: Parameters used to invert the field dataset using E3DMT v2.

Discussion of Parameters
Note: The parameters chosen for inversion of the tutorial data set were experimentally derived. The numbers used
here worked well for inverting this dataset but should not necessary be used as general default values!
Regarding beta cooling schedule:
For synthetic modeling, we know the uncertainties on our data. With real data, we cannot be 100% sure that we have
correctly estimated the uncertainties. In the case that we have globally under-estimated our uncertainties, we sometime
set the chi factor to be less than 1. That way, we get to see more of the Tikhonov curve.
When setting the cooling schedule for the tutorial data set, the strategy was pretty straight-forward:
• beta max = 0.01. The model recovered at the first iteration should clearly underfit the data. However if beta max
is too large, you will have multiple iterations where the model doesn’t budge because no emphasis is being put
on fitting the data. We knew a good starting beta for the final inversion from cursory inversions of the data.
10.3. Comprehensive Workflows: Magnetotellurics
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• beta min = 1e-10. This can be set quite low. But it is good for the inversion to terminate within a reasonable
number of beta iterations if target misfit is not reached.
• reduction factor = 0.25: We choose a value between 0.1 and 0.9. If the reduction factor is too large, the code
will run for a long time since the reduction in beta at each iteration is small. If the reduction factor is too small,
we do not get much detail regarding the convergence of the inversion.
• chi factor = 1 Here, we assume that appropriate uncertainties are set on the data. Thus, we assume the recovered
model explains the data without over-fitting (fitting the noise) when the data misfit equals the number of data
observations (chi factor = 1). In practice, you may choose a chi factor less than 1. This will allow you to get a
better understanding of the convergence, especially if you have over-estimated the uncertainties.
Regarding the alpha parameters:
As a default setting, we frequently let 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1 and we let 𝑎𝑙𝑝ℎ𝑎𝑠 = 1/𝑑ℎ2 ; where 𝑑ℎ is the width of the
smallest cells in the mesh. This effectively balances the emphasis on recovering a model that is similar to a reference
model, and recovering a model that has sufficient structure. If we have high confidence in our reference model, we may
choose to increase 𝛼𝑠 relative to 𝛼𝑥 , 𝛼𝑦 and 𝛼𝑧 . If we have low confidence in our reference model, we may choose to
decrease 𝛼𝑠 relative to 𝛼𝑥 , 𝛼𝑦 and 𝛼𝑧
For this exercise, we have been able to infer the range of resistivities for this region from apparent resistivity maps and
sounding curves. However, we could not identify a consistent background resistivity that works throughout the whole
region. As a result, we have set 𝛼𝑠 = 10−10 and let 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1. This will recover a conductivity model which
is primarily driven by the data, and is impacted minimally by the reference model.
Regarding the background, starting and reference models
For the background, starting and reference models, we chose 0.05 S/m. This value was inferred from the apparent
resistivity maps and sounding curves over the range of frequencies we are inverting.

10.3.7 Inversion Results
Here, we demonstrate a common practice for examining the output of the inversion code. This includes examining the
convergence, the data misfit and the recovered model. Before looking at recovered models, the user is strongly urged
to examine the convergence of the algorithm first (Tikhonov curve). By examining the convergence, we can:
• determine if our data is in UBC-GIF data convention. The data misfit will be large and will not reduce at each
iteration otherwise.
• see if the inversion is able to reach target misfit
• infer whether the target misfit is reasonable; i.e. did we globally over or under-estimate the uncertainties on our
data
We then assess how well a given recovered model explains the data by looking at the predicted data, observed data and
normalized data misfit maps. From this we can determine whether:
• the predicted data fits the amplitude, shape and character of observed anomalies for each component and for each
frequency
• the estimated uncertainties were reasonable for each component and for each frequency.
• the inversion must be re-run with a new set of uncertainties
Only when the convergence and data misfit are acceptable can we infer geological structures from recovered models.
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Convergence
Once the inversion outputs have been loaded (done in the inversion section)
• View convergence
The Tikhonov curve for our tutorial inversion is shown below. According to the figure:
• the inversion reaches target misfit (chi-factor = 1 in this case) after 6 iterations. Thus the algorithm is converging
over the course of the beta cooling schedule.
• the Tikhonov curve starts to flatten out at the 4th iteration, indicating the point on the Tikhonov curve after which
recovered models start to over-fit the data.
• Globally, we have likely under-estimated the uncertainties on our data. Or, most likely, we should have removed
any erroneous data values.

Data Misfit
According the Tikhonov curve, the recovered model at iteration 4 has a good chance of explaining the data without fitting
the noise. To be sure however, we must examine the observed data, predicted data and data misfit for the corresponding
model. Here are some good questions to ask during this step:
• Are the prominent anomaly features identified in the observed data also found in the predicted data? Is this true
for all components and for all frequencies?
• Are there obvious coherent features in the normalized misfit maps? If so, this indicates you are over-fitting certain
regions at the expense of others and that you must assign new uncertainties and re-run the inversion.
• Are the ranges of normalized misfits for each component and for each frequency generally the same? If not, the
uncertainties are not balanced between components and/or frequencies. In this case, new uncertainties should
be applied and the inversion should be re-run.
10.3. Comprehensive Workflows: Magnetotellurics
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Off-Diagonal Components:
The observed data, predicted data and normalized misfits for off-diagonal impedance data are shown below at 13.7 Hz.
We plotted -ZXYI and -ZYXR so that we could plot the values on a log scale. From these plots, and plots at other
frequencies, we found that:
• Predicted data generally reproduce the main features seen in the observed data. However, we did not fit localized
small impedance values because the uncertainties on those data were set fairly high (see ZXYI plot below).
• With some exceptions (ZYXR at 13.7 Hz for example), the range of normalized misfits is more or less the same
for all off-diagonal components and for all frequencies.
• Most of the normalized misfit maps do not show coherent structures.
• By trying to fit erroneous data values, we likely under-fit the data in other areas.
Diagonal Components:
The observed data, predicted data and normalized misfits for diagonal impedance data are shown below at 13.7 Hz.
From these plots, and plots at other frequencies, we found that:
• The predicted data explains most, but not all, of the large diagonal impedances.
• With some exceptions (ZXXR at 2.34 Hz for example), the range of normalized misfits is more or less the same
for all diagonal components and for all frequencies.
• Most of the normalized misfit maps do not show coherent structures.
• Uncertainties were set to prioritize fitting the off-diagonal components. Thus, we generally have a poorer fit of
the diagonal components and smaller misfits.
Recovered Model
The conductivity model recovered at the 4th iteration is shown below at 3 depths. According to the recovered model:
• We can see some pixelation in the recovered model right at the surface. This could be because insufficient
interface weighting was applied. It could also be due to the inversion trying to fit erroneous data.
• There is a large conductive structure in the East which extends to depth.
• The near surface conductivity is highly variable but is generally fairly conductive.
• In the West, there is a large resistive structure at depth.

10.4 Comprehensive Workflows: ZTEM
Author: Devin C. Cowan
Published: March, 2020
Here, we present a general workflow for loading, interpreting and inverting Z-axis Tipper electromagnetic (ZTEM)
data. We begin with ZTEM data in xyz data format. Our goal is to invert the data to recover a 3D conductivity model.
You may work with the tutorial dataset provided or your own data:
• Download the tutorial data
The data used for this tutorial were collected at Dufferin Lake as part of a uranium exploration project. The data are
public domain. They were downloaded from the Saskatchewan Mineral Assessment Database . The original data have
been down-sampled to make the size of data files more manageable.
Tutorial Sections
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Fig. 77: Observed data, predicted data and normalized misfit for all off-diagonal impedance components at 13.7 Hz.
For each component, predicted and observe data are plotted on the same scale. All normalized misfit maps are plotted
on a range from -3 to 3.
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Fig. 78: Observed data, predicted data and normalized misfit for all diagonal impedance components at 13.7 Hz. For
each component, predicted and observe data are plotted on the same scale (-0.1 - 0.1). All normalized misfit maps are
plotted on a range from -3 to 3.
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Fig. 79: Recovered model at iteration 4.
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10.4.1 Understanding ZTEM Anomalies
In order to properly interpret Z-axis Tipper electromagnetic (ZTEM) data, it is import to first understand the shape
and characteristics of ZTEM anomalies for basic structures. Here, we investigate the ZTEM anomalies produced by
compact conductors and resistors. The knowledge gained here can be used to determine the coordinate system and sign
convention for field collected data, and the operations required to transform the raw data into UBC GIF convention.
ZTEM data definition
During ZTEM surveys, we record the vertical component of the magnetic field (𝐻𝑧 ) everywhere above the survey
area while recording the horizontal components (𝐻𝑥 and 𝐻𝑦 ) at a ground-based reference station. The vertical and
horizontal field measurements are related by the following transfer functions:
𝐻𝑧 = 𝑇𝑧𝑥 𝐻𝑥 + 𝑇𝑧𝑦 𝐻𝑦

(10.3)

For each location, we compute the transfer function values 𝑇𝑧𝑥 and 𝑇𝑧𝑦 , also known as Tippers. For a 3-dimensional
Earth, the transfer functions can be defined using the magnetic field components for 2 orthogonal plane-wave polarizations; for example, one polarization with the electric field along the x-axis and one polarization with the electric file
along the y-axis. In this case,
]︃
]︃ [︃
[︃
]︂
(1) [︂
(1)
(1)
𝑇𝑧𝑥
𝐻𝑦
𝐻𝑥
𝐻𝑧
(10.4)
=
(2)
(2)
(2)
𝑇𝑧𝑦
𝐻𝑦
𝐻𝑥
𝐻𝑧
where 1 and 2 refer to fields associated with plane waves polarized along two perpendicular directions. Solving for the
transfer functions we obtain:
]︃
[︃
[︂ ]︂
(2) (1)
(1) (2)
(︀ (1) (2)
)︀
𝑇𝑧𝑥
(2) (1) −1 −𝐻𝑦 𝐻𝑧 + 𝐻𝑦 𝐻𝑧
= 𝐻𝑥 𝐻𝑦 − 𝐻𝑥 𝐻𝑦
(2) (1)
(1) (2)
𝑇𝑧𝑦
𝐻𝑥 𝐻𝑧 − 𝐻𝑥 𝐻𝑧
ZTEM data and coordinate conventions
ZTEM data are generally defined using a right-handed coordinate system. The question becomes, what direction is x,
y and z? And how does this impact the shape of the observed ZTEM anomalies?
UBC-GIF Tipper data are defined in a coordinate system where:
• X is Northing
• Y is Easting
• Z is +ve downward
Most airborne systems define their Tipper data in a coordinate system where:
• X is the along-line direction or “flight line direction” (degrees counter-clockwise from Northing)
• Y is cross-line direction (90 degrees counter clockwise from along-line direction)
• Z is +ve upwards
Below, we see the ZTEM anomalies for UBC-GIF modeled data and standard airborne data collected over the same
compact conductor. The standard airborne data were collected along flight lines with a bearing of 45 degrees (from
SW to NE). Thus the cross-line direction is -45 degrees (SE to NW). Looking at these anomalies, we see that:
• The response near the edges of the conductor is large and the response directly over the conductor is relatively
small; as ZTEM measurements are sensitive to lateral changes in conductivity and not the conductor itself.
• For UBC-GIF convention, the 𝑇𝑧𝑥 anomalies lie to the North and South of the conductor and 𝑇𝑧𝑦 anomalies lie
to the East and West.
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• For standard airborne data, the 𝑇𝑧𝑥 anomalies are oriented along the flight-direction (along-line) and 𝑇𝑧𝑦 anomalies are oriented in the cross-line direction.

Fig. 80: ZTEM anomaly in UBC-GIF coordinates over a compact conductor at 30 Hz. From left to right: Re[Tzx],
Im[Tzx], Re[Tzy] and Im[Tzy].

Fig. 81: ZTEM anomaly in airborne data coordinate system at 30 Hz. Flight lines were at 45 degree (SW to NE) From
left to right: Re[Tzx], Im[Tzx], Re[Tzy] and Im[Tzy].

Note: The process of transforming data from the field coordinate system to UBC-GIF is discussed further down on
the page.

Anomaly over a compact conductor
Let us work in the UBC-GIF ZTEM data convention; where X is Northing, Y is Easting and Z is +ve downward. The
real and imaginary components of the 𝑇𝑧𝑥 and 𝑇𝑧𝑦 anomalies over a conductive block are shown below. The conductor
is buried at a depth of 200 m. Its East-West dimension is 2000 m and its North-South dimension is 1000 m. The
background conductivity is 0.001 S/m and the conductivity of the block is 0.1 S/m. We can see that:
• The response near the edges of the conductor is large and the response directly over the conductor is relatively
small; as ZTEM measurements are sensitive to lateral changes in conductivity and not the conductor itself.
• At lower frequencies, ZTEM anomalies are broader. At higher frequencies, ZTEM anomalies are more compact.
• 𝑇𝑧𝑥 is sensitive to the North and South faces of the conductor while 𝑇𝑧𝑦 is sensitive to the East and West faces.
• The real component of 𝑇𝑧𝑥 is always +ve to the North of the block and -ve to the South of the block.
• The real component of 𝑇𝑧𝑦 is always +ve to the East of the block and -ve to the West of the block.
• For a −𝑖𝜔𝑡 Fourier convention (UBC-GIF), the real and imaginary components of the 𝑇𝑧𝑥 anomaly will generally
have opposing sign at low frequencies (see below at 30 Hz); likewise for the real and imaginary components
of 𝑇𝑧𝑦 . However because of the complicated nature of ZTEM anomalies, this is not true 100% of the time. If
possible, determine the Fourier convention from the contractor.
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• At sufficiently high frequencies, the imaginary component of the anomaly may undergo a change in polarity (see
below). This occurs when EM induction effects become larger than the galvanic effects that dominate at lower
frequencies.

Fig. 82: ZTEM anomaly over a compact conductor at 30 Hz. From left to right: Re[Tzx], Im[Tzx], Re[Tzy] and
Im[Tzy].

Fig. 83: ZTEM anomaly over a compact conductor at 720 Hz. From left to right: Re[Tzx], Im[Tzx], Re[Tzy] and
Im[Tzy].

Anomaly over a compact resistor
Let us work again in the UBC-GIF ZTEM data convention; where X is Northing, Y is Easting and Z is +ve downward.
The real and imaginary components of the 𝑇𝑧𝑥 and 𝑇𝑧𝑦 anomalies over a resistive block are shown below. The resistor
is buried at a depth of 200 m. Its East-West dimension is 2000 m and its North-South dimension is 1000 m. The
background conductivity is 0.001 S/m and the conductivity of the block is 0.1 S/m. We can see that:
• The response near the edges of the resistor is large and the response directly over the resistor is relatively small;
as ZTEM measurements are sensitive to lateral changes in conductivity and not the conductor itself.
• 𝑇𝑧𝑥 is sensitive to the North and South faces of the conductor while 𝑇𝑧𝑦 is sensitive to the East and West faces.
• The real component of 𝑇𝑧𝑥 is always +ve to the North of the block and -ve to the South of the block.
• The real component of 𝑇𝑧𝑦 is always +ve to the East of the block and -ve to the West of the block.
• For a −𝑖𝜔𝑡 Fourier convention (UBC-GIF), the real and imaginary components of the 𝑇𝑧𝑥 anomaly will generally
have opposing sign at low frequencies (see below at 30 Hz); likewise for the real and imaginary components
of 𝑇𝑧𝑦 . However because of the complicated nature of ZTEM anomalies, this is not true 100% of the time. If
possible, determine the Fourier convention from the contractor.
• At sufficiently high frequencies, the imaginary component of the anomaly may undergo a change in polarity (see
below). This occurs when EM induction effects become larger than the galvanic effects that dominate at lower
frequencies.
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Fig. 84: ZTEM anomaly over a compact resistor at 30 Hz. From left to right: Re[Tzx], Im[Tzx], Re[Tzy] and Im[Tzy].

Fig. 85: ZTEM anomaly over a compact resistor at 720 Hz. From left to right: Re[Tzx], Im[Tzx], Re[Tzy] and Im[Tzy].
Spatial Transformation to UBC-GIF convention
Let 𝜃 be the flight direction (counter-clockwise degrees from Northing). Let 𝑇𝑧𝑥 and 𝑇𝑧𝑦 be the Tipper data in the
UBC-GIF coordinate system. And let 𝑇𝑥′ and 𝑇𝑦′ be the Tipper data in the field data coordinate system. To go from
standard airborne data convention to UBC-GIF, the following transformation can be done:
[︂ ]︂
[︂
]︂ [︂
]︂ [︂
]︂
𝑇𝑧𝑥
1 0
𝑐𝑜𝑠𝜃 −𝑠𝑖𝑛𝜃 𝑇𝑧𝑥′
=−
𝑇𝑧𝑦
0 −1 𝑠𝑖𝑛𝜃 𝑐𝑜𝑠𝜃
𝑇𝑧𝑦′
The operations being performed can be summarized as follows:
• The rotation matrix is applied to rotate from flight orientation to Northing (if necessary).
• The diagonal matrix transforms the cross-line direction from being 90 degrees counter clockwise relative to
along-line direction, to being 90 degrees clockwise relative to along-line direction (if necessary).
• The negative sign out front transform the coordinate system from being z +ve upwards to z +ve downwards (if
necessary).
Note: This transformation has been built into GIFtools. We will demonstrate this in the workflow.

Note: If the Fourier convention of the the field collected data is not the same as UBC-GIF convention, the imaginary
components of the Tipper data can be multiplied by -1 after the coordinate system transform is carried out.
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Example
When ZTEM data are acquired, the contractor will frequently provide the cross-over polarity for data collected along
each flight direction (see below). Essentially, they provide the expected Re[Tzx] anomaly, at sufficiently low frequency,
over a compact conductor. Given this information, how do we determine the transformation required to go from the
field coordinate system to UBC-GIF?
In the figure below, we see the cross-over polarity for a survey that has data collected along two different flight line
directions. We will deduce the transformation required to go from the field data coordinate system to UBC-GIF.

Fig. 86: Convention for airborne data collected along 2 flight bearings.
Z +ve upward or Z +ve downward?
From the figure, we see that the coordinate system for field collected data is defined using a z +ve upward convention,
whereas UBC GIF uses a z +ve downward convention. Thus we will need to include this in our transformation.
Is cross-line 90 degrees clockwise or 90 degrees counter clockwise from the along-line direction?
From the figure, we see that the cross-line direction is 90 degrees counter clockwise from the along-line direction.
UBC-GIF is 90 clockwise. Thus we will need to include this in our transformation.
What is the flight line direction (along-line direction)?
According to the contractor, I would see +ve Re[Tzx] values followed by -ve Re[Tzx] values if I flew from South to
North. Given that data are currently defined with z +ve upward, I know the bearing for this data is 0 degrees. I do not
need to rotate the data collected South-North.
Flying Southeast to Northwest, I would see +ve Re[Tzx] values followed by -ve Re[Tzx] values as I fly over the conductor. Given that data are currently defined with z +ve upward, I know the bearing for this data is -45 degrees. I must
therefore rotate these data by +45 degrees.
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Interpretation using total divergence
Tipper data are sensitive to lateral changes in electrical conductivity. To represent the tipper data in a way that is directly
sensitive to conductive and resistive structures, we can compute the total divergence parameter (termed the ‘DT’). For
both the real and imaginary components, the total divergence parameter is computed by:
𝐷𝑇 =

𝜕𝑇𝑧𝑦
𝜕𝑇𝑧𝑥
+
𝜕𝑥
𝜕𝑦

where X = Northing and Y = Easting in the UBC-GIF convention. Below, we plot the total divergence parameter for
the real component at 30 Hz over a conductive block and over a resistive block. In these plots, we see that:
• A positive anomaly is present for the real component over the conductive block
• A negative anomaly is present for the real component over the resistive block
• The dimensions of the anomaly are similar to those of the conductor/resistor for simple geometries

Fig. 87: Total divergence of the real component over a conductor at 30 Hz (left). Total divergence of the real component
over a resistor at 30 Hz (right).
Note: The data used for this tutorial were collected at Dufferin Lake as part of a uranium exploration project. The
data are public domain. They were downloaded from the Saskatchewan Mineral Assessment Database . The original
data have been down-sampled to make the size of data files more manageable.

10.4.2 Loading and Transforming Field Data into GIF Convention
The first step in any project is to load field collected data and visualize it. ZTEM datasets are challenging to work
with for several reasons. First, ZTEM data are computed by applying a non-trivial operation to the components of the
measured magnetic fields. Second, the ZTEM data values are frequently represented in a survey-dependent coordinate
system.
Here, we will assume that you have some XYZ formatted ZTEM data. The goal is to transform these data into UBC-GIF
convention so that we can work entirely within the GIFtools framework. Using contractor information and GIFtools,
we will show how this is possible.
Important: Requires GIFtools v2.30 or later.
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Starting Your Project
• Open GIFtools
• Set the working directory
Import Files
Note: If you do not have Geosoft XYZ formatted data from which to work with, you may download tutorial data . It
is from this dataset that we will demonstrate the workflow.
Here, we import the ZTEM data and topography.
• Import topography data (XYZ format). The data file is named ZTEMtopo.xyz and is in the assets folder.
• Import ZTEM data from Geosoft XYZ. The data file is named ZTEMdata_XYZ.dat and is in the assets folder. If
you are using the tutorial data:
– We are loading data at 6 frequencies: 30, 45, 90, 180, 360 Hz and 720 Hz.
– There are 4 data groups (TZXR, TZXI, TZYR, TZYI)
– Make sure you load the bearing column as well!
• Once loaded, make sure to set IO headers for all ZTEM data.
• Pro tip: To avoid confusion between location and data coordinate systems, use the set data headers tool to define
location columns as Easting, Northing and Elevation.
Determining Data Convention
Now that we have loaded the XYZ data file and set the IO headers, we can take a first look at our data. By looking at
the raw data and using any contractor information we can determine:
1) the coordinate system in which our data are being represented
2) the transformation required to go from the raw data coordinate system to UBC-GIF
3) whether the data are represented using a +𝑖𝜔𝑡 or −𝑖𝜔𝑡 Fourier convention
Some things to consider when examining your dataset may include:
• Any information about data convention provided by the contractor. This is the most important.
• If the data values collected along different flight line directions do not match up at the same locations.
• If the shape of the Tzx anomaly over a known conductor or resistor lines up with the flight direction. Recall the
anomaly over a compact conductor .
• Whether the real and quadrature components are the same sign (+iwt) or opposing sign (-iwt) at the lowest
frequency. Use this only when necessary!!! It is best to determine the Fourier convention directly from the
contractor.
For the tutorial data, the real and imaginary components of the tipper data are plotted below. We see that data collected
Southwest to Northeast and data collected Northeast to Southwest are very different at similar locations. This indicates
the data coordinates are dependent on flight direction. According to the contractor, the imaginary component of the
tutorial data are represented using a −𝑖𝜔𝑡 Fourier convention. And for this particular dataset, we see that the real and
imaginary components of the Tipper data have opposing sign. Note that at 90 Hz (seen below), induction is significant
and the sign of the quadrature components has changed!!!
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Fig. 88: Raw ZTEM data (TZXR, TZXI, TZYR and TZYI) at 90 Hz. Figure shows that data collected along different
flight lines are not collected in the same coordinate system.
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Below, we see the convention for data collection provided by the contractor. The plot defines Z as +ve upwards. The
plot also indicates that the cross-line direction is 90 degrees counter clockwise from the along-line direction.
Flying Northwest to Southeast (bearing = 125 degrees), our Re[Tzx] anomaly would be positive to the Northwest of a
conductor and negative to the Southeast. Flying Southwest to Northeast (bearing = 35 degrees), our Re[Tzx] anomaly
would be positive to the Southwest and negative to the Northeast.

Fig. 89: Cross-over polarization for data flown along bearing 125 degrees (left) and along 35 degrees (right).

Transformation to UBC GIF Coordinates
According to the contractor information, we must apply the following transformations to the ZTEM data provided:
• Data collected along Northwest to Southeast must be rotated counter clockwise by 125 degrees. And data collected along Southwest to Northeast must be rotated counter clockwise by 35 degrees.
• We must transform the cross-line direction to being 90 degrees clockwise from the along-line direction instead
of 90 degrees counter clockwise.
• We must transform from z +ve upward to z +ve downward.
• The Fourier convention for the data is −𝑖𝜔𝑡 (which is consistent with UBC-GIF format). If this were not the
case, you would need to multiply the imaginary component of the Tipper data by -1 after the spatial transform.
To apply this transformation, we use the following utility:
• ZTEM data transformation. The XYZ file has a column which provides the along-line direction for each datum.
• Don’t forget to set IO headers such that the data are defined in the UBC-GIF convention.
Tipper data after applying the transformation is shown below. Data are now in the UBC-GIF convention, where X =
Northing, Y = Easting and Z is positive downward. The position of the data however, are still in standard UTM. The
data map indicates a possible conductive feature that trends from the Southwest to the Northeast.
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Fig. 90: ZTEM data (TZXR, TZXI, TZYR and TZYI) at 90 Hz represented in UBC-GIF coordinates. Figure shows
that all data are in the same coordinate system.
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Interpretation using total divergence
We can compute the total divergence parameter for the data at each frequency in order to locate obvious conductive and
resistive structures. To do this, we must make sure that we have first set IO headers to data columns in the UBC-GIF
convention. To compute this quantity for the real and imaginary components:
• Computer total divergence (DT) columns
The total divergence parameter computed for real data at 30 Hz, 90 Hz and 360 Hz is shown below. The total divergence
parameter map indicates the existence of conductive structures within a more resistive background. The most prominent
conductive feature strikes along a bearing of roughly 35 degrees from the North. This conductive feature is observed
across all frequencies.

Fig. 91: Total divergence parameter for the real component at 30 Hz (left), 90 Hz (middle) and 360 Hz (right).
Note: If structures were much more resistive than the background, they would be identified as large negative anomalies
in the total divergence parameter map.

10.4.3 Assigning Uncertainties
Here, we provide a basic approach for assigning uncertainties to ZTEM data. The role of uncertainties in geophysical
inversion is presented in the fundamentals of inversion. When assigning uncertainties, we want to ensure we fit the
anomaly and not the background. We also want to ensure we fit each component and frequency equally.
Percent Versus Floor Uncertainty
For each frequency (roughly 30 Hz to 720 Hz), and for each component (TZXR, TZXI, TZYR, TZYI), ZTEM data
values span roughly the same range. Because of this:
• ZTEM anomalies observed at higher frequencies have roughly the same magnitude as ZTEM anomalies observed
at low frequencies.
• TZXR, TZXI, TZYR and TZYI anomalies have similar magnitudes.
Therefore the uncertainties applied to ZTEM data should generally be dominated by a floor value; as opposed to a
percent which scales data values at different orders of magnitude.
There is another problem which occurs if the uncertainties are dominated by a percent. Since the background response
for ZTEM data is theoretically zero, larger uncertainties are applied to ZTEM anomalies if a percent is used. This
results in an inversion which attempts to over-fit the background at the expense of under-fitting the anomalies.
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When the inversion is complete, we will be able to assess whether the estimated uncertainties on our data were correct.
If not, the inversion will need to be re-run with a new set of uncertainties.
General Approach
There are a few options for choosing the floor uncertainty values for each component at each frequency:
1) The user may take some fractional percents of the largest anomalous value and use that as the floor.
2) The user may sort the data by absolute value, and choose a threshold at which the data values contain an insignificant amount of signal and are dominated by noise.

Fig. 92: Option 1 for choosing uncertainties (left). Option 2 for choosing uncertainties (right).
To keep our synthetic example simple, we chose to add uncertainties of 0.02 to all data. This was roughly 5-10 % the
maximum anomaly amplitude for most components and frequencies. Despite being a quick way to assign uncertainties,
we may end up over-fitting certain frequencies and/or components at the expense of others. To apply uncertainties:
• Use the GUI for applying frequency-dependent uncertainties.

10.4.4 Data Preparation
Before creating a survey-dependent mesh, writing UBC-GIF formatted data files or inverting, certain steps must be
completed. These include:
• Down-sampling the data to a manageable number of data points
• Setting the base station (unless Hx and Hy are measured at the same location as Hz)
• Setting the data type (base station or no base station)
• Defining the Hx, Hy and Hz receiver loops (only needed for E3DMT v2)
These steps are covered here.
10.4. Comprehensive Workflows: ZTEM
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Down-Sampling
The sampling rate in the along-line direction is generally much higher than is needed to characterize ZTEM anomalies.
Furthermore, 3D EM inversions are generally unable to recover geologically plausible models when the data spacing
is less than 2-3 horizontal cell widths; implying you may consider some aspects of mesh design during this step. The
desired station spacing is generally determined by the flight-line separation. Here, we down-sample the data based on
a desired minimum separation.
Our Approach:
The flight-line separation for the tutorial dataset is 200 m, indicating we may want to down-sample such that the
minimum data separation is 150-200 m. We chose to down-sample the data such that the minimum data spacing was
400 m. This was done so we invert the data on a coarser mesh. For this step:
• Down-sample based on distance
Setting the Base Station
The horizontal magnetic fields are general measured at a base station. In this case, we must define the base station
location. For the tutorial data, the base station is located at Easting = 697523 m, Northing = 6375971 and elevation =
533 in UTM zone 12. To carry out this step:
• Set/reset base station
Setting ZTEM Data Type
We need to specify if the horizontal fields are measured at a base station or with sensors attached to the aircraft. This
is done with the following functionality:
• Set ZTEM data type
Defining Receivers
E3DMT v1 models the magnetic fields at discrete points whereas E3DMT v2 allows the user to define the receiver
loops. If you intend to invert data with E3DMT v2, this step is required. To define the receiver loops, we use the
following functionality:
• Set/reset receivers from data locations
Our approach:
According to the contractor, Hx and Hy were measured at a base station. The receivers at the base station were circular
with a diameter of 0.27 m. Hz was measured with a circular loop with a diameter of 7.4 m. Thus we used the following
parameters to fill in the fields:
• Hx, Hy receiver width: 0.27
• Hx, Hy number of segments: 8
• Hz receiver width: 7.4
• Hz number of segments: 8
• Orientation from Nothing (deg): 0 (since all rotations to UBC-GIF were done already)
Note: If any of the loops are square, choose the number of segments to be 4. GIFtools will define the loop as a square
with side length equal to the value specified.
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10.4.5 Mesh Design
Here we provide a basic approach for mesh design when inverting ZTEM data. The tutorial data set was collected in a
region with minimal topography. However, we will complete this step as if the topography is significant and must be
modeled.
Skin Depth
For frequency-domain data, an important step is to compute the minimum and maximum skin depth for the data you
want to invert. The minimum and maximum skin depths can be used to estimate the depth range your data are sensitive
to. The skin depth depends on frequency and the electrical resistivity/conductivity:
√︂
√︂
𝜌
1
= 500
𝛿 ≈ 500
𝑓
𝜎𝑓
Unlike MT and FEM data, you cannot estimate the electrical conductivity from ZTEM data directly. Ideally you would
have an idea of the background conductivity from physical property measurements or other geophysical data.
Our Approach:
2D ZTEM inversion results from past studies used a background conductivity of 0.001 S/m. As a result, we assume a
background conductivity of 0.001 S/m. We are inverting 6 frequencies between 30 Hz and 720 Hz. For the maximum
and minimum frequencies, and for the background conductivity chosen, the skin depths are:
• 𝛿𝑚𝑖𝑛 = 589 m
• 𝛿𝑚𝑎𝑥 = 2887 m
Create Mesh
Here, we explain how to create an OcTree mesh based on ZTEM survey geometry. We also explain the reasoning for
the parameter values entered. We can create OcTree meshes from ZTEM surveys with the following utilities:
• create OcTree mesh with E3DMT utilities
• create OcTree mesh with E3DMT v2 utilities
Once you have created the object, complete the following steps:
1) Set the data object corresponding to the survey
2) Define the mesh using Edit Options
3) Run the utility
4) Load results
For the tutorial data, we chose to create the mesh with E3DMT v2 utilities. This was done because we are able to define
the receiver loops. The parameters set in Edit Options are shown below along with reasoning for several important
choices. For definitions of the parameters, consult the E3DMT or E3DMT v2 manual.
Minimum cell width (horizontal): A minimum horizontal cell width of 150 m was chosen based on a minimum
data separation of 400 m. In practice, the user should have at least 2-3 cells between each data point. In general, the
down-sampling and minimum horizontal cell width is dependent on the flight-line separation.
Minimum cell width (vertical): The minimum vertical cell width is determined primarily by the smallest skin depth.
If the topography is flat and the geology is relatively simple, the minimum vertical cell width can be roughly 10%-20%
the minimum skin depth. Because the source signal for natural source EM data is a vertically propagating plane-wave,
it is sometimes more beneficial to discretize in the vertical more than in the horizontal; because lateral variations in the
fields are smaller. For the tutorial data, a minimum vertical cell width of 75 m was chosen.
10.4. Comprehensive Workflows: ZTEM
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Fig. 93: Parameters used to define the mesh for the field dataset using E3DMT v2 mesh utility.
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Max. topo cell: Even if the topography is significant, we do not want to over-discretize in regions far from the survey,
as the fields there do not greatly impact the data. As a result, this parameter was set to a larger number. If you want to
more finely discretize the topography, set this to 8, 4, or even 2. E3DMT v1 does not have this option.
Padding cell expansions: The extent of the mesh depends on the largest skin depth. The mesh should extend 2-3
largest skin depths from the survey region in all directions. Because OcTree meshes pad out so effectively, setting this
to be very large does not add many additional cells.
Core region discretization: Thickness 1 *should be used to discretize the region sensitive to the highest frequencies
(2-3 smallest skin depths). *Thickness 2 and 3 should be used to discretize the additional regions sensitive to he lower
frequencies. Thickness 1 + Thickness 2 + Thickness 3 should be roughly equal to at least 1 largest skin depth.
Number of cells around Rx: The number of fine mesh cells near receivers does need to be as large for natural source
EM modeling as is does for controlled source EM modeling. Fields associated with natural sources are are much
smoother. You can make the mesh a much more reasonable size by taking advantage of this, however sufficient discretization is still required to model the fields accurately.
Make polygon: For UBC-GIF v2 codes, this parameter controls the horizontal extent of the core mesh region. In
pratice, this should be 1-2 times the smallest skin depth.
Shift data: We chose to shift the data locations so that true flight height was preserved over the discretized topography.
See important notices below.
Important: If you choose to shift data for E3DMT v2 utilities, the mesh utility will create a receivers file. When
loading output, a new data object is created under the mesh utility. You will notice that the base station is not defined
and that the ZTEM data type is ‘MTH’. This is not a problem, as all receivers are organized to measure the fields at the
appropriate places. But if you are concerned, you can repeat the steps in the data preparation section .

10.4.6 ZTEM Inversion
Here, we provide the steps for setting up and running an inversion with E3DMT or E3DMT v2. We then discuss some
important aspects of choosing inversion parameters.
Reducing Artifacts through Interface Weighting
When inverting ZTEM data, the E3DMT codes have a tendency to place conductive structures near receiver locations
due to the sensitivity of the data to those locations. Here, we generate interface weights to counteract this problem. By
forcing lateral smoothness within the top few layers of cells, we can limit the artifacts and force the inversion to place
conductive structures at the appropriate depths.
• Create and interface weights utility
• Use edit options and set the following parameters:
– set the OcTree mesh
– set as log model
– set topography as the active cells model
– set number of layers and corresponding weights (choose something exponentially decreasing. We chose
20, 10, and 5)
– Face value = 0.001
– Face tolerance = 0.001
• Run the utility
10.4. Comprehensive Workflows: ZTEM
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• Load results
Create, Run and Load Inversion
We can now invert ZTEM data using E3DMT v1 or v2.
• Create E3DMT v1 or v2 inversion object
• Use edit options for v1 or v2 to set the inversion parameters
• Click Apply and write files
• Run the inversion
• Load results
For the tutorial data, we chose to invert using E3DMT v2, as we were able to define the receiver loops. Things are
effectively the same for E3DMT v1. The parameters used are shown below. Note that we chose the data object that
has shifted locations relative to discretized topography.

Fig. 94: Parameters used to invert the field dataset using E3DMT v2.

Discussion of Parameters
Note: The parameters chosen for inversion of the field dataset were experimentally derived. The numbers used here
worked well for inverting this dataset but should not necessary be used as general default values!
Regarding beta cooling schedule:
For synthetic modeling, we know the uncertainties on our data. With real data, we cannot be 100% sure that we have
correctly estimated the uncertainties. In the case that we have globally under-estimated our uncertainties, we sometime
set the chi factor to be less than 1. That way, we get to see more of the Tikhonov curve.
When setting the cooling schedule for the tutorial data set, the strategy was pretty straight-forward:
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• beta max = 0.1. The model recovered at the first iteration should clearly underfit the data. However if beta max
is too large, you will have multiple iterations where the model doesn’t budge because no emphasis is being put
on fitting the data. We knew a good starting beta for the final inversion from cursory inversions of the data.
• beta min = 1e-7. This can be set quite low. But it is good for the inversion to terminate within a reasonable
number of beta iterations if target misfit is not reached.
• reduction factor = 0.25: Generally we choose a value between 0.1 and 0.9. If the reduction factor is too large,
the code will run for a long time since the reduction in beta at each iteration is small. If the reduction factor is
too small, we do not get much detail regarding the convergence of the inversion.
• chi factor = 1 Here, we assume that appropriate uncertainties are set on the data. Thus, we assume the recovered
model explains the data without over-fitting (fitting the noise) when the data misfit equals the number of data
observations (chi factor = 1). In practice, you may choose a chi factor less than 1. This will allow you to get a
better understanding of the convergence, especially if you have over-estimated the uncertainties.
Regarding the alpha parameters:
As a default setting, we frequently let 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1 and we let 𝑎𝑙𝑝ℎ𝑎𝑠 = 1/𝑑ℎ2 ; where 𝑑ℎ is the width of the
smallest cells in the mesh. This effectively balances the emphasis on recovering a model that is similar to a reference
model and recovering a model that has sufficient structure. If we have high confidence in our reference model, we may
choose to increase 𝛼𝑠 relative to 𝛼𝑥 , 𝛼𝑦 and 𝛼𝑧 . If we have low confidence in our reference model, we may choose to
decrease 𝛼𝑠 relative to 𝛼𝑥 , 𝛼𝑦 and 𝛼𝑧
For this exercise, we have been provided with zero prior information regarding the Earth’s structure or its electrical
conductivity. We have assumed the background conductivity is 0.001 S/m but at no point have we validated this
assumption. As a result, we have set 𝛼𝑠 = 10−10 and let 𝛼𝑥 = 𝛼𝑦 = 𝛼𝑧 = 1. This will recover a conductivity model
which is primarily driven by the data, and is impacted minimally by the reference model.
Regarding the background, starting and reference models
For the background, starting and reference models, we chose 0.001 S/m. This value was suggested by a 2D ZTEM
study that came with the original dataset. Before you choose these values for your project, there are some things you
should consider.
If you choose a background conductivity that is lower than the true conductivity:
• The overall range of conductivities in the recovered model may be lower than the true range of conductivities.
• Your inversion will be more sensitive to structures at depth. Recovered conductors may be lower conductivity
and placed at larger depths.
If you choose a background conductivity that is higher than the true conductivity:
• The overall range of conductivities in the recovered model may be higher than the true range of conductivities.
• Your inversion will be not but as sensitive to structures at depth. Recovered conductors may highly conductive
and placed at shallower depths.

10.4.7 Inversion Results
Here, we demonstrate a common practice for examining the output of the inversion code. This includes examining the
convergence, the data misfit and the recovered model. Before looking at recovered models, the user is strongly urged
to examine the convergence of the algorithm first (Tikhonov curve). By examining the convergence, we can:
• determine if our data is in UBC-GIF data convention. The data misfit will be large and will not reduces at each
iteration otherwise.
• see if the inversion is able to reach target misfit
• infer whether the target misfit is reasonable; i.e. did we globally over or under-estimate the uncertainties on our
data
10.4. Comprehensive Workflows: ZTEM
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We then assess how well a given recovered model explains the data by looking at the predicted data, observed data and
normalized data misfit maps. From this we can determine whether:
• the predicted data fits the amplitude, shape and character of observed anomalies for each component and for each
frequency
• the estimated uncertainties were reasonable for each component and for each frequency.
• the inversion must be re-run with a new set of uncertainties
Only when the convergence and data misfit are acceptable can we infer geological structures from recovered models.
Convergence
Once the inversion outputs have been loaded (done in the inversion section)
• View convergence
The Tikhonov curve for our example inversion is shown below. According to the figure:
• the inversion reaches target misfit (chi-factor = 1 in this case) after 4 iterations. Thus the algorithm is converging
over the course of the beta cooling schedule.
• the inversion reaches a chi-factor of 1 (data misfit equals number of data) somewhere between the 3rd or 4th
iteration. Assuming the estimate of our uncertainties is correct, the optimum recovered model should correspond
to a chi-factor of 1.
• the Tikhonov curve starts to flatten out at the 4th iteration, indicating the point on the Tikhonov curve after which
recovered models start to over-fit the data. You may choose to verify this by setting the chi factor to something
like 0.5 and re-running the inversion.
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Data Misfit
According the Tikhonov curve, the recovered model at iteration 4 has a good change of explaining the data without fitting
the noise. To be sure however, we must examine the observed data, predicted data and data misfit for the corresponding
model. Here are some good questions to ask during this step:
• Are the prominent anomaly features identified in the observed data also found in the predicted data? Is this true
for all components and for all frequencies?
• Are there obvious coherent features in your normalized misfit map? If so, this indicates you are over-fitting
certain regions at the expense of others and that you must assign new uncertainties and re-run the inversion.
• Are the ranges of normalized misfits for each component and for each frequency generally the same? If not, the
uncertainties are not balanced between components and/or frequencies. In this case, new uncertainties should
be applied and the inversion should be re-run.
For our example inversion, here are some things we noticed:
• The general shape and amplitude of the main geophysical signatures are well reproduced by the predicted data
at all frequencies and for all components.
• The range of normalized misfits are generally consistent over all frequencies and over all components. This
indicates that our basic estimate of the data uncertainties was a good first estimate.
• The TZXI component has noticeably smaller normalized misfits than the other components, indicating the inversion fits these data better than it does the other components.
• TZYI shows higher normalized misfits and more coherent features at low frequencies.
• Individual misfit maps shown coherent features, but these features are not consistent over all frequencies.
For our example, better results could be obtained by decreasing the floor uncertainty on TZXI by some factor and
re-running the inversion to ensure we recover a model which fits the data evenly. This change will force the inversion
to fit the TZXI component as well as it does the TZXR, TZYR and TZYI components. We may also adjust the floor
uncertainty for individual components and frequencies which we feel are over/under fit.
Recovered Model
The conductivity model recovered at the 4th iteration is shown below. A cutoff of 0.003 S/m was applied. The model
was also sliced horizontally at an elevation of 253 m. To show how well structures in the recovered model match data
signatures, we plotted the total divergence parameter at 45 Hz and at 180 Hz.
The inversion recovers the large conductive feature that strikes along a bearing of 35 degrees. The conductivity along
the recovered feature corresponds well to amplitude of the ZTEM response. A secondary conductive feature is also
recovered at the Southernmost tip of the survey area. Along the Eastern end of the of the survey area, ZTEM data and
the total divergence parameter indicated the possible presence of another conductor. Although the inversion placed
conductive structures in this area, the feature is poorly constrained by the data.
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Fig. 95: Predicted data, observed data and normalized misfit for all data components at 180 Hz. For each component,
predicted and observe data are plotted on the same scale. All normalized misfit maps are plotted on a range from -3 to
3.
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Fig. 96: Recovered model and total divergence parameter at 45 Hz (left) and at 180 Hz (right).
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CHAPTER

ELEVEN

VIDEO TUTORIALS

Below is our entire collection of video tutorials!
Overview
• General functionality
Data types
• Magnetics data
• Gravity data
• DC data
• IP data
• Frequency-domain EM data
• Time-domain EM data
• Magnetotellurics data
• Z-axis tipper data
• Physical property and borehole data
• Topography data
Meshes
• 3D tensor mesh
• OcTree mesh
Models
• Cell-centred discretized model
• Face-centred discretized model
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11.1 General functionality covering all data types
• Main look and feel of GIFtools: YouTube, download (11 MB)
• Import ascii-based XYZ files: YouTube, download (18 MB)
• Import ascii-based CSV files: YouTube, download (23 MB)
• Import ascii-based XYZ or CSV files for EM data: YouTube, download (49 MB)
• Import GIF-formatted files: YouTube, download (5 MB)
• Change the number of openMP threads for executables and find the version number: YouTube, download (12
MB)
• General data GUI: YouTube, download (87 MB)
• General model GUI: YouTube, download (123 MB)
• Create a tensor mesh: YouTube, download (34 MB)
• Using the modelBuilder module: YouTube, download (11 MB)
• Assign simple uncertainties to any data set: YouTube, download (7 MB)
• Use of data calculators: YouTube, download (35 MB)
• Use of calculator for models: YouTube, download (16 MB)
• View convergence curves for an inversion: YouTube, download (15 MB)
• Create topography data from data: YouTube, download (8 MB)
• Downsample data using a mesh: YouTube, download (26 MB)
• Remove data outside of a mesh: YouTube, download (11 MB)
• Set i/o headers: YouTube, download (8 MB)
• Rename data headers: YouTube, download (5 MB)
• Set the number of OMP threads: YouTube, download (9 MB)
• View data as a table: YouTube, download (8 MB)

11.2 Data types
In this section, we summarize the general functionality associated with each data type that can be used within GIFtools.
Magnetics data (MAGdata)
• I/O of GIF-formatted mag3d data files: see general functionality
• I/O of ascii-based CSV and XYZ file type: see general functionality
• Change/set (anomaly) inclinations, declinations, and field strength: YouTube, download (2.9 MB)
• Remove DC bias: YouTube, download (7.7 MB)
• De-trend data with polynomial fits: YouTube, download (17.5 MB) (or via the data GUI)
• Assign standard deviations (% and/or floor) to data: see general functionality
• Edit datum or standard deviation or completely remove them: see general functionality
• Output files for forward modelling: YouTube, download (10 MB)
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• Set up input files for use with mag3d inversion: YouTube, download (14.5 MB)
• Read output files from mag3d and view predicted data, recovered models, and inversion diagnostics (e.g.,
Tikhonov curve): YouTube, download (26 MB)
• Perform joint inversion on multiple magnetic data sets with mag3d: YouTube, download (50 MB)
• Perform equivalent source processing (with magsenes and maginves): YouTube, download (25 MB)
• Add Gaussian noise to the data: YouTube, download (6 MB)
Gravity data (GRAVdata)
• I/O of GIF-formatted grav3d data files: see general functionality
• I/O of ascii-based CSV and XYZ file type: see general functionality
• De-trend data with polynomial fits: see magnetic data or via the data GUI
• Assign standard deviations (% and floor) to data: see general functionality
• Edit datum or standard deviation or completely remove them: see general functionality
Tip: Check the magnetic data section, too, as often what works there, also works for gravity (both being potential
field data).
Direct current data (DCdata)
• I/O of GIF-formatted dcip2d and dcip3d data files: see general functionality
• Import DCIP ascii files: YouTube, download (15 MB)
• Create 2D data sets from 3D data and combine 2D data sets into 3D data files: YouTube, download (27 MB)
• Add standard deviations (% and floor) to data: see general functionality
• Edit datum or standard deviation or completely remove them: see general functionality
• Calculate normalized voltage from apparent resistivity: YouTube, download (8 MB)
• Calculate apparent resistivity from normalized voltage: YouTube, download (6 MB)
• Create input files and run make_wdat.exe: YouTube, download (24 MB)
Induced polarization data (IPdata)
• I/O of GIF-formatted dcip2d and dcip3d data files: see general functionality
• Import DCIP ascii files: YouTube, download (15 MB)
• Add standard deviations (% and floor) to data: see general functionality
• Edit datum or standard deviation or completely remove them: see general functionality
General frequency-domain EM data (FEMdata)
• I/O of GIF-formatted E3Dinv data files: see general functionality
• I/O of ascii-based CSV and XYZ file type: see general functionality
• Edit datum or standard deviation or completely remove them: see general functionality
• Simple and column calculator (same functionality as TEM): YouTube, download (5 MB)
• Assigning frequency-based uncertainty to EM data (same functionality as TEM): YouTube, download (19 MB)
General time-domain EM data (TEMdata)

11.2. Data types
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• I/O of GIF-formatted TDoctree or H3DTD data files: see general functionality
• I/O of ascii-based CSV and XYZ file type: see general functionality
• Edit datum or standard deviation or completely remove them: see general functionality
• Add AEM coincident loop sources: YouTube, download (10 MB)
• Add AEM offset loop sources: YouTube, download (15 MB)
• Simple and column calculator: YouTube, download (5 MB)
• Assigning time-based uncertainty to EM data: YouTube, download (19 MB)
Magnetotelluric EM data (MTdata)
• I/O of GIF-formatted MT3Dinv data files: see general functionality
• I/O of ascii-based CSV and XYZ file type: see general functionality
• Import EDI files: YouTube, download (14 MB)
• Edit datum or standard deviation or completely remove them: see general functionality
Z-Axis tipper EM data (ZTEMdata)
• I/O of GIF-formatted MT3Dinv data files: see general functionality
• I/O of ascii-based CSV and XYZ file type: see general functionality
• Edit datum or standard deviation or completely remove them: see general functionality
• Add a base station: YouTube, download (5 MB)
Physical property data (BOREdata and PROPdata) via modelBuilder
• Load borehole property, collar, and optional survey files: YouTube, download (60 MB)
• Edit datum or standard deviation or completely remove them: see general functionality
• Discretize borehole and property data onto a GIF mesh: YouTube, download (90 MB)
• Assign bounds and create a reference model for GIF inversions: YouTube, download (90 MB)
• Create weighting functions to add soft constraints to GIF inversions: YouTube, download (24 MB)
• Work in any units and convert them at the end to the proper units required for inversion via the calculators: see
general functionality
Topography data (TOPOdata)
• I/O and view GIF topography data files: YouTube, download (5.8 MB)
• Load and view Canadian Digital Elevation Data (CDED): YouTube, download (13 MB)
• Merge topography data sets together: YouTube, download (11 MB)
• Down-sample: YouTube, download (7.6 MB)
• Extend topography to mesh edges: YouTube, download (6 MB)
• Create 2D topography from 3D: YouTube, download ( MB)
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11.3 Meshes
In this section, we summarize the general functionality associated with each type of mesh that can be used within
GIFtools.
Three-dimensional tensor mesh (mesh3D)
• I/O and view 3D tensor meshes (for use with 3D codes): YouTube, download (9.8 MB)
• Create meshes internally with GIFtools for potential-field data: see general functionality
• Create a simple mesh: YouTube, download (13 MB)
OcTree meshes (meshOctree)
• I/O and view the ocTree meshes (for use with ocTree codes): YouTube, download (9.4 MB)
• Create refined octree mesh and active cell model from topography: YouTube, download (21 MB)

11.4 Models
In this section, we summarize the general functionality associated with each type of model that can be used within
GIFtools.
Cell-centred discretized models (GIFmodel)
• I/O and view GIF models: see general functionality
• Build reference models for inversion using other GIFmodels, geologic information, and/or borehole data: see
modelBuilder functionality
• Use a simple calculator to convert between units and change the unit description: YouTube, download (5 MB)
• Create active cell models from topography data (TOPOdata): YouTube, download (16 MB)
• Create simple constant-value models: YouTube, download (4.7 MB)
• Assign value to air cells: YouTube, download (13 MB)
Face discretized models (FACEmodel)
• I/O and view GIF models discretized on faces (e.g., weighting files): see general functionality (model GUI will
view FACEmodels)
• Create face weighting for inversion based on a reference model: see modelBuilder functionality

11.3. Meshes
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TWELVE

GIFTOOLS SITE MAP

Tip: Try using the search bar to quickly find what you are looking for!

Tip: Figures too small to read? Right-click on them and select “Open image in new tab” to get a bigger view.

Example
Look for this type of box throughout the cookbook to find examples to download. It is recommended to use the latest
version of GIFtools.
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